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Preface

About This Guide

This guide describes how to install and configure the RSA Access Manager Servers, 
the Data Adapters, and the RSA Administrative Console.

This guide is intended for administrators and other trusted personnel. Do not make this 
guide available to the general user population.

RSA Access Manager Documentation

The RSA Access Manager documentation set includes:

Release Notes. Provides information about what is new and changed in this release, as 
well as workarounds for known issues. The latest version of the Release Notes is 
available from RSA SecurCare Online at https://knowledge.rsasecurity.com.

Getting Started. Lists what the kit includes (DVD, CDs, licenses and documentation), 
specifies the location of documentation on the DVD, and lists RSA Customer Support 
web sites.

Planning Guide. Provides a general understanding of RSA Access Manager, its 
high-level architecture, its features, and deployment information.

Servers Installation and Configuration Guide. Provides instructions for installing 
and configuring the RSA Access Manager Servers and additional components. This 
guide also contains descriptions of the different configuration options, features, and 
production environment considerations.

Administrator’s Guide. Provides information for security administrators about using 
the RSA Administrative Console to administer users, resources, and security policy in 
RSA Access Manager.

Developer’s Guide. Provides information about developing custom programs using 
application programming interfaces (APIs) included with the RSA Access Manager 
Servers.

API Delta Document. Provides information about the differences between previous 
and current versions of the APIs included with the RSA Access Manager Servers.

Upgrade Guide. Provides information about how to upgrade previous versions of 
RSA Access Manager Servers, data store schema, and data to the current version.

Security Configuration Guide. Provides an overview of the settings available in the 
RSA Access Manager Server and compatible Agents to ensure secure operation of the 
product.

RSA Administrative Console Help. Provides instructions on how to perform specific 
administrative tasks. To view Help, click the Help tab on the RSA Administrative 
Console screen.
 Preface 13
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RSA - Service Console Help. Describes day-to-day user tasks performed in the User 
Self-Service Console. To view Help, click the Help tab on the RSA User Self-Service 
Console.

Related Documentation

For more information about products related to RSA Access Manager 6.1, see the 
following:

RSA Access Manager Agents documentation set. The documentation related to 
agents is available from RSA SecurCare Online at 
https://knowledge.rsasecurity.com.

RSA Adaptive Authentication documentation set. The documentation related 
to RSA Adaptive Authentication is available from RSA SecurCare Online at 
https://knowledge.rsasecurity.com.

RSA Envision documentation set. The documentation related to RSA Envision 
is available from RSA SecurCare Online at https://knowledge.rsasecurity.com.

Getting Support and Service

RSA SecurCare Online offers a Knowledgebase that contains answers to common 
questions and solutions to known problems. It also offers information on new releases, 
important technical news, and software downloads.

The RSA Secured Partner Solutions Directory provides information about third-party 
hardware and software products that have been certified to work with RSA products. 
The directory includes Implementation Guides with step-by-step instructions and 
other information about interoperation of RSA products with these third-party 
products.

Before You Call Customer Support

Make sure that you have direct access to the computer running the RSA Access 
Manager software. 

Please have the following information available when you call:

 Your RSA Security Customer/License ID. 

This is a paper license. You can find this number only on the license distribution 
medium. If you do not have access to the paper-based RSA Customer/License ID, 
contact RSA Customer Support.

 RSA Access Manager software version number and patch level.

RSA SecurCare Online https://knowledge.rsasecurity.com

Customer Support Information www.rsa.com/support

RSA Secured Partner Solutions Directory www.rsasecured.com
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 The make and model of the machine on which the problem occurs.

 The name, version, and patch level of the operating system under which the 
problem occurs.
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1 Preparing for Installation

• Platform and Operating System Requirements

• Binary Compatibility

• Memory Requirements

• RSA Access Manager Administrative Console Requirements

• Runtime Web Service Requirements

• Supported Data Store Servers

• Supported RSA Access Manager Agents

• Required Components

• Optional Components

• Installation Overview

The RSA Access Manager 6.1 DVD contains directories for Windows, Solaris, Linux, 
and AIX operating systems. Use the files in the directory that corresponds to your 
target operating system. Each directory provides platform-specific installation 
programs and instructions.

Note: The term “UNIX” in this document refers to all supported UNIX and 
UNIX-like platforms. When specific information applies only to a particular platform, 
the document states that platform name explicitly.

Note: References to LDAP directories, unless otherwise noted, refer to all directories, 
including Active Directory and Active Directory Application Mode.

Platform and Operating System Requirements

The following tables list the system requirements for a basic installation of the 
RSA Access Manager Servers on each supported operating system. These 
requirements assume that the machine supports:

• One Entitlements Server

• One Authorization Server

• One Dispatcher/Key Server

• One Data Adapter
1: Preparing for Installation 17
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Windows System Requirements

Solaris System Requirements

Linux System Requirements

Operating System Microsoft Windows Server 2003 SP2 – (32-bit) x86

Microsoft Windows Server 2003 R2 SP2 – (64-bit) x86

Microsoft Windows Server 2008 SP2 – (32-bit) x86

Microsoft Windows Server 2008 SP2 – (64-bit) x86

Microsoft Windows Server 2008R2 SP1 (64bit)

Java Runtime 
Environment

Sun JRE 1.5 and 1.6 (32-bit or 64-bit)

The Access Manager APIs require Sun JDK 1.5 or 1.6

Architecture x86/x86-64/EM64T, 500 MHz or faster

Disk Space 200 MB

Operating System Solaris 9 on SPARC

Solaris 10 on SPARC (64-bit)

Java Runtime 
Environment

Sun JRE 1.5 and 1.6 (32-bit or 64-bit)

The Access Manager APIs require Sun JDK 1.5 or 1.6

Architecture UltraSPARC, 500 MHz or faster

Disk Space 200 MB

Operating System Red Hat Enterprise Linux 4.0, and later– (32-bit) x86

Red Hat Enterprise Linux ES 5.0 ES – (64-bit) x86

Red Hat Enterprise Linux 6.0

SUSE Linux ES 9 – (32-bit) x86

SUSE Linux ES 10 – (64-bit) x86

SUSE Linux ES 11 – (64-bit) x86

Java Runtime 
Environment

Sun JRE 1.5 and 1.6 (32-bit or 64-bit)

The Access Manager APIs require Sun JDK 1.4 or 1.5

Architecture x86/x86-64/EM64T, 500 MHz or faster

Disk Space 200 MB
18 1: Preparing for Installation



RSA Access Manager 6.1 SP4 Servers Installation and Configuration Guide
AIX System Requirements

Binary Compatibility

Java components shipped with Access Manager execute in both 32-bit and 64-bit Java 
Runtime Environment (JRE) environments. 

Native code components shipped with Access Manager are 32-bit and execute on both 
32-bit and 64-bit processor models. Included libraries can only be used to build 32-bit 
applications.

Memory Requirements

The following table lists the minimum memory requirements for the Access Manager 
Servers. The production system load affects the memory usage of each Server.

The number of data store objects in the system that can be cached determines memory 
usage on the Entitlements Server. Memory usage on the Authorization Servers 
depends on the number of user and group entitlement records saved. You can 
configure the number of records cached by the Authorization Servers. Increasing the 
number of records cached improves runtime performance.

Operating System AIX 5.3 PowerPC

AIX 6.1 PowerPC

Java Runtime 
Environment

IBM JRE 1.5 and 1.6 (64-bit)

Architecture POWER4 or later

Disk Space 200 MB

Access Manager Server Memory Requirement 

Entitlements Server 128 MB

Authorization Server 128 MB per Authorization Server

Dispatcher/Key Server 64 MB

Instrumentation Server 64 MB

Log Server 64 MB
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RSA Access Manager Administrative Console Requirements

The Administrative Console is a web-based Java Server Pages (JSP) application. 
Using a web browser interface, administrators manage users, groups, resources, and 
policies. The Administrative Console is deployed as a web archive (WAR) file and 
requires a third-party servlet engine or application server that supports WAR files and 
implements the Java Servlet 2.3 and JSP 1.2 specifications. For this release, RSA 
supports the Administrative Console running on the products listed in the following 
table.

RSA Access Manager User Self-Service Console Requirements

The User Self-Service module is a web-based application that helps users manage 
their basic profile data and change their password. For this release, RSA supports the 
User Self-Service Console running on the following application servers.

Note: The User Self-Service Console is also exposed to Access Manager users. You 
must consider informing the users about the list of supported browsers.

System Component Minimum Requirement

Application Servers Apache Tomcat 5.5, 6.0, and 7.0

Oracle WebLogic Server 10.0, 11gR1

IBM WebSphere Application Server 7.0, and 8.0

Supported Browsers Microsoft Internet Explorer 6.0 on Microsoft Windows XP

Microsoft Internet Explorer 7.0 on Microsoft Windows Vista

Mozilla Firefox 3.0 on Microsoft Windows XP

Mozilla Firefox 3.0 on Linux

System Component Minimum Requirement

Application Servers Apache Tomcat 5.5, 6.0, and 7.0

Oracle WebLogic Server 10.0, 11gR1

IBM WebSphere Application Server 7.0, and 8.0

Supported Browsers Microsoft Internet Explorer 7.0 and 8.0 on Microsoft 
Windows XP

Mozilla Firefox 4.0 and 5.0 on Microsoft Windows XP

Mozilla Firefox 3.0 on Linux

Chrome 
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Runtime Web Service Requirements

The Access Manager Runtime Web Service is an optional server component that 
exposes Runtime API operations to clients in a language-agnostic way. For this 
release, RSA has certified the Runtime Web Service on the following application 
servers:

• Apache Tomcat 5.5 and 6.0 and 7.0

• Oracle WebLogic Server 10.0, 11gR1

Administrative Web Service Requirements

The Access Manager Administrative Web Service is an optional server component 
that exposes Administrative API operations to clients. For this release, RSA has 
certified the Administrative Web Service on Apache Tomcat 5.5 and 6.0.

Supported Data Store Servers

The Access Manager SQL or LDAP Data Adapter links Access Manager to your data 
store. Access Manager supports the following data store versions with the latest 
updates.

SQL LDAP

Oracle 10g Release 2 (10.2)

Oracle 10g Release 2 RAC

Oracle 10g Release 2 (10.2) RAC

Oracle 11g R2

Oracle 11g R2 RAC

Sybase 15.5

Microsoft SQL 2005 SP3

Microsoft SQL 2008 

Microsoft SQL 2008 Release 2

Microsoft Active Directory (AD) on Microsoft 
Windows Server 2003 

Microsoft Active Directory (AD) in combination with 
Active Directory Application Mode (ADAM) on 
Microsoft Windows Server 2003

Microsoft Active Directory (AD) on Microsoft 
Windows Server 2008 

Microsoft Active Directory Lightweight Directory 
Services (AD LDS) on Microsoft Windows Server 
2008

Microsoft Active Directory (AD) in combination with 
Active Directory Lightweight Directory Services 
(AD LDS) on Microsoft Windows Server 2008 

Sun Java System Directory Server 5.2, 6.3 and 7.0

Novell eDirectory 8.8.0 and later

OpenDJ 2.4.3
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Supported RSA Access Manager Agents

RSA Access Manager supports RSA Access Manager Agents 4.7 and later with the 
latest hot fixes. To contact RSA Customer Support, go to 
http://www.rsasecurity.com/support/.

Also, see your RSA Access Manager Agent documentation. 

Required Components

To install Access Manager, you must install and configure all of the following 
components:

• Access Manager Servers

• Administrative Console

• Access Manager Data Adapter

• Access Manager Web Server and Application Server Agents. 

The following table provides information on what you must do for each component.

Component What You Must Do

Access Manager 
Servers and 
Administrative 
Console

Install at least one of each:

• Entitlements Server

• Authorization Server

• Dispatcher/Key Server

• Administrative Console

Access Manager Data 
Adapter

Install one for each data store that Access Manager must access. If 
your site uses an LDAP directory, see Chapter 3, “Installing the 
LDAP Data Adapter” for installation instructions. If your site uses 
an SQL database, see Chapter 5, “Installing and Configuring the 
SQL Data Adapter.”

RSA Access Manager 
Agent

Install an appropriate agent on each web server or application server 
that you must protect.
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The following figure shows all of the required components and their high-level 
architecture. You can install all the Access Manager Servers on one machine, as 
shown in this figure, or on multiple machines. For maximum performance and 
reliability, RSA recommends that you install each Access Manager Server on a 
separate machine. You can run the Access Manager components in a Windows, UNIX, 
or mixed Windows and UNIX environment.

Optional Components

You can implement these optional components depending on your security needs, 
system load, existing network architecture, and logging requirements:

• Additional distributed Authorization Servers

• A redundant Entitlements Server (third-party high-availability software required)

• A redundant Dispatcher/Key Server

• Redundant LDAP directory instances for directories that support replication

• Access Manager Secure Proxy Server

• Access Manager Software Development Kit (SDK)

• RSA Certificate Manager (to create server certificates for Access Manager 
intercomponent security)
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• Access Manager Log Server (to centralize the log output of the Access Manager 
Servers).
On Windows, the Log Server is installed with the other Servers. If you plan to use 
this feature, you must enable the Log Server during the installation. For more 
information, see “Installing the RSA Access Manager Servers on Windows” on 
page 30. 

On UNIX, the Log Server is installed by default with the other Servers. For more 
information, see “Installing the RSA Access Manager Servers on UNIX” on page 
33.
If you do not enable the Log Server and configure the required remote log 
management parameters, the log files for the Access Manager Servers are saved 
on each individual Server. For more information, see Chapter 13, “Managing 
RSA Access Manager Log Files.”

• Access Manager Instrumentation Server (to provide Simple Network 
Management Protocol (SNMP) support for a third-party Network Management 
System (NMS)).
On Windows, the Instrumentation Server is installed with the other Servers. If you 
plan to use this feature, you must enable the Instrumentation Server during 
installation. For more information, see “Installing the RSA Access Manager 
Servers on Windows” on page 30. 
On UNIX, the Instrumentation Server is installed by default with the other 
Servers. For more information, see “Installing the RSA Access Manager Servers 
on UNIX” on page 33. 
For more information, see Chapter 14, “Simple Network Management Protocol 
Support.” 

Installation Overview 

When you install Access Manager for the first time, you must:

1. Make sure that your data store is installed and running.

2. Install the Access Manager Servers (Entitlements Server, Authorization Server, 
Dispatcher/Key Server), either all on one machine or distributed across any 
number of machines. RSA recommends that you install each Access Manager 
Server on its own machine in a production environment.
For more information, see Chapter 2, “Installing the RSA Access Manager 
Servers.”

Note: To centralize log files generated by each Access Manager Server, you must 
enable the Log Server during the installation process on Windows.
On UNIX, the Access Manager Log Server is installed by default with the Access 
Manager Servers. 

3. Update JRE. For more information, see “Updating JRE” on page 37.
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4. Install a Data Adapter on each data store that the Access Manager Servers must 
access. 
For more information, see Chapter 3, “Installing the LDAP Data Adapter” and 
Chapter 5, “Installing and Configuring the SQL Data Adapter.”

5. Configure each Access Manager Server by editing its configuration file. 
For more information, see Appendix A, “Configuration Files.” 

6. Copy the license file located on the license CD included in the Access Manager 
product package to your Access Manager Servers configuration directory.
For more information, see “Installing the License File” on page 39.

7. Start your Access Manager Servers to test the connection between the Servers and 
your data store.
For more information, see Chapter 6, “Running Your RSA Access Manager 
Servers.”

8. Install and configure the RSA Administrative Console. 
For more information, see “Overview of RSA Administrative Console 
Installation” on page 130.

9. Install and configure a Web Server Agent on each web server that Access 
Manager must protect. Install and configure an Application Server Agent on each 
application server that Access Manager must protect. 
For more information, see your relevant Agent documentation for instructions.

10. Optional. Install and configure redundant Access Manager Server components 
and complete your production and high-availability configurations.
For more information, see Chapter 11, “Deploying RSA Access Manager in 
Production Environments.”

11. Optional. Install and configure the Access Manager User Self-Service Console to 
allow users to change or reset their passwords and update other attributes such as 
their first name, e-mail, and other custom properties without any intervention 
from an administrator.

12. Optional. Configure any additional features of Access Manager that you are 
deploying, such as unique user session, intercomponent security, single sign-on, 
and URL retention. 

13. Log on to the Administrative Console to test your Console configuration settings. 
For more information, see “Starting the RSA Administrative Console” on page 
139. 

14. Use the Administrative Console to manage authorization and access. 
For information about using the Administrative Console, see the Administrator’s 
Guide.
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2 Installing the RSA Access Manager Servers

• Before You Begin

• Server Installation Overview

• Installing the RSA Access Manager Servers on Windows

• Installing the RSA Access Manager Servers on UNIX

• Updating JRE

• Enabling Support for Sybase as the Data Store

• Next Steps

A minimum, standard installation requires that you install and configure at least one of 
each of the following RSA Access Manager Servers: 

• Entitlements Server

• Dispatcher/Key Server

• Authorization Server 

There are also optional servers that you can install to provide additional functionality. 
The following table describes each required and optional Server component. For more 
information, see “Understanding RSA Access Manager Components” in the Planning 
Guide.

Server Component Description

Entitlements Server Required. Provides Administrative API clients (including the 
RSA Administrative Console) with read/write access to the 
Access Manager data store containing user, administrator, and 
security policy data.

Dispatcher/Key Server Required. The Dispatcher keeps track of all available 
Authorization Servers. By default, Agents are configured to 
query the Dispatcher at startup for available Authorization 
Servers. Agents then connect to the Authorization Servers that 
are available. 

The Key Server generates single sign-on (SSO) token encryption 
keys (or secret keys), which carry a limited lifetime in order to 
implement secure single sign-on. 

Authorization Server Required. Performs the authentication and authorization checks 
for users at runtime.

Log Server Optional. Provides centralized log output from the Entitlements 
Server, Dispatcher/Key Server, and Authorization Server. 

For more information, see “Centralized Logging” on page 244.
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Note: By default, the Access Manager installer installs the components on a single 
host. RSA does not recommend this architecture for a production deployment. Instead, 
RSA recommends that you distribute your Access Manager Server components across 
multiple hosts and deploy backup components to ensure high-availability. For more 
information, see Chapter 11, “Deploying RSA Access Manager in Production 
Environments.”

Before You Begin

Before installing the Access Manager Servers:

• Review “Installation Overview” on page 24 and “Platform and Operating System 
Requirements” on page 17 to ensure that you have accounted for all important 
prerequisites or dependencies. 

• Determine where the Access Manager Servers will be installed. If you are setting 
up multiple Access Manager Servers for failover and high-availability, see 
Chapter 11, “Deploying RSA Access Manager in Production Environments.”

Instrumentation Server Optional. Provides Simple Network Management Protocol 
(SNMP) support for a third-party Network Management System 
(NMS). 

For more information, see Chapter 14, “Simple Network 
Management Protocol Support.” 

Software Development 
Kit (SDK)

Optional. Allows you to develop custom applications for Access 
Manager.

Runtime Web Service 
and Administrative Web 
Service

Optional. The Runtime Web Service allows client applications to 
perform tasks such as authenticating users, authorizing user 
access to resources, retrieving properties, and manipulating 
single sign-on tokens, all by means of the web service standard. 
The Administrative Web Service allows client applications to 
perform tasks such as creating and managing users, groups, and 
applications.

For more information about the Runtime Web Service and 
Administrative Web Service, see Chapter 10, “Deploying 
Runtime and Administrative Web Services.”

Also, see “Runtime Web Service” and “Administrative Web 
Service” in the Developer’s Guide.

User Self-Service Optional. Allows you to change or reset passwords and update 
other attributes, such as first name, e-mail, and other custom 
properties without any intervention from an administrator. 

For more information, see Chapter 8, “Installing the RSA Access 
Manager User Self-Service Console.”

Server Component Description
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• Determine whether to use silent mode for installing Access Manager. Silent mode 
lets you perform an installation without manual user input. You can use silent 
mode in both Windows and UNIX environments. For instructions on using silent 
mode, see Appendix B, “Installing the RSA Access Manager Servers Using Silent 
Mode.” 

• Decide whether to enable or install the optional components described in the 
previous table.

Important: RSA recommends that the Access Manager Servers be installed on hosts 
with static IP addresses. Running the Servers on hosts using Dynamic Host 
Configuration Protocol (DHCP) may affect system performance.

Note: Throughout this document, the directory where you install the Access Manager 
Servers is called AXM_HOME. 

Server Installation Overview

During the installation of the Access Manager Servers, you must:

1. Use the installation method for your operating system to copy the Access 
Manager Server files to a location on your computer.

• For a Windows installation, see the following section, “Installing the 
RSA Access Manager Servers on Windows.” 

• For a UNIX installation, see “Installing the RSA Access Manager Servers on 
UNIX” on page 33. 

• For instructions on using silent installation mode, see Appendix B, “Installing 
the RSA Access Manager Servers Using Silent Mode.”

2. Update JRE in the Access Manager installation. For more information, see 
“Updating JRE” on page 37.

3. Install the Access Manager Data Adapter on your data store. The Access Manager 
Servers must be able to connect to the data store before they can start. 

• For an LDAP directory, see Chapter 3, “Installing the LDAP Data Adapter.” 

• For an SQL database, see Chapter 5, “Installing and Configuring the SQL 
Data Adapter.”

4. Install your Access Manager license file in the AXM_HOME/conf directory of 
your Access Manager installation. You cannot start the Access Manager Servers 
without a valid license. 

5. Start your Access Manager Servers to test your installation.
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Note: With a data store connection and valid license file, the Access Manager Servers 
can start. However, you cannot use the Servers to authenticate users or authorize 
access to resources until you complete additional tasks, such as setting up the 
Administrative Console, installing the Agents, and configuring authentication types. 
For information on installing Agents and configuring authentication types, see your 
RSA Access Manager Agent Installation and Configuration Guide.

Installing the RSA Access Manager Servers on Windows

You can install the Access Manager Servers using one of these methods: 

• Standard installation using the InstallShield program.

• Automated silent installation with an InstallShield silent (.iss) setup file. For more 
information on silent installation, see Appendix B, “Installing the RSA Access 
Manager Servers Using Silent Mode.”

Important: On Microsoft Windows, RSA recommends that only the Local 
Administrator install the Access Manager Servers. If the Domain Administrator 
installs the Access Manager Servers, the Domain Administrator must have Full 
Control permission.

RSA recommends using the standard installation method described in the following 
procedure.

By default, the Access Manager files are installed in C:\Program Files\RSA\Access 
Manager Servers 6.1. You can change this to another location during installation.

To install RSA Access Manager Servers on Windows using standard 
installation:

1. Make sure that your data store is installed and running before you begin your 
installation.

2. On the RSA Access Manager 6.1 DVD, navigate to the \win32-x86\axm_servers 
directory. 

3. Double-click setup.exe.

4. In the Welcome to RSA Access Manager dialog box, click Next.

5. In the Region Selection dialog box, make the requested selection, and click Next.

6. In the Software License Agreement dialog box, click Yes.
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7. In the Installation Type dialog box, select New or Upgrade, and then click Next.
The following table describes each option.

8. In the Destination Folder dialog box, accept the default installation location or 
browse to an alternative location where you want to have the Access Manager 
Servers installed, and click Next.

9. In the Dispatcher Configuration dialog box, enter a valid e-mail address for use 
with your Access Manager administrator account. If necessary, change the default 
ports, and click Next.

10. In the Data Adapter Selection dialog box, select your data store, and click Next.

Note: For Sybase, select Oracle 10g R2/Oracle RAC or Microsoft SQL Server 
2005, and continue with the installation. After installation, follow the steps 
explained in “Enabling Support for Sybase as the Data Store” on page 38.

11. In the data_store Connection Information dialog box, enter the following 
information about your data store: 

Hostname. The hostname of your data store host.

Port. The port number that Access Manager will use to connect to this data store. 

Base DN. Identifies the root node of your LDAP directory, pointing Access 
Manager to the directory containing your user data.

Note: The Base DN information is recorded in the .basedn parameter in the 
ldap.conf file and the install-data_store.ldif file. 

12. Click Next.

13. In the data_store Logon Information dialog box, accept the default value, 
CT_ADMIN. In the Password and Confirm Password fields, enter the 
administrator password used to connect to your data store.

Option What RSA Access Manager Installs

New Installs the Access Manager Entitlements Server, Dispatcher/Key 
Server, Authorization Server, the Java Runtime Environment, and the 
Data Adapter files. The Instrumentation Server, Log Server, and 
64-bit Mode are also installed, but if you plan to use them, they must 
be enabled by selecting them as additional features during the 
installation routine. If you do not enable these optional features 
during the installation routine, they may be enabled at a later time. 
For more information, see Chapter 6, “Running Your RSA Access 
Manager Servers.”

Upgrade Installs current server binaries in a new directory separate from the 
existing RSA Access Manager installation. For more information on 
upgrading your Servers, see the Upgrade Guide.
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Note: This data store connection password serves as your master startup password 
if you select the option to encrypt your configuration files, as described in step 17.

14. Click Next.

15. In the Access Manager Servers Administrator Information dialog box, enter an 
administrator user name and password to use when starting the Access Manager 
Administrative Console.

Note: This logon and password information provides the Super Admin access to 
user and policy data. The password must be highly secure. It is required for initial 
logon to the Administrative Console.

Note: For an Active Directory or an Active Directory/ADAM or Active 
Directory/ installation, an administrator user name and password is not requested 
because the installation process uses the existing Active Directory administrator 
credentials. You can designate an Access Manager administrator who is different 
from the Active Directory administrator after the installation process is complete. 
For more information, see “Installing the Data Adapter on Active Directory” on 
page 44.

16. In the Enable Additional Features dialog box, select any of the additional features 
that you want to enable, and click Next.

17. In the Configuration File Encryption dialog box, select Encrypt conf files? to 
encrypt the administrator password that you specified in step 15.

Note: If you select this option, the cryptedit utility automatically encrypts the 
password and accepts this same password as the master startup password needed 
to reboot the Servers. You can change the password or encrypt more values in 
your configuration files. For more information, see Chapter 12, “Implementing 
Security Features.”

Important: Encrypting passwords has important implications: First, unattended 
system reboots are made impossible, because you must manually enter at least one 
master password at machine startup time to permit decryption of the password 
information that Access Manager uses. Second, if your Servers use encrypted 
configuration files, you cannot stop them by using the stop argument of their run 
scripts. Instead, you must find the shell where each Server is running, and type 
CTRL+C to stop that Server.

18. Click Next.

19. In the Ready to Install dialog box, click Install.

20. In the Installation Complete dialog box, click Finish.

To install the Access Manager SDK, see the following section, “Installing the 
RSA Access Manager SDK on Windows.” 
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To update JRE, see “Updating JRE,” on page  37.

To complete your Access Manager installation, see “Installing the License File” on 
page 39.

Installing the RSA Access Manager SDK on Windows

To install the RSA Access Manager SDK on Windows:

1. Create a directory on your machine for the API files.

2. On the RSA Access Manager 6.1 DVD, navigate to the \win32-x86\sdk directory, 
and locate the .zip file for the SDK. This archive contains the Access Manager 
APIs, API documentation, and the needed libraries.

3. Copy this .zip file to the directory you created in step 1, and extract its contents. 
You will find the extracted API files in the SDK_HOME\sdk directory.

Note: SDK_HOME is the term used in Access Manager documentation to refer to 
the directory where you unpacked the API files.

For information about building applications, see the Developer’s Guide 
(SDK_HOME\sdk\docs\index.html).

Installing the RSA Access Manager Servers on UNIX

You can install the Access Manager Servers on UNIX using one of these methods: 

• Standard installation using the installation script.

• Automated silent installation with a response file. For more information on silent 
installation, see Appendix B, “Installing the RSA Access Manager Servers Using 
Silent Mode” on page 291.

RSA recommends using the standard installation method described in the procedure, 
“To install the RSA Access Manager Servers on UNIX using standard installation:” 
on page 34.

By default, the Access Manager files are installed in one of these locations:

• AIX: /usr/axm

• Linux and Solaris: /opt/axm

Note: Throughout this document, the directory where you install the Access Manager 
Servers is called AXM_HOME. 
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Installing the IBM AIX JDK

To install the IBM AIX JDK:

1. Download and install the 32-bit or 64-bit version of the required IBM JRE for 
AIX. For more information, contact your IBM representative, or go to 
http://www.ibm.com/developerworks/java/jdk/.

2. Note the path where you installed the IBM AIX JRE. The default path is:

• /usr/java5/jre for java5

• /usr/java6/jre for java6

Installing the RSA Access Manager Servers on UNIX Using Standard 
Installation

To install the RSA Access Manager Servers on UNIX using standard installation:

1. Log on as user root.

2. Insert the RSA Access Manager 6.1 DVD, mount your DVD drive, and do one of 
the following:

• On Solaris, navigate to /solaris-sparc/axm_servers.

• On AIX, navigate to /aix-rs6000/axm_servers.

• On Linux, navigate to /linux-x86/axm_servers.

Note: Before performing step 3, read the following information that pertains to 
your situation, and perform any required tasks.

AIX and Linux users only. Do not press CTRL+C to stop the installation. If the 
installation is stopped before completion, not all IBM install packages are 
installed on AIX and not all rpm packages are installed on Linux. Incomplete 
installations can cause problems for future uninstallation and reinstallation 
attempts. If you accidentally enter the wrong information during installation, let 
the install script finish, then navigate to AXM_HOME/bin/uninstall, and run 
uninstall-server.sh before you attempt to reinstall the Servers.

AIX users only. When the installer prompts for the location of the IBM JRE 
installed on your system, enter the path to the AIX JRE. This is the path you noted 
in step 2 of the procedure “To install the IBM AIX JDK:” on page 34. The default 
path is:

• /usr/java5/jre for java5

• /usr/java6/jre for java6

Upgrade only. The installation script asks whether this is a “New or Upgrade 
Installation.” If you are upgrading from an earlier version of Access Manager, 
provide the version number and the installation path. For more information, see 
the Upgrade Guide.

3. Run the installation script. Type:

# ./install-server.sh
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4. Accept the displayed license agreement.

5. Follow the prompts for directory information, entering information as required. In 
a typical installation, at the Installation Base Directory prompt, accept one of 
these default values:

• AIX: /usr/axm/

• Linux and Solaris: /opt/axm/

6. Follow the prompts for Access Manager user and file information. Provide a name 
for the Access Manager user account and group. Change default values as 
necessary.

7. From the Select Data Adapter Type prompt, select your data store.

Note: For Sybase, select Oracle 10g R2/Oracle RAC or Microsoft SQL Server 
2005, and continue with the installation. After installation, follow the steps 
explained in “Enabling Support for Sybase as the Data Store” on page 38.

8. LDAP directory only. At the your_data_store Server Connection Information 
prompt, submit connection information about your data store. Specify the base 
DN that identifies the root node of your LDAP directory, enabling Access 
Manager to find the directory containing your user data. This information is saved 
in the ldap.conf file, and is used to update the install-server_type.ldif file.

9. At the Access Manager Server Administrator Information prompt, provide an 
administrator logon name and password to use when starting the Administrative 
Console.

Note: This logon and password information provides the Super Admin access to 
user and policy data. This password must be highly secure. It is required for initial 
logon to the Administrative Console.

Note: For an Active Directory or an Active Directory/ADAM or Active 
Directory/ installation, an administrator user name and password is not requested 
because the installation process uses the existing Active Directory administrator 
credentials. You can designate an Access Manager administrator who is different 
from the Active Directory administrator after the installation process is complete. 
For more information, see “Installing the Data Adapter on Active Directory” on 
page 44.

10. At the Update Schema prompt, RSA recommends that you choose to update the 
schema. If you choose not to update the schema, no data adapter file is installed on 
your system, and you will have to manually copy and tailor the data adapter files 
to match your data store schema.

11. At the Continue With Configuration prompt, do one of the following:

• Press ENTER to configure the Access Manager Servers. For instructions, see 
the following section, “Configuring the RSA Access Manager Servers on 
UNIX.”
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• Type any key except ENTER to end the installer session. Configuration files 
are not updated and startup scripts are not installed. You can update these at 
any time by running AXM_HOME/bin/axm-configure.sh. The Access 
Manager Servers do not run until you run axm-configure.sh to complete 
configuration, and until you install the license file.

Configuring the RSA Access Manager Servers on UNIX

To configure the RSA Access Manager Servers on UNIX:

Note: If you have ended the installer session, go to AXM_HOME/bin, and run 
axm-configure.sh before completing the following steps.

1. At the Configuring Dispatcher prompt, type a valid e-mail address to use for your 
Access Manager administrator account. If necessary, change the default ports 
from 5608 and 5607.

2. At the your_data_store Connection Information prompt, enter the following 
connection information about your data store:

Data store hostname. The hostname of your data store host machine. 

Data store port. The default port number that Access Manager uses to make a 
connection to the data store.

LDAP base DN. Specify the base DN that identifies the root node of your LDAP 
directory, enabling Access Manager to find the directory containing your user 
data. This information is saved in the ldap.conf file and is used to update the 
install-server_type.ldif file. 

LDAP bind DN or SQL user name and password. The logon name used for 
connecting to the data store.

Service or Database name. The service name for Oracle or the database name for 
Sybase or MSSQL Server.

Note: This data store connection password is also used as your master startup 
password if you select the option to encrypt your configuration files, as described 
in step 3 of this procedure.

3. At the Encrypt Access Manager Configuration Files prompt, you can choose to 
encrypt the administrator password that you specified at the your_data_store 
Server Connection Information prompt. If you select this option, the cryptedit 
utility automatically encrypts the password and accepts this same password as the 
master startup password needed for Server reboot. You can change the password 
or encrypt more values in your configuration files later.

Important: Encrypting the password has important implications. In particular, 
unattended system reboots are rendered impossible, because you must manually 
enter at least one master password at machine startup to permit decryption of the 
password information needed by Access Manager. 

4. Allow the configuration script to run to completion.
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Note: If at any time you want to reconfigure your installation, rerun 
axm-configure.sh.

To install the Access Manager SDK, see the following section, “Installing the 
RSA Access Manager SDK on UNIX.” 

To complete your Access Manager installation, see “Installing the License File” on 
page 39.

Installing the RSA Access Manager SDK on UNIX

To install the RSA Access Manager SDK on UNIX:

1. Insert the RSA Access Manager 6.1 DVD, mount your DVD drive, and do one of 
the following:

• On AIX, navigate to: /aix-rs6000/sdk

• On Linux, navigate to: /linux-x86/sdk

• On Solaris, navigate to: /solaris-sparc/sdk

2. Locate the compressed file for the SDK. This archive contains the Access 
Manager APIs, API documentation, and the required libraries.

3. Copy the archive to a directory where you plan to unpack it. Uncompress and 
untar the archive. 

Note: RSA recommends using GNU tar and zip for this purpose.

4. Type:

tar xvf <archive file name>

After the archive is unpacked, you can find the API files in the SDK_HOME/sdk 
subdirectory.

Note: SDK_HOME is the term used in Access Manager documentation to refer to 
the directory where you unpacked the API files in step 3.

For information on building applications, see the Developer’s Guide 
(SDK_HOME/sdk/docs/index.html).

Updating JRE

After installing Access Manager Servers, you must update the existing JRE (or 
JRE64) folder of the AXM_HOME folder with the JRE update 21. This section 
provides you instructions to update JRE in Windows and UNIX.
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To update JRE in Windows:

1. Download the JDK 6 Update 21 for Windows from 
http://java.sun.com/javase/downloads/index.jsp.

2. Run the .exe file that you have downloaded.
The Installation Wizard is displayed.

3. Follow the instructions on the Installation Wizard.
After you complete the instructions on the Installation Wizard, a 
Java\jdk1.6.0_21\jre6 directory is created at the location that you specify. The 
default location of the directory is C:\Program Files.

4. For 32-bit machines, replace the contents of the AXM_HOME\jre directory with 
the contents of the Java\jdk1.6.0_21\jre6 directory.

5. For 64-bit machines, replace the contents of the AXM_HOME\jre64 directory 
with the contents of the Java\jdk1.6.0_21\jre6 directory.

To update JRE in UNIX (32-bit and 64-bit):

1. Download the JDK 6 Update 21 for UNIX from 
http://java.sun.com/javase/downloads/index.jsp.

2. Run the .sh/.bin file that you have downloaded (.sh for Solaris/ .bin for UNIX).
A Java\JDK_version\jre directory is created at the location from where you run 
the downloaded script file.

3. Replace the contents of the AXM_HOME/jre directory with the contents of the 
Java/JDK_version/jre directory.

4. Based on your machine type (32-bit or 64-bit), do one of the following:

• For 32-bit machines, go to AXM_HOME/jre/bin, and type:

chmod 777 AxM_HOME/jre/bin/java

• For 64-bit machines, go to AXM_HOME/jre64/bin, and type:

chmod 777 AxM_HOME/jre64/bin/java

• For Solaris 64-bit, go to AXM_HOME/jre64/bin/sparcv9, and type:

chmod 777 AXM_HOME/jre64/bin/sparcv9/java

To update JRE in AIX:

1. Install the IBM AIX JDK 1.6 SR8 FP1, see “Installing the IBM AIX JDK” on 
page 34.

2. Replace the contents of the AXM_HOME/jre directory with the contents of the 
Java/Java_version/jre directory.

Enabling Support for Sybase as the Data Store

During installation of the Access Manager Servers, an option to select Sybase as the 
data store is not available. To enable support for sybase as the data store perform the 
following steps.
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To enable support for sybase:

1. Copy sql-sybase.conf from the Access Manager product package to 
AXM_HOME/conf.

2. Copy SybaseCreateCT.sql and SybaseDropCT.sql scripts to 
AXM_HOME/data_adapters.

3. Copy the password hash of the administrator from OracleCreateCT.sql (if Oracle 
is the database) or SqlServerCreateCT.sql (if Microsoft SQL Server is the 
database), and save it.

4. Install the AXM schema. For more information, see “Running the Installation 
Script on Sybase” on page 118.

5. Copy the password hash (saved in step 3) to replace the value present in the 
PASSWORD column of the PASSWORD table, and save the changes.

6. Follow the instructions in the readme.txt from the Access Manager product 
package to upgrade to SP4.

7. In the sql-sybase.conf file, enter the connection information about your data store.

8. Modify the cleartrust.data.source.configuration parameter in aserver.conf and 
eserver.conf to point to the sql-sybase.conf file.

9. Start your Access Manager Servers.

Installing the License File

In order to run your Access Manager Servers, you must install the license file.

To install the license file:

Copy license.xml from the license CD included in your Access Manager product 
package to AXM_HOME/conf.

Next Steps

Do one of the following:

• If you selected the option to encrypt passwords while installing your Access 
Manager Servers, see “Encrypting Parameters in the Configuration Files” on page 
204. After you encrypt the configuration files with the Access Manager cryptedit 
tool, install the LDAP or SQL Data Adapters, depending on your type of data 
store.

• If you did not select the option to encrypt passwords during your installation, see 
Chapter 3, “Installing the LDAP Data Adapter” or Chapter 5, “Installing and 
Configuring the SQL Data Adapter.”
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3 Installing the LDAP Data Adapter

• Before You Begin

• Overview of the LDAP Data Adapter Installation

• Installing Your Data Adapter

• Installing the Data Adapter on Active Directory

• Installing the Data Adapter for an Active Directory-Active Directory Application 
Mode Installation or Active Directory-Active Directory Lightweight Directory 
Services Installation

• Installing the Data Adapter on Sun Java System Directory Server

• Installing the Data Adapter on Novell eDirectory

• Installing the Data Adapter on standalone Active Directory Lightweight Directory 
Service

• Installing the Data Adapter on OpenDJ

The RSA Access Manager LDAP Data Adapter allows Access Manager to use your 
LDAP directory as a data store. For a list of supported data stores, see “Supported 
Data Store Servers” on page 21.

You must install and configure a Data Adapter on each LDAP directory host that 
Access Manager must access, including LDAP directories used for referrals and 
replicas.

Before You Begin

Before you begin installing the LDAP Data Adapter, make sure that:

• Your LDAP directory host is running.

• Access Manager Servers are installed.

• Your Access Manager license file is copied to AXM_HOME/conf.

For more information, see Chapter 2, “Installing the RSA Access Manager Servers.”

Overview of the LDAP Data Adapter Installation 

When you select the LDAP option during your Access Manager Servers installation, 
the installer program installs the LDAP Data Adapter files and edits your ldap.conf 
file, setting up the basic configuration for the LDAP host you specified. The values 
you provide to the installer program for base DN, administrator user name, and 
password are used to update the appropriate entries in the LDIF file for your LDAP 
Data Adapter. This file and other Data Adapter files are installed in the 
AXM_HOME/data_adapters/ldap/directory_type_name directory.
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To install data adapters on remote servers in a distributed environment, follow the 
instructions provided in this chapter for each host. The manual process of installing 
the Access Manager LDAP Data Adapter includes the following high-level steps:

1. Install the Access Manager LDAP Data Adapter on your LDAP directory host. 
For instructions for your server type, see the following section, “Installing Your 
Data Adapter.”

2. Install the Access Manager bootstrap data. 

Note: For Sun Java System Directory Server and Novell eDirectory, RSA 
provides an LDIF file (install-server_ type.ldif) that you must edit and import into 
your directory host to set up the policy store.

For Active Directory, you must run the appropriate batch file to update the 
schema. For a combined Active Directory and Active Directory Application Mode 
or Active Directory and AD LDS installation, you must run additional batch files 
for AD-ADAM or AD-AD LDS support.

3. Restart your LDAP directory host.

4. Verify that the relevant ldap.conf parameters for this Data Adapter installation are 
accounted for in the primary Access Manager Servers installation. This must be 
done before you can start the Access Manager Servers. For more information, see 
Chapter 4, “Configuring the LDAP Data Adapter.”

5. Optional. Set up Secure Sockets Layer (SSL) connectivity between the LDAP 
directory host and the Access Manager Servers.

Note: SSL connectivity is required for user creation and user password 
modification in Active Directory.

6. Tune your LDAP directory host for optimal performance with Access Manager. 
For more information, see “Tuning Your LDAP Directory for RSA Access 
Manager” on page 109.

Installing Your Data Adapter

To start your Data Adapter installation, install the Access Manager LDAP Data 
Adapter on your LDAP directory host(s). The Data Adapter contains the attribute type 
definitions and object class definitions required to store Access Manager data. See the 
installation instructions specific to your LDAP platform:

• “Installing the Data Adapter on Active Directory” on page 43.

• “Installing the Data Adapter for an Active Directory-Active Directory Application 
Mode Installation or Active Directory-Active Directory Lightweight Directory 
Services Installation” on page 52.

• “Installing the Data Adapter on Sun Java System Directory Server” on page 59.

• “Installing the Data Adapter on Novell eDirectory” on page 61.
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You must install the LDAP Data Adapter files on every directory server that Access 
Manager must access. 

Installing the Data Adapter on Active Directory

This section describes how to install the Access Manager LDAP Data Adapter on 
Windows Server 2003 and Windows Server 2008 Active Directory. The instructions 
include the required pre-installation tasks, as well as required post-installation SSL 
configuration. 

The installer for this Data Adapter does not prompt for, or create, an Access Manager 
administrator account during installation. Instead, the Active Directory administrator 
account becomes the default Access Manager administrator account. For Active 
Directory, you can override this default setting by modifying the schema as described 
in “Installing the Data Adapter on Active Directory” on page 44.

Pre-Installation Tasks

Before installing the Access Manager Data Adapter on your directory host, you must 
complete these required tasks:

• Enable schema changes on Active Directory

• Modify the directory compatibility level

Enabling Schema Changes on Active Directory

Before you can install the Access Manager Data Adapter, you must configure Active 
Directory to accept schema changes. The master copy of the schema on Active 
Directory is stored on a single domain controller called the schema master. If you 
make schema changes on a domain controller that is not the schema master, the 
schema master must be online at the time you make the change. 

Make sure that your domain controller has the FSMO schema master role so that you 
can modify the schema. You can set this role through the Microsoft Management 
Console. For instructions, see your Microsoft documentation. 

Checking the Directory Compatibility Level 

The Active Directory hosts, which Access Manager utilizes, must be set to the 
appropriate compatibility level. Verify that the domain operation mode is set to 
Windows Server 2003 or Windows Server 2008 based on your Active Directory 
setup.

Note: Access Manager does not support Windows 2000 Server Active Directory, even 
in mixed environments that use both Windows 2000 Server and Windows Server 2003 
or in mixed environments that use both Windows 2000 Server and Windows Server 
2008 Active Directory. Before you install the Data Adapter, you need to upgrade to 
Windows Server 2003 Active Directory or Windows Server 2008 Active Directory. 
For more information, see the Upgrade Guide.

When you have completed the required pre-installation tasks, continue to the 
following section, “Installing the Data Adapter on Active Directory.”
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Installing the Data Adapter on Active Directory

To install the Data Adapter on Active Directory:

1. Log on to the primary domain controller (the Active Directory schema master 
host) as an administrator.

2. Copy the files from your_operating_system/data_adapters/ldap/activedirectory 
on your RSA Access Manager 6.1 DVD, and save them in a location on your host 
machine. Be sure to include the following batch files:

install-ctschema.bat. This file makes the schema changes required for storing 
Access Manager data.

install-ctdata.bat. This file adds Access Manager data to the directory.

3. From a command prompt, run install-ctschema.bat with “ad” as the install type, 
the hostname with port number, and domain base DN as parameters. Separate 
each parameter with a space. To define the base DN, you must use a comma with 
no spaces.
For example, type:

install-ctschema ad "localhost:389" "dc=domain,dc=com"

where:

• localhost:389 is the hostname and port number.

• dc=domain,dc=com is the domain base DN.

Note: This loads install-ctuser.ldif and install-ctschema.ldif.

4. Optional. To designate an Access Manager administrator other than the Active 
Directory administrator (the default), navigate to the location where you copied 
the files on your host machine in step 2, and open install-activedirectory.ldif. 
Scroll down to Default Administrative User, and make the following change to 
ctscUserDN. 
Replace:

ctscUserDN: cn=Administrator,cn=users,dc=domain,dc=com
with

ctscUserDN: cn=valid user,cn=users,dc=domain,dc=com
where valid user is an existing user in Active Directory and dc=domain,dc=com 
is the domain base DN. 

Important: This modification is space-sensitive. Make sure that you separate each 
item using commas with no spaces. If the user you want to specify is not in Active 
Directory, create the user with the user provisioning tool before making this 
change.
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5. From a command prompt, run install-ctdata.bat with ad as the install type, 
hostname with port number, and the domain base DN as parameters. Separate 
each parameter with a space. To define the base DN, you must use a comma with 
no spaces.
For example, type:

install-ctdata ad "localhost:389" "dc=domain,dc=com"

where:

• localhost:389 is the hostname and port number.

• dc=domain,dc=com is the domain base DN.
After the batch files run, your Active Directory schema is updated with the Access 
Manager data model.

6. Using the Active Directory Schema Console, create indexes in your directory for 
the ctscPublicMemberList and ctscPrivateMemberList attributes. For instructions, 
see your Microsoft documentation.

Note: The ctscUserAuxClass auxiliary class, containing optional attributes related 
to password policy, account management, and other features, is not included in 
this default schema update for the Access Manager installation.

Setting Up SSL for Active Directory

The Access Manager Servers are configured by default for Secure Sockets Layer 
(SSL) connections to the Active Directory host on port 636. Prior to starting the 
Servers, you must enable SSL connections on your Active Directory host. 

RSA recommends that an administrator with knowledge of public key infrastructure, 
Active Directory certificate operations, and the use of Sun Java keytool perform these 
tasks: 

• Add a Microsoft Certificate Authority. For more information, see the following 
section, “Adding the Microsoft Certificate Authority.”

• Generate a certificate for Active Directory and export it to a DER-encoded file or 
a base 64 encoded file. For more information, see “Generating and Exporting the 
CA Certificate” on page 47.

• Import the Microsoft CA certificate into the Access Manager Server keystores. 
For more information, see “Importing the CA Certificate on Windows 2003 and 
Windows 2008 Active Directory” on page 49. 

• Set relevant parameter values in the ldap.conf file. For more information, see 
“Setting SSL Parameter Values on Windows 2003 and Windows 2008 Active 
Directory” on page 49.

Adding the Microsoft Certificate Authority

The Microsoft Certificate Authority is required to generate a certificate for the Active 
Directory host. If you have not already added and configured the Microsoft CA, 
perform these steps now.
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Note: These instructions for Microsoft certificate operations are included here for the 
administrator’s convenience. For more information about advanced options and 
troubleshooting, see your Microsoft documentation.

To add the Microsoft Certificate Authority on Windows 2003 Active Directory:

1. Log on to the primary domain controller (the Active Directory schema master 
host) as administrator.

2. Click Start > Settings > Control Panel > Add/Remove Programs > 
Add/Remove Windows Components.

3. In the Windows Components wizard, click Certificate Services > Yes > Next > 
Standalone Root CA. 

4. Enter the name of the certificate authority and other necessary information. None 
of this information can be changed after the CA setup is complete.

5. In Validity duration, specify the validity duration for the root CA, and click 
Next.

6. Specify the storage locations of the certificate database, the certificate database 
log, and the shared folder, and then click Next. 

7. If the World Wide Web Publishing service is running, click OK to stop the 
service before proceeding with the installation. 

8. If prompted, type the path to the Certificate Services installation files.

To add the Microsoft Certificate Authority on Windows 2008 Active Directory:

1. Log on to the primary domain controller (the Active Directory schema master 
host) as an administrator, and start Server Manager.

2. In the Roles Summary page, click Add Roles.

3. If necessary, review the information on the Before You Begin page, and click 
Next.

4. On the Select Server Roles page, select Active Directory Certificate Services, 
and click Next. 

5. If necessary, review the information on the Active Directory Certificate Services 
page, and click Next.

6. Select Certificate Authority, and click Next.

7. On the Specify Setup type page, select Enterprise, and click Next.

8. On the Specify Root CA page, select Root CA, and click Next.

9. On the Select Set up private key page, select Create a new private key, and click 
Next.

10. On the Configure Cryptography for CA page, select RSA#Microsoft Software 
Key Provider, specify the key length as 1024, and click Next.

11. On the Configure CA Name page, enter common name for the new CA, and click 
Next.
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12. On the Set Validity Period page, set the validity period, and click Next.

13. Specify the storage locations of the certificate database, the certificate database 
log, and the shared folder, and click Next.

14. Review the information on the Active Directory Certificate Services page, and 
click Next.

15. On the Confirm Installation Selections page, click Install.

16. On the Installation Results page, click Close this wizard. 

Generating and Exporting the CA Certificate

After adding the Microsoft Certificate Authority, generate the server certificate for 
Active Directory. Then, export the CA certificate of the signing CA for use in the 
Access Manager Servers keystores.

To generate the CA certificate on Windows 2003 Active Directory:

1. Log on to the primary domain controller (the Active Directory schema master 
host) as administrator.

2. Click Start > Run, and type mmc.

3. Click OK.

4. Click File > Add/Remove Snap-in.

5. In the Add/Remove Snap-in dialog box, click Add under the Standalone tab.

6. In the Add Standalone Snap-in dialog box, select Certificates, and click Add.

7. In the Certificates snap-in dialog box, select Computer account and click Next.

8. In the Select Computer dialog box, select Local computer, and click Finish.

9. In the Add Standalone Snap-in dialog box, click Close.

10. In the Add/Remove Snap-in dialog box, click OK.

11. In the left pane, under Console Root, click Certificates > Personal.

12. Right-click Certificates, and click All Tasks > Request New Certificate.

13. In the Certificate Request wizard: 

a. Select Domain Controller.

b. Select Advanced, and click Next. 

c. Select Microsoft RSA SChannel Cryptographic Provider, and click Next.

d. Select the CA from which you want to request the certificate, and click Next.

e. Enter a user-friendly name and description for your certificate, and click 
Next. 

f. Click Finish.
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To generate the CA certificate on Windows 2008 Active Directory:

1. Log on to the primary domain controller (the Active Directory schema master 
host) as administrator.

2. Click Start > Run, and type mmc.

3. Click OK.

4. Click Console > Add/Remove Snap-in > Add.

5. Under Snap-in, click Certificates > Computer account > Next.

6. Click Local computer > Finish.

7. Click Certificates > Personal.

8. Click All Tasks > Request New Certificate.

9. In the Certificate Enrollment wizard: 

a. On the certificate enrollment page, click Next.

b. Select Domain Controller, and click Enroll.

c. Click Finish.

10. Right-click the certificate created to enter a user-friendly name.

To export the CA certificate to a file on Windows 2003 Active Directory:

1. In the console root of the MMC, click Certificates.

2. In the detail pane, click the CA certificate for the Microsoft CA that generated 
your Active Directory host certificate.

3. Right-click the CA certificate, click All Tasks > Export.

4. In the Certificate Export wizard, select No, do not export the private key. 

5. Select Base-64 encoded X.509, and click Next. 

Note: Do not use PKCS #7.

6. Enter a path and name for the CA certificate file, and click Next.

7. Click Finish.

To export the CA certificate to a file on Windows 2008 Active Directory:

1. In the console root of the MMC, click Certificates to generate certificates.

2. In the details pane, click the certificate you created in step 1.

3. Click All Tasks > Export.

4. In the Certificate Export wizard, select No, do not export the private key.

5. Select the file format to use to store the exported certificate (A base-64 encoded 
X.509 file).

Note: Do not use PKCS #7.
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6. Enter a path and name for the CA certificate file.

7. Click Finish.

Importing the CA Certificate on Windows 2003 and Windows 2008 Active 
Directory

You must import the CA certificate to your Active Directory Data Adapter. You can 
use either the Sun Java keytool or the Access Manager certool utility. 

The Sun Java keytool imports this certificate in JKS (Java Key Store) format. For 
information on importing and manipulating certificates using the Sun Java keytool, go 
to http://java.sun.com/j2se/1.5.0/docs/tooldocs/windows/keytool.html.

If you are already using PKCS #12 format keystores and mutually authenticated SSL 
between your Access Manager Servers, use the Access Manager certool utility. You 
must use the -add options to import the PEM format Microsoft CA cert into your 
existing CA keystore, and use that keystore for your ca.keystore_file value in the 
ldap.conf file. For more information, see “Generating Certificates” on page 222. 

To import the CA certificate using the Sun Java keytool:

1. At a command prompt, type:

C:\<AXM_HOME>\jre\bin\keytool -import -v -trustcacerts 
-alias alias_name -file path_and_file_name_of_certificate 
-keypass key_password -keystore 
server_keystore_file_name.jks -storepass store_password

where:

• alias_name is the name assigned to the keystore entry.

• path_and_file_name_of_certificate is the path to and file name of 
the certificate.

• key_password is the password required to use the key.

• server_keystore_file_name is the name and location of the persistent 
keystore file.

• store_password is the password used to protect the keystore.

Note: This command is case-sensitive.

2. If presented with the prompt, Trust this certificate?, enter Yes.
If the import is successful, you see the message “Certificate was added to 
keystore”.

3. Start the Access Manager Servers to complete the import of the CA certificate.

Setting SSL Parameter Values on Windows 2003 and Windows 2008 
Active Directory

After importing the CA certificate with Sun Java keytool, you must set these SSL 
parameters with the following values in the AXM_HOME/conf/ldap.conf file:

cleartrust.data.ldap.directory.activedirectory.ssl.use :auth 

cleartrust.data.ldap.directory.activedirectory-bind.ssl.use :auth 
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cleartrust.data.ldap.directory.activedirectory.ssl.ca_keystore_file 
:server_keystore_file_name.jks 

cleartrust.data.ldap.directory.activedirectory-bind.ssl.ca_keystore_file 
:server_keystore_file_name.jks

where server_keystore_file_name is the name and location of the persistent keystore 
file.

cleartrust.data.ldap.directory.activedirectory.ssl.ca_keystore_type :JKS

cleartrust.data.ldap.directory.activedirectory-bind.ssl.ca_keystore_type :JKS

cleartrust.data.ldap.directory.activedirectory.ssl.ca_keystore_passphrase 
:password

cleartrust.data.ldap.directory.activedirectory-bind.ssl.ca_keystore_passphrase 
:password

where password is the password used to protect the keystore.

Note: Because SSL is enabled by default for Active Directory installations, many of 
the ldap.conf parameters for secure connections are preset.

The second member of each pair of these parameters references the Active Directory 
bind connection pool for bind authentication. For more information, see “Connection 
Pool Management for Bind Authentication” on page 82. The values set for each pair 
must be identical, point to the same keystore, and use the same keystore passphrase.

After you have set the keystore_type to JKS, you must update the keystore_type 
parameter for all Servers interacting with it. The relevant parameter is 
cleartrust.net.ssl.ca.keystore_type in aserver.conf and eserver.conf.

Active Directory Forest Support

The Windows 2003 and Windows 2008 Active Directory supports a replicated 
directory called the Global Catalog. The Global Catalog is a read-only directory that 
contains every entry in an Active Directory forest with a subset of the attributes. 
Access Manager can use the Global Catalog to allow all users and some groups in an 
Active Directory forest to access resources protected by Access Manager. The 
mechanism used to support authentication and authorization of all users in the forest is 
a special read-only aux store connection, pointing to the Global Catalog. For more 
information about aux stores, see “Configuring an LDAP Directory as an Aux Store” 
on page 96.

Because the Global Catalog is a replicated server, it sometimes presents inconsistent 
data to the Access Manager Servers. For example, consider a scenario where a Smart 
Rule exists allowing User A to access a resource if the department of User A is 
“Human Resources.” User A just changed departments from “Finance” to “Human 
Resources,” and the department attribute was updated accordingly in their domain. It 
may take several minutes for that information to be replicated to the Global Catalog. 
Until that time, User A cannot access the resource. Consult your Windows 
Administrator to estimate the replication delay for your environment. 

The replication delays can affect group entitlements as well. When a user is added to a 
group, it may take some time for any group entitlements to be activated for that user. 
Because the Global Catalog contains a subset of the attributes for an entry, 
administrators must tag attributes used for Smart Rules as “replicated to the Global 
Catalog” in the MMC Schema Manager snap-in.
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The groups that Access Manager uses are determined by the userstore configuration 
parameter. This parameter must specify either the Global Catalog as a directory or the 
Access Manager store directory. If the Global Catalog is configured, you can use all 
universal groups in the forest for entitlements. If the Access Manager store directory is 
configured, you can use only universal and (domain local) groups within the Access 
Manager store domain. If the userstore points to the Global Catalog, all groups are 
read-only. You cannot create or modify these groups through the administrative GUI 
or APIs.

Note: Not all group membership information is replicated to the Global Catalog. For 
information about replication constraints on group membership information, see your 
Active Directory documentation.

Make sure that replication and DNS are working properly on all domain controllers in 
your forest. Use the Microsoft tools to test this. Make sure that the Microsoft nslookup 
tool is able to find all the domain controllers in your forest, and use Microsoft’s dcdiag 
tool to test replication, connectivity, topology, and other functions. If you receive any 
failures in those areas, your forest is not set up properly. Other Microsoft tools that 
you can use to help troubleshoot are repadmin, netdiag, replmon, and nltest.

Next Step

Before you can start the Access Manager Servers, you must verify that the relevant 
ldap.conf parameters for this Data Adapter installation are accounted for in the 
primary Access Manager Servers installation. For more information, see Chapter 4, 
“Configuring the LDAP Data Adapter.”

Installing the Data Adapter for an Active Directory-Active Directory 
Application Mode Installation or Active Directory-Active Directory 
Lightweight Directory Services Installation

RSA Access Manager supports the combined use of Active Directory (AD) and 
Active Directory Application Mode (ADAM) and AD and Active Directory 
Lightweight Services (AD LDS). This allows you to source users and groups from 
your existing organization-level AD deployment, while storing Access Manager 
administrative and policy data to a local ADAM/AD LDS installation.

Note: In this document, Active Directory-Active Directory Application Mode 
(AD-ADAM) is used in the context of Microsoft Windows Server 2003 and Active 
Directory-Active Directory Lightweight Directory Services (AD-AD LDS) is used in 
the context of Microsoft Windows Server 2008.

The following sections describe how to apply the Access Manager LDAP Data 
Adapter to Microsoft Windows Server 2003 for AD-ADAM installation and 
Microsoft Windows Server 2008 for AD-AD LDS installation. This process allows 
Access Manager to support AD and ADAM or AD and AD LDS in the same 
installation.

• Installing the Data Adapter on Active Directory
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• Installing the Data Adapter on ADAM or AD LDS

In case of Microsoft Windows Server 2003, you first perform pre-installation tasks for 
AD and then for ADAM. In case of Microsoft Windows Server 2008, first perform the 
pre-installation tasks for AD and then for AD LDS. Then, you install the Access 
Manager Data Adapter on each one.

Installing the Data Adapter on Active Directory

The following sections describe how to install the Access Manager LDAP Data 
Adapter on Microsoft Windows Server 2003 for an AD-ADAM installation and on 
Microsoft Windows Server 2008 for AD-AD LDS installation. The process for Active 
Directory requires pre-installation tasks and post-installation SSL configuration. 

Make sure that you have completed the tasks described in “Pre-Installation Tasks” on 
page 43. When you have completed these tasks, continue with the following 
procedure to install the Data Adapter.

Note: In order to use the Access Manager password policy and to use the User 
Self-Service feature, you must install the Access Manager schema on Active 
Directory.

To install the Data Adapter on Active Directory:

1. Log on to the primary domain controller (the Active Directory schema master 
host) as administrator.

2. Copy the files from your_operating_system/data_adapters/ldap/activedirectory 
on your RSA Access Manager 6.1 DVD, and save them in a location on your host 
machine. Be sure to include the following batch files for schema installation:

install-ctschema.bat. This file makes the schema changes required for storing 
Access Manager data.

install-ctdata.bat. This file adds Access Manager data to the directory.

3. From a command prompt, run install-ctschema.bat with ad-adam as the install 
type, the hostname with port number, and domain base DN as parameters. 
Separate each parameter with a space. To define the base DN, you must use a 
comma with no spaces.
For example, type:

install-ctschema ad-adam "localhost:389" 
"dc=domain,dc=com"

where:

• localhost:389 is the hostname and port number.

• dc=domain,dc=com is the domain base DN.

Note: This loads install-ctuser.ldif and install-ctschema.ldif.
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4. Optional. To designate an Access Manager administrator other than the Active 
Directory administrator (the default), navigate to the location where you copied 
the files on your host machine in step 2, and open install-activedirectory.ldif. 
Scroll down to Default Administrative User, and make the following change to 
ctscUserDN. 
Replace:

ctscUserDN: cn=Administrator,cn=users,dc=domain,dc=com
with

ctscUserDN: cn=valid user,cn=users,dc=domain,dc=com
where valid user is an existing user in Active Directory and dc=domain,dc=com 
is the domain base DN. 

Important: While making this change, be sure to separate each item using 
commas with no spaces. If the user you want to specify is not listed in the Active 
Directory, create the user with the user provisioning tool before making this 
change.

5. From a command prompt, run install-ctdata.bat with ad-adam as the install type, 
hostname with port number, and the domain base DN as parameters. Separate 
each parameter with a space. To define the base DN, you must use a comma with 
no spaces.
For example, type:

install-ctdata ad-adam "localhost:389" "dc=domain,dc=com"

where:

• localhost:389 is the hostname and port number.

• dc=domain,dc=com is the domain base DN.
After the batch files run, your Active Directory schema is updated with the Access 
Manager data model.

6. Using the Active Directory Schema Console, create indexes in your directory for 
the ctscPublicMemberList and ctscPrivateMemberList attributes. For instructions, 
see your Microsoft documentation.

Note: The ctscUserAuxClass auxiliary class containing optional attributes related to 
password policy, account management, and other features, is not included in this 
default schema update for the Access Manager installation.

Setting Up SSL for Active Directory

For setting up SSL after Active Directory installation in an AD-ADAM/AD-AD LDS, 
see the following sections:

• “Adding the Microsoft Certificate Authority” on page 45.

• “Generating and Exporting the CA Certificate” on page 47.

• “Importing the CA Certificate on Windows 2003 and Windows 2008 Active 
Directory” on page 49.
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• “Setting SSL Parameter Values on Windows 2003 and Windows 2008 Active 
Directory” on page 49.

• “Active Directory Forest Support” on page 50.

When you have completed the post-installation SSL setup, continue to the following 
section, “Installing the Data Adapter on ADAM or AD LDS” to install the Data 
Adapter on ADAM/AD LDS.

Installing the Data Adapter on ADAM or AD LDS

This section describes how to install the Access Manager LDAP Data Adapter on a 
Microsoft Windows Server 2003 for AD-ADAM installation and Microsoft Windows 
Server 2008 for AD-AD LDS installation. The process includes making modifications 
to ADAM/AD LDS and then installing the Data Adapter. 

Perform the following procedures to make the required modifications to ADAM/AD 
LDS for an AD-ADAM/AD-AD LDS installation.

To modify install-activedirectory.ldif:

1. Navigate to the location where you copied the files on your host machine in step 2 
in “Installing the Data Adapter on Active Directory” on page 43.

2. Open install-activedirectory.ldif. Scroll down to Default Administrative User, 
and make the following change to ctscUserDN.
Replace:

ctscUserDN: cn=Administrator,cn=users,dc=domain,dc=com
with

ctscUserDN: cn=valid user,cn=users,dc=domain,dc=com
where valid user is an existing user in Active Directory and dc=domain,dc=com 
is the domain base DN of your Active Directory. This modification is 
space-sensitive. Make sure that there are no spaces surrounding the commas.

To create schema with ADAM ADSI Edit on AD-ADAM 2003:

1. Click Start > All Programs > ADAM > ADAM ADSI Edit.

2. In the left pane, click ADAM ADSI Edit.

3. From the menu bar, click Action > Connect to.

4. In the Connection Settings dialog box, perform these tasks in the following order:

a. In the Connection name field, enter Schema.

b. In the Server name and Port fields, change the name and number if 
necessary.

c. Under Connect to the following node, make sure that Well-known naming 
context is selected and that Schema is selected from the drop-down menu.

d. Under Connect using these credentials, make sure that The account of the 
currently logged on user is selected.

e. Click OK.
54 3: Installing the LDAP Data Adapter



RSA Access Manager 6.1 SP4 Servers Installation and Configuration Guide
To create a schema with ADSI Edit on AD-AD LDS 2008:

1. Click Start > Programs > Administrative Tools> ADSI Edit.

2. In the left pane, click ADSI Edit.

3. Click Action > Connect to.

4. In the Connection Settings dialog box, perform these tasks in the following order:

a. In the Name field, enter Schema.

b. Under Connection Point, make sure that Select a Well Known Naming 
Context is selected and the schema is selected from the drop-down menu.

c. Click Advanced. 

d. Enter the AD LDS port number.

e. In the Advanced window, click OK.

f. Click OK.

To copy the CN parameter from ADAM ADSI Edit on AD-ADAM 2003:

1. In the left pane of ADAM ADSI Edit, click + to expand Schema.

2. Right-click the folder below Schema, and select Properties.

3. Under Attributes in the Attribute Editor dialog box, select distinguishedName, 
and click Edit.

4. From the Value field in the String Attribute Editor dialog box, copy and save the 
last CN parameter.
For example, CN={08BA9CFE-A409-443D-BF52-A036881B7DFC}

5. In the String Attribute Editor dialog box, click Cancel. 

6. In the Attribute Editor dialog box, click Cancel.

To copy the CN parameter from ADSI Edit on AD-AD LDS 2008:

1. In the left pane of ADSI Edit, click + to expand Schema.

2. Right-click the folder below Schema, and select Properties.

3. Under Attributes in the Attribute Editor dialog box, select Distinguished Name, 
and click View.

4. From the Value field in the String Attribute Editor dialog box, copy and save the 
last CN parameter. 
For example, CN={66FEBBED-6315-4135-A116-7028FBD5B3F0}

5. In the String Attribute Editor dialog box, click Cancel.

6. In the Attribute Editor dialog box, click Cancel.

To create an admin user with ADAM ADSI Edit on AD-ADAM 2003:

1. In the left pane of ADAM ADSI Edit, click ADAM ADSI Edit.

2. From the menu bar, click Action > Connect to.
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3. In the Connection Settings dialog box, perform these tasks in the following order:

a. Under Connection name, accept the default setting My Connection.

b. In the Server name and Port fields, change the name and number if 
necessary.

c. Under Connect to the following node, select Distinguished name (DN) or 
naming context, and from the drop-down menu, select the domain where the 
Access Manager data object will be installed.

d. Under Connect using these credentials, make sure that The account of the 
currently logged on user is selected.

e. Click OK.

4. In the left pane of ADAM ADSI Edit, click + to expand My Connection.

5. Right-click the folder below My Connection, and click New > Object.

6. In the Create Object dialog box, select inetOrgPerson, and click Next.

7. In the value field, enter ctadmin, and click Next > Finish.

To create an admin user with ADSI Edit on AD-AD LDS 2008:

1. In the left pane of ADSI Edit, click AD LDS ADSI Edit.

2. Click Action > Connect to.

3. In the Connection Settings dialog box, perform these tasks in the following order:

a. Under Name, change connection name to My Connection.

b. Under Connection Point, select Select or Type a Distinguished Name or 
Naming Context, and from the drop-down menu, select the domain where 
you want to install the Access Manager data object.

c. Click Advanced.

d. Enter the AD LDS port number.

e. In the Advanced window,, click OK.

f. Click OK.

4. In the left pane of ADSI Edit, click + to expand My Connection.

5. Right-click the folder below My Connection, and click New > Object.

6. In the Create Object dialog box, select inetOrgPerson, and click Next.

7. In the value field, enter ctadmin and click Next > Finish.

To reset a password for ctadmin with ADAM ADSI Edit on AD-ADAM 2003:

1. In the left pane of ADAM ADSI Edit, click + to expand My Connection, and 
click + to expand the folder under My Connection.

2. Right-click CN=ctadmin, and select Reset Password.

3. In the New password field of the Reset Password dialog box, enter a new 
password. 
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4. In the Confirm password field, enter the password again, and click OK.

To reset a password for ctadmin with ADSI Edit on AD-AD LDS 2008:

1. In the left pane of ADSI Edit, click + to expand My Connection, and click the 
folder under My Connection.

2. In the right pane of ADSI Edit, right-click CN=ctadmin, and select Reset 
Password.

3. In the New password field of the Reset Password dialog box, enter a new 
password. 

4. In the Confirm password field, enter the password again, and click OK.

To set msDS-UserAccountDisabled to false with ADAM ADSI Edit on AD-ADAM 
2003:

1. In the left pane of ADAM ADSI Edit, click + to expand My Connection, and 
click + to expand the folder under My Connection.

2. In the left pane of ADAM ADSI Edit, right-click CN=ctadmin, and click 
Properties.

3. Under Attributes in the Attribute Editor dialog box, select 
msDS-UserAccountDisabled, and click Edit.

4. Under Value in the Boolean Attribute Editor dialog box, select False, and click 
OK.

5. In the Attribute Editor dialog box, click Apply > OK.

To set msDS-UserAccountDisabled to false with ADSI Edit on AD-AD LDS 2008:

1. In the left pane of ADSI Edit, click + to expand My Connection, and click the 
folder under My Connection.

2. In the right pane of ADSI Edit, right-click CN=ctadmin, and click Properties.

3. Under Attributes in the Attribute Editor dialog box, select 
msDS-UserAccountDisabled, and click Edit.

4. Under Value in the Boolean Attribute Editor dialog box, select False, and click 
OK.

5. In the Attribute Editor dialog box, click Apply > OK.

To add an ADAM account with ADAM ADSI Edit on AD-ADAM 2003:

1. In the left pane of ADAM ADSI Edit, click + to expand My Connection, click + 
to expand the folder under My Connection, and click + to expand CN=Roles.

2. Right-click CN=Administrators, and click Properties.

3. Under Attributes in the Attribute Editor dialog box, select member, and click 
Edit.

4. In the Multi-valued Distinguished Name With Security Principal Editor dialog 
box, click Add ADAM Account.
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5. In the Enter a distinguished name (DN) for an object field in the Add ADAM 
Account dialog box, enter cn=ctadmin,dc=rsasecurity,dc=com.

6. In the Add ADAM Account dialog box, click OK.

7. In the Multi-valued Distinguished Name With Security Principal Editor dialog 
box, click OK.

8. In the Attribute Editor dialog box, click Apply > OK.

To add an AD LDS account with ADSI Edit on AD-AD LDS 2008:

1. In the left pane of ADSI Edit, click + to expand My Connection, click + to 
expand the folder under My Connection, and click CN=Roles.

2. In the right pane of ADSI Edit, right-click CN=Administrators, and click 
Properties.

3. Under Attributes in the Attribute Editor dialog box, select member, and click 
Edit.

4. In the Multi-valued Distinguished Name With Security Principal Editor dialog 
box, click Add DN.

5. In the Add Distinguished Name (DN) dialog box, in the Enter a Distinguished 
Name (DN) for an Object field, enter cn=ctadmin,dc=rsasecurity,dc=com.

6. In the Add Distinguished Name (DN) dialog box, click OK.

7. In the Multi-valued Distinguished Name With Security Principal Editor dialog 
box, click OK.

8. In the Attribute Editor dialog box, click Apply > OK.

After you have made the required modifications for an AD-ADAM/AD-AD LDS 
installation, you need to install the Data Adapter. See the following section, “Installing 
the Data Adapter on ADAM or AD LDS.”

Installing the Data Adapter on ADAM or AD LDS

To install the Data Adapter on ADAM/AD LDS:

1. From a command prompt, run install-ctschema.bat with “adam” as the install 
type, the hostname with port number, and the last part of the schema DN that you 
copied and saved in “To copy the CN parameter from ADAM ADSI Edit on 
AD-ADAM 2003:” on page 55 or “To copy the CN parameter from ADSI Edit on 
AD-AD LDS 2008:” on page 55. Separate each parameter with a space.
For example, type:

install-ctschema adam "localhost:389" 
"CN={08BA409-443D-BF52-A036881B7DFC}"

where: 

• localhost:389 is the hostname and port number.

• CN={08BA409-443D-BF52-A036881B7DFC} is the last part of the schema 
DN that you copied and saved.
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2. From a command prompt, run install-ctdata.bat with “adam” as the install type, 
the hostname with port number, and domain base DN as parameters. Separate 
each parameter with a space. To define the base DN, you must use a comma with 
no spaces.
For example, type:

install-ctdata adam "localhost:389" "dc=domain,dc=com"

where: 

• localhost:389 is the hostname and port number.

• dc=domain,dc=com is the domain base DN for your Access Manager policy 
store.

3. Using the ADAM/AD LDS Schema Console, create an index in your directory for 
the ctscPublicMemberList and ctscPrivateMemberList attributes. For more 
information, see your Microsoft documentation.

Next Step

Before you can start the Access Manager Servers, you must verify that the relevant 
ldap.conf parameters for this Data Adapter installation are accounted for in the 
primary Access Manager Servers installation. For more information, see Chapter 4, 
“Configuring the LDAP Data Adapter.”

Note: If the default MaxPageSize setting is used, an AD-ADAM/AD-AD LDS data 
store can fail to function properly when managing Access Manager objects, such as 
users or groups, that are very large. To fix this problem, use dsmgmt to increase the 
value of the AD-ADAM/AD-AD LDS MaxPageSize parameter. For information 
about using dsmgmt, see your Microsoft Windows documentation.

Installing the Data Adapter on Sun Java System Directory Server 

This section describes how to insert and enable the Access Manager LDAP Data 
Adapter on Sun Java System Directory Server.

To install the Data Adapter on Sun Java System Directory Server 5.2:

1. In your Access Manager installation, locate the file, 
AXM_HOME/data_adapters/ldap/iplanet/61rsa-axm.ldif.

2. Copy 61rsa-axm.ldif into the following directory on the machine that is running 
your Sun Java System Directory Server. Software root directory is the directory 
where you installed your Sun Java System Directory Server:

• On Windows:
software root directory\slapd-hostname\config\schema

• On UNIX:
software root directory/slapd-hostname/config/schema

3. Restart your Sun Java System Directory Server so that the new schema 
(61rsa-axm.ldif) is read into the directory.
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4. Import the Access Manager bootstrap data from the install-iplanet.ldif file. This 
file contains the default administrator and password policy entries that are 
required the first time you log on to the RSA Administrative Console. Use the Sun 
Console to import the data. Do the following:

a. Run the Sun Console.

b. Open the directory server instance where Access Manager will be installed.

c. Click the Tasks tab, and select Import from LDIF.

d. Navigate to install-iplanet.ldif, and select it. The file is located at 
AXM_HOME/data_adapters/ldap/iplanet/install-iplanet.ldif

e. Click Add only > OK.

Note: The Access Manager installer prompts the user to specify the base DN, and then 
inserts this base DN value throughout the install-iplanet.conf file. Before you import 
the file, you may want to check that the correct base DN appears in the file. To do this, 
check the dn value in the Base Suffix section at the start of the file. The default value 
is dc=rsasecurity,dc=com. For a typical installation, you do not need to make any 
modifications to the install-iplanet.ldif.

If you already have an LDAP directory that contains your user and group data, you 
may want to remove the People and Groups DN entries from the LDIF file before you 
import it. In this case, you must also map your existing users and groups to Access 
Manager by modifying the Access Manager ldap.conf file. 

5. Add two indexes in your LDAP directory for the ctscPublicMemberList and 
ctscPrivateMemberList attributes. 
For more information on creating indexes in the directory, see your Sun 
documentation.

To install the Data Adapter on Sun Java System Directory Server 6.3 and 7.0:

1. Navigate to the directory server instance directory, that you have created. For 
more information on creating a directory server instance refer to the DSEE 7.0 
installation guide.
For example: c:\dsee7\tmp\<dsInst>

2. In your Access Manager installation, locate the file, 
AXM_HOME/data_adapters/ldap/iplanet/61rsa-axm.ldif.

3. Copy the 61rsa-axm.ldif to the directory server instance location.
For example: C:\dsee7\tmp\<dsInst>\config\schema

4. Start the directory server instance
For example: c:\dsee7\bin\dsadm start c:\dsee7\tmp\<dsInst>

5. Populate directory server instance with the base dn.
For example: c:\dsee7\bin\dsconf create-suffix -p 1389 -e 
dc=rsasecurity,dc=com
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6. Import the Access Manager bootstrap data from the install-iplanet.ldif file into the 
directory server instance using the command:
c:\dsee7\bin\dsconf import -h localhost -p 1389 -e 
AXM_HOME/data_adapters/ldap/iplanet/install-iplanet.ldif 
dc=rsasecurity,dc=com
This file contains the default administrator and password policy entries that are 
required the first time you log on to the RSA Administrative Console.

Note: The Access Manager installer prompts the user to specify the base DN, and 
then inserts this base DN value throughout the install-iplanet.conf file. Before you 
import the file, you may want to check that the correct base DN appears in the file. 
To do this, check the DN value in the Base Suffix section at the start of the file. 
The default value is dc=rsasecurity,dc=com. For a typical installation, you do not 
need to make any modifications to the install-iplanet.ldif.
If you already have an LDAP directory that contains your user and group data, 
you may want to remove the People and Groups DN entries from the LDIF file 
before you import it. In this case, you must also map your existing users and 
groups to Access Manager by modifying the Access Manager ldap.conf file.

7. Add two indexes in your LDAP directory for the ctscPublicMemberList and 
ctscPrivateMemberList attributes.
For more information on creating indexes in the directory, see your Sun Directory 
server 7.0 documentation.

Note: The examples refer to Sun Java System Directory Server 7.0. Use similar 
commands with appropriate directory names for 6.3 versions.

Next Step

Before you can start the Access Manager Servers, you must verify that the relevant 
ldap.conf parameters for this Data Adapter installation are accounted for in the 
primary Access Manager Servers installation. For more information, see Chapter 4, 
“Configuring the LDAP Data Adapter.”

Installing the Data Adapter on Novell eDirectory

This section describes how to insert and enable the Access Manager LDAP Data 
Adapter files on Novell eDirectory.

You need to access the following files to integrate Novell eDirectory with Access 
Manager. These files are located at AXM_HOME/data_adapters/ldap/edirectory:

• eDirSchema-at.ldif 

• eDirSchema-oc.ldif 

• install-edirectory.ldif 

You also need to modify the ldap.conf file to describe your directory tree structure. 
For more information, see Chapter 4, “Configuring the LDAP Data Adapter.”
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Note: Before performing this integration, make sure that you have a fully working 
installation of Novell eDirectory including the Novell iManager utility. RSA also 
recommends that you have access to Novell eDirectory and Access Manager 
documentation, and a basic familiarity with LDIF syntax before making the 
modifications described in this section. 

You must complete these tasks to install the Data Adapter:

1. Import the Access Manager attributes. 

2. Import the object classes specific to Access Manager into the directory tree. 

Important: The process is not complete unless you follow the import order outlined 
here. 

Importing the RSA Access Manager Attributes 

To import the Access Manager attributes:

1. Open the Novell iManager utility.

2. In the left pane, click Schema > Extend Schema.

3. In the ICE Wizard, select Add schema from a file, and click Next.

4. From the File type drop-down list, select LDIF.

5. From the File to import field, browse to eDirSchema-at.ldif, and click Next.

6. Under the Select the Server section, enter the following LDAP server information:

• Server IP address

• Port

• Choose the appropriate .der file if you are using SSL

7. Select Authenticated Login, enter the administrator user DN, and the password 
and click Next.

8. Click Finish.

Importing the RSA Access Manager Object Classes

To import the Access Manager object classes:

1. Open the Novell iManager utility.

2. In the left pane, click Schema > Extend Schema.

3. In the ICE Wizard, select Add schema from a file, and click Next.

4. From the File type drop-down list, select LDIF.

5. From the File to import field, browse to eDirSchema-oc.ldif, and click Next.

6. Under the Select the Server section, enter the following LDAP server information:

• Server IP address
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• Port

• Choose the appropriate .der file if you are using SSL

7. Select Authenticated Login, enter the administrator user DN, and the password 
and click Next.

8. Click Finish.

Importing the RSA Access Manager Bootstrap Data

This section describes how to import the Access Manager bootstrap data from the 
install-edirectory.ldif file. This file contains the default administrator and password 
policy entries that are required, the first time you log on to the Access Manager 
Administrative Console.

Pre-Import Task

By default, Access Manager creates all objects with a distinguished name that 
includes dc=rsasecurity, dc=com. You must modify this entry to match your 
directory before you import the file. To change the distinguished name, navigate to 
AXM_HOME/data_adapters/ldap/edirectory on your local machine, and edit 
install-edirectory.ldif. 

After changing the distinguished name, scroll down to Default Administrative User, 
and edit ctscUserDN. Remove the spaces between the parameters. 

For example: ctscUserDN: cn=Administrator,cn=users,ou=cleartrust,o=rsasecurity 

Next, you must import the Access Manager object classes contained in 
install-eDirectory.ldif. 

To import the Access Manager bootstrap data:

1. Open the Novell iManager utility.

2. In the left pane, click Schema > Extend Schema.

3. In the ICE Wizard, select Import data from file on disk, and click Next.

4. From the File type drop-down list, select LDIF.

5. From the File to import field, browse to install-edirectory.ldif, and click Next.

6. Under the Select the Server section, enter the following LDAP server information:

• Server IP address

• Port

• Choose the appropriate .der file if you are using SSL.

7. Under the Advanced Settings section, select the following checkboxes:

• Use LBURP

• Allow forward references

8. Click Finish.
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Next Step

Before you can start the Access Manager Servers, you must verify that the relevant 
ldap.conf parameters for this Data Adapter installation are accounted for in the 
primary Access Manager Servers installation. For more information, see Chapter 4, 
“Configuring the LDAP Data Adapter.”

Installing the Data Adapter on standalone Active Directory 
Lightweight Directory Service

This section describes the steps required to manually install the data adapter on an 
Active Directory Lightweight Directory Service (AD LDS).

Before you begin

1. Make sure that the Access Manager 6.1 SP4 servers are successfully installed.

2. Make sure that the AD LDS is installed and an instance is created.

Note: It is recommended that the local administrator perform this data adapter 
installation.

Installing the AD LDS Data Adapter

Follow the steps below to install the AD LDS Data Adapter.

To install the AD LDS Data Adapter:

1. Copy the data adapter files from /adlds/ folder to the machine on which AD LDS 
is installed.

2. Open install-adlds.ldif. Scroll down to Default Administrative User and replace 
ctscUserDN: cn=admin, cn=Administrators, cn=Users, dc=domain, dc=com with 
ctscUserDN: cn=valid user, cn=Administrators, cn=Users, dc=domain, dc=com, 
where valid user is a user in AD LDS and dc=domain,dc=com is the domain base 
DN of your AD LDS instance. 

Note: This modification is space-sensitive. Ensure that there are no spaces 
surrounding the commas. 

Note: If the username mentioned in the install-adlds.ldif file is not the default 
‘admin’and is mentioned as ctscUserDN, the same user needs to be modified in 
the corresponding references of the ‘admin’ as user in this file. Only then is the 
user created in the AD LDS.

3. Follow the steps below to create a schema on AD LDS:

a. Open ADSI Edit tool

b. From the menu bar, click Action > Connect to.
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c. In the Connection Settings dialog box, perform these tasks in the following 
order:

• In the Connection name field, type schema.

• Under Computer, choose the option Select or type a domain or server 
and enter the AD LDS instance domain and port.

• Under the Connection Point section, make sure that Well-known 
naming context is selected and that the schema is selected from the 
drop-down menu.

• Click OK.

4. Follow the steps below to copy the CN parameter from ADSI Edit on AD LDS:

a. In the left pane of ADSI Edit, click the plus sign (+) to expand Schema.

b. Right-click the folder below Schema, and select Properties.

c. Under Attributes in the Attribute Editor dialog box, select 
distinguishedName and click Edit.

d. From the Value field in the String Attribute Editor dialog box, copy and save 
the last CN parameter. For example, 
CN={08BA9CFE-A409-443D-BF52-A036881B7DFC}

e. In the String Attribute Editor dialog box, click Cancel.

f. In the Attribute Editor dialog box, click Cancel.

5. Follow the steps below to set the dsHeuristic flag:

a. Open ADSI Edit tool

b. From the menu bar, click Action > Connect to.

c. In the Connection Settings dialog box, perform these tasks in the following 
order:

• In the Connection name field, enter Configuration.

• Under Computer, choose the option Select or type a domain or server 
and enter the AD AD LDSLDS instance domain and port.

• Under the Connection Point section, make sure that Well-known 
namingcontext is selected and that Configuration is selected from the 
drop-down menu.

• Click OK.

d. In the left pane of AD LDS ADSI Edit, click the plus sign (+) to expand 
Configuration

e. Click + to expand CN=Services

f. Click + to expand CN=Windows NT

g. Right click on CN=Directory Service and select Properties

h. In the attribute editor enter the value of dsHeuristic flag to 0000000001001
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6. From a command prompt, run install-axmschema.bat with the hostname, port 
number, and the last part of the schema DN that you copied and saved in Step 
4“To copy the CN parameter from ADSI Edit on AD LDS”. Separate each 
parameter with a space.
For example, type install-axmschema "localhost:50000" 
"CN={08BA409-443D-BF52-A036881B7DFC}",where localhost:50000 is the 
hostname and port number of the AD LDS instance and 
CN={08BA409-443D-BF52-A036881B7DFC} is the last part of the schema DN that 
you copied and saved.

7. From a command prompt, run install-axmdata.bat with the hostname, port 
number, domain base DN as parameters. Separate each parameter with a space. To 
define the base DN, you must use a comma with no spaces.
For example, type: install-axmdata "localhost:50000" "dc=domain,dc=com", 
where localhost:50000 is the hostname and port number.of the AD LDS instance 
dc=domain,dc=com is the domain base DN for your Access Manager policy 
store.

8. Using the AD LDS Schema Console, create an index in your directory for the 
ctscPublicMemberList and ctscPrivateMemberList attributes. For more 
information, see your Microsoft documentation.

9. Follow the steps below to reset a password for <administrator> with ADSI Edit:

a. Open ADSI Edit tool.

b. Click Action > Connect to. 

c. Perform the following steps in the Connection Settings dialog box:

• Under Connection name, change connection name to My Connection.

• Under Connect to the following node, select Distinguished name (DN) 
or naming context, and from the drop-down menu, select the domain 
where you want to install the Access Manager data object.

• In the Select or type domain or server, provide the domain name or the IP 
address and port number

d. Navigate to CN=<Administrator>, right click and select Reset Password

e. In the New Password field of the Reset Password dialog box, enter a new 
password.

f. In the Confirm Password field, enter the password again and click OK.

10.  Follow the steps below to add a DN account with ADSI Edit:

a. In the left pane of ADSI Edit, click the plus sign to expand My Connection, 
click + to expand the folder under My Connection, and click + to expand 
CN=Roles.

b. Right-click CN=Administrators, and click Properties.

c. Under Attributes in the Attribute Editor dialog box, select member, and click 
Edit.

d. In the Multi-valued Distinguished Name with Security Principal Editor dialog 
box, click Add DN Account.
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e. In the Enter a distinguished name (DN) for an object field in the Add DN 
Account dialog box, enter 
cn=<administrator>,cn=Administrators,cn=users,dc=<domain>,dc=com

f. Click OK on the rest of the screens.

g. Repeat the above steps for CN=Readers role

11. Follow the steps below to manually add the ctscuserAuxClass in AD LDS

a. Open the MMC snap-in for AD LDS schema management and add 
ctscUserAuxClass as valid Aux Class for user objectclass.

b. Reload the AD LDS schema for the changes to take effect.

12. Add SamAccountName as an attribute for group objectclass.

13. Restart the AD LDS service. 

Setting up SSL for AD LDS

The Access Manager Servers can be configured for Secure Sockets Layer (SSL) 
connections to the Active Directory Lightweight Directory Service host. Prior to 
starting the Servers, you must enable SSL connections on your AD LDS host.

Before you begin

1. Make sure that IIS has been installed and has been configured for HTTPS binding.

2. Make sure that AD CS has been installed and set up as Standalone Root CA.

Note: Make sure that the certificate that you install or import must be marked for 
server authentication. When you request the certificate, specify the fully qualified 
domain name (FQDN) of the computer on which your AD LDS instance is 
running as the identifying name for the certificate. In other words, the server 
authentication certificate must be issued to the FQDN of the computer on 
which your AD LDS instance is running.

Follow the steps below to set up SSL:

Note: RSA recommends that an administrator with knowledge of public key 
infrastructure, Active Directory certificate operations, and the use of Sun Java keytool 
perform these tasks.

1. Download the Trusted Root (CA) certificate

2. Import the Trusted Root (CA) Certificate

3. Create a setup information (.inf) file

4. Create a request file to use with a Standalone CA

5. Submit a request to a Standalone CA

6. Import the certificate into the certificate store

7. Verify that the certificate is stored under the AD LDS instance's personal store
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8. Configure permissions on the server authentication certificate

9. Import the CA Certificate using the Sun JAVA keytool

10. Setting SSL Parameter Values on AD LDS 2008

Download the Trusted Root (CA) certificate

To download the Trusted Root (CA) certificate:

1. Log on to the computer where you installed a certificate; for example, the gateway 
server or management server.

2. Launch Internet Explorer, and connect to the computer hosting the 
Certificate Services; for example, https://<servername>/certsrv.

3. On the Welcome page, select Download a CA Certificate, certificate chain, or 
CRL.

4. On the Download a CA Certificate, Certificate Chain, or CRL page, select 
Encoding method, choose Base 64, and then click Download CA certificate 
chain.

5. In the File Download dialog box, click Save and save the certificate; for example, 
Trustedca.p7b.

6. When the download has finished, exit Internet Explorer.

Import the Trusted Root (CA) Certificate

To import the Trusted Root (CA) Certificate:

1. On the Windows desktop, select Start> Run and type mmc in the Run dialog box 
and then click OK.

2. In the Console1 window, select File> Add/Remove Snap-in.

3. In the Available Snap-ins dialog box, select Certificates and then click Add.

4. In the Certificates snap-in dialog box, select Computer account, and then click 
Next.

5. In the Select Computer dialog box, ensure that Local computer (the computer that 
this console is running on) is selected, and click Finish.

6. In the Add/Remove Snap-in dialog box, click OK.

7. In the Console1 window, click the plus sign to expand Certificates (Local 
Computer), and then expand Trusted Root Certification Authorities, and then click 
Certificates.

8. Right-click Certificates, select All Tasks, and then click Import.

9. In the Certificate Import Wizard, click Next.

10. On the File to Import page, click Browse and select the location where you 
downloaded the CA certificate file, for example, TrustedCA.p7b, select the file, 
and then click Open.
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11. On the File to Import page, select Place all certificates in the following store and 
ensure that Trusted Root Certification Authorities appears in the Certificate store 
box, and then click Next.

12. On the Completing the Certificate Import Wizard page, click Finish.

Create a setup information (.inf) file

To create a setup information (.inf) file

1. On the computer hosting the Operations Manager component for which you are 
requesting a certificate, click Start, and then click Run.

2. In the Run dialog box, type Notepad, and then click OK.

3. Create a text file containing the following content:
[NewRequest] 
Subject="CN=<FQDN of computer you are creating the 
certificate>" 
Exportable=TRUE 
KeyLength=2048 
KeySpec=1 
KeyUsage=0xf0 
MachineKeySet=TRUE 
[EnhancedKeyUsageExtension] 
OID=1.3.6.1.5.5.7.3.1 
OID=1.3.6.1.5.5.7.3.2 

4. Save the file with an .inf file name extension; for example, RequestConfig.inf.

5. Close Notepad.

Create a request file to use with a Standalone CA

To create a request file to use with a Standalone CA

1. On the computer hosting the Operations Manager component for which you are 
requesting a certificate, select Start> Run.

2. In the Run dialog box, type cmd, and then click OK.

3. In the command window, type CertReq –New –f RequestConfig.inf 
CertRequest.req, and then press Enter.

4. Using Notepad, open the resulting file (for example, CertRequest.req), and copy 
the contents of this file into the clipboard.

Submit a request to a Standalone CA

To submit a request to a Standalone CA

1. On the computer hosting the Operations Manager component for which you are 
requesting a certificate, start Internet Explorer, and then connect to the computer 
hosting Certificate Services; for example, https://<servername>/certsrv.

2. On the Microsoft Active Directory Certificate Services Welcome screen, click 
Request a certificate.
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3. On the Request a Certificate page, click Advanced Certificate Request.

4. On the Advanced Certificate Request page, click Submit a certificate request by 
using a base-64-encoded CMC or PKCS #10 file, or submit a renewal request 
by using a base-64-encoded PKCS #7 file.

5. On the Submit a Certificate Request or Renewal Request page, in the Saved 
Request text box, paste the contents of the CertRequest.req file that you copied in 
step 4 in the previous procedure.

6. Exit the Internet Explorer.

Approve the pending certificate request

To approve the pending certificate request

1. Log on as a certification authority administrator to the computer hosting Active 
Directory Certificate Service.

2. On the Windows desktop, click Start > Programs > Administrative Tools, and 
then click Certification Authority.

3. Under Certification Authority, expand the node for your certification authority 
name, and then click Pending Requests.

4. In the results pane, right-click the pending request, point to All Tasks, and then 
click Issue.

5. Click Issued Certificates, and confirm that the certificate you just issued is listed.

6. Close Certification Authority.

7. On the Certificate Issued page, select Base 64 encoded, and then click Download 
certificate.

8. In the File Download – Security Warning dialog box, click Save, and save the 
certificate; for example, save as NewCertificate.cer.

9. Exit Internet Explorer.

Import the certificate into the certificate store

To import the certificate into the certificate store

1. On the computer hosting the Operations Manager component for which you are 
configuring the certificate, select Start> Run.

2. In the Run dialog box, type cmd, and then click OK.

3. In the command window, type CertReq –Accept NewCertifiate.cer, and then 
click Enter.
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Verify that the certificate is stored under the AD LDS instance's personal 
store

To verify that the certificate is stored under the AD LDS instance's personal 
store

1. Click Start, right-click Command Prompt, and then click Run as 
administrator.

2. Type mmc to open Microsoft Management Console (MMC).

3. Select File> Add/Remove Snap-in, select the Certificates snap-in under 
Available snap-ins, and then click Add.

4. In Add or Remove Snap-ins, select Service Account to view the certificates that 
are stored in the AD LDS instance's personal store, and then click Next.

5. Under Add or Remove Snap-ins, select Local computer, and then click Next.

6. Under Service Account, select the name of the AD LDS instance to which you 
want to connect over LDAPS, and then click Finish.

7. In the Add or Remove Snap-ins dialog, click OK. 

8. In the console tree, expand Certificates - Service, expand 
ADAM_instance_name\Personal, and then expand Certificates.

9. Locate the installed or imported certificate. In the details pane, verify that the 
certificate is marked for Server Authentication in the Intended Purposes column. 
In the details pane, verify that the computer's fully qualified host name appears in 
the Issued To column.

Configure permissions on the server authentication certificate

Before you attempt to use the server authentication certificate with AD LDS, you must 
ensure that the service account under which the AD LDS instance is running has read 
access to the certificate that you installed or imported.

To configure permissions on the server authentication certificate

1. Navigate to the following default directory where the installed or imported 
certificates are stored:
C:\ProgramData\Microsoft\Crypto\RSA\MachineKeys

2. Right-click the appropriate server authentication certificate, and then click 
Properties.

3. On the Security tab, click Edit.

4. In the Permissions dialog box, click Add.

5. In the Select Users, Computers, or Groups dialog box, type Network Service, 

click Check Names for confirming and then click OK.
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Import the CA Certificate using the Sun JAVA keytool

To import the CA certificate using the Sun Java keytool

1. At the command prompt, type C:\<AXM_HOME>\jre\bin\keytool -import -v –
trustcacerts -alias <alias_name> -file <path_and_file_name_of_certificate> 
-keypass <key_password >–keystore <server_keystore_file_name>.jks 
-storepass <store_password>
where

• alias_name is the name assigned to the keystore entry.

• path_and_file_name_of_certificate is the path to and file name of the 
certificate.

• key_password is the password required to use the key

• server_keystore_file_name is the name and location of the persistent keystore 
file

• store_password is the password used to protect the keystore

Note: This command is case-sensitive.

2. If presented with the prompt, Trust this certificate?, click Yes.
If the import is successful, you see the message “Certificate was added to 
keystore”.

3. Start the Access Manager Servers to complete the import of the CA certificate.

Setting SSL Parameter Values on AD LDS 2008

After importing the CA certificate with Sun Java keytool, you must set these SSL 
parameters with the following values in the AXM_HOME/conf/ldap-adlds.conf file:

• cleartrust.data.ldap.directory.adlds.ssl.use :auth

• cleartrust.data.ldap.directory.adlds-bind.ssl.use :auth

• cleartrust.data.ldap.directory.adlds.ssl.ca_keystore_file: 
server_keystore_file_name.jks, where server_keystore_file_name is the name and 
location of the persistent keystore file

• cleartrust.data.ldap.directory.adlds-bind.ssl.ca_keystore_file: 
server_keystore_file_name.jks, where server_keystore_file_name is the name and 
location of the persistent keystore file

• cleartrust.data.ldap.directory.adlds.ssl.ca_keystore_type :JKS

• cleartrust.data.ldap.directory.adlds-bind.ssl.ca_keystore_type :JKS

• cleartrust.data.ldap.directory.adlds.ssl.ca_keystore_passphrase: password, where 
password is the password used to protect the keystore

• cleartrust.data.ldap.directory.adlds-bind.ssl.ca_keystore_passphrase :password, 
where password is the password used to protect the keystore
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Post Installation tasks

Perform the following post installation tasks in the sequence given below:

1. Copy the ldap-adlds.conf from the /adlds/ folder to AXM_HOME/conf directory.

2. Set the following necessary parameters to reflect to AD LDS datastore

• cleartrust.data.ldap.directory.<adlds>.hostname

• cleartrust.data.ldap.directory.<adlds-bind>.hostname

• cleartrust.data.ldap.directory.<adlds>.port

• cleartrust.data.ldap.directory.<adlds-bind>.port

• cleartrust.data.ldap.directory.<adlds>.binddn

• cleartrust.data.ldap.directory.<adlds-bind>.binddn

• cleartrust.data.ldap.directory.<adlds>.password

• cleartrust.data.ldap.directory.<adlds-bind>.password

• cleartrust.data.ldap.userstore

• cleartrust.data.ldap.groupstore

• cleartrust.data.ldap.authentication_store

• cleartrust.data.ldap.policystore

• cleartrust.data.ldap.adminstore

Note: Other parameters maybe set depending on the user’s requirement

3. Set the parameter “cleartrust.data.ldap.directory.adlds.type’ to ‘adlds’.

4. Set the parameter cleartrust.data.source.configuration to ldap-adlds.conf in both 
aserver.conf and eserver.conf

5. Change all occurrences of <dc=domain,dc=com> in ldap-adlds.conf to reflect 
your dn structure.

6. Restart Access Manager Servers. The Servers should start successfully.

Next Step

Before you can start the Access Manager Servers, you must verify that the relevant 
ldap.conf parameters for this Data Adapter installation are accounted for in the 
primary Access Manager Servers installation. For more information, see Chapter 4, 
“Configuring the LDAP Data Adapter.”
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Installing the Data Adapter on OpenDJ

This section describes the steps required to install the Data Adapter on OpenDJ.

To install the Data Adapter on OpenDJ

1. Copy 61rsa-axm.ldif from the /OpenDJ/ folder to the following directory: 
<software root directory> \config\schema, where software root directory is the 
directory where you installed your OpenDJ.

2. Import the Access Manager bootstrap data from the /OpenDJ/install-opendj.ldif 
file. 
This file contains the default administrator and password policy entries that are 
required the first time you log on to the RSA Administrative Console.

Note: Use the OpenDJ control panel to import the data. Make sure the DN 
validation is unchecked.

3. Add two indexes in your LDAP directory for the ctscPublicMemberList and 
ctscPrivateMemberList attributes.For more information on creating indexes in the 
directory, see your Sun documentation.

Note: Before you import the file, ensure that the correct base DN appears in the file. 
To do this, check the DN value in the Base Suffix section at the start of the file. The 
default value is dc=rsasecurity,dc=com.
The attribute 'allow-pre-encoded-passwords' should be set to 'true' in OpenDJ 
Password policy.

Next Step

Before you can start the Access Manager Servers, you must verify that the relevant 
ldap.conf parameters for this Data Adapter installation are accounted for in the 
primary Access Manager Servers installation. For more information, see Chapter 4, 
“Configuring the LDAP Data Adapter.”
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4 Configuring the LDAP Data Adapter

• Before You Begin

• Role of the ldap.conf File

• Identifying Your LDAP Directory Hosts

• Configuring Your LDAP Directory Failover

• Configuring Connection Information

• Connection Management

• Connection Pool Management for Bind Authentication

• LDAP Directory Host Referrals

• Mapping Your External LDAP Directory Data

• Mapping Your User Data

• Mapping Your Group Data

• Configuring an LDAP Directory as an Aux Store

• Setting Up an Aux Store

• Setting Up a Global Catalog Aux Store

• Configuring the Aux Store as Read-Only or Read-Write

• Setting Up a Global Catalog Aux Store

• User Identity Mapping for Integrated Windows Authentication and Other 
Applications

• Tuning Your LDAP Directory for RSA Access Manager

• Next Step

This chapter describes how to configure your LDAP directory to function as a data 
store for the RSA Access Manager Servers. For very basic installations of Access 
Manager, you may skip this chapter. If you want Access Manager to read user data 
from an existing directory, use a failover directory host, or both, follow the 
instructions in this chapter.

To complete the configuration tasks in this chapter, edit the parameters in the 
AXM_HOME/conf/ldap.conf file. This file contains detailed descriptions of each 
parameter.

Read the introductory paragraph of each section to determine if the parameters in that 
section apply to your installation.
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Before You Begin

Before you configure the connections to your LDAP directory host and map your user 
and group data, make sure that:

• Your Access Manager Servers are installed (at least one Entitlements Server, 
Dispatcher/Key Server, and Authorization Server).

• The Access Manager LDAP Data Adapter is installed on each LDAP directory 
host you are using.

• The Access Manager policy store is set up on at least one LDAP directory host 
(RSA provides an LDIF file to set this up for you).

• Your user store is set up on at least one LDAP directory host. You can either use 
the Access Manager default user store or your own external user store.

• You have gathered the following information for each LDAP directory host that 
Access Manager must access:

– Logical name (this can be any name you choose to identify that server, such as 
Users_NY, Users_LA, Policy1, Policy_Replica1, and so on.)

– Fully qualified hostname or IP address.

– The port on your LDAP directory host that listens for incoming requests from 
clients. The default LDAP port is 389.

– The administrator logon ID and password necessary to connect to the LDAP 
directory host.

– Whether the LDAP directory host must be accessed by Access Manager as 
read-only or read-write. RSA recommends that you configure Access 
Manager to access your external user and group data in read-only mode.

• If you are mapping external user data to Access Manager, you need the following 
information about your user store:

– The base DN where users are located in your directory. This is where Access 
Manager initiates searches for user entries. 

– The base DN where groups are located in your directory. This is where Access 
Manager initiates searches for group entries.

– The Relative Distinguished Name (RDN) for users. This is the attribute that is 
unique for each user.

– The RDN for groups.

– The names of the object classes that define your user objects.

– The names of the object classes that define your group objects.

– The filter to use to return only user entries.

– The filter to use to return only group entries.

– The list of attributes that define a user in your directory.
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– The list of attributes that define a group in your directory. Access Manager 
only supports membership (the uniquemember attribute in LDAP) to define a 
group of users.

Role of the ldap.conf File

The Access Manager LDAP configuration file (ldap.conf) controls how Access 
Manager finds and accesses the data in your LDAP directory. This file is used to 
enable connections to your LDAP directory host and to map your external user and 
group data to Access Manager.

The ldap.conf file is accessed by the Entitlements Server and the Authorization 
Servers. A copy of this file must reside on each machine that is running either an 
Entitlements Server or an Authorization Server. Your Entitlements Server 
(eserver.conf) and Authorization Server (aserver.conf) configuration files have a 
parameter (cleartrust.data.source.configuration) that points to the name and relative 
location of the ldap.conf file.

In most installations, you can retain this default setting. If your ldap.conf file is stored 
in a different location or under a different name, set this parameter to point to the 
correct filename and relative path location of the file.

Identifying Your LDAP Directory Hosts

If your installation uses multiple LDAP directory hosts, you must give each host a 
unique name within Access Manager. This section describes how to set those names. 
If your installation has only one LDAP directory host and you specified its name when 
you ran the Access Manager installer routine, skip this section and go to “Mapping 
Your User Data” on page 86.

Pick a name for each LDAP directory host that is used as a data store for Access 
Manager. This includes your read-write masters, your read-only replicas (for failover, 
for example), and all distributed directory hosts. 

Note: If a read-only data store is used by the Authorization Server, by default, Access 
Manager cannot lock out unauthorized users. To configure Access Manager to lock 
out unauthorized users when using a read-only, see “Password Lockout for Read-Only 
Configurations” on page 213.

Also, you must separately name the unique connection pool for bind authentication. 
For more information, see “Connection Pool Management for Bind Authentication” 
on page 82. 

Note: If you define multiple data stores in the ldap.conf file, they must all be 
accessible when the Access Manager Servers are started. By default, if a defined data 
store is not contacted during startup, the Servers report a failure and exit. For more 
information, see the cleartrust.data.ldap.startupfailuremode parameter in the 
ldap.conf file.
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To name and identify your LDAP directory hosts:

1. Open the ldap.conf file. 

2. Identify the name for every LDAP directory host by setting this parameter:
cleartrust.data.ldap.directory_name 

Choose logical names that reflect the purpose of the LDAP directory hosts. 
In the ldap.conf file used by Authorization Servers, list only LDAP directory 
hosts that are read-only replicas. 
In the ldap.conf file used by Entitlements Servers, list the writable master copies 
first in the list, followed by read-only replicas.

3. Identify the name of the primary LDAP directory host that is used to access user 
and group data by setting this parameter: 

cleartrust.data.ldap.userstore
In the ldap.conf file used by Authorization Servers, this is a read-only replica. 
In the ldap.conf file used by Entitlements Servers, this is the writable master 
copy.

4. Identify the name of the primary LDAP directory host that is used to access 
Access Manager policy data by setting this parameter:

cleartrust.data.ldap.policystore
In the ldap.conf file used by Authorization Servers, this is a read-only replica. 
In the ldap.conf file used by Entitlements Servers, this is the writable master 
copy.

5. Identify the name of the primary LDAP directory host that is used to access 
administrative user and administrative group data by setting this parameter:

cleartrust.data.ldap.adminstore
This is the same directory host you use for your Access Manager policy data. 
In the ldap.conf file used by Authorization Servers, this is a read-only replica. 
In the ldap.conf file used by Entitlements Servers, this is the writable master 
copy.

Configuring Your LDAP Directory Failover

If your installation uses failover directory hosts to provide a backup in case your main 
directory host fails, you must configure Access Manager to connect to the failover 
directory hosts.

Access Manager supports LDAP directory host failover for lookup and search 
operations only. 

Note: Access Manager does not support multiple master copies of an LDAP directory. 
Therefore, if your primary writable LDAP directory host goes down, you cannot 
create or modify records in your LDAP directory with the RSA Administrative 
Console.
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The ldap.conf file must specify a list of LDAP directory hosts for your primary LDAP 
directory and directory replicas. The Data Adapters must all be of the same version 
and type.

For more information about LDAP directory host failover, see the following section 
“Deploying Redundant Directory Hosts.”

Deploying Redundant Directory Hosts

Access Manager supports LDAP directory host failover for search operations only. If 
your primary LDAP directory host is unavailable, configure Access Manager to 
contact one or more backup LDAP directory hosts (or replicas). This is implemented 
in a three-step process: 

1. Name the failover groups

2. Define the failover groups

3. Associate each failover group with a data store (a user store, admin store, or 
policy store).

To configure failover LDAP directory hosts:

1. Open the conf/ldap.conf file. 

2. Add this parameter to name and create separate User Failover Groups (groups of 
LDAP hosts). For details on this parameter, see your 
AXM_HOME/conf/ldap.conf file.

cleartrust.data.ldap.failover_group: user_failover, policy_failover, 
admin_failover

3. Add this parameter to establish that when your primary user LDAP directory host 
is unavailable, the second host in the group is used as adata store. For details on 
this parameter, see the conf/ldap.conf file.

cleartrust.data.ldap.failover_group.user_failover:User, 
UserReplica1,UserReplica2

4. Add this parameter to establish the members of your Policy Failover Group of 
LDAP policy store hosts. This group of LDAP hosts is used as failover if your 
primary LDAP policy store host goes down. For details on this parameter, see the 
conf/ldap.conf file.

cleartrust.data.ldap.failover_group.policy_failover: Policy, PolicyReplica1, 
PolicyReplica2

5. Add this parameter to establish the members of your Administrators Failover 
Group of LDAP directory hosts. This group of LDAP hosts is used as failover if 
your primary LDAP admin store host goes down. For details on this parameter, 
see the conf/ldap.conf file.

cleartrust.data.ldap.failover_group.admin_failover: Admin, AdminReplica1, 
AdminReplica2

6. Implement your failover groups by associating the appropriate data store with the 
appropriate group. For your user data store, set the parameter 
cleartrust.data.ldap.userstore with the value of the failover group you named in 
step 2.
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Note: You do not need separate failover groups for each data store type. As your 
needs dictate, you may use the same failover group for all three data stores.

This example shows failover configured for all three data store types—admin, 
policy, and user:

cleartrust.data.ldap.adminstore: admin_failover 
cleartrust.data.ldap.policystore: policy_failover 
cleartrust.data.ldap.userstore: user_failover 

7. Set up the LDAP Server Connection parameters. For more information, see 
“Configuring Connection Information” on page 80.

8. For clear or anonymous SSL connections, you must add this SSL parameter with 
the appropriate value:

cleartrust.data.ldap.directory.aux-store-name.ssl.use: clear | anon 
Setting up authenticated SSL requires you to manually include all parameters 
noted under “Setting Keystore Parameters in ldap.conf” on page 219. You must 
include the aux store name for the directory_name variable indicated on this page.

9. Restart your Access Manager Servers for the new settings to take effect. Access 
Manager supports hot failover for LDAP directory hosts. 

Note: Make sure that your failover LDAP directory hosts are running when you 
restart the Access Manager Servers.

Configuring Connection Information

Once you name and identify each of your LDAP directory hosts, you must specify the 
information that Access Manager needs to find and connect to those hosts. Each 
LDAP directory that you list and name must have its own block of connection 
parameters with the appropriate server name applied. Refer to the server names that 
you specified in the cleartrust.data.ldap.directory_name server identification 
parameter, and replace the servername in the connection parameters with the correct 
name of your LDAP directory host. 

For more information about the LDAP connection parameters, see the 
cleartrust.data.ldap.directory parameters in the AXM_HOME/conf/ldap.conf file.

To enable connection to an LDAP directory host:

1. Enter the hostname or IP address of the LDAP directory host. If you are using 
LDAP directory referrals, define this hostname in the same format as the referral 
URL. For example:

cleartrust.data.ldap.directory.servername.hostname :ldapserver.company.com
80 4: Configuring the LDAP Data Adapter



RSA Access Manager 6.1 SP4 Servers Installation and Configuration Guide
where:

• servername is the name of your LDAP server. For example, iplanet.

• ldapserver.company.com is the valid IP address or DNS name of your LDAP 
server.

2. Specify the port number that Access Manager uses to make a connection to the 
LDAP directory host. 389 is the default listener port for most LDAP vendors. 636 
is the default port if you are using LDAPS. For example:

cleartrust.data.ldap.directory.servername.port :389

3. Set the following two parameters, which are needed to bind to the LDAP directory 
whenever a request is made. Set these parameters to the administrator DN and to 
the password used to log on to the LDAP directory.

cleartrust.data.ldap.directory.servername.binddn :cn=Directory Manager
cleartrust.data.ldap.directory.servername.password :abc123

where:

• cn=Directory Manager is the administrator logon name.

• abc123 is the password for the administrator account.

4. The following parameter controls whether Access Manager accesses the data on 
this LDAP directory host in read-only or read-write mode. You may want to make 
an LDAP directory host read-only if, for example, it is just a replica used for 
failover or load balancing purposes. If set to true, you cannot modify the 
information on this LDAP directory host using the Administrative Console. 

cleartrust.data.ldap.directory.servername.readonly:true|false
You can also specify read-only mode for individual objects, such as users or 
groups. This read-only setting takes precedence over the read-only settings at the 
object level.

5. In your ldap.conf file, make sure that the use_abandon and can_view_schema 
parameters are set to suit the requirements of your LDAP server vendor. For 
details, see the comments in the ldap.conf file.

Connection Management

Access Manager allows you to configure the connections made to your LDAP 
directory host or hosts. In most cases, the default connection management settings are 
optimal. However, if an LDAP directory host is used only for the purpose of accepting 
referrals, disable the connection management. For detailed information about the 
connection management parameters, see the comments for the 
cleartrust.data.ldap.directory.server_name.connection parameters in the 
AXM_HOME/conf/ldap.conf file.
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Connection Pool Management for Bind Authentication

The LDAP Data Adapter can be configured to authenticate users by doing a bind to 
the LDAP directory with the users’ credentials by setting the following parameter to 
true: 

cleartrust.data.ldap.password.validate_with_connect:

When this parameter is set to true, additional parameters must be set. Active 
Directory Data Adapters are installed with these parameters set by default. 

Data Adapters for other LDAP directories configured to authenticate by doing a bind 
must have these parameters set properly in the ldap.conf file to create a dedicated 
connection pool for authentications:

cleartrust.data.ldap.directory.your_ldap_directory-bind.hostname: 
cleartrust.data.ldap.directory.your_ldap_directory-bind.port: 
cleartrust.data.ldap.directory.your_ldap_directory-bind.binddn: 
cleartrust.data.ldap.directory.your_ldap_directory-bind.password:

The following parameter is important in systems configured for LDAP directory 
referrals:

cleartrust.data.ldap.directory.your_ldap_directory-bind.referto: 

When the Access Manager Servers receive a referral, they attempt to look up 
connection information based on the target host or port. If multiple pools are defined 
for the same LDAP directory host, the Access Manager Servers cannot determine 
which connection settings to use. Setting this parameter to false ensures that the 
Access Manager Servers do not attempt to connect the connection pool used 
exclusively for authentication binds.

It is necessary to add this connection pool to the directory_name list parameter in the 
ldap.conf file, as shown in this example:

cleartrust.data.ldap.directory_name: 
your_ldap_directory,your_ldap_directory-bind,Replica1,Replica2

If the cleartrust.data.ldap.password.validate_with_connect: parameter is set to true, 
you must also properly set the cleartrust.data.ldap.authentication_store parameter in 
the ldap.conf file. The authentication_store parameter establishes the primary LDAP 
directory host that is used to perform bind operations for user authentication. For more 
information, see the comments for the authentication_store parameter in your 
ldap.conf file.
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LDAP Directory Host Referrals

A referral is a piece of information returned by an LDAP directory host that indicates 
to the client that it must contact other LDAP directory hosts to fulfil the request. The 
client then contacts the other LDAP directory hosts to which it is referred, resubmits 
the original request, and presents the results to the user. Referrals allow an 
organization to distribute its directory across multiple LDAP directory hosts or to 
implement a high-availability directory architecture.

If you are using LDAP directory host referrals, you must set some parameters in your 
ldap.conf file to configure Access Manager to accept LDAP directory host referrals. 
For more information, see the cleartrust.data.ldap.directory parameters in the 
AXM_HOME/conf/ldap.conf file.

To enable referrals:

1. Set the following parameter to true for each LDAP directory host defined in your 
ldap.conf file to enable Access Manager to accept LDAP referrals from a 
particular LDAP directory host:

cleartrust.data.ldap.directory.usermaster.referral.enable:

2. Optional. Use this parameter to set the maximum number of LDAP referrals to 
follow in a sequence when performing an LDAP directory request:

cleartrust.data.ldap.directory.usermaster.referral.hop_limit:

3. If you have LDAP directory referrals enabled, match the hostname and port 
number in the referral URL (as defined by your LDAP directory host) as entered 
in the following connection parameters for the destination LDAP directory host:

cleartrust.data.ldap.directory.userreplica1.hostname:ldapserver.company.com
cleartrust.data.ldap.directory.userreplica1.port :389

The format of referral URLs varies depending on your LDAP directory host. For 
example, some referral URLs contain the fully qualified hostname 
(ldap://hostname.domain.com:389) and some do not (ldap://hostname:389).

Binding LDAP Referral Servers with Default Credentials or Specific Credentials

Access Manager enables you to bind multiple LDAP referral servers with default or 
specific bind credentials (bind DN and bind password), instead of an anonymous bind 
in a distributed directory topology. 

You can configure the ldap.conf file with default or specific bind credentials to enable 
the LDAP server to bind to other directory servers whose referral locations are 
unknown while following referrals.

When there are no bind credentials available for a directory server being referred, they 
are picked up from the ldap.conf file. These credentials are used instead of binding 
anonymously to the directory server whose mappings are not available in the 
ldap.conf file.

Note: The referral directory servers to which the clients are being referred must 
contain the default credentials that are set in the master directory server for 
authenticating the client and binding the request.
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To configure binding of multiple LDAP referral servers with default credentials:

1. Open the AXM_HOME/conf/ldap.conf file.

2. Add the names of all the master LDAP and referral servers separated by comma to 
the cleartrust.data.ldap.directory_name parameter.

cleartrust.data.ldap.directory_name: directoryname1, directoryname2
where: 

• directoryname1 is the name of the master LDAP server.

• directoryname2 is the name of the referral server.

3. Add the hostnames of the LDAP servers. For example:
cleartrust.data.ldap.directory.directoryname1.hostname: host1
cleartrust.data.ldap.directory.directoryname2.hostname: host2

4. Add the port numbers for the LDAP servers. For example:
cleartrust.data.ldap.directory.directoryname1.port:port1
cleartrust.data.ldap.directory.directoryname2.port:port2

5. Add the bind DN and bind password for the master LDAP using these parameters. 
For example:

cleartrust.data.ldap.directory.directoryname1.binddn1                     
cleartrust.data.ldap.directory.directoryname1.password1 

6. Set the value for these parameters for the master LDAP to true:
cleartrust.data.ldap.directory.directoryname1.referto
cleartrust.data.ldap.directory.directoryname1.referral.enable

7. Set the value for these parameter for the referral server to false:
cleartrust.data.ldap.directory.directoryname2.referto
cleartrust.data.ldap.directory.directoryname2.referral.enable

8. Provide the default bind DN and default bind password for the LDAP servers 
using these parameters:

cleartrust.data.ldap.directory.DN.referral.credentials.binddn: Default binddn
cleartrust.data.ldap.directory.DN.referral.credentials.password: Default 
password

Note: If you do not provide the default bind DN and default bind password in the 
parameters above, the binding with the referral server would be anonymous.

9. Set the value for this parameter to sub:
cleartrust.data.ldap.user.scope
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To configure binding of multiple LDAP referral servers with specific credentials:

1. Open the AXM_HOME/conf/ldap.conf file.

2. Add these parameters to configure binding with specific credentials:
cleartrust.data.ldap.directory_name: directoryname1, directoryname2
cleartrust.data.ldap.directory.directoryname1.hostname:host1
cleartrust.data.ldap.directory.directoryname2.hostname:host2
cleartrust.data.ldap.directory.directoryname1.port:port1
cleartrust.data.ldap.directory.directoryname2.port:port2
cleartrust.data.ldap.directory.directoryname1.binddn1    
cleartrust.data.ldap.directory.directoryname2.binddn2                 
cleartrust.data.ldap.directory.directoryname1.password1                    
cleartrust.data.ldap.directory.directoryname2.password2 
cleartrust.data.ldap.directory.directoryname1.referto: true  
cleartrust.data.ldap.directory.directoryname2.referto :true
cleartrust.data.ldap.directory.directoryname1.referral.enable:true
cleartrust.data.ldap.directory.directoryname2.referral.enable:true
cleartrust.data.ldap.user.scope:sub

Mapping Your External LDAP Directory Data

Before Access Manager can use user data in an external LDAP directory, you must 
map your LDAP directory attributes to Access Manager attributes. If your external 
LDAP directory contains groups that you wish to use with Access Manager, these 
groups must be mapped as well. 

Note: The Access Manager store holds the policy, resource, and administrator 
information for Access Manager. The Access Manager store is proprietary to Access 
Manager. As a result, you cannot map to existing policy data as you can to existing 
users and groups. Instead, you must create Access Manager policy entries using the 
Administrative Console. 

CAUTION: You must never edit the Access Manager store entries, such as 
ctscAdministrativeRoleList, directly in the LDAP. Always use the Administrative 
Console or the Administrative API to make edits. In the case of administrators, direct 
LDAP edits to the Access Manager store result in that administrator being unable to 
log on.
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Mapping Your User Data

The procedures in this section assume that you already have an external LDAP 
directory for your users, as well as your own object class that defines your user entries. 
Make sure that you know the location of your LDAP directory and the object class of 
your users.

Note: The cn for Windows users created with the Microsoft MMC user management 
tools takes the form of givenname, middle initial, lastname. Access Manager creates 
users with the cn equal to the userid (samAccountName). The difference does not 
cause any conflicts in system data operations.

Read-Only Access to User Data

You have the option of setting Access Manager to access your user data in either 
read-write or read-only mode.

If you decide to use the read-write mode (the default), you can create, edit, or delete 
user accounts in the Administrative Console. Use the read-write mode if you are using 
the default Access Manager user store and if you have created your user data within 
Access Manager.

Ensuring Data Integrity for External Data

RSA recommends that you use the read-only setting if you have an external user store. 
In this case, use your current user management application or the LDAP tool (instead 
of the Administrative Console) to create and modify user entries. This ensures the 
integrity of your user data by using your existing business rules, data validation logic, 
and data formats to save and edit user information.

Important: If you decide to use the read-only mode, you cannot use the 
Administrative Console to create or modify user entries. You only use the 
Administrative Console to create the access control policies for users, not to modify 
the user entries themselves. Your user account data is accessed only at runtime to 
perform authentication and authorization of users.

To specify read-only access for user data, do one of the following:

• In the ldap.conf file, set the cleartrust.data.ldap.user.readonly: parameter to true. 
For example:

cleartrust.data.ldap.user.readonly :true
This specifies read-only access for user data on all LDAP directory hosts accessed 
by Access Manager. RSA recommends this setting, if you have user data that is 
external to Access Manager.
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• In the ldap.conf file, set the cleartrust.data.ldap.directory.servername.readonly: 
parameter to true. For example:

cleartrust.data.ldap.directory.servername.readonly :true
This specifies read-only access for all data on a particular LDAP directory host 
(for example, a read-only replica). The read-only setting at the server level takes 
precedence over the read-only setting at the user level.

Identifying User Entries

In order for Access Manager to use your external LDAP directory as a data store, you 
must identify what defines a user in your current LDAP directory configuration and 
how to find user data in your LDAP directory by setting parameters in the 
AXM_HOME/conf/ldap.conf file. When you set user entries in the ldap.conf file, 
note that base DNs may be case-sensitive. For more information, see the 
cleartrust.data.ldap.user parameters in the AXM_HOME/conf/ldap.conf file.

To identify a user entry:

1. Set the cleartrust.data.ldap.user.basedn parameter to specify the Base DN for the 
LDAP directory serving as the user store. For example:

cleartrust.data.ldap.user.basedn: ou=People, dc=rsasecurity, dc=com

Note: In Active Directory installations, where Global Catalog is configured or 
used as aux store, you must set the cleartrust.data.ldap.user.basedn: data store not 
the aux store. Set cleartrust.data.ldap.user.basedn to point to a DN in your local 
domain, not a DN in your Global Catalog domain. No users need to be physically 
located in Global Catalog.

2. Set the cleartrust.data.ldap.user.scope parameter to specify which level of the 
directory tree hierarchy to search in relation to the base DN. For example:

cleartrust.data.ldap.user.scope: sub

Note: In order to be able to search for a user by DN, you must change the default 
setting of the cleartrust.data.ldap.user.attributemap.certdn parameter. For more 
information, see the comments for this parameter in the ldap.conf file.

3. Set the cleartrust.data.ldap.user.filter parameter to specify how user entries are 
distinguished in your LDAP directory. For example: 

cleartrust.data.ldap.user.filter: (objectclass=inetOrgPerson)

Note: If hunting and failover are enabled, you can apply only one filter.

4. Set the cleartrust.data.ldap.user.dnattribute parameter to specify, for the DN in 
.basedn, the Relative Distinguished Name (RDN) that is unique for each user 
entry. For example:

cleartrust.data.ldap.user.dnattribute: uid
4: Configuring the LDAP Data Adapter 87



RSA Access Manager 6.1 SP4 Servers Installation and Configuration Guide
5. Set the cleartrust.data.ldap.user.objectclass parameter to specify whether to 
modify the object class hierarchy of a user entry when the user is created or saved 
For example:

cleartrust.data.ldap.user.objectclass: top, person, organizationalPerson, 
inetOrgPerson, ctscUserAuxClass

Note: For Sun Java System Directory Server, MD5 algorithm is not supported as a 
password hashing algorithm.

Required Attributes for an RSA Access Manager User Entry

A user entry in Access Manager must have the following attributes. You can map your 
existing LDAP directory attributes by setting the correct LDAP attribute name (as 
defined in your user object class) for the associated parameter in the following table. 
To view your LDAP directory default settings, see the cleartrust.data.ldap.user 
parameters in the AXM_HOME/conf/ldap.conf file.

Mapping RSA Access Manager Users to Windows Users 

If you are using Active Directory as your user store, or if you are using Active 
Directory as your user store and Active Directory Application Mode as your Access 
Manager store, there are two additional parameters that need to be set:

cleartrust.data.ldap.user.windows_user:
cleartrust.data.ldap.user.windows_lockout:

These parameters determine if the users created through Access Manager are 
considered valid users in your Windows Server environment. For more information on 
these parameters, see the AXM_HOME/conf/ldap.conf file.

Note: When Active Directory and Active Directory Application Mode are running in 
the same environment, this procedure only needs to be applied to Active Directory.

Required Attribute ldap.conf User Mapping Parameters

user name user.attributemap.name

first name user.attributemap.firstname

last name user.attributemap.lastname

e-mail address user.attributemap.email

password user.attributemap.password
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Optional Attributes for an RSA Access Manager User Entry

There are several attributes for a user entry that are specific to Access Manager. These 
attributes, which are a standard feature in the Sun Java System Directory Server Data 
Adapter, are used to provide additional functionality, such as password policy and user 
account administration. These attributes are all defined in an auxiliary object class 
called ctscUserAuxClass, which you may manually add to the Active Directory 
schema, or which you may selectively modify at the attribute level. 

You can map your existing LDAP directory attributes by setting the correct LDAP 
attribute name (as defined in the ctscUserAuxClass object class or in your own user 
object class) for each associated ldap.conf parameter. For more information on these 
parameters, see the AXM_HOME/conf/ldap.conf file. 

Manually Adding the Auxiliary User Class in Active Directory

This section describes how to enable optional Access Manager features on Active 
Directory. 

These features are disabled by default because Windows supports similar features 
associated with the user’s domain account. Maintaining two account policies, one for 
Active Directory and one for Access Manager is potentially confusing. Support for 
these features also requires a schema change to the user object class.

Note: RSA recommends using only the account policy for Active Directory. If you 
decide to use two account policies, set the Access Manager user policy to be more 
restrictive than the Active Directory policy. The Active Directory policy always 
supersedes the Access Manager policy.

To enable these optional features, you must implement the ctscUserAuxClass 
auxiliary user object class. Perform these steps to add this class to your Active 
Directory schema:

Note: This procedure requires the Administrative Console. For more information, see 
Chapter 7, “Installing the RSA Access Manager Administrative Console.”

To add the auxiliary user class manually in Active Directory:

1. Open the RSA Administrative Console configuration file (admingui.cfg), and set 
the parameter disableuserextensions to true.

2. Restart the Administrative Console servlet engine for the change to take effect.

3. Open the MMC snap-in for the Active Directory schema, and add 
ctscUserAuxClass to the user objectclass.

4. Reload the schema for the change to take effect.

5. In the “User Mapping Parameters: Optional Elements” section of the 
AXM_HOME/conf/ldap.conf file, uncomment each of the following parameters:

#cleartrust.data.ldap.user.attributemap.failedlogincount:ctscFailedLoginCount

#cleartrust.data.ldap.user.attributemap.lockedout:ctscUserKeywords

#cleartrust.data.ldap.user.attributemap.passwordexpirationstatus:ctscUserKeywords

#cleartrust.data.ldap.user.attributemap.passwordexpirationstate:ctscUserKeywords
4: Configuring the LDAP Data Adapter 89



RSA Access Manager 6.1 SP4 Servers Installation and Configuration Guide
#cleartrust.data.ldap.user.attributemap.passwordhistory:ctscPasswordHistory

#cleartrust.data.ldap.user.attributemap.passwordcreationdate:ctscPasswordCreationDate

#cleartrust.data.ldap.user.attributemap.passwordcreationdate.format:yyyyMMddHHmmss'Z'

#cleartrust.data.ldap.user.attributemap.passwordcreationdate.timezone:GMT

#cleartrust.data.ldap.user.attributemap.passwordexpirationdate:ctscPasswordExpirationDate

#cleartrust.data.ldap.user.attributemap.passwordexpirationdate.format:yyyyMMddHHmmss'Z'

#cleartrust.data.ldap.user.attributemap.passwordexpirationdate.timezone:GMT

#cleartrust.data.ldap.user.attributemap.accountstartdate:ctscAccountStartDate

#cleartrust.data.ldap.user.attributemap.accountstartdate.format:yyyyMMddHHmmss'Z'

#cleartrust.data.ldap.user.attributemap.accountstartdate.stringcomparable:true

#cleartrust.data.ldap.user.attributemap.accountstartdate.timezone:GMT

#cleartrust.data.ldap.user.attributemap.accountenddate:ctscAccountEndDate

#cleartrust.data.ldap.user.attributemap.accountenddate.format:yyyyMMddHHmmss'Z'

#cleartrust.data.ldap.user.attributemap.accountenddate.stringcomparable:true

#cleartrust.data.ldap.user.attributemap.accountenddate.timezone:GMT

#cleartrust.data.ldap.user.attributemap.lastresetdate:ctscLastResetDate

#cleartrust.data.ldap.user.attributemap.lastresetdate.format:yyyyMMddHHmmss'Z'

#cleartrust.data.ldap.user.attributemap.lastresetdate.timezone:GMT

#cleartrust.data.ldap.user.attributemap.lockoutexpirationdate:ctscLockoutExpirationDate

#cleartrust.data.ldap.user.attributemap.lockoutexpirationdate.format:yyyyMMddHHmmss'Z'

#cleartrust.data.ldap.user.attributemap.lockoutexpirationdate.timezone:GMT

6. Either start or restart your Access Manager Servers for this change to take effect.

Adding a Relationship for ctscUserAuxClass and the User Object Class 
on Active Directory

You must add a relationship for ctscUserAuxClass and the user object class on the 
host machine for Active Directory while logged on as an administrator.

To add a relationship for ctscUserAuxClass:

1. Click Start > Run, type mmc in the Open field, and click OK. 

2. On the Microsoft Management Console menu, open the console with the Active 
Directory Schema snap-in.

3. On the console tree in the left pane, click Classes.

4. In the right pane, right-click ctscUserAuxClass.

5. Select Properties.

6. In the User Properties dialog box, click the Relationship tab.

7. Click Add Superior.

8. In the Select Schema Object dialog box, select the user object class.

9. Click OK > Apply > OK.
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To add a relationship for the user object class:

1. In the right pane of the Microsoft Management Console, right-click the user object 
class.

2. Select Properties.

3. In the User Properties dialog box, click the Relationship tab.

4. Click Add Class.

5. In the Select Schema Object dialog box, select ctscUserAuxClass.

6. Click OK > Apply > OK.

Dynamic Updates to the User Object Class

If your user object class does not have the attributes to accept the optional Access 
Manager data (such as password expiration date), you can configure the ldap.conf file 
to add the attributes to all existing user entries that are modified using the 
Administrative Console. The cleartrust.data.ldap.directory.servername.readonly must 
be set to false. For example:

cleartrust.data.ldap.directory.servername.readonly :false

The cleartrust.data.ldap.user.update_objectclass_on_modify parameter must be set to 
true. For example:

cleartrust.data.ldap.user.update_objectclass_on_modify :true

For more information, see the AXM_HOME/conf/ldap.conf file.

Important: Because Active Directory does not support dynamic auxiliary object 
classes, the cleartrust.data.ldap.user.update_objectclass_on_modify parameter must 
always be set to false in environments using Active Directory.

This updates your object class with the ctscUserAuxClass (or any other class that you 
create that contains the Access Manager optional attributes) and the values are saved 
whenever you modify a user using the Administrative Console (or the Administrative 
API).

Adding Attributes to the User Object Class to Define an Additional Access 
Manager Property

Your user entries may have additional attributes, called properties in Access Manager, 
that are not specified in the Access Manager as required or optional attributes. Your 
additional attributes are part of an object class that you have defined.

Properties supplement the basic set of user information and are the basis for defining 
criteria for Smart Rule authorization policies. For example, you can define an LDAP 
attribute that stores the job title for a user as an additional property in Access 
Manager.

In order to use these additional LDAP attributes to define Smart Rules in Access 
Manager, you must create a property definition in the Administrative Console that 
maps to the existing LDAP attribute in your user object class.
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Access Manager does not check for uniqueness when creating or modifying property 
values. It is the LDAP directory administrator’s responsibility to properly configure 
the native LDAP matching rules for each attribute to make sure that uniqueness is 
enforced.

The LDAP attribute must exist in your user object class before you create a 
corresponding property definition in Access Manager. If the property name and the 
LDAP attribute name do not match exactly, you get object class errors whenever you 
attempt to create or modify a user with the Administrative Console.

To add an attribute to the user object class to define an additional Access 
Manager property:

1. For Sun Java System Directory Server, perform the following to add an attribute 
to the user object class:

a. Modify the cleartrust.data.ldap.user.objectclass parameter in your ldap.conf 
file to add your object class that contains an attribute that you want to use as a 
property in Access Manager. 
The default value of this parameter is as follows:
cleartrust.data.ldap.user.objectclass :top, person, organizationalPerson, 
inetOrgPerson, ctscUserAuxClass

b. To use attributes that are part of myLocalAttributeClass, add this class to the 
cleartrust.data.ldap.user.objectclass parameter:
cleartrust.data.ldap.user.objectclass :top, person, organizationalPerson, 
inetOrgPerson, ctscUserAuxClass, myLocalAttributeClass

2. For Active Directory: Using MMC, add the additional attribute to the 
ctscUserAuxClass object class.

3. Restart the Access Manager Servers.

4. Add a new property using the Administrative Console. For more information, see 
the Help topic “Adding Properties.”

a. The Property Name must match the LDAP attribute name, as defined in your 
object class.

Note: If the property you are creating is a multi-value property, you must 
check your underlying LDAP schema to verify that this LDAP attribute is also 
defined as a multi-value attribute. You may not use an attribute that only takes 
a single value.

Do not create properties for LDAP attributes that are mapped to Access 
Manager attributes or LDAP attributes that are system-level attributes. If you 
are using the default object classes, the attributes dn, cn, uid, sn, o, dc, 
userPassword, unicodePwd cannot be used as properties in Access Manager.

b. From the Data Type drop-down menu, select one of the following options: 
String. This is used for any string. 
Date. Access Manager saves and recognizes dates in this format:
dow mon dd hh:mm:ss zzz yyyy
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where:

– dow is the day of the week (Sun, Mon, Tue, Wed, Thu, Fri, Sat). 

– mon is the month (Jan, Feb, Mar, Apr, May, Jun, Jul, Aug, Sep, Oct, Nov, 
Dec). 

– dd is the day of the month (01 through 31), as two decimal digits. 

– hh is the hour of the day (00 through 23), as two decimal digits. 

– mm is the minute within the hour (00 through 59), as two decimal digits. 

– ss is the second within the minute (00 through 59), as two decimal digits. 

– zzz is the time zone (and may reflect daylight saving time). Standard time 
zone abbreviations include those recognized by the parse method in the 
DateFormat class. If time zone information is not available, then zzz is 
empty - that is, it consists of no characters at all. 

– yyyy is the year, as four decimal digits. 

Boolean. Holds a true/false value. Access Manager interprets the value 
properly regardless of the actual data type your directory uses for a Boolean 
attribute:

– Sun Java System Directory Server uses an integer: “1” for true and “0” for 
false. 

– Active Directory uses a string: “TRUE” and “FALSE”. 

– eDirectory uses a native Boolean attribute.

Int. This is used for whole numbers.

– MIN: -2147483648

– MAX: 2147483647

Float. This is used for numbers with decimal points.

– MIN: 1.40129846432481707e-45f

– MAX: 3.40282346638528860e+38f

For more information about using the Administrative Console to create property 
definitions and Smart Rules, see the Administrator’s Guide.

External Properties

Access Manager also lets you define external properties. External properties are 
properties that have values stored in an external data store or other mechanism.

For internal properties, the definitions and values of the properties are stored in the 
Access Manager store. For external properties, only the definitions of the properties 
are stored in the Access Manager store. The system obtains the property value as 
needed by using a runtime call to an external source through a well-defined callout 
interface.

For more information on specifying external properties, see the comments for the 
cleartrust.property.providers parameter in the aserver.conf file as well as the 
Developer’s Guide.
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Mapping Your Group Data

Mapping group data is similar to mapping user data. If you already have an 
established LDAP directory for your users and groups, as well as your own object 
class that defines how groups are created, you must map this data to Access Manager 
using the group mapping parameters. If you do not want to use existing, external 
groups, see “Configuring an LDAP Directory as an Aux Store” on page 96.

In Access Manager, groups are defined by a uniquemember attribute, which contains 
all of the DNs of the users and groups contained in that group. 

Important: To enable nesting of groups in Active Directory, you must change your 
domain functional level from Windows 2000 mixed to Windows 2000 native or 
Windows Server 2003. Nested group functionality is only available with an Active 
Directory functional level of Windows 2000 native or Windows Server 2003.

Read-Only Access to Group Data

You have the option of setting Access Manager to access your group data in either 
read-write or read-only mode. 

If you decide to use the read-write mode (the default), you can create, edit, or delete 
groups in the Administrative Console. Use the read-write mode only if you are using 
the default Access Manager user store and created your user and group data within 
Access Manager. 

To specify read-only access for group data, do one of the following:

• In the AXM_HOME/conf/ldap.conf file, set the 
cleartrust.data.ldap.group.readonly parameter to true. For example:

cleartrust.data.ldap.group.readonly :true
This specifies read-only access for group data on all LDAP directory hosts 
accessed by Access Manager. RSA recommends this setting if you have group 
data that is external to Access Manager.

• In the ldap.conf file, set the cleartrust.data.ldap.directory.servername parameter 
to true. For example:

cleartrust.data.ldap.directory.servername.readonly :true
This specifies read-only access for all data on a particular LDAP directory host 
(for example, a read-only replica). The read-only setting at the server level takes 
precedence over the read-only setting at the group level.
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Identifying Group Entries

In order for Access Manager to use your external LDAP directory as a data store, you 
must identify what defines a group in your current LDAP directory configuration and 
how to find group data in your LDAP directory by setting parameters in the 
AXM_HOME/conf/ldap.conf file. When you set group entries in the ldap.conf file, 
note that the base DNs may be case-sensitive. For more information, see the 
cleartrust.data.ldap.group parameters in the AXM_HOME/conf/ldap.conf file.

To identify a group entry:

1. Set the cleartrust.data.ldap.group.basedn parameter to specify the Base DN for the 
LDAP directory serving as the group store. For example:

cleartrust.data.ldap.group.basedn: ou=Groups, dc=rsasecurity, dc=com

Note: In Active Directory installations, where Global Catalog is configured or 
used as aux store, you must set the cleartrust.data.ldap.group.basedn parameter to 
point to the local Access Manager and not to the aux store. Set 
cleartrust.data.ldap.group.basedn to point to a DN in your local domain and not to 
a DN in your Global Catalog domain. No groups need to be physically located in 
Global Catalog.

2. Set the cleartrust.data.ldap.group.scope parameter to specify which level of the 
directory tree hierarchy to search in relation to the base DN. For example:

cleartrust.data.ldap.group.scope: sub

3. Set the cleartrust.data.ldap.group.filter parameter to specify how group entries are 
distinguished in your LDAP directory. For example: 

cleartrust.data.ldap.group.filter: (objectclass=inetOrgPerson)

4. Set the cleartrust.data.ldap.group.dnattribute parameter to specify, for the DN in 
.basedn, the Relative Distinguished Name (RDN) that is unique for each group 
entry. For example:

cleartrust.data.ldap.group.dnattribute: cn

5. Set the cleartrust.data.ldap.group.objectclass parameter to specify whether to 
modify the object class hierarchy of a user entry when the user is created or saved 
For example:

cleartrust.data.ldap.group.objectclass: top, groupOfUniqueNames

Required Attributes for an RSA Access Manager Group Entry

A group entry in Access Manager must have the following attributes. You can map 
your existing LDAP directory attributes by setting the correct LDAP attribute name 
(as defined in your group object class) for the associated parameter in the following 
table. To view your LDAP directory default settings, see the cleartrust.data.ldap.group 
parameters in the AXM_HOME/conf/ldap.conf file.
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Mapping RSA Access Manager Groups to Windows Groups

If you are using Active Directory or Active Directory and Active Directory 
Application Mode (AD-ADAM) or Active Directory and Active Directory Light 
weight Directory Services (AD-) as your LDAP directory, there are two additional 
parameters that need to be set:

cleartrust.data.ldap.group.windows_group
cleartrust.data.ldap.group.grouptype

These parameters determine the type of group you want to create. 

In Active Directory, there are three types of groups that determine the scope of that 
group’s membership and permissions— Domain Local, Global, and Universal. 
Because Access Manager only has one type of group, you must choose what type of 
Active Directory group you want to use. Access Manager supports inter-domain group 
membership. If the Domain Local and Universal groups contain users from other 
domains within the same forest, Access Manager recognizes users from the other 
domains.

For more information, see the AXM_HOME/conf/ldap.conf file.

Configuring an LDAP Directory as an Aux Store

If your installation uses two data stores and you want to designate one data store as the 
Access Manager auxiliary store, or aux store, you must configure it to function as an 
aux store. If you do not want to designate an aux store, see “Tuning Your LDAP 
Directory for RSA Access Manager” on page 109.

Access Manager supports the optional Access Manager aux store for installations 
using LDAP directories. The aux store is any LDAP directory (outside your Access 
Manager LDAP directory) that you designate to hold user accounts. Typically, after 
you designate your corporate LDAP user store as your aux store, the Access Manager 
LDAP directory continues to hold all Access Manager policy, administrator 
information, user and group accounts.

When Access Manager is set up to use an aux store, the Access Manager LDAP 
directory can continue to store user accounts as well. Access Manager performs 
authentication and authorization seamlessly across the entire set of user accounts 
stored in the Access Manager LDAP directory and the aux store.

The Access Manager aux store can have read-only or read-write access. Designating 
an aux store is particularly useful in cases where you have read-only access to an 
LDAP directory. When you designate a read-only LDAP directory as your aux store, 
Access Manager has the following capabilities:

Required Attribute ldap.conf Group Mapping Parameters

name group.attributemap.name

member group.attributemap.member
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• Users with accounts that reside in a read-only (as well as a read-write) aux store 
may be designated as Access Manager administrators.

• You can use the Access Manager tools to create users in the Access Manager.

• You can use the Access Manager tools to edit the user accounts that reside in a 
read-write aux store.

Where Data Types Are Stored

The Access Manager store is always installed with Access Manager and contains all of 
the administrative and resource data for the installation. If the aux store is enabled, the 
Access Manager usually holds only supplementary user accounts. Typically, these are 
user accounts created with Access Manager tools. The roles for administrators are also 
stored in the Access Manager store.

Deciding Whether to Use the Aux Store

If you have write access to the user and plan to use Access Manager tools to create 
user accounts, you probably do not want to implement the aux store. (When you create 
users through the Access Manager tools, they are always saved in the Access Manager 
store.)

If your user accounts are managed with a system other than Access Manager, you 
must define the LDAP directory as your aux store. In this case, the aux store holds 
your main set of user accounts and the Access Manager store (a separate LDAP 
directory) holds all other Access Manager information.

Importing RSA Access Manager Schema into the Aux Store Host

If you plan to maintain users in the aux store through Access Manager (using either 
the Administrative Console or Administrative API), you must install the Access 
Manager schema on the LDAP directory host that hosts the aux store.

For more information, see “Installing the Data Adapter on Active Directory” on page 
44, or “Installing the Data Adapter on Sun Java System Directory Server” on page 59.

Aux Store Options

For your aux store, choose one of the following options: 

• A read-only 

• A read-write 

• A Global Catalog (Active Directory only)

A Global Catalog aux store is a special aux store that supports multiple domains using 
Active Directory. The following sections describe how to set up and configure each 
aux store option. They also describe how Access Manager operates with each type of 
aux store.
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Setting Up an Aux Store

To set up an aux store:

1. Open the AXM_HOME/conf/ldap.conf file. 

Note: This procedure assumes that you have an LDAP directory installed and 
configured for Access Manager.

All of the parameter values in this procedure are examples. The actual values you 
use depends on your directory type. For more information, see the parameter 
comments in the ldap.conf file.

2. Add the name of your aux store to the cleartrust.data.ldap.directory_name 
parameter.
For Active Directory:

cleartrust.data.ldap.directory_name:abc-accessman-store,abc-accessman-stor
e-bind,abc-aux-store,abc-aux-store-bind

For iPlanet or eDirectory:
cleartrust.data.ldap.directory_name:abc-accessman-store,abc-aux-store

where:

• abc-accessman-store is the name of your Access Manager.

• abc-aux-store is the name of your aux store.

3. Add these parameters, and set the name of your aux store:
cleartrust.data.ldap.auxstore: abc-aux-store
cleartrust.data.ldap.aux_authentication_store: abc-aux-store-bind (Active 
Directory only)

4. Add and set these parameters to indicate whether the aux store is read-only or 
read-write.

cleartrust.data.ldap.directory.abc-aux-store.readonly: true| false
cleartrust.data.ldap.directory.abc-aux-store-bind.readonly: true| false

Note: Setting these parameters to false enables read-write access. Setting these 
parameters to true enables read-only access and overrides the other readonly 
parameter settings. For more information on setting read-write or read-only 
access, see “Configuring the Aux Store as Read-Only or Read-Write” on page 
100.
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5. Add and set these parameters to configure the hostname, port, binddn, and 
password information for your aux store connection. For information on setting 
these parameters, see the comments for the equivalent parameters set for your 
Access Manager in the AXM_HOME/conf/ldap.conf file.

cleartrust.data.ldap.directory.abc-aux-store.hostname: localhost
cleartrust.data.ldap.directory. abc-aux-store-bind.hostname: localhost

cleartrust.data.ldap.directory.abc-aux-store.port: 389
cleartrust.data.ldap.directory.abc-aux-store-bind.port: 389

cleartrust.data.ldap.directory.abc-aux-store.binddn: cn=Directory Manager
cleartrust.data.ldap.directory.abc-aux-store-bind.binddn: cn=Directory 
Manager

cleartrust.data.ldap.directory.abc-aux-store.password: password
cleartrust.data.ldap.directory.abc-aux-store-bind.password: password

6. Add and set these auxuser parameters to configure the base DN and other 
specifications that define the user object for users in your aux store. The auxuser 
parameters are analogous to the cleartrust.data.ldap.user parameters. For 
information on setting these parameters, see the comments for the equivalent 
parameters set for your Access Manager in the AXM_HOME/conf/ldap.conf file.

cleartrust.data.ldap.auxuser.basedn: cn=Users, dc=kid, dc=rsacd4, dc=com
cleartrust.data.ldap.auxuser.filter: 
(&(objectClass=user)(objectCategory=person))
cleartrust.data.ldap.auxuser.scope: sub
cleartrust.data.ldap.auxuser.dnattribute: cn
cleartrust.data.ldap.auxuser.update_objectclass_on_modify: true | false
cleartrust.data.ldap.auxuser.objectclass: top, user
cleartrust.data.ldap.auxuser.readonly: true | false
cleartrust.data.ldap.auxuser.default_private: true | false

7. Set up the LDAP Server Connection Parameters. For more information, see 
“Configuring Connection Information” on page 80. 

8. Add and set this SSL parameter with the appropriate value for clear or server 
authenticated SSL connections:

cleartrust.data.ldap.directory.aux-store-name.ssl.use: clear | auth 

Note: Setting up server authenticated SSL requires you to manually include all 
parameters noted under “Setting Keystore Parameters in ldap.conf” on page 219. 
You must include the aux store name for the directory_name variable indicated on 
this page.

9. Save your ldap.conf file, and restart your Access Manager Servers.
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Configuring the Aux Store as Read-Only or Read-Write

The aux store can be configured as read-only or as read-write by setting the read-only 
parameters in the ldap.conf file. The parameter settings for each configuration are 
shown in the following table.

Important: Do not set the read-only parameters as shown in the following table. This 
configuration, which permits user updates but not group updates, causes an 
OperationNotSupportedException to be returned when an administrator edits a user 
account but is forbidden from editing the user’s group associations. Some edits to user 
accounts require an edit to the user’s group associations. For this reason, the 
auxuser.readonly and group.readonly settings must both be set to false or both to true.

Read-Only Aux Store Operations

If your aux store is read-only, the following behavior applies:

• As long as your Access Manager store is writable, the Administrative Console or 
the Administrative API may be used to create new user accounts. Access Manager 
always saves new users to the Access Manager store.

• You cannot modify properties of users stored in aux store through the 
Administrative Console or Administrative API.

The following tables describe the treatment of Access Manager objects in a read-only 
aux store.

Configuration Parameters to Set

Read-only aux store cleartrust.data.ldap.directory.abc-aux-store.readonly :true

cleartrust.data.ldap.auxuser.readonly :true

cleartrust.data.ldap.group.readonly :true

Read-write aux store cleartrust.data.ldap.directory.abc-aux-store.readonly :false

cleartrust.data.ldap.auxuser.readonly :false

cleartrust.data.ldap.group.readonly :false

Unsupported Combination of Writability Parameters

cleartrust.data.ldap.directory.abc-employees.readonly :true

cleartrust.data.ldap.auxuser.readonly :true

cleartrust.data.ldap.group.readonly :false
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Users

Administrators 

Action Details

Create Creates a user account in the Access Manager store. Name is checked for 
uniqueness in both the Access Manager store and the aux store. 

Read Searches for the user account first in the Access Manager store and then in 
the aux store.

Update If the user account is defined in the aux store, you cannot update user 
attributes using the Administrative Console or Administrative API. You can 
only update the user’s ownership information (for example, administrative 
group) using the Administrative Console or Administrative API. These 
attributes are allowed updates because they are stored in the Access Manager 
store.

If the user account is defined in the Access Manager store, you can update all 
attributes through the Administrative Console or Administrative API.

Delete If the user account is defined in the aux store, you cannot delete the user 
account through the Administrative Console or Administrative API. You 
must use third-party tools to delete users.

If the user account is defined in the Access Manager store, you can delete all 
the information about the user through the Administrative Console or 
Administrative API.

Action Details

Create Creates an administrator user account in the Access Manager store.

Read Searches the Access Manager store followed by the aux store.

Update If the user account is defined in the aux store, you cannot update user 
attributes using the Administrative Console or Administrative API. You can 
only update a user’s administrator attributes, such as role associations, super 
admin flag, helpdesk flag, and ownership (admin group). These attributes are 
allowed updates because they are stored in the Access Manager store. 

If the user account is defined in the Access Manager store, you can update all 
attributes through the Administrative Console or Administrative API.

Delete If a user account is defined in the aux store, you cannot delete the user 
account using the Administrative Console or Administrative API. However, 
you can delete all references and associations of this user stored in the 
Access Manager . 

If the user account is defined in the Access Manager , you can delete all the 
information about the user with the Administrative Console or 
Administrative API.
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Read-Write Aux Store Operations

If your aux store is configured to allow read-write access, you can use the 
RSA Administrative Console or the Administrative API to edit and delete user 
accounts in the aux store. When either tool creates a user account, that user is saved in 
the Access Manager store.

The following tables describe the treatment of Access Manager objects in a read-write 
aux store.

Users

Groups

Administrators

Action Details

Create Creates a user account in the Access Manager store. Name is checked for 
uniqueness in both the Access Manager  and aux store. 

Read Searches for the user account first in the Access Manager store and then in 
the aux store.

Update All updates are allowed irrespective of the  containing the account.

Delete The user account and all references and associations of the user account are 
deleted irrespective of the  containing the account.

Action Details

Create Creates a group in the Access Manager . 

Read Searches for a group in the Access Manager .

Update Updates a group definition in the Access Manager .

Delete Deletes a group definition in the Access Manager .

Action Details

Create Creates an admin user account in the Access Manager store.

Read Searches the Access Manager store first and then the aux store.

Update All updates are allowed irrespective of the  containing the account.

Delete The user account and all references or associations of the user account are 
deleted irrespective of the  containing the definition.
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Setting Up a Global Catalog Aux Store

A Global Catalog aux store is a special read-only aux store that supports multiple 
domains using Active Directory. The procedure is similar to setting up an aux store.

To set up a Global Catalog aux store:

1. Open the AXM_HOME/conf/ldap.conf file. 

Note: This procedure assumes that you have an LDAP directory installed and 
configured for Access Manager.

All of the parameter values in this procedure are examples. The actual values you 
use depends on your directory type. For more information, see the parameter 
comments in the ldap.conf file.

2. Add the name of your Global catalog aux store to the 
cleartrust.data.ldap.directory_name parameter.

cleartrust.data.ldap.directory_name:abc-accessman-store,abc-accessman-stor
e-bind,abc-aux-store,abc-aux-store-bind

where: 

• abc-accessman-store is the name of your Access Manager .

• abc-aux-store is the name of your Global Catalog aux store.

3. Add these parameters, and set the name of your Global Catalog aux store:
cleartrust.data.ldap.auxstore: abc-aux-store
cleartrust.data.ldap.aux_authentication_store: abc-aux-store-bind

4. Add and set these parameters to indicate that the Global Catalog aux store is 
read-only:

cleartrust.data.ldap.directory.abc-aux-store.readonly: true
cleartrust.data.ldap.directory.abc-aux-store-bind.readonly: true

Note: For more information on setting read-only access, see “Configuring the 
Read-Only Parameters for the Global Catalog Aux Store” on page 106.
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5. Add and set these parameters to configure the hostname, port, binddn, and 
password information for your Global Catalog aux store connection. For 
information on setting these parameters, see the comments for the equivalent 
parameters set for your Access Manager  in the AXM_HOME/conf/ldap.conf 
file.

cleartrust.data.ldap.directory.abc-aux-store.hostname: localhost
cleartrust.data.ldap.directory. abc-aux-store-bind.hostname: localhost

cleartrust.data.ldap.directory.abc-aux-store.port: 3268
cleartrust.data.ldap.directory.abc-aux-store-bind.port: 3268

cleartrust.data.ldap.directory.abc-aux-store.binddn: 
cn=administrator,cn=Users,dc=domain,dc=com

cleartrust.data.ldap.directory.abc-aux-store-bind.binddn: 
cn=administrator,cn=Users,dc=domain,dc=com

cleartrust.data.ldap.directory.abc-aux-store.password: password
cleartrust.data.ldap.directory.abc-aux-store-bind.password: password

6. Add and set these auxuser parameters to configure the base DN and other 
specifications that define the user object for users in your Global Catalog aux 
store. The auxuser parameters are analogous to the cleartrust.data.ldap.user 
parameters. For information on setting these parameters, see the comments for the 
equivalent parameters set for your Access Manager  in the 
AXM_HOME/conf/ldap.conf file.

cleartrust.data.ldap.auxuser.basedn: cn=Users, dc=kid, dc=rsacd4, dc=com
cleartrust.data.ldap.auxuser.filter: 
(&(objectClass=user)(objectCategory=person))
cleartrust.data.ldap.auxuser.scope: sub
cleartrust.data.ldap.auxuser.dnattribute: cn
cleartrust.data.ldap.auxuser.update_objectclass_on_modify: true | false
cleartrust.data.ldap.auxuser.objectclass: top, user
cleartrust.data.ldap.auxuser.readonly: true
cleartrust.data.ldap.auxuser.default_private: true | false

7. Add and set these additional auxuser parameters. For information on setting these 
parameters, see the comments for the equivalent parameters set for your Access 
Manager  in the AXM_HOME/conf/ldap.conf file.

cleartrust.data.ldap.auxuser.attributemap.name: samAccountName
cleartrust.data.ldap.auxuser.attributemap.firstname: givenname
cleartrust.data.ldap.auxuser.attributemap.lastname: sn
cleartrust.data.ldap.auxuser.attributemap.password: unicodePwd
cleartrust.data.ldap.auxuser.attributemap.email: mail
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Note: Make sure that the cleartrust.data.ldap.auxuser.attributemap parameters in 
the ldap.conf file correctly describe your user attributes. The user accounts stored 
in the Global Catalog aux store are treated just like other Access Manager users. 
In the ldap.conf file, the attribute mappings for all users (those stored in the 
Access Manager store and those stored in the Global Catalog aux store) are set 
using the parameters in the User Mapping Parameters: Required Attribute Map 
Elements section of the ldap.conf file. For this reason, your LDAP schema for 
your Access Manager store and your Global Catalog aux store must use the same 
attributes to define a user object. If you have user attributes in your Global 
Catalog aux store that are different from the attributes in the Access Manager 
store, modify the schema of the Access Manager store to match the schema of the 
Global Catalog aux store, and add these attributes to the user.attributemap 
parameters.

8. If necessary, add auxuser parameters to match any optional user parameters. For 
information about the optional user parameters, see the 
AXM_HOME/conf/ldap.conf file.

9. Set up the LDAP Server Connection Parameters. For more information, see 
“Configuring Connection Information” on page 80. 

10. Add and set this SSL parameter with the appropriate value for clear or server 
authenticated SSL connections:

cleartrust.data.ldap.directory.aux-store-name.ssl.use: clear | auth 
cleartrust.data.ldap.directory.aux-store-name-bind.ssl.use: clear | auth

Note: Setting up server authenticated SSL requires you to manually include all 
parameters noted under “Setting Keystore Parameters in ldap.conf” on page 219. 
You must include the aux store name for the directory_name variable indicated on 
this page.

11. Add this parameter and set to true to indicate that this is a Global Catalog aux 
store:

cleartrust.data.ldap.auxstore_is_globalcatalog: true

12. If domain user names (samAccountName) are not unique across your forest, you 
can map another attribute to the cleartrust name attribute. Map this attribute at, for 
example, mail: 

cleartrust.data.ldap.user.attributemap.name: mail
cleartrust.data.ldap.user.attributemap.email: samAccountName

Note: Users must enter the value of the chosen attribute as the User ID during 
authentication to an Access Manager Agent or Administrative Console. In order 
for this to work, you must ensure that this attribute is populated for your users (in 
particular, the Administrator account in each domain).

13. Save your ldap.conf file, and restart your Access Manager Servers.
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Configuring the Read-Only Parameters for the Global Catalog Aux Store

The Global Catalog is a read-only . Configure the Global Catalog aux store as 
read-only by setting the following read-only parameters in the ldap.conf file.

For more information, see “Configuring the Aux Store as Read-Only or Read-Write” 
on page 100.

Global Catalog Aux Store Operations

For Global Catalog configurations, the following behaviors apply:

• If the Access Manager store is writable, you can use the Access Manager 
Administrative Console or the Access Manager Administrative API to create new 
user and user group accounts. Access Manager always saves new users and user 
groups to the Access Manager store. Use native tools to manage user and user 
group data in other domains. 

• You must use native tools to update properties for all users outside of the Access 
Manager store.

• Microsoft Active Directory restricts the associations you can make between the 
group types and users from various domains. If you add a user in the aux store to 
the global user group in the Access Manager store, check to ensure that your 
group type and user domain are compatible.

• If you use the memberOf attribute to determine user entitlements, the entitlements 
directly granted to users do not pass until the memberOf information replicates to 
the Global Catalog.

The following tables describe the treatment of Access Manager objects in a Global 
Catalog aux store.

Users

Configuration Parameters to Set

Global Catalog aux 
store

cleartrust.data.ldap.directory.aux_store_name.readonly :true

cleartrust.data.ldap.auxuser.readonly :true

cleartrust.data.ldap.group.readonly :true

Action Details

Create Creates a user account in the Access Manager store. Name is checked for 
uniqueness in both Access Manager store and Global Catalog aux store. 

Read Searches for the user account first in the Access Manager store and then in 
the Global Catalog aux store.
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Administrators

Update If the user account is defined in the Global Catalog aux store, you cannot 
update user attributes in the account using the Administrative Console or 
Administrative API. You can only update the ownership information of the 
user (for example, administrative group) through the Administrative Console 
or Administrative API. These attributes are allowed updates because they are 
stored in the Access Manager store.

If the user account is defined in the Access Manager store, you can update all 
attributes through the Administrative Console or Administrative API.

Delete If the user account is stored in the Global Catalog aux store, you cannot 
delete the user account using the Administrative Console or Administrative 
API. You must use third-party tools to delete user accounts. 

If the user account is stored in the Access Manager , you can delete all the 
information about the user using the Administrative Console or 
Administrative API.

Action Details

Action Details

Create Creates an administrator user account in the Access Manager store.

Read Searches the Access Manager store followed by the Global Catalog aux 
store.

Update If the user account is stored in the Global Catalog aux store, you cannot 
update user attributes in the account using the Administrative Console or 
Administrative API. You can only update administrator attributes of the user, 
for example, role associations, super admin flag, helpdesk flag, and 
ownership (admin group). These attributes are allowed updates because they 
are stored in the Access Manager store. 

If the user account is stored in the Access Manager store, you can update all 
attributes using the Administrative Console or Administrative API.

Delete If the user account is stored in the Global Catalog aux store, you cannot 
delete the user account using the Administrative Console or Administrative 
API. However, you can delete all references and associations of this user 
stored in the Access Manager store. 

If the user account is defined in the Access Manager store, you can delete all 
the information about the user through the Administrative Console or 
Administrative API.
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User Identity Mapping for Integrated Windows Authentication and 
Other Applications

Access Manager supports mapping an Access Manager User ID to other identities that 
the user may possess. This is necessary, for example, if you want to protect resources 
using Integrated Windows Authentication (IWA). In this case, you must map to the 
Windows User Principal Name (UPN) of the user. A UPN is a user name stored in 
Active Directory as an e-mail address (RFC 822) format, for example, 
auser@example.com.

To enable User ID mapping:

1. If you do not already have an organizational unit (ou) in your  to hold User IDs, 
create it now. RSA suggests using this name for the ou: 
ctscLibertyFederatedMappingRepository.

2. Open your ldap.conf file.

3. Set the cleartrust.data.ldap.identity_mapping_store parameter to the name of the 
LDAP server that stores the User IDs. Make sure that the name entered here is 
also declared in the directory_name parameter setting in the ldap.conf file.

4. Set the cleartrust.data.ldap.identity_mapping_store.basedn parameter to the name 
(dn) of the ou that stores the User IDs (for example, Windows UPNs or Liberty 
User IDs). If you followed the suggestion in step 1, this is 
ctscLibertyFederatedMappingRepository.

5. Check to make sure that you have set the connection parameters for your identity 
mapping store. If you are using an existing  such as your policy , this information 
is probably already defined. If not, check the following parameters:

• cleartrust.data.ldap.directory_name: This parameter contains a list of all the 
LDAP directories Access Manager uses. Make sure that your User ID store 
name is on this list.

• Connection parameters: If needed, add LDAP connection information for 
your User ID store by making the following parameter settings. You must 
replace all values shown here in italics:
cleartrust.data.ldap.directory.store name.hostname :LDAP host
cleartrust.data.ldap.directory.store name.port :LDAP port
cleartrust.data.ldap.directory.store name.binddn :cn of the Directory Manager
cleartrust.data.ldap.directory.store name.password :password of the Directory 
Manager 

6. Save the ldap.conf file, and restart your Access Manager Servers.

If you are implementing IWA, perform the procedures in “Setting Up Windows User 
Principal Name Mapping for Integrated Windows Authentication” on page 158.
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Tuning Your LDAP Directory for RSA Access Manager

If you are using the Administrative Console, RSA recommends making a number of 
adjustments to your LDAP directory to improve search performance. If you are not 
using the Administrative Console, or if your  contains only a small number of users, 
see “Next Step” on page 110.

To improve search performance, make the following adjustments to your LDAP 
directory:

• Verify that you have indexes for the ctscPublicMemberList and 
ctscPrivateMemberList attributes in your LDAP policy stores. These indexes were 
created as part of the LDAP Data Adapter installation. For more information on 
creating indexes in LDAP, see your LDAP vendor documentation.

• In Sun Java System Directory Server installations, you can speed up user searches 
by adding a substring index on each of the following attributes:

– uid

– The attribute used to store the users’ last names, which is typically the sn 
attribute. To find the attribute name, check this setting in your ldap.conf file: 
cleartrust.data.ldap.user.attributemap.lastname.

– Any other user attributes that you frequently search.

• In Sun Java System Directory Server installations, you must periodically rebuild 
the LDAP directory indexes in order to maintain optimal performance. In 
particular, do a rebuild after making significant changes to the ’s content, or after 
you have added new attribute indexes.
To rebuild indexes on the Sun Java System Directory Server:

– Stop the slapd process.

– Run the db2index.pl command located in the slapd instance directory.

– Restart the slapd process.

• For installations on Active Directory, you may achieve runtime (authentication 
and authorization) performance improvements by setting the 
cleartrust.data.ldap.entitlement.member.back-reference parameter in the 
ldap.conf file. For more information, see the comments in the ldap.conf file.

• If you are using certificate authentication, create an index for the attribute used to 
store the certificate DN. To find out the name of this attribute in your schema, 
check this setting in the ldap.conf file: 
cleartrust.data.ldap.user.attributemap.certdn. Due to a directory server limitation, 
Access Manager may be unable to search for user by dn if certdn is mapped to dn.

• If you are using the Administrative API to bulk load records into your LDAP 
directory, change cleartrust.eserver.runtime.granular_updates to false.
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• To improve the cache hit ratio on search operations, increase the amount of data 
that the LDAP directory host maintains in its cache. To do this, increase the 
number of entries stored in the cache, and increase the cache size. The maximum 
values that you can set for these cache attributes depends on the amount of 
physical memory on your LDAP directory host. The amount of available memory 
on your host must always be greater than: 
(Maximum Entries in Cache + Maximum Cache Size) times the average entry size

• For more information on tuning your Sun Java System Directory Server, go to 
http://docs.sun.com/.

• For more information on tuning your Active Directory Server, go to 
http://support.microsoft.com/.

Next Step

Once you have completed your LDAP configuration, you are ready to start your 
Access Manager Servers and test the connection with your  data store server(s). For 
more information, see Chapter 6, “Running Your RSA Access Manager Servers.”
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5 Installing and Configuring the SQL Data 
Adapter

• Before You Begin

• Overview of SQL Data Adapter Installation

• Preparing Your  Data Store for Installing the Data Adapter

• Installing the RSA Access Manager SQL Data Adapter

• Configuring the RSA Access Manager Servers and the Data Adapter

• Configuring SQL Adapter with Microsoft SQL Server for Integrated 
Authentication

• Next Step

Before You Begin

Make sure that:

• The Access Manager Server components are installed.

• Your Access Manager license file is in place.

For more information, see Chapter 2, “Installing the RSA Access Manager Servers.”

Overview of SQL Data Adapter Installation

The RSA Access Manager SQL Data Adapter allows you to use your SQL database as 
a  data store for all user and policy data. When you select the SQL option in your 
Access Manager Servers installation, Access Manager automatically installs and 
configures a fully functional SQL Data Adapter for that host. During this process, 
Access Manager uses the values you provide for administrator user name and 
password to update the appropriate entries in the data schema. Access Manager 
installs relevant files in the AXM_HOME/data_adapters/sql/database type directory.

To install Data Adapters on remote hosts in a distributed environment, you must 
manually perform these tasks in the following order:

1. Set up your  data store environment for Access Manager. For more information, 
see the following section, “Preparing Your  Data Store for Installing the Data 
Adapter.”

2. Install the Data Adapter for your database to create the Access Manager data 
tables, indexes, and the bootstrap data. For more information, see “Installing the 
RSA Access Manager SQL Data Adapter” on page 117.
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3. Complete the required settings in the Data Adapter, Authorization Server, and 
Entitlements Server configuration files. For more information, see “Configuring 
the RSA Access Manager Servers and the Data Adapter” on page 118.

Preparing Your  Data Store for Installing the Data Adapter

Before installing the Data Adapter, make sure that you satisfy all system requirements 
for your data store. You must install the JDBC drivers for database connections to 
Access Manager. Select the appropriate JDBC driver and install it in the 
AXM_HOME/lib directory of the Access Manager installation:

• Sybase jConnect driver version 6.0 (6.05 or later)

• Oracle driver version 10g (10.2.0.1 or later)

• The Microsoft JDBC Driver 4.0 for Microsoft SQL Server

Configuring Oracle  Data Store to use the JDBC Type II OCI Driver

Before configuring the  to use the JDBC Type II Open Connectivity Interface (OCI) 
driver, install the Oracle Instant Client. To download the Oracle Instant Client, go to

http://www.oracle.com/technology/tech/oci/instantclient/index.html.

To configure Oracle Data Store to use the JDBC Type II OCI Driver:

1. Unzip the contents to a folder and set the Instant Client classpath in the system 
environment path. 

2. Install the Oracle JDBC driver for database connections to Access Manager in the 
AXM_HOME\lib folder. 

3. Open the sql.conf file and edit these entries for your  data store type. 
cleartrust.data.sql.server.oracle.jdbc_url: 
jdbc20:oracle:oci:@hostname:port:AXM
cleartrust.data.sql.server.oracle.hostname: hostname
cleartrust.data.sql.server.oracle.user: AXM_ADMIN
cleartrust.data.sql.server.oracle.password: password

Note: These settings specify database logon information. Values shown here in 
italics are variables. Replace each of these with the value appropriate to your 
installation. The default port number is 1521 for Oracle. These instructions 
assume that your database name is AXM.

If you want to install the JDBC Type IV drivers, see your Oracle documentation.
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Preparing Oracle for Installing the Data Adapter

Using the native Oracle administrative tool, the setup tasks are identical for Windows 
and UNIX platforms.

Before running the script to install the Access Manager Data Adapter on Oracle, you 
must create a database instance with the appropriate users and table spaces. The 
procedure described in this section applies to the Oracle data server 10g2, 11g, and 
Oracle 10g2 RAC. To create the database instance, use the administrative tool.

To prepare Oracle for installing the Data Adapter:

1. Using the appropriate administrative tool for your version, create a database 
instance, for example, CT.

2. Using SQL*Plus, log on and create the table spaces. Type the following script 
commands, substituting the appropriate values for the data files and sizes, 
depending on the number of users in your data store. You can also choose your 
own filenames and location to save the files.

create tablespace CT_DATA
datafile 'Oracle_Installation/oradata/CT_DATA.dbf' size 
250M
default storage (INITIAL 2M NEXT 2M PCTINCREASE 0);

create tablespace CT_INDEX
datafile 'Oracle_Installation/oradata/CT_INDEX.dbf' size 
250M
default storage (INITIAL 2M NEXT 2M PCTINCREASE 0);

3. To add the CT_OWNER User ID, and make it the database administrator (DBA), 
type:

create user CT_OWNER identified by ct_owner
default tablespace CT_DATA
temporary tablespace temp
profile default account unlock;

grant CONNECT to CT_OWNER;
grant DBA to CT_OWNER;
grant UNLIMITED TABLESPACE to CT_OWNER;
alter user CT_OWNER default role all;

Preparing Sybase for Installing the Data Adapter

RSA recommends updating the JDBC driver to version 6.05 or later. This version 
provides more reliable operation.

Before running the script to install the Access Manager Data Adapter on Sybase, 
perform these tasks:

• Create a data device.

• Create a log device.

• Create segments for data and indexing.

• Add the CT_OWNER User ID.

• Add the CT_ADMIN and CT_USER.
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Note: For Access Manager installations with a single Authorization Server, RSA 
recommends setting your Sybase server to accept at least 100 connections. For 
installations with multiple Authorization Servers, assume that each Access Manager 
Server opens the number of connections specified in the maxconnections parameter of 
that Server.

To determine the number of connections that your Sybase server must be able to 
accept, add up the maxconnections settings for all your Access Manager Servers. In 
other words, for a default installation running one Authorization Server and one 
Entitlements Server, each set to maxconnections=50, the Sybase server must support 
100 connections. For each Authorization Server you add, your Sybase server must be 
able to handle the additional number of connections specified by the added 
maxconnections setting of the Server.

To prepare Sybase for installing the Data Adapter:

1. Run isql, and log on as sa.

2. Create the data device by typing the following commands. Substitute the 
appropriate values for these parameters in this example:

• PHYSNAME: Actual path to the data device.

• VDEVNO: List devices by typing sp_helpdevice at the command line. 
Choose a number that is not in the device number column.

• SIZE: Number of 8 KB blocks. (There are 128 8-KB blocks in 1MB, so 51200 
is 400MB.)

USE master
go
DISK INIT

NAME='CT_DATA',
PHYSNAME='D:\Sybase\Data\CT_DATA.dat',
VDEVNO=2,
SIZE=51200

go

Note: RSA recommends using a page size of 8 KB or 16 KB in order to avoid 
runtime errors caused by long nested hierarchies of Administrative Group names.

3. Create the log device by typing the following commands with the appropriate 
values, as described in the previous step:

USE master
go
DISK INIT

NAME='CT_LOG',
PHYSNAME='D:\Sybase\Data\CT_LOG.dat',
VDEVNO=3,
SIZE=51200

go

4. Create the CT database on the above devices by typing the following commands, 
substituting the appropriate device sizes. The unit of size is in MB.

USE master 
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go

CREATE DATABASE CT
ON CT_DATA = 400
LOG ON CT_LOG = 100

go

USE master
go

EXEC sp_dboption 'CT','select into/bulkcopy/pllsort',true
go

EXEC sp_dboption 'CT','trunc log on chkpt',true
go

EXEC sp_dboption 'CT','abort tran on log full',true
go

USE CT
go

CHECKPOINT
go

5. Create segments for data and index by typing the following commands.

USE CT
go

EXEC sp_addsegment 'CT_DATA','CT','CT_DATA'
go

USE CT
go

EXEC sp_addsegment 'CT_INDEX','CT','CT_DATA'
go

6. Add the CT_OWNER User ID, set a password, and make the CT_OWNER the 
DBA by typing the following commands:

EXEC sp_addlogin 'CT_OWNER', 'password'
go

grant role sso_role to 'CT_OWNER'
go

USE CT
go  

EXEC sp_changedbowner 'CT_OWNER'
go

7. Add the CT_ADMIN, CT_USER, and set the password by typing the following 
commands. RSA recommends using the same password for both logons, but 
making it different from that of CT_OWNER.

EXEC sp_addlogin 'CT_ADMIN', 'password'

EXEC sp_addlogin 'CT_USER', 'password'

go

8. Log off, or Exit from isql.
5: Installing and Configuring the SQL Data Adapter 115



RSA Access Manager 6.1 SP4 Servers Installation and Configuration Guide
Preparing the Microsoft SQL Server for Installing the Data Adapter

Before installing the Access Manager Data Adapter on Microsoft SQL Server, 
perform these tasks:

• Install Microsoft SQL Server.

• Create a new database. 

• Set up security logons for the CT_ADMIN and CT_USER.

To prepare the Microsoft SQL Server for installing the Data Adapter:

1. Install Microsoft SQL Server.

2. To start the Microsoft SQL Server Management Studio application, click Start >   
Programs > Microsoft SQL Server > SQL Server Management Studio.

3. To log on to Microsoft SQL Server:

a. Click File > Connect Object Explorer. The Connect to Server dialog box 
opens.

b. Select Database Engine from the Server type drop-down list. 

c. Select the hostname of the server that you just installed from the Server name 
drop-down list. 

d. Select SQL Server authentication from the Authentication drop-down list.

e. In the Login field, enter the login ID of the system administrator that was 
created during the installation of the Microsoft SQL Server.

f. In the Password field, enter the password of the system administrator.

g. Click Connect.

To create a new database:

1. Log on to Microsoft SQL Server.

2. From the directory tree in the left pane, right-click Databases. 

3. Select New Database.

4. Under the General tab, enter CT in the Database Name field.

Note: If you are using a different database name, you must manually update your 
database name in the SqlServerCreateCT.sql and SqlServerDropCT.sql files.

5. In the Database file section, replace CT with CT_PRIMARY for the PRIMARY 
Filegroup.

6. Under the Filegroups tab, enter CT_DATA and CT_INDEX to create the 
necessary data files.

7. Under the General tab, in the Database file section, enter CT_DATA as the 
Filegroup name for the CT_DATA logical name and CT_INDEX as the 
Filegroup name for the CT_INDEX logical name.

8. Click OK. 
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To set up logons for the CT_ADMIN and CT_USER:

1. Log on to Microsoft SQL Server.

2. Under the <configured server>, right-click Security > New > Login. The Login - 
New dialog box opens.

3. Click the General tab. 

4. In the Login name field, enter CT_ADMIN.

Note: If you are using a different database admin name,  you must manually update 
your database admin name in the SqlServerCreateCT.sql and SqlServerDropCT.sql 
files.

5. Select SQL Server Authentication. 

6. In the Password field, enter a password.

7. In the Confirm Password field, re-enter the password.

8. Deselect the option, User must change password for next logon.

9. From the Default database drop-down list, select the CT database, and click OK.

10. Under the user mapping tab, select CT.

11. Click OK.

12. Repeat steps 3 to 11 to create the logon for CT_USER.

Installing the RSA Access Manager SQL Data Adapter

The SQL Data Adapter is based on a schema of data tables that organize and store all 
user and policy data. To create this schema on your data store, you must run the 
appropriate SQL script for your database platform. 

The SQL scripts described in this section are located in your installation directory 
under AXM_HOME/data_adapters/sql/database type. These scripts are updated 
with the Access Manager administrator password, provided during installation of the 
Access Manager Servers. Installing the schema with these scripts is a simple, one-step 
process. 

Script commands for Oracle, Sybase, and Microsoft SQL Server differ slightly in 
syntax, as detailed in this section.

Running the Installation Script on Oracle

To run the installation script on Oracle:

Use SQL*Plus to create the Access Manager tables, indexes, and the bootstrap data. 
Log on as CT_OWNER, and type:

sqlplus>@OracleCreateCT.sql;
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Running the Installation Script on Sybase

To run the installation script on Sybase:

Execute isql using the following syntax to load and run the SybaseCreateCT.sql file, 
entering the CT_OWNER password when prompted. You must type this command on 
one line. The switches are case-sensitive.

isql -D CT -S ServerName -U CT_OWNER -i SybaseCreateCT.sql

Running the Installation Script on the Microsoft SQL Server

To run the installation script on the Microsoft SQL Server

1. Log on to Microsoft SQL Server.

2. From the directory tree in the left pane, select CT.

3. Click New Query.

4. Click File > Open > File.

5. Navigate to AXM_HOME\data_adapters\sql\mssql, and open 
SqlServerCreateCT.sql.

6. Click Connect when prompted to connect to the Database Engine.

7. Click Execute. 
The script sets up the Access Manager schema and installs the bootstrap data.

8. Scroll through the results to confirm that no errors occurred.

Configuring the RSA Access Manager Servers and the Data Adapter

The installer configures the Access Manager Servers and the Data Adapter. Use this 
section only if you must verify or make changes to the following Access Manager 
configuration files located in AXM_HOME/conf:

• eserver.conf

• aserver.conf

• sql.conf

To change the settings in these files, you need the hostname and port values for your 
data store.
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To configure the Data Adapter and Entitlements/Authorization Servers:

1. Open the sql.conf file, and if needed, edit the following entries for your data store 
type. These settings specify database logon information. Values shown here in 
italic are variables. Replace each of these with the value appropriate to your 
installation. The default port number is 1521 for Oracle, 5000 for Sybase, and 
1433 for Microsoft SQL Server. These instructions assume your database name is 
CT.

For Oracle:

cleartrust.data.sql.server.oracle.jdbc_url: jdbc20:oracle:thin:@hostname:port:CT
cleartrust.data.sql.server.oracle.hostname: hostname
cleartrust.data.sql.server.oracle.user: CT_ADMIN
cleartrust.data.sql.server.oracle.password: password
cleartrust.data.sql.server.oracle.jdbcdriver: oracle.jdbc.OracleDriver

For Sybase:

cleartrust.data.sql.server.sybase.jdbc_url: jdbc:sybase:Tds:hostname:port/CT?
cleartrust.data.sql.server.sybase.hostname: hostname 
cleartrust.data.sql.server.sybase.user: CT_ADMIN
cleartrust.data.sql.server.sybase.password: password
cleartrust.data.sql.server.sybase.jdbcdriver: com.sybase.jdbc3.jdbc.SybDriver

For Microsoft SQL Server:

cleartrust.data.sql.server.sql_server.jdbc_url: 
jdbc:sqlserver://hostname:port/database=CT
cleartrust.data.sql.server.sql_server.hostname: hostname 
cleartrust.data.sql.server.sql_server.user: CT_ADMIN
cleartrust.data.sql.server.sql_server.password: password
cleartrust.data.sql.server.mssql.jdbcdriver:com.microsoft.sqlserver.jdbc.SQLServ
erDriver

2. Open your Entitlements Server configuration file (eserver.conf), and verify that 
the following entries are correct:

cleartrust.data.source=sirrus.da.sql.admin.factory.SQLFactory
cleartrust.data.source.configuration=sql.conf

3. Open your Authorization Server configuration file (aserver.conf), and verify that 
the following entries are correct:

cleartrust.data.source=sirrus.da.sql.auth.factory.SQLFactory
cleartrust.data.source.configuration=sql.conf

Once you have completed these steps and saved your configuration files, your Data 
Adapter installation is complete. 
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Configuring SQL Adapter with Microsoft SQL Server for Integrated 
Authentication

To enable integrated authentication, you must configure the SQL adapter with 
Microsoft SQL server.

Note: Integrated authentication is supported only on Windows.

To configure SQL adapter with Microsoft SQL server for integrated 
authentication:

1. Download SQL JDBC from 
http://msdn.microsoft.com/en-us/sqlserver/aa937724 and run the executable 
file.

2. Copy the sqljdbc4.jar file from 
JDBC_INSTALL_DIR\sqljdbc_version\language to AXM_HOME\lib 
directory.
where:

• JDBC_INSTALL_DIR is the location where JDBC is installed.

• version is the JDBC version that is installed.

• language is the JDBC language that is installed.

3. Copy sqljdbc_auth.dll from 
JDBC_INSTALL_DIR\sqljdbc_version\language\auth to the system path, for 
example C:\Windows\system32.

• If you are running a 32-bit Java Virtual Machine (JVM), copy the 
sqljdbc_auth.dll file from the x86 folder, even if the operating system is 
64-bit. 

• If you are running a 64-bit JVM on a x64 processor, copy the 
sqljdbc_auth.dll file from the x64 folder. 

• If you are running a 64-bit JVM on a Itanium processor, copy the 
sqljdbc_auth.dll file from the IA64 folder.

You can also set the java.library.path system property to specify the directory of 
the sqljdbc_auth.dll. For example, if the JDBC driver is installed in the default 
directory, you can specify the location of the DLL file using the following 
argument:

-Djava.library.path=C:\Microsoft SQL Server JDBC 
Driver\sqljdbc_version\enu\auth\x86

4. Enable integrated authentication.
Locate cleartrust.data.sql.server.mssql.jdbc_url 
:jdbc:sqlserver://hostname:1433;databaseName=CT in 
AXM_HOME\conf\sql-mssql.conf file and add “;integratedSecurity=true” to the 
string. 
For example,
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cleartrust.data.sql.server.mssql.jdbc_url 
:jdbc:sqlserver://localhost:1433;databaseName=CT;integrat
edSecurity=true;

Next Step

You are now ready to start your Access Manager Servers and test the connection with 
your data store. For more information, see Chapter 6, “Running Your RSA Access 
Manager Servers.”
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6 Running Your RSA Access Manager Servers

• Before You Begin

• Starting the RSA Access Manager Servers

• Running the RSA Access Manager Servers on Windows

• Running the Servers on UNIX

• Next Step

Before You Begin

Before you can run your RSA Access Manager Servers, you must have your license 
files installed in the correct location. For more information, see Chapter 2, “Installing 
the RSA Access Manager Servers.” 

You must also have your primary data store up and running with the Access Manager 
Data Adapter installed. For more information, see Chapter 3, “Installing the LDAP 
Data Adapter” and Chapter 5, “Installing and Configuring the SQL Data Adapter.”

Starting the RSA Access Manager Servers

You must start the required Access Manager Servers in this order:

1. Dispatcher/Key Server

2. Authorization Server

3. Entitlements Server

Note: After you have started the required Servers, you can also start these optional 
Servers if you have enabled them to run.

4. Log Server (optional)

5. Instrumentation Server (optional)

Running the RSA Access Manager Servers on Windows

You can run the Access Manager Servers either as Windows applications or as 
Windows services. Running the Servers manually as Windows applications makes it 
easier to troubleshoot when you are starting the Servers on a host for the first time. 
Running the Servers as Windows services enables you to automate the restart process, 
just as you can with any Windows service. 
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Starting the RSA Access Manager Servers as Windows Applications

When you run a script to start a Server using the start argument, a new command shell 
window displaying startup information opens in the background. Each Server takes a 
few seconds to start. Wait until the Server has started before you launch the next 
script. To view a Server’s startup information, click the command shell icon on the 
Taskbar at the bottom of the Windows desktop. Then, click the name of the Server you 
want to view.

If the shell disappears, the Server has failed and is no longer running. If this happens:

• Make sure that your data store is running.

• Make sure that you have a valid license.xml file in your AXM_HOME\conf 
directory.

• Make sure that the Server configuration files (also in AXM_HOME\conf) are set 
correctly.

To start the RSA Access Manager Servers as Windows applications:

1. Make sure that your primary data store is running.

2. From a command prompt, navigate to AXM_HOME\bin.

3. In the bin directory, run the following scripts in this order. Type:

dispatcher.bat start

aserver.bat start

eserver.bat start

lserver.bat start (optional)

iserver.bat start (optional)

Stopping the RSA Access Manager Servers as Windows Applications

To stop the RSA Access Manager Servers as Windows applications:

1. From a command prompt, navigate to AXM_HOME\bin.

2. In the bin directory, run the following scripts for each Server. Type:

dispatcher.bat stop

aserver.bat stop

eserver.bat stop

lserver.bat stop

iserver.bat stop

Important: If your Servers use encrypted configuration files, you cannot stop them 
using the stop argument in the dispatcher.bat, aserver.bat, eserver.bat, or (optional) 
lserver.bat script. Instead, you must open the shell where the Server is running, and 
then type CTRL+C to stop that Server.
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Running the RSA Access Manager Servers as Windows Services

By running the Access Manager Servers as Windows services, you are able to set the 
Servers to start automatically when the system boots. When run as Windows services, 
you can manage the Server operation from the Services Panel. After a system restart, 
you can verify that all services have started by checking the Services Panel. You can 
also use the Services Panel to start any Servers that are not running.

To start the RSA Access Manager Servers as Windows services:

1. Make sure that your primary data store is running.

2. Click Start > Settings > Control Panel > Administrative Tools > Services.

3. The Servers are named as follows:

• RSAdispatch – The Dispatcher/Key Server

• RSAeserver – The Entitlements Server

• RSAaserver – The Authorization Server

• RSAlserver – The Log Server (optional)

• RSAiserver – The Instrumentation Server (optional)

4. Right-click a Server name. From the menu, select Start. Servers must be started in 
the order indicated in “Starting the RSA Access Manager Servers” on page 123. If 
a server fails to start by this method, see “Starting the RSA Access Manager 
Servers as Windows Applications” on page 124.

Disabling the RSA Access Manager Servers as Windows Services

The Access Manager installer enables the Servers to start automatically as Windows 
services. If you prefer to start the Access Manager Servers as applications when the 
system restarts, disable Windows services for each of the Servers.

To disable the RSA Access Manager Servers as Windows Services:

1. Click Start > Settings > Control Panel > Administrative Tools > Services.

2. Right-click a Server name in the Services dialog box, and from the menu, select 
Properties.

3. From the Startup type drop-down list in the Properties dialog box, select 
Disabled.

4. Click OK.

5. Repeat steps 2 to 4 until all the Servers are disabled.
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Running the Servers on UNIX

This sections describes how to start the Access Manager Servers on UNIX.

Starting the Servers Manually on UNIX

Start the Access Manager Servers in the order indicated in “Starting the RSA Access 
Manager Servers” on page 123.

To start the Servers manually on UNIX:

1. Make sure that your primary data store is running.

2. Open a command shell, and navigate to AXM_HOME/bin.

3. In the /bin directory, run the following scripts in this order. Type:

Note: Each Server takes a few seconds to start. Wait until a Server starts before 
you launch the next script. 

# ./dispatcher.sh start

# ./aserver.sh start

# ./eserver.sh start

# ./lserver.sh start (optional)

# ./iserver.sh start (optional)

If a Server fails to start: 

• Make sure that your data store is running. 

• Make sure that you have a valid license.xml file in your AXM_HOME/conf 
directory. 

• Make sure that the Servers configuration files (also in AXM_HOME/conf) are set 
correctly. 

Note: To examine errors in a startup script, RSA recommends that you redirect the 
script’s standard output and errors to a file. To do this, open the startup script you want 
to examine, and review the script’s definition of OUTFILE for instructions. If you 
want the script’s standard output and errors details to be displayed on the console, 
uncomment the OUTFILE definitions in the respective server script files.

Stopping the Servers Manually on UNIX

To stop the Servers manually on UNIX:

1. Open a command shell, and navigate to AXM_HOME/bin.

2. In the bin directory, run the following scripts for each Server. Type:

# ./dispatcher.sh stop

# ./aserver.sh stop

# ./eserver.sh stop
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# ./lserver.sh stop

# ./iserver.sh stop

Note: If your Servers use encrypted configuration files, you cannot stop them 
using the stop argument in the dispatcher.sh, aserver.sh, eserver.sh, iserver.sh, or 
lserver.sh scripts. Instead, open the shell where the Server is running, and type 
CTRL+C to stop that Server.

Disabling the RSA Access Manager Servers on UNIX from Starting 
Automatically 

The Access Manager installer adds files that enable the Servers to start automatically 
when the system restarts. If you prefer to start the Access Manager Servers manually, 
you must remove certain files.

To disable the RSA Access Manager Servers on UNIX from starting 
automatically:

• On Solaris, remove the /etc/init.d/axm61 file.

• On AIX, remove the files K00axm61 and S99axm61 from the /etc/rc.d/rc2.d/ 
directory, and then remove the /etc/inittab entry with the identifier RSActsvr.

• On Linux, remove the /etc/init.d/axm61, /etc/rc.d/rc3.d/S99axm61, 
/etc/rc.d/rc5.d/S99axm61, and /etc/rc.d/rc0.d/K00axm61 files.

Next Step

You are now ready to install and configure the RSA Administrative Console. For more 
information, see Chapter 7, “Installing the RSA Access Manager Administrative 
Console.”
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7 Installing the RSA Access Manager 
Administrative Console

• Before You Begin

• Overview of RSA Administrative Console Installation

• Deploying the Web Application Archive File

• Configuring the RSA Administrative Console

• Starting the RSA Administrative Console

• Logging On to the RSA Administrative Console

• Next Steps

The RSA Access Manager Administrative Console is a web-based administrative tool 
for managing administrators, protected resources, and security policy in Access 
Manager. Depending on your needs and system configuration, you can also use the 
Administrative Console to manage user data. 

The Administrative Console is deployed as a Web Archive (WAR) file and requires a 
third-party servlet engine or application server. For this release, RSA has certified 
deploying the Administrative Console using the servers and browsers listed under 
“RSA Access Manager Administrative Console Requirements” on page 20. 

The Administrative Console supports secure browser-to-manager connections using 
anonymous SSL. This chapter describes setup tasks on the servlet engine and the 
Administrative Console configuration file (admingui.cfg).

Before You Begin

Make sure that:

• Your LDAP directory host or SQL database host is running.

• The Access Manager Server components are installed.

• Your Access Manager license file is in place.

• Your Access Manager Data Adapters are installed.

• You have tested the communication between your Access Manager Servers and 
your data hosts.

For more information, see Chapter 2, “Installing the RSA Access Manager Servers.”
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Overview of RSA Administrative Console Installation 

To install the RSA Administrative Console, you must:

1. Set up your application server environment as described in the documentation 
from the application server vendor. This step includes enabling SSL connections if 
you plan to use secure manager-to-browser connections.

2. Deploy the Administrative Console WAR file in your application server 
administration environment. For more information, see the following section, 
“Deploying the Web Application Archive File.”

3. Configure the Administrative Console by editing its configuration file, 
admingui.cfg. For more information, see “Configuring the RSA Administrative 
Console” on page 137.

4. Access the Administrative Console web application through your client browser. 
For more information, see “Starting the RSA Administrative Console” on 
page 139.

Deploying the Web Application Archive File

This section describes how to deploy the Administrative Console Web Archive 
(WAR) file, axm-admin-gui.war, on supported application servers. The WAR file is 
the package that contains the program files required by the Administrative Console. 
On both Windows and UNIX systems, the axm-admin-gui.war file is located in 
AXM_HOME/webapps.

In addition to deploying the program files, you must copy the Administrative Console 
configuration file, admingui.cfg, to a location on the host. RSA recommends that you 
copy the admingui.cfg file outside of the deployment directory, to maintain your 
settings in case you need to redeploy the WAR file. You must also set the 
webgui.config.directory parameter in the web.xml file under the deployment directory 
to point to this location.

For instructions on deploying the Administrative Console WAR file 
(axm-admin-gui.war), see the appropriate procedure for your application server. For 
information about supported versions, see Chapter 1, “Preparing for Installation.”

Note: Steps for deploying the Administrative Console WAR file on your application 
server are the same for Windows or UNIX. The examples provided in the following 
sections use Windows directory paths. If you are using UNIX, substitute with the 
appropriate UNIX paths.

To deploy the WAR file on Apache Tomcat:

1. From AXM_HOME/webapps, copy axm-admin-gui.war to the webapps 
directory in your Tomcat installation. 

2. Restart the Tomcat application server. This step deploys the WAR file into a folder 
named webapps/axm-admin-gui.
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3. From AXM_HOME/webapps, copy admingui.cfg to a directory on the 
application server host. RSA recommends that you copy the admingui.cfg file 
outside of the deployment directory. For example: C:\Program 
Files\configuration_files\

4. From the webapps/axm-admin-gui/WEB-INF directory of your Tomcat 
installation, open web.xml. Make the following change to the param-value 
contents:

<context-param>
<param-name>webgui.config.directory</param-name>
<param-value>admingui.cfg_location</param-value>

</context-param>
where admingui.cfg_location is the path and name of the directory where you 
placed admingui.cfg in step 3. For example: C:\\Program 
Files\\configuration_files\\.

Note: Use only double backward slash (\\) characters when entering the location.

5. For SSL only. If you plan to use SSL connections to the browser, add the 
following entry to context-param contents in web.xml. If you are using a different 
port for HTTP and HTTPS, make sure that you enter it correctly. Otherwise, 
proceed to the next step.

<context-param>
<param-name>http_port</param-name>
<param-value>8080</param-value>

</context-param>
<context-param>

<param-name>https_port</param-name>
<param-value>8443</param-value>

</context-param>

6. For 8-bit character support only. If you require support for 8-bit characters 
(such as Å), add the following entry to web.xml. Otherwise, proceed to the next 
step.

Note: The following lines must be added right after the <context-param> 
parameter and before the <session-config> parameter. This filter enables the 
support for non-ASCII characters in the Administrative Console.

<filter>
<filter-name>i18nFilter</filter-name>
<filter-class>sirrus.admingui.I18NFilter</filter-class>

</filter>
<filter-mapping>

<filter-name>i18nFilter</filter-name>
<url-pattern>/*</url-pattern>

</filter-mapping>
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7. Save web.xml, and restart your Tomcat server.

8. Configure the RSA Administrative Console. For more information, see 
“Configuring the RSA Administrative Console” on page 137.

To deploy the WAR file on WebLogic:

1. From AXM_HOME/webapps, copy admingui.cfg to a directory on the 
application server host. RSA recommends that you copy the admingui.cfg file 
outside of the deployment directory. For example: 
C:\Program Files\configuration_files.

2. Create a directory named “axm-admin-gui” under the WebLogic domain 
application directory. For example: 
C:\bea\user_projects\mydomain\applications\axm-admin-gui.

3. From AXM_HOME/webapps, unzip the axm-admin-gui.war file into the newly 
created axm-admin-gui directory.

4. From C:\bea\user_projects\mydomain\applications\axm-admin-gui
\WEB-INF, open web.xml. Make the following change to the param-value 
contents:

<context-param>
<param-name>webgui.config.directory</param-name>
<param-value>admingui.cfg_location</param-value>

</context-param>
Where admingui.cfg_location is the path and name of the directory where you 
placed admingui.cfg in step 1. For example, 
C:\\Program Files\\configuration_files.

Note: Use only double backward slash (\\) characters when entering the location.

5. For SSL only. If you plan to use SSL connections to the browser, add the 
following entry to web.xml. If you are using a different port for HTTP and 
HTTPS, make sure that you enter it correctly.

<context-param>
<param-name>http_port</param-name>
<param-value>7001</param-value>

</context-param>
<context-param>

<param-name>https_port</param-name>
<param-value>7002</param-value>

</context-param>

6. Use the WebLogic Administration Console to deploy the Administrative Console 
from the axm-admin-gui directory.

7. Configure the RSA Administrative Console. For more information, see 
“Configuring the RSA Administrative Console” on page 137.

To deploy the WAR file to multiple WebLogic target servers:

1. Log on to the WebLogic console (http://hostname:7001/console).

2. Expand the tree structure, and click mydomain > Deployments.
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3. Click axm-admin-gui.

4. Click Targets. 

5. Select the desired target server from the available list, and click the right arrow.

6. Click Apply.

7. Restart the WebLogic server.

8. Configure the RSA Administrative Console. For more information, see 
“Configuring the RSA Administrative Console” on page 137.

Note: This procedure deploys the axm-admin-gui.war file on the “myserver” target 
server of WebLogic. If you plan to deploy the WAR file on other target servers, repeat 
this procedure for each additional server.

Note: For added security, RSA recommends that you protect the Access Manager 
directory where the Administrative Console files are installed. For more information, 
see “Protecting the RSA Access Manager Directory” on page 202.

To deploy the WAR file on WebSphere:

Note: The RSA Access Manager Administrative Console is not supported on 
WebSphere 6.1, when the axm-admin-gui.war file is deployed with anonymous SSL 
enabled. This is due to a limitation of Sun JRE 1.5.

Note: For deploying the WAR file on WebSphere 7.0, see the following procedure, 
“To deploy the WAR file on WebSphere 7.0:”

1. From AXM_HOME/webapps, copy the axm-admin-gui.war and admingui.cfg 
files to a new directory on the application server host.

2. Log on to the WebSphere Application Server Administrative Console.

3. From the tree in the left pane, expand Applications, and click Install New 
Application.

4. In the right pane, click Browse. 

5. Make sure that Local Path is selected to point to the location of the 
axm-admin-gui.war file on your local machine, and select the 
axm-admin-gui.war file.

6. In the Context Root field, enter the value axm-admin-gui.

7. Click Next.

8. In the Step 1: Select installation options screen, select Use Binary 
Configuration, accept the other default settings, and click Next.

9. In the Step 2: Map modules to servers screen, select the default module, and click 
Next.
7: Installing the RSA Access Manager Administrative Console 133



RSA Access Manager 6.1 SP4 Servers Installation and Configuration Guide
10. In the Step 3: Map virtual hosts for web modules screen, select the default web 
module, and click Next.

11. In the Step 4: Summary screen, read the summary, and click Finish.

12. When you see the message “Application axm-admin-gui_war installed 
successfully”, click the Save link to save directly to master configuration.

13. From WebSphere_Application_Server_ROOT/AppServer/profiles/profile 
name/installedApps/your-machine-name/axm-admin-gui_war.ear/
axm-admin-gui.war/WEB-INF, open web.xml. Make the following change to 
the param-value contents:

<context-param>
<param-name>webgui.config.directory</param-name>
<param-value>admingui.cfg_location</param-value>

</context-param>
where admingui.cfg_location is the path and name of the directory where you 
placed admingui.cfg in step 1.

Note: Use only double backward slash (\\) characters when entering the location.

14. For 8-bit character support only. If you require support for 8-bit characters 
(such as Å), add the following entry to web.xml. Otherwise, proceed to the next 
step.

Note: The following lines must be placed right after the <context-param> 
parameter and before the <session-config> parameter. This filter enables the 
support for non-ASCII characters in the Administrative Console.

<filter>
<filter-name>i18nFilter</filter-name>
<filter-class>sirrus.admingui.I18NFilter</filter-class>

</filter>
<filter-mapping>

<filter-name>i18nFilter</filter-name>
<url-pattern>/*</url-pattern>

</filter-mapping>

15. From the tree in the left pane, expand Applications, and click Enterprise 
Applications.

16. On the right pane, select axm-admin-gui.war, and click Start on the top of the 
page.

17. Configure the RSA Administrative Console. For more information, see 
“Configuring the RSA Administrative Console” on page 137.
134 7: Installing the RSA Access Manager Administrative Console



RSA Access Manager 6.1 SP4 Servers Installation and Configuration Guide
To deploy the WAR file on WebSphere 7.0:

1. From AXM_HOME/webapps, copy the axm-admin-gui.war and admingui.cfg 
files to a new directory on the application server host.

2. Log on to the WebSphere Application Server Administrative Console.

3. From the tree in the left pane, expand Applications, and click New Application.

4. In the right pane, click New Enterprise Application > Browse.

5. Make sure that Local Path is selected to point to the location of the 
axm-admin-gui.war file on your local machine, and select the 
axm-admin-gui.war file.

6. Click Next.

7. Select any one of the following and click Next:

Fast Path. To prompt only when additional information is required

Detailed. To show all installation options and parameters

8. If you have selected Fast Path in step 7, perform the following:

a. In the Step 1: Select installation options screen, select Use Binary 
Configuration, accept the other default settings, and click Next.

b. In the Step 2: Map modules to servers screen, select the default module, and 
click Next.

c. In the Step 3: Map virtual hosts for web modules screen, select the default 
web module, and click Next.

d. In the Step 4: Map context roots for Web modules screen, in the Context Root 
field, enter the value axm-admin-gui.

e. In the Step 5: Summary, read the summary screen, and click Finish.

9. If you have selected Detailed in step 7, perform the following:

a. In the right pane, click Continue.

b. In the Step 1: Select installation options screen, select Use Binary 
Configuration, accept the other default settings, and click Next.

c. In the Step 2: Map modules to servers screen, select the default module, and 
click Next.

d. In the Step 3: Provide JSP reloading options for Web modules screen, click 
Next.

e. In the Step 4: Map shared libraries screen, select the default shared libraries, 
and click Next.

f. In the Step 5: Map shared library relationships screen, select the default 
module references, and click Next..

g. In the Step 6: Map virtual hosts for web modules screen, select the default 
web module, and click Next.
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h. In the Step 7: Map context roots for Web modules screen, in the Context Root 
field, enter the value axm-admin-gui.

i. In the Step 8: Summary, read the summary screen, and click Finish.

10. When you see the message “Application axm-admin-gui_war installed 
successfully”, click the Save link to save directly to master configuration.

11. From WebSphere_Application_Server_ROOT/AppServer/profiles/profile 
name/installedApps/your-machine-name/axm-admin-gui_war.ear/
axm-admin-gui.war/WEB-INF, open web.xml. Make the following change to 
the param-value contents:

<context-param>
<param-name>webgui.config.directory</param-name>
<param-value>admingui.cfg_location</param-value>

</context-param>
where admingui.cfg_location is the path and name of the directory where you 
placed admingui.cfg in step 1.

Note: Use only double backward slash (\\) characters when entering the location.

12. For 8-bit character support only. If you require support for 8-bit characters 
(such as Å), add the following entry to web.xml. Otherwise, proceed to the next 
step.

Note: The following lines must be placed right after the <context-param> 
parameter and before the <session-config> parameter. This filter enables the 
support for non-ASCII characters in the Administrative Console.

<filter>
<filter-name>i18nFilter</filter-name>
<filter-class>sirrus.admingui.I18NFilter</filter-class>

</filter>
<filter-mapping>

<filter-name>i18nFilter</filter-name>
<url-pattern>/*</url-pattern>

</filter-mapping>

13. From the tree in the left pane, expand Applications > Application Types, and 
click WebSphere enterprise applications.

14. On the right pane, select axm-admin-gui.war, and click Start on the top of the 
page.

15. Configure the RSA Administrative Console. For more information, see the 
following section “Configuring the RSA Administrative Console.”
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Configuring the RSA Administrative Console

The Administrative Console requires the admingui.cfg file, which contains 
connection information for the Entitlements Server host and other important 
parameters. Each parameter in this file contains comments that explain how to set the 
value.

You can accept default values for most parameters except for the host parameter, 
which points the Administrative Console to a valid Entitlements Server. The host 
setting is covered in this section. 

Important: The admingui.cfg file must be located in the directory set in the 
webgui.config.directory parameter in web.xml. The Administrative Console does not 
operate properly if it cannot locate admingui.cfg.

To configure the RSA Administrative Console:

1. Open the admingui.cfg file from the location where you saved it in the 
deployment process.

2. Edit the host connection parameter, entering the hostname where the Entitlements 
Server resides, for example, host=server1.company.com. If the Entitlements 
Server is installed on the same host as the Administrative Console, you can accept 
the default value of localhost.

3. Edit other parameters, as desired. For an explanation of each configuration 
parameter, see the comments for “Manually Adding the Auxiliary User Class in 
Active Directory” on page 89.

4. AD-ADAM/AD- Users only. Uncomment the parameter disableuserextensions. 
Set this to false only if you plan to add the auxiliary user classes as described in 
“Manually Adding the Auxiliary User Class in Active Directory” on page 89. If 
you do not plan to use auxiliary user classes, leave this parameter set to true.

5. Save admingui.cfg, and restart your application server.

SSL Configuration

The Administrative Console supports secure connections with anonymous SSL 
between: 

• The Administrative Console and the browser

• The Administrative Console and the Entitlements Server

You can configure anonymous SSL by setting the appropriate parameters in 
admingui.cfg.

To enable an anonymous SSL connection between the Administrative Console 
and the browser:

Set the browser.use.ssl parameter to on. For example:

cleartrust.admingui.browser.use.ssl=on
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To enable an anonymous SSL connection between the Administrative Console 
and the Entitlements Server:

1. Accept the default value, anon, of the ssl.mode parameter. For example:
cleartrust.admingui.admin_api.use_ssl=anon

2. Make sure that this setting matches the cleartrust.eserver.api_port.use_ssl setting 
in the Entitlements Server configuration file (eserver.conf). If you change one to 
clear, you must change the other. By default, both of these parameters are set to 
anon. 

Customizing the RSA Administrative Console User Interface

Extensive user interface customization is neither supported nor recommended for 
RSA Access Manager 6.1. However, you can replace the RSA logo graphic with a 
graphic of your choice in server_name/axm-admin-gui/images. 

You cannot change the filename, height, or width dimensions. A replacement graphic 
must conform to the following name and dimensions:

• logo.gif

• 47px high x 297px wide

Customizing the Logon Access Banner Text on the RSA Administrative 
Console Logon Page

You can customize the logon access banner text that appears on the Administrative 
Console logon page.

To customize logon access banner text:

1. Open admingui.cfg_location/admingui.cfg.
Where admingui.cfg_location is the location on the host, where you have copied 
the admingui.cfg file.

2. Add your logon access banner text to the following parameter:

cleartrust.admingui.prohibitory.text=

3. Restart your application server.

Excluded Words File

The excluded words file contains words that cannot be used as passwords, including 
several thousand commonly used words, like “password,” that are likely to be 
included as part of any dictionary attacks on the system. You can customize this file by 
adding additional words.

When you use the Administrative Console to create a new password policy, the 
filename of the excluded words file is required in the Excluded Words File field. The 
default file, words.txt, is stored in the AXM_HOME\conf\ directory. If you are using 
the default file, or a file with another name, which is stored in the default location, you 
only need to enter the filename. To use a file with another filename, if the file is stored 
in the AXM_HOME\conf\ directory, enter the relative path and filename, otherwise 
enter the absolute path and filename. You must store the excluded words file on the 
same machine that hosts the Entitlements Server.
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Starting the RSA Administrative Console

After completing the installation procedures:

1. Restart your Dispatcher/Key Server and Entitlements Server. 

2. Start the RSA Administrative Console using one of the supported browsers. 

3. Point the browser to the Administrative Console Application URL on the 
appropriate host and port. 

For a standard deployment using default values, the URL is:

• http://server1:8080/axm-admin-gui for Apace Tomcat

• http://server1:7001/axm-admin-gui for WebLogic

• http://server1:9080/axm-admin-gui for WebSphere

Note: A number of dependencies can affect the successful startup of your 
Administrative Console. For more information, see Appendix M, “Troubleshooting.”

Logging On to the RSA Administrative Console

To log on to the RSA Administrative Console, enter your administrator User ID and 
password as specified during the Access Manager installation.

To change your password after logging on for the first time:

1. Click Manage Users > Users & Administrators > Manage Existing. Use the 
search fields.

2. In the Edit column, click Edit next to your User ID.

3. Enter the new password in the Password field.

4. Re-enter the new password in the Retype Password field.

5. Click Update.

Important: This password is not used in systems configured for Windows NT, 
RSA SecurID, or Certificate authentication. It is only used in Basic authentication. 

For more information on using the Administrative Console, see the Administrator’s 
Guide or Help.

Next Steps

Install and configure an RSA Access Manager Agent on each web server and 
application server that Access Manager must protect. For more information, see your 
RSA Access Manager Agent documentation.
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8 Installing the RSA Access Manager User 
Self-Service Console

• Overview of Access Manager User Self-Service Console Installation

• Deploying the Web Application Archive File

• Configuring the Access Manager User Self-Service Console

• Running Lockbox Migration Tool

• Accessing the Access Manager User Self-Service Console

• Customizing Help for the Access Manager User Self-Service Console

The Access Manager User Self-Service Console is a web-based application that 
allows users to change or reset their passwords and update other attributes, such as 
first name, e-mail, and other custom properties without any intervention from an 
administrator. 

The User Self-Service Console is deployed as a Web Archive (WAR) file and requires 
a third-party servlet engine or application server. For this release, RSA has certified 
deploying the User Self-Service Console using the servers and browsers listed under 
“RSA Access Manager User Self-Service Console Requirements” on page 20. 

RSA Access Manager supports secure connections using anonymous SSL and mutual 
SSL between Entitlements Server and User Self-Service Console and between 
Authorization Server and User Self-Service Console. This chapter describes setup 
tasks on the servlet engine and the User Self-Service Console configuration file 
(selfservice.conf). 

Note: The configuration file (selfservice.conf) is inside the WAR file 
(axm-selfservice-gui.war).

Overview of Access Manager User Self-Service Console Installation 

To install the User Self-Service Console, you must:

1. Set up your application server environment as described in the documentation 
from the application server vendor.

2. Deploy the User Self-Service Console WAR file in your application server 
environment. For more information, see the following section, “Deploying the 
Web Application Archive File.”

Note: If you are upgrading to 6.1 SP4, run the migration tool before upgrading the 
self-service console.  For more information, see “Running Lockbox Migration 
Tool” on page 151.
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3. Configure the User Self-Service Console by editing its configuration file, 
selfservice.conf. For more information, see “Configuring the Access 
Manager User Self-Service Console” on page 147.

4. Access the User Self-Service Console through your client browser. For more 
information, see “Accessing the Access Manager User Self-Service Console” on 
page 152.

Deploying the Web Application Archive File

This section describes how to deploy the User Self-Service Console Web Archive 
(WAR) file, axm-selfservice-gui.war, on supported application servers. On both 
Windows and UNIX systems, the axm-selfservice-gui.war file is located in 
AXM_HOME\webapps.

In addition to deploying the program files, you must copy the User Self-Service 
Console configuration file, selfservice.conf to a location on the host system. RSA 
recommends that you copy the selfservice.conf file outside of the deployment 
directory, to maintain your settings in case you need to redeploy the WAR file. 

You must also set the webgui.config.directory parameter in the web.xml file under the 
deployment directory to point to this location.

For instructions on deploying the User Self-Service Console WAR file 
(axm-selfservice-gui.war), see the appropriate procedure for your application server. 
For information about supported versions, see Chapter 1, “Preparing for Installation.”

Note: Steps for deploying the User Self-Service Console WAR file on your 
application server are the same for Windows or UNIX. The examples provided in the 
following sections use Windows directory paths. If you are using UNIX, substitute 
with the appropriate UNIX paths.

To deploy the WAR file on Apache Tomcat:

1. From AXM_HOME\webapps\axm-selfservice-gui.war, copy selfservice.conf to 
a directory on the application server host. RSA recommends that you copy the 
selfservice.conf file outside of the deployment directory. For example: 
C:\Program Files\configuration_files.

2. Create a directory named axm-selfservice-gui in the webapps directory in your 
Tomcat installation.

3. From AXM_HOME\webapps, unzip the axm-selfservice-gui.war file into the 
newly created axm-selfservice-gui directory.
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4. From the webapps\axm-selfservice-gui\WEB-INF directory of your Tomcat 
installation, open web.xml. Make the following change to the param-value 
contents:

<context-param>
<param-name>webgui.config.directory</param-name>
<param-value>selfservice.conf_location</param-value>

</context-param>
where selfservice.conf_location is the path and name of the directory where you 
placed selfservice.conf in step 1. For example: 
C:\\Program Files\\configuration_files\\.

Note: Use only double backward slash (\\) characters when entering the location.

5. Save web.xml.

6. Configure the User Self-Service Console, see “Configuring the Access 
Manager User Self-Service Console” on page 147.

7. Restart your Tomcat server

To deploy the WAR file on WebLogic:

1. From AXM_HOME\webapps\axm-selfservice-gui.war, copy selfservice.conf to 
a directory on the application server host. RSA recommends that you copy the 
selfservice.conf file outside of the deployment directory. For example: 
C:\Program Files\configuration_files.

2. Create a directory named axm-selfservice-gui under the WebLogic domain 
application directory. For example: 
C:\bea\user_projects\mydomain\applications\axm-selfservice-gui.

3. From AXM_HOME\webapps, unzip the axm-selfservice-gui.war file into the 
newly created axm-selfservice-gui directory.

4. From C:\bea\user_projects\domains\mydomain\axm-selfservice-gui\ 
WEB-INF\, open web.xml. Make the following change to the param-value 
contents:

<context-param>
<param-name>webgui.config.directory</param-name>
<param-value>selfservice.conf_location</param-value>

</context-param>
Where selfservice.conf_location is the path and name of the directory where you 
placed selfservice.conf in step 1. For example, 
C:\\Program Files\\configuration_files.

Note: Use only double backward slash (\\) characters when entering the location.

5. Configure the User Self-Service Console, see “Configuring the Access 
Manager User Self-Service Console” on page 147.

6. Navigate to web-inf lib directory. For example, 
C:\bea\user_projects\domains\mydomain\axm-selfservice-gui\WEB-INF\lib.
8: Installing the RSA Access Manager User Self-Service Console 143



RSA Access Manager 6.1 SP4 Servers Installation and Configuration Guide
7. Move CSP-3.0.jar, CSPJNI-3.0.jar, LB-3.0.jar and LBJNI-3.0.jar files from 
"WEB-INF/lib" to domain lib directory.vFor example, 
"C:\bea\user_projects\domains\mydomain\lib".

8. Use the WebLogic Administration Console to deploy the User Self-Service 
Console from the axm-selfservice-gui directory.

To deploy the WAR file to multiple WebLogic target servers:

1. Log on to the WebLogic console (http://hostname:7001/console).

2. Expand the tree structure, and click mydomain > Deployments.

3. Click axm-selfservice-gui.

4. Click Targets. 

5. Select the desired target server from the available list.

6. Click Save.

7. Restart the WebLogic server.

8. Configure the User Self-Service Console, see “Configuring the Access 
Manager User Self-Service Console” on page 147.

To deploy the WAR file on WebSphere:

Note: Before you deploy the WAR file on WebSphere 6.1, make sure that you update 
the patch for WebSphere 6.1 to 6.1.0.19 or above.

Note: For deploying the WAR file on WebSphere 7.0, see the following procedure, 
“To deploy the WAR file on WebSphere 7.0:”.

1. From AXM_HOME/webapps, copy the axm-selfservice-gui.war to a new 
directory on the application server host.

2. Log on to the WebSphere Application Server Administrative Console.

3. From the tree in the left pane, expand Applications, and click Install New 
Application.

4. In the right pane, click Browse. 

5. Make sure that Local Path is selected to point to the location of the 
axm-selfservice-gui.war file on your local machine, and select the 
axm-selfservice-gui.war file.

6. In the Context Root field, enter the value axm-selfservice-gui.

7. Click Next.

8. In the Step 1: Select installation options screen, select Use Binary 
Configuration, accept the other default settings, and click Next.

9. In the Step 2: Map modules to servers screen, select the default module, and click 
Next.
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10. In the Step 3: Map virtual hosts for web modules screen, select the default web 
module, and click Next.

11. In the Step 4: Summary, read the summary screen, and click Finish.

12. When you see the message “Application axm-selfservice-gui_war installed 
successfully”, click the Save link to save directly to master configuration.

13. From WebSphere_Application_Server_ROOT/AppServer/profiles/profile 
name/installedApps/your-machine-name/axm-selfservice-gui_war.ear/
axm-selfservice-gui.war/WEB-INF, open web.xml. Make the following change 
to the param-value contents:

<context-param>
<param-name>webgui.config.directory</param-name>
<param-value>selfservice.conf_location</param-value>

</context-param>
where:
selfservice.conf_location is 
WebSphere_Application_Server_ROOT/AppServer/profiles/profile 
name/installedApps/your-machine-name/axm-selfservice-gui_war.ear/
axm-selfservice-gui.war/.

Note: Use only double backward slash (\\) characters when entering the location.

14. From the tree in the left pane, expand Servers > Application Servers > 
your-server-name> Web Container Settings > Web Container, and click 
Custom Properties.

15. Create a new property as follows:

• Name: com.ibm.ws.webcontainer.invokefilterscompatibility

• Value: true

16. From the tree in the left pane, expand Applications, and click Enterprise 
Applications.

17. On the right pane, select axm-selfservice-gui.war, and click Start on the top of 
the page.

18. Configure the User Self-Service Console, see “Configuring the Access 
Manager User Self-Service Console” on page 147.

To deploy the WAR file on WebSphere 7.0:

1. From AXM_HOME/webapps, copy the axm-selfservice-gui.war to a new 
directory on the application server host.

2. Log on to the WebSphere Application Server Administrative Console.

3. From the tree in the left pane, expand Applications, and click New Application.

4. In the right pane, click New Enterprise Application > Browse.

5. Make sure that Local Path is selected to point to the location of the 
axm-selfservice-gui.war file on your local machine, and select the 
axm-selfservice-gui.war file.
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6. Click Next.

7. Select any one of the following and click Next:

Fast Path. To prompt only when additional information is required

Detailed. To show all installation options and parameters

8. If you have selected Fast Path in step 7, perform the following:

a. In the Step 1: Select installation options screen, select Use Binary 
Configuration, accept the other default settings, and click Next.

b. In the Step 2: Map modules to servers screen, select the default module, and 
click Next.

c. In the Step 3: Map virtual hosts for web modules screen, select the default 
web module, and click Next.

d. In the Step 4: Map context roots for Web modules screen, in the Context Root 
field, enter the value axm-selfservice-gui.

e. In the Step 5: Summary, read the summary screen, and click Finish.

9. If you have selected Detailed in step 7, perform the following:

a. In the right pane, click Continue.

b. In the Step 1: Select installation options screen, select Use Binary 
Configuration, accept the other default settings, and click Next.

c. In the Step 2: Map modules to servers screen, select the default module, and 
click Next.

d. In the Step 3: Provide JSP reloading options for Web modules screen, click 
Next.

e. In the Step 4: Map shared libraries screen, select the default shared libraries, 
and click Next.

f. In the Step 5: Map shared library relationships screen, select the default 
module references, and click Next..

g. In the Step 6: Map virtual hosts for web modules screen, select the default 
web module, and click Next.

h. In the Step 7: Map context roots for Web modules screen, in the Context Root 
field, enter the value axm-selfservice-gui.

i. In the Step 8: Summary, read the summary screen, and click Finish.

10. When you see the message “Application axm-selfservice-gui_war installed 
successfully”, click the Save link to save directly to master configuration.
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11. From WebSphere_Application_Server_ROOT/AppServer/profiles/profile 
name/installedApps/your-machine-name/axm-selfservice-gui_war.ear/
axm-selfservice-gui.war/WEB-INF, open web.xml. Make the following change 
to the param-value contents:

<context-param>
<param-name>webgui.config.directory</param-name>
<param-value>selfservice.conf_location</param-value>

</context-param>
where:
selfservice.conf_location is 
WebSphere_Application_Server_ROOT/AppServer/profiles/profile 
name/installedApps/your-machine-name/axm-selfservice-gui_war.ear/
axm-selfservice-gui.war/.

Note: Use only double backward slash (\\) characters when entering the location.

12. From the tree in the left pane, expand Servers > WebSphere application servers 
> your-server-name> Web Container Settings > Web Container, and click 
Custom Properties.

13. Create a new property as follows:

• Name: com.ibm.ws.webcontainer.invokefilterscompatibility

• Value: true

14. From the tree in the left pane, expand Applications > Application Types, and 
click WebSphere enterprise applications.

15. On the right pane, select axm-selfservice-gui.war, and click Start on the top of 
the page.

16. Configure the User Self-Service Console, see the following section “Configuring 
the Access Manager User Self-Service Console.” 

Configuring the Access Manager User Self-Service Console

The Access Manager User Self-Service Console requires the selfservice.conf file, 
which contains connection information for the Entitlements Server host, 
Authorization Server host, and other important parameters. Each parameter in this file 
contains comments that explain how to set the value.

Important: The selfservice.conf file must be located in the directory as configured in 
the webgui.config.directory parameter in web.xml. The Self-Service Console does not 
operate if it cannot locate selfservice.conf.
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To configure the Access Manager User Self-Service Console:

1. Open the selfservice.conf file from the location where you saved it in the 
deployment process.

2. Enter the encrypted values for the following parameters. Use the EncryptUtil tool 
to encrypt the values for the following parameters. For more information, see 
Running the EncryptUtil Tool on page 212.

com.rsa.axm.selfservice.adapi.user_id

com.rsa.axm.selfservice.adapi.user_password

3. Configure the following parameter to the lockbox file generated or used in step 2.
com.rsa.axm.selfservice.lockbox_file_path = valid_file_path

For more information on generating lockbox, see “Generating lockbox” on 
page 231.

4. Edit other parameters, as desired. 

Note: The instructions to edit the selfservice.conf file are provided in the same 
file.

5. Save selfservice.conf, and restart your application server.

Defining User Self-Service Properties Using RSA Access Manager 
Administrative Console

In addition to configuring the parameters in the selfservice.conf file, you must define 
the following properties using the RSA Access Manager Administrative Console:

• ctscPasswordResetAttempts

• ctscSecretQuestionAnswer

Note: Both these properties must be of String type. While defining these properties 
make sure that you select Export/Publish.

For more information on adding properties, see the Administrative Console Help topic 
“Adding Properties.”

Note: If you are using an Oracle or Microsoft SQL data store, the properties are 
automatically added to the data store.

Configuration SSL

Access Manager supports secure connections with anonymous SSL and mutual SSL 
between: 

• The User Self-Service Console and the Entitlements Server

• The User Self-Service Console and the Authorization Server

You can configure anonymous SSL and mutual SSL by setting the appropriate 
parameters in the selfservice.conf file.
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Note: The User Self-Service Console deployed on WebSphere 6.1 does not support 
anonymous SSL connections.

To enable anonymous SSL connection between the User Self-Service Console 
and the Entitlements Server:

1. Accept the default value, Anon, for the following parameter in the 
selfservice.conf file:

com.rsa.axm.selfservice.adapi.ssl=Anon

2. Make sure that this setting matches the cleartrust.eserver.api_port.use_ssl setting 
in the Entitlements Server configuration file (eserver.conf). If you change one to 
Clear, you must change the other. By default, both of these parameters are set to 
Anon. 
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To enable anonymous SSL connection between the User Self-Service Console 
and the Authorization Server:

1. Accept the default value, Anon, for the following parameter in the 
selfservice.conf file:

com.rsa.axm.selfservice.rtapi.ssl=Anon

2. Make sure that this setting matches the cleartrust.net.ssl.use setting in the 
Authorization Server configuration file (aserver.conf). If you change one to 
Clear, you must change the other. By default, both of these parameters are set to 
Anon.

To enable Mutual SSL connection between the User Self-Service Console and 
the Entitlements Server:

1. Set the value for the following parameter to Auth:

com.rsa.axm.selfservice.adapi.ssl=Auth

2. Make sure this setting matches the cleartrust.eserver.api_port.use_ssl setting in the 
Entitlements Server configuration file (eserver.conf). If you change one to clear, 
you must change the other. By default, both of these parameters are set to anon. 

3. Enter the encrypted values for the following parameters in the selfservice.conf 
file. Use the EncryptUtil tool to encrypt the values for the following parameters. 
For more information, see Running the EncryptUtil Tool on page 212.

com.rsa.axm.selfservice.ssl.ca.keystore_passphrase

com.rsa.axm.selfservice.ssl.private.keystore_passphrase

com.rsa.axm.selfservice.ssl.private.key_passphrase

4. Set the values for the following parameters in the selfservice.conf file.

com.rsa.axm.selfservice.ssl.ca.keystore_file

com.rsa.axm.selfservice.ssl.ca.keystore_type

com.rsa.axm.selfservice.ssl.ca.keystore_provider

com.rsa.axm.selfservice.ssl.private.keystore_file

com.rsa.axm.selfservice.ssl.private.keystore_type

com.rsa.axm.selfservice.ssl.private.keystore_provider

com.rsa.axm.selfservice.ssl.private.key_alias

To enable Mutual SSL connection between the User Self-Service Console and 
the Authorization Server:

1. Set the value for the following parameter to Auth:

com.rsa.axm.selfservice.rtapi.ssl

2. Make sure that this setting matches the cleartrust.net.ssl.use setting in the 
Authorization Server configuration file (aserver.conf). If you change one to 
Clear, you must change the other. By default, both of these parameters are set to 
Anon.
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3. Enter the encrypted values for the following parameters in the selfservice.conf 
file. Use the EncryptUtil tool to encrypt the values for the following parameters. 
For more information, see Running the EncryptUtil Tool on page 212.

com.rsa.axm.selfservice.ssl.ca.keystore_passphrase

com.rsa.axm.selfservice.ssl.private.keystore_passphrase

com.rsa.axm.selfservice.ssl.private.key_passphrase

4. Set the values for the following parameters in the selfservice.conf file.

com.rsa.axm.selfservice.ssl.ca.keystore_file

com.rsa.axm.selfservice.ssl.ca.keystore_type

com.rsa.axm.selfservice.ssl.ca.keystore_provider

com.rsa.axm.selfservice.ssl.private.keystore_file

com.rsa.axm.selfservice.ssl.private.keystore_type

com.rsa.axm.selfservice.ssl.private.keystore_provider

com.rsa.axm.selfservice.ssl.private.key_alias

User Self-Service Console for Administrator

By default AxM Admin users are not allowed to access self-service console. However, 
this behavior can be modified by using the following parameter in selfservice.conf

com.rsa.axm.selfservice.allow_admin=TRUE|FALSE 

SSO Configuration

Self-service module can be configured for single sign-on (SSO) with AxM agent. 
Once enabled user won't be prompted for re-authentication if they are already 
authenticated to the AxM web agent.

Configure the below property to enable the SSO with AxM agent

com.rsa.axm.selfservice.sso_cookie_name=CTSESSION

To invalidate the SSO session from self-service module please configure the below 
property. This property has to point to the Agent's logout URL. For more information 
see the description of below property in the selfservice.conf

com.rsa.axm.selfservice.sso_logout_url=

Running Lockbox Migration Tool

From 6.1 SP4, Lockbox is used to manage the encryption key. For this reason, the 
encryption key used by the is changed from 6.1 SP3 or older.

This tool provides a migration path for self-service console upgradation from 6.1 SP3 
or older version to 6.1 SP4.

Note: You must run the Lockbox migration tool only if self-service is upgraded to 6.1 
SP4. Do not run this tool for new deployment of self-service console.
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To run the lockbox migration tool:

1. Install the Lockbox.

2. Generate the Lockboc file. For instructions, see “Generating lockbox” on 
page 231.

3. Shut down the self-service console.

4. Ensure selfservice.conf has valid connection credentials to Entitlement server.

5. If LDAP is the datastore used to store self-service data then set 
cleartrust.data.ldap.server_side_sorting   :true in ldap.conf.

6. Ensure Entitlement server is up and running. 

7. Edit the lockbox-migration-tool.bat or lockbox-migration-tool.sh file to set the 
AXM_HOME path.

8. For 64 bit machine, Edit the lockbox-migration-tool.bat or 
lockbox-migration-tool.sh file and set the JAVA_HOME as below.
set JAVA_HOME=%AXM_HOME%\jre64 

or
JAVA_HOME=$AXM_HOME/jre64

9. Run the tool by using below command.
lockbox-migration-tool -conf <selfservice_conf_file> 
-lockbox <lockbox_file> –mode <fips | nonfips mode>

where,
-conf <selfservice_conf_file> = Valid path to the Self-service 
configuration file.
-lockbox <lockbox_file> = Valid path to the Lockbox file.
-mode <fips | nonfips> = Use fips or nonfips algorithm for encrption. If 
you are planning to run the self-service in FIPS mode please set mode to fips, else 
set to nonfips.
For example:
lockbox-migration-tool -conf C:\conf\selfservice.conf 
-lockbox c:\lockbox.clb -mode nonfips

10. Restart the self-service console.

Accessing the Access Manager User Self-Service Console

After completing the installation procedures, restart your Dispatcher/Key Server and 
Entitlements Server. Users can then access the RSA User Self-Service Console using 
one of the supported browsers. Users must point the browser to the User Self-Service 
Console Application URL on the appropriate host and port. 

For a standard deployment using default values, the URL is:

• http://hostserver:8080/axm-selfservice-gui on Apace Tomcat

• http://hostserver:7001/axm-selfservice-gui on WebLogic

• http://hostserver:9060/axm-selfservice-gui on WebSphere
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Customizing Help for the Access Manager User Self-Service 
Console

You can customize the User Self-Service Console Help to reflect how your company 
uses user self-service.

By editing the HTM files, you can customize the Help to:

• Reflect any changes that you make to the User Self-Service Console when editing 
the properties file.

• Add information for your company using company-specific terminology.

• Remove non-applicable information from the HTM files.

The location of the HTM files is: <Self Service_HOME>\web_help\en

Where Self Service_HOME is the directory, where you have installed the User 
Self-Service Console.
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9 Supported Authentication Types

• Authentication Overview

• Supported Authentication Types

• Configuring Authentication Types

• RSA SecurID Authentication

• Microsoft Integrated Windows Authentication

• Microsoft Windows Domain Single Sign-On

• NTLM Authentication

• RSA Adaptive Authentication

• Configuring Windows-Based Authentication

Authentication Overview

Authentication is the process of verifying user credentials before a user can access a 
protected resource. RSA Access Manager provides its own internal authentication 
mechanism—validating the user name and password against the Access Manager data 
store. Access Manager also integrates with several external authentication types such 
as Microsoft NT PDC, X.509 certificates, RSA SecurID, NTLM, and Integrated 
Windows Authentication (IWA). For added security, you can combine authentication 
types for specific resources.

Supported Authentication Types

The following table provides an overview of the authentication types supported by 
Access Manager. 

Type Description

Basic Basic authentication involves validating the user name and password 
provided at logon with the user account information in the Access 
Manager data store. If no other authentication mechanisms are configured, 
this is the default authentication mechanism for all protected resources.

Certificate Access Manager supports X.509 certificates for authentication. You can 
configure your web server or application server to accept an HTTPS 
request (SSL connection) from your browser and use one of the user 
certificates previously imported into your browser for authentication.
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Whenever users attempt to access a protected resource, they are prompted to provide 
the appropriate user credentials for the authentication type that you have enabled.

For example, in the case of Windows NT and Basic authentication types, the 
credentials consist of a user name and password. For RSA SecurID, the credentials 
consist of a user name and passcode. For Certificate, the credentials consist of a user 
certificate issued by a certificate authority. Users must provide the requested proof. If 
the authentication mechanism accepts the credentials, Access Manager then checks 
for the user’s authorization privileges on the requested resource.

Configuring Authentication Types

You specify the authentication type by setting parameters in the RSA Access Manager 
Agent configuration file, after you install your Agent. For a complete description of 
configuring authentication, see your Agent Installation and Configuration Guide. 

RSA SecurID Access Manager supports RSA SecurID two-factor authentication to 
validate a user passcode at logon against the credentials stored in RSA 
Authentication Manager. A user account of the same user name must also 
exist in the Access Manager data store. 

Windows Access Manager supports three types of Windows-based authentication:

IWA authentication. This is handled by the Microsoft IIS Web Server. 
The RSA Access Manager Agent trusts the return values from the web 
server without independently verifying the user’s credentials. IWA may be 
used for resources on IIS and non-IIS Web Servers protected by a version 
4.5 or later of RSA Access Manager Agent.

NTLM authentication. This is handled by the Access Manager 
Authorization Server, which authenticates the user through the Windows 
NTLM facility. NTLM authentication may be used for resources on 
non-IIS Web Servers only, and requires a version 4.5 or later of 
RSA Access Manager Agent.

NT authentication. This is handled by the Access Manager Authorization 
Server, which authenticates the user by verifying user name and password. 
Resources protected by NT are not covered by the IWA SSO feature.

Custom You can use an RSA Access Manager Web Server Agent Extension 
(WAX) or the RSA Access Manager Runtime API to create your own 
custom authentication routine. You can create your own error messages 
and logging. You can also create a WAX program that integrates with 
existing legacy authentication mechanisms or any number of other 
integrations. For more information, see the Developer’s Guide.

RSA Adaptive 
Authentication

You can integrate Access Manager and Agent with the Adaptive 
Authentication Server to get a first level of authentication before a second 
level of authentication with Access Manager.

Type Description
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Some authentication types require Access Manager Server configuration. The 
following sections explain the Server configuration required for:

• RSA SecurID Authentication

• Microsoft Integrated Windows Authentication

• Microsoft Windows Domain Single Sign-On

• NTLM Authentication

• RSA Adaptive Authentication

RSA SecurID Authentication

Access Manager supports RSA SecurID two-factor authentication to validate a user 
passcode at logon against the credentials stored in RSA Authentication Manager. A 
user account with same user name must also exist in the Access Manager data store.

Setting Up RSA SecurID Authentication

Before you can use RSA SecurID authentication, you must have RSA Authentication 
Manager installed and configured. For more information, see your Authentication 
Manager documentation. 

To set up RSA SecurID authentication:

1. Stop the Authorization Server.

2. Using the Database Administration application, create an Agent Host. Copy 
sdconf.rec and (optionally) the node secret for it to AXM_HOME/conf.

3. Start the Authorization Server.

To troubleshoot problems, start the Authorization Server with the “securid” debug 
facility set. This will generate a pair of files containing logging and debug information 
to AXM_HOME/logs:

• securid_authn_api.log 

• securid_authn_api_debug.log

Microsoft Integrated Windows Authentication

Access Manager supports Integrated Windows Authentication (IWA), permitting 
single sign-on (SSO) across Windows resources and resources protected by Access 
Manager. Together, this feature and the Windows Domain SSO feature provide SSO 
for users in Windows environments. For more information, see “Microsoft Windows 
Domain Single Sign-On” on page 160.

The IWA SSO feature allows a user logged on to Windows to access resources 
protected by Access Manager without retyping logon credentials. This normally 
occurs in the following series of steps:
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1. The user logs on to Windows.

2. The user attempts to load a page protected by IWA in his or her browser.

3. The IIS server authenticates the user, using one of the IWA mechanisms such as 
Windows NT LAN Manager (NTLM) or Kerberos.

4. The RSA Access Manager Agent considers the user authenticated for resources 
protected with the IWA authentication type.

You may choose to extend IWA SSO to include resources protected by NTLM. In step 
4, if NTLM is the IWA authentication type used, and if the Agent is configured to 
include resources protected by NTLM in IWA SSO, the Agent considers the user 
authenticated for resources protected by both IWA and NTLM. However, the reverse 
is not true. An NTLM authentication (performed by Access Manager) is only 
sufficient to provide access to resources protected by NTLM.

Requirements

In order to use Integrated Windows Authentication, you must have:

• An RSA Access Manager Agent (version 4.7 or later).

• At least one Internet Information Services (IIS) Web Server with an RSA Access 
Manager Agent and Access Manager logon forms installed.

Setting Up Windows User Principal Name Mapping for Integrated Windows 
Authentication

This section describes the Access Manager Server configuration required for IWA.

Note: In addition to the steps below, you must set up your RSA Access Manager 
Agents. For more information, see the procedure “To configure IWA in webagent.conf 
and in the IIS Web Server management console” in the RSA Access Manager Agent 
for WebServer Installation and Configuration Guide. 

Your web servers protected by Access Manager must include at least one IIS Web 
Server. The IIS Web Server handles the IWA authentication.

Choose the appropriate instructions for your installation:

• See the following section, “Attribute Lookup” if you store users in an LDAP 
directory and you already have a Windows User Principle Name (UPN) stored for 
each user.

• See “Manual Lookup” on page 159 if your  data store does not contain UPNs for 
users. If your users are stored in an SQL store, Manual Lookup is your only 
option.

Note: These two lookup types are mutually exclusive. Choose one type.
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Attribute Lookup

Attribute lookup of UPNs assumes that each user record in your data store contains the 
user’s UPN. Access Manager loads each user’s UPN from the attribute you specify 
using the user.attributemap.windowsupn parameter. This procedure works for LDAP 
directories only. 

To use a data store that contains user UPNs:

1. Open your ldap.conf file.

2. Set the cleartrust.data.ldap.user.attributemap.windowsupn parameter to the name 
of the LDAP attribute that contains user UPNs.

3. Save the ldap.conf file, and restart your Servers. 
Access Manager will now use the user’s UPN when requesting an IWA 
authentication from the IIS Server.

Note: Users created using the RSA Administrative Console do not have the 
attribute specified by .attributemap.windowsupn set. You must add this attribute 
manually.

Manual Lookup

If your user records do not contain UPNs, create the mappings manually in the Access 
Manager store.

To create name mappings using manual lookup:

1. Set up the data store:

• SQL users: No preparation is required. Continue with step 2.

• LDAP users: You must create a UPN for each user. For more information, see 
“User Identity Mapping for Integrated Windows Authentication and Other 
Applications” on page 108. 

2. From AXM_HOME/sdk/java/admin/example, compile and run 
UserMappingExample. 

3. Follow the program’s prompts to create a mapped UPN for each user in your data 
store. 

Note: For a typical installation, modify this program to facilitate the quick 
creation of UPNs for many users.

4. From AXM_HOME/sdk/java/runtime/example, check your mapped UPNs 
using UserMappingRTExample. 

Note: If you came to this section from “User Identity Mapping for Integrated 
Windows Authentication and Other Applications” on page 108, return to that page to 
continue.
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Microsoft Windows Domain Single Sign-On

Windows Domain single sign-on (SSO) support allows a user authenticated by Access 
Manager to access Windows applications (for example, Microsoft Outlook) without 
retyping logon credentials. Together, this feature and the IWA feature provide SSO for 
users in Windows environments. Windows Domain SSO normally occurs in the 
following series of steps:

1. The user attempts to load a page protected by Access Manager in his or her 
browser.

2. Access Manager prompts the user for logon credentials, authenticates the user, 
and, if successful, grants access to the page.

3. The user attempts to access a protected Windows application, such as Outlook 
Web Access.

4. The RSA Access Manager Agent passes user credentials to the Windows 
application. How this is done depends on the Agent configuration.

Setting Up UPN Mapping for Windows Domain Single Sign-On

To set up Windows Domain SSO, follow the steps in “Setting Up Windows User 
Principal Name Mapping for Integrated Windows Authentication” on page 158. 

Note: In addition, you must set up your RSA Access Manager Agents. For more 
information, see “Windows Domain SSO with Outlook Web Access” in the 
RSA Access Manager Agent for Installation and Configuration Guide.

If you use the Attribute Lookup method to obtain UPNs, and if your users are stored in 
Active Directory, Access Manager provides a Dynamic Creation feature that allows 
the system to handle users without UPNs. When Access Manager encounters a user 
without a UPN, it generates the UPN from the user’s sAMAccountName and DN data. 
This is useful in cases where the UPN does not exist for some or all users. For 
example, in some environments UPNs are not exported to the Global Catalog. 

NTLM Authentication

Access Manager can authenticate users against a Windows primary domain controller 
(PDC) using NTLM. Basic configuration of NTLM is accomplished by editing the 
cleartrust.aserver.ntlm_domain_controllers parameter in the aserver.conf file.

The Authorization Server uses the jCIFS library to communicate with domain 
controllers. In certain situations, it may be necessary to tune the jCIFS settings for 
better compatibility (for example, to provide NTLMv2 support), security (for 
example, to use only NTLMv2), or to optimize performance in a particular Windows 
environment. This tuning is done by passing jCIFS its own properties file. To do this, 
see the cleartrust.aserver.jcifs.configuration parameter in the aserver.conf file.
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Note: If NTLMv2 authentication is enabled, users must enter the domain component 
of the logon credentials using uppercase letters. Authorization fails if lowercase letters 
are used.

In order to perform NTLM authentication in the RSA Access Manager Agents, you 
must use version 4.7 or later Agents.

Multidomain NTLM Authentication 

You can also perform NTLM authentication in a multidomain environment, however 
this requires some additional setup. In order to enable NTLM authentication for users 
spread across multiple domains:

• You must create trust relationships between all of the domains that have domain 
controllers with which the Authorization Server communicates.

• You may have to create user mappings between each user’s Access Manager User 
ID and his or her Windows domain\user name combination.

Creating Domain Trust Relationships 

Perform the following steps to create a trust relationship. For more information, see 
your Microsoft documentation. 

To create a trust relationship: 

1. Open Active Directory Domains and Trusts, and click Start > Programs > 
Administrative Tools > Active Directory Domains and Trusts.

Note: The system must accept your password in both the trusting and the trusted 
domains. 

Use Run as to administer a domain to which you are not currently logged on. 

2. In the console tree, right-click the domain node for the domain you want to 
administer, and click Properties. 

3. Click the Trusts tab. 

4. Depending on your requirements, click either Domains trusted by this domain 
or Domains that trust this domain, and click Add. 

5. Type the full DNS name of the domain.

6. Type the password for this trust, and confirm the password. 

7. Repeat this procedure on the domain that forms the other part of the explicit trust 
relationship. 
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Setting Up Windows User Name Mapping 

With multiple domains, it is possible to have users in more than one domain with the 
same Windows user name. For example, domains SF and NY may both contain a user 
“barney”. When users authenticate using NTLM, they provide their user name in the 
form domain\sAMAccountName, where “sAMAccountName” is the Active Directory 
user attribute that stores the User ID. Access Manager needs to map this form to the 
Access Manager User ID in order to successfully create tokens and provide access 
control for users. For more details on user identity mapping, see “User Identity 
Mapping for Integrated Windows Authentication and Other Applications” on page 
108. 

Choose the appropriate instructions for your installation:

• See the following section, “Attribute Lookup” if you store users in an LDAP 
directory, and you already have an attribute containing the value 
domain\sAMAccountName for each user.

• See “Manual Lookup” on page 162 if your data store does not contain an attribute 
holding domain\sAMAccountName. If your users are stored in an SQL database, 
you must use the Manual Lookup option.

Note: These two lookup types are mutually exclusive. Choose one type.

Attribute Lookup

Attribute lookup of Access Manager User IDs assumes that each user record in your  
data store contains the user’s domain\sAMAccountName. Access Manager loads each 
user’s domain\sAMAccountName from the attribute you specify using the 
user.attributemap.windowssam parameter. This procedure works for LDAP directories 
only.

To create name mapping using attribute lookup:

1. Open your ldap.conf file.

2. Set the Access Manager .data.ldap.user.attributemap.windowssam parameter to 
the name of the LDAP attribute that contains user domain\sAMAccountName.

3. Save the ldap.conf file, and restart your Servers. 
After authentication against a domain controller, Access Manager uses the 
domain\sAMAccountName entered by the user in order to find the Access 
Manager User ID.

Manual Lookup

If your user records do not contain an attribute holding domain\sAMAccountName, 
create the mappings manually in the Access Manager store. 
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To create name mappings using manual lookup: 

1. Set up the data store:

• SQL users: No preparation is required. Continue with step 2.

• LDAP users: You must create a domain\sAMAccountName entry for each 
user. For more information, see “User Identity Mapping for Integrated 
Windows Authentication and Other Applications” on page 108.

2. From AXM_HOME/sdk/java/admin/example, compile and run 
UserMappingExample. 

3. Follow the program’s prompts to create a mapped domain\sAMAccountName for 
each user in your store. 

Note: In a typical installation, modify this program to facilitate the bulk creation 
of mappings for many users. 

Note: The domain to be used in place of CT_WINDOWS_UPN is 
CT_WINDOWS_NTLM. Domain refers to the user mapping type in the Access 
Manager data store.

4. From AXM_HOME/sdk/java/runtime/example, check your mapped 
domain\sAMAccountName using UserMappingRTExample.

RSA Adaptive Authentication

RSA Adaptive Authentication is a flexible, layered authentication solution designed to 
tighten security and lower transaction risk. It uses device fingerprints to determine the 
risk of end-user logons. Device fingerprint information is provided to the Adaptive 
Authentication Server for assessing risk and building user profiles.

When you integrate Access Manager and an Agent with the Adaptive Authentication 
Server, you get two levels of authentication. The first level of authentication is 
performed by the Adaptive Authentication Server and the second level of 
authentication is performed by Access Manager. You can configure the second level of 
authentication as Basic authentication or combination of Basic and RSA SecurID 
authentication. For information on configuring Adaptive Authentication on the Access 
Manager Server, see Chapter 15, “Integrating RSA Access Manager with RSA 
Adaptive Authentication.”

Note: Use RSA Access Manager Agent 4.9 SP1 or later with Access Manager to 
integrate with the Adaptive Authentication Server. For more information, see the 
Agent Installation and Configuration Guide.
9: Supported Authentication Types 163



RSA Access Manager 6.1 SP4 Servers Installation and Configuration Guide
Configuring Windows-Based Authentication

When the user ID to be authenticated is in UPN form, for example, abc@fzs.com, the 
Authorization Server binds to the directory corresponding to the fzs.com domain. The 
mapping between the domain and the directory must be defined in the 
ldap-activedirectory.conf file using the domain mapping parameter, and all the 
details must be defined for every directory.

The presence of a global catalog is required as the Authorization Server makes a call 
to the global catalog to make sure that the userID exists, before proceeding to perform 
authentication.

Note: The user ID must be in the UPN form for this feature to work.
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10Deploying Runtime and Administrative Web 
Services

• Overview of Runtime Web Service Installation

• Deploying the Runtime Web Service Web Application Archive File

• Configuring the RSA Access Manager Runtime Web Service

• Overview of Administrative Web Service Installation

• Deploying the Administrative Web Service Web Application Archive File

• Configuring the RSA Access Manager Administrative Web Service

A web service is a software component, deployed at a URL, that serves requests from 
other systems made using XML-based messaging protocols. It is independent of 
platform and programming language.

RSA Access Manager Runtime and Administrative web services are optional server 
components that expose the Access Manager Runtime and Administrative APIs to 
other applications without requiring them to embed the JAR file or shared library.

The Runtime Web Service allows client applications to perform tasks such as 
authenticating users, authorizing users to resources, fetching user properties, and 
manipulating single sign-on tokens, all in a platform and language-agnostic way. The 
Administrative Web Service allows client applications to perform tasks such as 
creating and managing users, groups, and applications.

Using anonymous and mutually authenticated Secure Sockets Layer (SSL), Access 
Manager supports secure connections between the web service and supported 
application servers.

For this release, RSA has certified the Runtime web services and Administrative web 
services on the application servers listed under “Runtime Web Service Requirements” 
and “Administrative Web Service Requirements” respectively on page 21.

This chapter describes setting up secure connections between the Access Manager 
Runtime and Administrative web services and your application server, deploying the 
Web Application Archive (WAR) file for the web services, and editing parameters in 
the web.xml file.

Overview of Runtime Web Service Installation 

Before you deploy Runtime Web Service, make sure that:

• The LDAP directory host or SQL database host is running.

• The Access Manager Server components are installed.

• The Access Manager license file is in place.
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• The Access Manager Data Adapters are installed.

• You have tested the communication between your Access Manager Servers and 
your data hosts.

To install the Access Manager Runtime Web Service, you must:

1. Set up your application server environment as described in the documentation 
from the application server vendor. This step includes enabling SSL connections if 
you plan to use secure connections between the Runtime Web Service and your 
application server. For more information, see the following section, “Application 
Server SSL Configuration.”

2. In your application server administration environment, deploy the WAR file 
(axm-ws-runtime-api.war)for the Access Manager Runtime Web Service. For 
more information, see “Deploying the Runtime Web Service Web Application 
Archive File” on page 167.

3. Configure the Access Manager Runtime Web Service by editing parameters in the 
web.xml file. For more information, see “Configuring the RSA Access Manager 
Runtime Web Service” on page 169.

Application Server SSL Configuration

Access Manager supports secure connections with anonymous and mutually 
authenticated SSL between the Runtime Web Service and your application server. 

For instructions on setting up secure connections, see the appropriate section for your 
application server:

• The following section, “Setting Up SSL Connections for Tomcat” 

• “Setting Up SSL Connections for WebLogic” on page 167

Setting Up SSL Connections for Tomcat

To set up SSL connections for Tomcat, you need to:

• Establish trust between Tomcat and the client.

• Set up Tomcat to handle HTTPS and SSL.

To establish trust between Tomcat and the client:

Do one of the following:

• If you already have a PKCS #12 keystore, make a copy of it in Tomcat and the 
client machine, and go to the following procedure, “To set up Tomcat to handle 
HTTPS and SSL:”

• If you do not have a PKCS #12 keystore, establish trust properly through a 
certificate authority.
see “Installing the RSA Certificate Manager” on page 222.
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To set up Tomcat to handle HTTPS and SSL:

1. In your Tomcat installation, open Tomcat_version_number/conf/server.xml.

2. Uncomment the following section:
<Connector className="org.apache.coyote.tomcat4.CoyoteConnector"
               port="8443" minProcessors="5" maxProcessors="75"
               enableLookups="true"
       acceptCount="100" debug="0" scheme="https" secure="true"
               useURIValidationHack="false" disableUploadTimeout="true">
      <Factory className="org.apache.coyote.tomcat4.

CoyoteServerSocketFactory" clientAuth="false" protocol="TLS" />
    </Connector>

3. Change the port from 8443 to some other value, if necessary.

4. Add keystoreFile, keystorePass, and keyStoreType attributes to the “Factory” 
element, and give them appropriate values, as follows:
<!--  Define a SSL Coyote HTTP/1.1 Connector on port 8443 --> 
<Connector className="org.apache.coyote.tomcat4.CoyoteConnector"
               port="8443" minProcessors="5" maxProcessors="75"
               enableLookups="true"
       acceptCount="100" debug="0" scheme="https" secure="true"
               useURIValidationHack="false" disableUploadTimeout="true"> 
<FactoryclassName="org.apache.coyote.tomcat4.CoyoteServerSocketFactory"

keystoreFile="path to server.keystore"
       keystorePass="password"
               keystoreType="key store type"

clientAuth="false" protocol="TLS" />

5. Start Tomcat.

Setting Up SSL Connections for WebLogic

For information on how to set up secure connections between the Access Manager 
web service and WebLogic, see your Oracle WebLogic documentation.

Deploying the Runtime Web Service Web Application Archive File

This section describes how to deploy the Access Manager Runtime Web Service WAR 
file, axm-ws-runtime-api.war, on supported application servers. The WAR file is the 
package that contains the program files required by the Access Manager Runtime Web 
Service. In both Windows and UNIX, the axm-ws-runtime-api.war file is located in 
the AXM_HOME/webapps directory.
10: Deploying Runtime and Administrative Web Services 167



RSA Access Manager 6.1 SP4 Servers Installation and Configuration Guide
For instructions on deploying the Runtime Web Service WAR file, see the appropriate 
section for your application server:

• The following procedure, “To deploy the WAR file on Apache Tomcat:” 

• “To deploy the WAR file on WebLogic:” on page 168

Note: Steps for deploying the Runtime Web Service WAR file on your application 
server are the same for Windows or UNIX. The examples provided in the following 
sections use Windows directory paths. If using UNIX, substitute with the appropriate 
UNIX paths.

To deploy the WAR file on Apache Tomcat:

1. Copy the axm-ws-runtime-api.war file to the webapps directory in your Tomcat 
installation.

2. Restart the Tomcat application server.

3. Go to the webapps/axm-ws-runtime-api/WEB-INF directory, and open 
web.xml.

4. Configure the Access Manager Runtime Web Service. 
For more information, see the following section, “Configuring the RSA Access 
Manager Runtime Web Service.” 

To deploy the WAR file on WebLogic:

1. Under the WebLogic domain application directory, create a directory named 
“axm-ws-runtime-api”. For example:

C:\bea\user_projects\mydomain\applications\axm-ws-runtime-api

2. From AXM_HOME/webapps, unzip the axm-ws-runtime-api.war file into this 
newly created directory.

3. Configure the Access Manager Runtime Web Service. 
For more information, see the following section, “Configuring the RSA Access 
Manager Runtime Web Service.”
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Configuring the RSA Access Manager Runtime Web Service

To configure the Access Manager Runtime Web Service:

1. Go to \WEB-INF in the directory where you unzipped the 
axm-ws-runtime-api.war file, and open web.xml.

2. Edit the following parameters.

Parameter Name
<param-name>

Description

cleartrust.ws.rtapi.enable_multi_refs Enables support for multiple references in the 
SOAP messages. Sending multiple reference 
has however interoperability issues with 
.NET clients. This parameter can be set to 
'false' in such circumstances.

cleartrust.ws.rtapi.direct This parameter specifies whether to create an 
authenticated server pool from a List of 
ServerDescriptor objects or from a server 
dispatcher.

cleartrust.ws.rtapi.server_list This parameter gives the host names (or IP 
addresses) and port numbers of the 
Dispatcher Servers.

cleartrust.ws.dispatcher.timeout This parameter specifies the timeout in 
milliseconds to be used in all authorization 
server requests. A value of 0 is interpreted as 
an infinite timeout.

cleartrust.ws.aserver.round_robin This parameter identifies whether the pool 
will run in round robin mode or not.

cleartrust.ws.aserver.retry_count The number of attempts the Runtime API 
client makes in trying to establish a valid 
Authorization Server connection. Each 
attempt is an attempt to contact one server in 
the list. For most installations, RSA 
recommends that you set this to the maximum 
number of Authorization Servers that you 
expect to run simultaneously.

cleartrust.ws.aserver.timeout This parameter specifies the time interval in 
milliseconds to wait without receiving a 
response from an Authorization Server before 
declaring it unavailable.

cleartrust.ws.aserver.group_preference_list This parameter is an ordered array of String 
location class codes.
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cleartrust.ws.rtapi.enable_property Enables the retrieval of properties per request. 
When set to True, all properties defined for 
the user are retrieved for every request, unless 
the service specifically overrides this setting 
through the "propertyOptionEnabled" or the 
"appPropertyOnly" options available in the 
Runtime Web Services WSDL file. For more 
information, see the reference version of the 
WSDL file.

cleartrust.ws.rtapi.enable_token Enables the retrieval of session tokens per 
request. When set to True, the session token 
is retrieved for every request, unless the 
service specifically overrides this setting 
through the "tokenContentBack" option 
available in the Runtime Web Services 
WSDL file. For more information, see the 
reference version of the WSDL file.

cleartrust.ws.rtapi.enable_group Enables the retrieval of group memberships 
per request. When set to True, the user's 
group memberships are retrieved for every 
request, unless the service specifically 
overrides this setting through the 
"groupOptionEnabled" option available in the 
Runtime Web Services WSDL file. For more 
information, see the reference version of the 
WSDL file.

cleartrust.ws.rtapi.log.filename Sets the name of the log file into which the 
Runtime Web Service writes its log messages.

cleartrust.ws.rtapi.log.level Determines which events are recorded in the 
log file. The level of severity is as follows: 
OFF, FATAL, ERROR, WARN, INFO, 
DEBUG, and ALL. The All level provides the 
most debugging information.

cleartrust.ws.rtapi.log.server_host This parameter is used to specify the 
hostname of the Log Server. When this 
parameter is set, all log messages are sent to 
the Log Server instead of being logged to a 
local file. 

cleartrust.ws.rtapi.log.server_port This parameter is used to specify the port 
number of the Log Server.

Parameter Name
<param-name>

Description
170 10: Deploying Runtime and Administrative Web Services



RSA Access Manager 6.1 SP4 Servers Installation and Configuration Guide
cleartrust.ws.http.enable_basic_auth Enables HTTP Basic Authentication of the 
client. Note that this authenticates the client, 
separate from user authentication.

cleartrust.ws.http.security_provider Modify these values only if you want to 
specify your own HTTP Basic Authentication 
provider with the full class name of the 
security provider. These default values 
specify the security provider native to Access 
Manager Runtime Web Services.

cleartrust.net.ssl.use Specifies the level of SSL security in 
communications between the RSA Access 
Manager Web Service and Access Manager 
Runtime API-an optional server component 
that is a client of the Java Runtime API. 
clear= cleartext, no encryption at all; anon= 
anonymous SSL, SSL encryption with no 
certificate authentication; auth = mutually 
authenticated SSL, SSL encryption with PKI 
certificate authentication.

cleartrust.net.ssl.ca.keystore_file Specifies the filename of the keystore where 
the issuing CA certificate is stored. Place this 
file in the /conf directory, or provide a path 
relative to the /conf directory. This file is used 
to validate the certificate chains of clients and 
servers connecting to the Runtime Service 
Web Service. Allowed values: Relative path 
and filename for the CA keystore.

cleartrust.net.ssl.ca.keystore_type The type of keystore in which the CA 
certificate is stored. PKCS12 = the PKCS#12 
standard.

cleartrust.net.ssl.ca.keystore_provider The provider of the keystore algorithm used 
for unlocking and using the CA keystore.

cleartrust.net.ssl.ca.keystore_passphrase The passphrase needed to unlock the CA 
keystore.

Parameter Name
<param-name>

Description
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3. Save web.xml, and restart your application server.

Overview of Administrative Web Service Installation

Before you deploy Administrative Web Service, make sure that:

• The Servlet 2.3 Container is running.

• The JDK 1.5 or JDK 1.6 is installed.

• The LDAP directory host or SQL database host is running.

• The Access Manager Server components are installed.

• The Access Manager license file is in place.

• The Access Manager Data Adapters are installed.

• You have tested the communication between your Access Manager Servers and 
the data hosts.

cleartrust.net.ssl.private.keystore_file The filename of the keystore where the 
private key for this is stored. This file must be 
placed in the /conf directory of your Access 
Manager installation. If it is not placed in the 
/conf directory, you must provide the relative 
path information to this file as well. This file 
is used for client authentication between 
Access Manager components.

cleartrust.net.ssl.private.keystore_type The PKCS#12 standard

cleartrust.net.ssl.private.keystore_provider The provider of the keystore algorithm used 
for unlocking and using the private keystore.

cleartrust.net.ssl.private.keystore_passphrase The passphrase needed to unlock the keystore 
that holds the private key.

cleartrust.net.ssl.private.key_alias The alias (Common Name) of your private 
key in the keystore.

cleartrust.net.ssl.private.key_passphrase The passphrase needed to unlock the private 
key specified by 
cleartrust.net.ssl.private.key_alias.

Parameter Name
<param-name>

Description
172 10: Deploying Runtime and Administrative Web Services



RSA Access Manager 6.1 SP4 Servers Installation and Configuration Guide
To install the Access Manager Administrative Web Service, you must:

1. Set up your application server environment as described in the documentation 
from the application server vendor. This step includes enabling SSL connections, 
if you plan to use secure connections between the Administrative Web Service and 
your application server. For more information, see the following section, 
“Application Server SSL Configuration for Tomcat.”

2. In the application server administration environment, deploy the WAR file 
(axm-ws-admin-api.war)for the Access Manager Administrative Web Service. 
For more information, see “Deploying the Administrative Web Service Web 
Application Archive File” on page 174 .

3. Configure the Access Manager Administrative Web Service by editing parameters 
in the web.xml file. For more information, see “Configuring the RSA Access 
Manager Administrative Web Service” on page 175.

4. Place the axm-ws-admin-api.war file in the deployment directory of the server. 
For example, in case of Tomcat, place the file in <TOMCAT_HOME>/webapps. 
Also, you can deploy this file using the admin console of the server.

Best Practices for Installing Administrative Web Services

For security and better performance, RSA recommends the following best practices 
while installing Access Manager Administrative web services:

• Use SSL for the communication between the web service client and the 
Administrative Web Service.

• Use security constraints to secure web services Description Language (WSDL) 
end.

• Use separate application server instances for web service Administrative API and 
web service Runtime API.

Application Server SSL Configuration for Tomcat

Access Manager supports secure connections with anonymous and mutually 
authenticated SSL between the Administrative Web Service client and your Tomcat 
server.

To set up SSL connections for Tomcat, you need to:

• Establish trust between Tomcat and the client.

• Set up Tomcat to handle HTTPS and SSL.
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To establish trust between Tomcat and the client:

Do one of the following:

• If you already have a PKCS #12 keystore, make a copy of it in Tomcat and the 
client machine, follow the steps given in the following procedure “To set up 
Tomcat to handle HTTPS and SSL:.”

• If you do not have a PKCS #12 keystore, establish trust properly through a 
certificate authority.
see “Installing the RSA Certificate Manager” on page 222.

To set up Tomcat to handle HTTPS and SSL:

1. In your Tomcat installation, open Tomcat_version_number/conf/server.xml.

2. Uncomment the following section:
<Connector port="8443" maxHttpHeaderSize="8192"
maxThreads="150" minSpareThreads="25" maxSpareThreads="75"
enableLookups="false" disableUploadTimeout="true"
acceptCount="100" scheme="https" secure="true"
clientAuth="false" sslProtocol="TLS" />

3. Change the port from 8443 to some other value, if necessary.

4. Add keystoreFile, keystorePass, and keyStoreType attributes to the “Connector” 
element, and give them appropriate values, as follows:
<!--  Define a SSL Coyote HTTP/1.1 Connector on port 8443 --> 
<Connector port="8443" maxHttpHeaderSize="8192"
maxThreads="150" minSpareThreads="25" maxSpareThreads="75"
enableLookups="false" disableUploadTimeout="true"
keystoreFile="path to server:keystore" 
keystorePass="password"
acceptCount="100" scheme="https" secure="true"
clientAuth="false" sslProtocol="TLS" />

5. Start Tomcat.

Deploying the Administrative Web Service Web Application Archive 
File

This section describes how to deploy the Access Manager Administrative Web 
Service WAR file, axm-ws-admin-api.war, on supported application servers. The 
WAR file is the package that contains the program files required by the Access 
Manager Administrative Web Service. In both Windows and UNIX, the 
axm-ws-admin-api.war file is located in the AXM_HOME/webapps directory.

Note: Steps for deploying the Administrative Web Service WAR file on your 
application server are the same for Windows or UNIX. The examples provided in the 
following sections use Windows directory paths. If using UNIX, substitute with the 
appropriate UNIX paths.
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To deploy the WAR file on Apache Tomcat:

1. Copy the axm-ws-admin-api.war file to the webapps directory in your Tomcat 
installation.

2. Restart the Tomcat application server.

3. Go to the webapps/axm-ws-admin-api/WEB-INF directory, and open web.xml.

4. Configure the Access Manager Administrative Web Service. 
For more information, see the following section, “Configuring the RSA Access 
Manager Administrative Web Service.” 

To deploy the WAR file on WebLogic:

1. Under the WebLogic domain application directory, create a directory named 
“axm-ws-admin-api”. For example:

C:\bea\user_projects\mydomain\applications\axm-ws-admin-api

2. From AXM_HOME/webapps, unzip the axm-ws-admin-api.war file into this 
newly created directory.

3. Configure the Access Manager Administrative Web Service. 
For more information, see the following section, “Configuring the RSA Access 
Manager Administrative Web Service.”

Configuring the RSA Access Manager Administrative Web Service

To configure the RSA Access Manager Administrative Web Service:

1. Go to \WEB-INF in the directory where you unzipped the 
axm-ws-admin-api.war file, and open web.xml.

2. Edit the following parameters.

Parameter Name
<param-name>

Description

cleartrust.ws.admin.api.admin_api.hostname Hostname of the Entitlement Server

cleartrust.ws.admin.api.admin_api.port Port number of the Entitlement Server

cleartrust.ws.admin.api.session_timeout Session timeout period in milliseconds for the 
Access Manager web service Administrative 
API, which maintains an open connection to 
the entitlement Server for enhanced 
performance. RSA recommends to keep this 
value relatively smaller. 

Note: The timeout period for this parameter 
must be less than the accepted timeout period 
for the Entitlement Server in 
cleartrust.ws.admin.api.admin_api.timeout. 
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cleartrust.ws.admin.api.admin_api.use_ssl Level of SSL security in communication 
between the web service Administrative API 
and Administrative API. 

Allowed values:

• clear -cleartext, no encryption at all

• anon - anonymous SSL, SSL encryption 
with no certificate authentication

• auth - mutually authenticated SSL, SSL 
encryption with PKI certificate 
authentication.

cleartrust.net.ssl.ca.keystore_file Filename of the keystore where the issuing 
CA certificate is stored. 

Place this file in the classpath and provide a 
path relative to the classpath. This file is used 
to validate the certificate chains of clients and 
servers connecting to the Administrative 
Service web service. 

Allowed values: Relative path and filename 
for the CA keystore.

cleartrust.net.ssl.ca.keystore_type Type of keystore in which the CA certificate 
is stored. 

Allowed values: JKS or PKCS12

cleartrust.net.ssl.ca.keystore_provider The provider of the keystore algorithm used 
for unlocking and using the CA keystore.

Recommended value: This must not be set 
for almost all the installations. In the current 
implementation, this defaults to "null" which 
signifies "any available."

Dependencies: If you change the keystore 
provider, you may also need to edit the 
java.security configuration file for your java 
Virtual Machine (JVM) in order to ensure that 
the provider is available. This file is located 
in the /jre/lib/security directory of your 
Access Manager installation.

cleartrust.net.ssl.ca.keystore_passphrase Password to unlock the CA keystore

Parameter Name
<param-name>

Description
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cleartrust.net.ssl.private.keystore_file File name of the keystore where private keys 
for signing are stored. Place this file in the 
classpath and provide a path relative to the 
classpath. 

Allowed values: Relative path and filename 
for the private keystore.

cleartrust.net.ssl.private.keystore_type Password to unlock the private keystore

Allowed values: JKS or PKCS12

cleartrust.net.ssl.private.keystore_provider The provider of the keystore algorithm used 
for unlocking and using the private keystore.

Recommended value: This must not be set 
for almost all the installations. In the current 
implementation, this defaults to "null" which 
signifies "any available."

Dependencies: If you change the keystore 
provider, you may also need to edit the 
java.security configuration file for your Java 
Virtual Machine (JVM) in order to ensure that 
the provider is available. This file is located 
in the /jre/lib/security directory of your 
Access Manager installation.

cleartrust.net.ssl.private.keystore_
passphrase

Password to unlock the keystore that holds 
the private key.

cleartrust.net.ssl.private.key_alias Alias name of your private key in the 
keystore.

cleartrust.net.ssl.private.key_passphrase Password to unlock the private key specified 
by the cleartrust.net.ssl.private.key_alias 
parameter.

cleartrust.ws.admin.api.log.filename Name of the log file into which the 
administrative web services writes its log 
messages.

Parameter Name
<param-name>

Description
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cleartrust.ws.admin.api.log.level Determines which events are recorded in the 
log file. 

Set the level of severity to any one of the 
following:

• OFF

• FATAL

• ERROR

• WARN

• INFO

• DEBUG

• ALL - This level provides the most 
debugging information.

cleartrust.ws.admin.api.log.server_host Hostname of the Log Server.

When this parameter is set, all log messages 
are sent to the Log Server instead of being 
logged to a local file.

cleartrust.ws.admin.api.log.server_port Port number of the Log Server.

cleartrust.ws.admin.api.endrange End range in case of all Get commands and 
search commands. The default value is 500. 

cleartrust.ws.admin.api.Webserver
ManufacturersList

List of web server manufacturers supported.

When you add a newly supported Access 
Manager Web Server Agent to your 
deployment, add the corresponding web 
server product name to this list in order to 
assign types in the API.

Note: While creating a server, enter at least 
one manufacturer from the list. Else, the 
create server operation will not work.

cleartrust.ws.admin.api.AppserverManufact
urersList

List of application server manufacturers 
supported.

When you add a newly supported Access 
Manager Application Server Agent to your 
deployment, add the corresponding 
application server product name to this list in 
order to assign types in the API.

Note: While creating a server, enter at least 
one manufacturer from the list. Else, the 
create server operation will not work.

Parameter Name
<param-name>

Description
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3. SSL is mandatory for communication in Access Manager web service 
Administrative API calls. By default, this transport constraint is enabled. You can 
disable SSL by changing the value of the parameter <transport-guarantee> to 
None. 

Important: RSA recommends to have this transport level constraint enabled.

cleartrust.ws.admin.api.EnhancedAppserver
ManufacturersList

List of enhanced application server 
manufacturers supported.

When you add a newly supported Access 
Manager Application Server Agent to your 
deployment, add the corresponding 
application server product name to this list in 
order to assign types in the API.

Note: While creating a server, enter at least 
one manufacturer from the list. Else, the 
create server operation will not work.

cleartrust.ws.admin.api.DescriptionLength Length of the description that may be 
specified during creation of various entities.

cleartrust.ws.admin.api.NameLength Length of the name that must be specified 
during creation of various entities.

cleartrust.ws.admin.api.DisableUser
Extensions

When set to true, this parameter disables user 
extensions in systems where the data source 
is Active Directory. Since the Active 
Directory Data Adapter does not utilize user 
extensions, they must be disabled to prevent 
administrators from using those data fields.

Parameter Name
<param-name>

Description
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4. If required, to enable basic authentication uncomment the following sections:
<auth-constraint>

<description>
The Access Manager Web Service Admin API user role.
</description>
<role-name>admin_api_user</role-name>

</auth-constraint>

<login-config>
<auth-method>BASIC</auth-method>

</login-config>

<security-role>
<role-name>admin_api_user</role-name>

</security-role>

Note: RSA recommends you to enable basic authentication for web services to 
prevent unsolicited access of web services.

5. Save web.xml, and restart your application server.
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11 Deploying RSA Access Manager in 
Production Environments

• Deploying Components Across a Firewall

• Deploying Components on Multi-Homed Machines

• Redundancy and Failover

• Generating a Shared Secret Using Keygen

• Authorization Server Caching

• Next Steps

This chapter describes the configuration parameters required to deploy RSA Access 
Manager in a production environment. When deploying the Access Manager 
components in production, you must deploy the various components within your 
existing network architecture, including these possible scenarios, such as firewalls, 
network address translation, multihomed machines, redundant Access Manager 
components, the Authorization Server Cache, and the Virtual Web Server Hosts.

You must also deploy multiple Access Manager components to increase performance 
and stability. RSA does not recommend running all of your Access Manager Servers 
on one machine for a production deployment of Access Manager. 

The following table summarizes possible scenarios in different types of production 
architectures. For more information on each scenario, go to the section that relates to 
your production environment.

Production 
Scenario

Description

Firewalls In most production scenarios, you must deploy the Access Manager 
components on opposite sides of a firewall. This chapter contains the 
default ports for each of the Access Manager components, as well as the 
configuration parameters that you must change if you do not plan to use 
the default ports. 

For more information, see the following section, “Deploying Components 
Across a Firewall.”

Network 
Address 
Translation

If your network uses a Network Address Translation (NAT) firewall 
solution, you must configure Access Manager to correctly resolve both 
internal and external IP addresses. 

For more information, see “Network Address Translation” on page 185.
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Deploying Components Across a Firewall

For any two Access Manager components to communicate across a firewall, you must 
configure the firewall to allow connections on a specific port.

To run a particular component across the firewall from your Access Manager Servers, 
you must configure your firewall to allow particular TCP/IP connections from the 
Agents or API clients to the Access Manager Servers.

For extranet applications, you must run Access Manager components in various 
configurations with the firewall.

Multihomed 
Machines

For all Access Manager components deployed on machines with multiple 
Network Interface Cards (NICs), the components bind to their respective 
ports on all of the available IP addresses by default. If you do not want the 
Access Manager Server processes to bind to all interfaces, you must tell 
the server process which IP is the one to which it must bind.

For more information, see “Deploying Components on Multi-Homed 
Machines” on page 186.

Redundant 
Access 
Manager 
Components

You can deploy a high-availability architecture for the runtime 
authentication and authorization capabilities of Access Manager. In a 
production deployment, you can increase stability and maximize 
performance by deploying distributed Authorization Servers. You can 
eliminate single points of failure by setting up redundant Dispatcher/Key 
Servers and read-only replicas of your LDAP directory hosts. You can also 
set up a stand-by Entitlements Server to eliminate down time of the 
administrative capabilities of Access Manager. 

For more information, see “Redundancy and Failover” on page 187.

The 
Authorization 
Server Cache

In order to quickly fulfill authentication and authorization requests at 
runtime, Access Manager keeps requested records in the cache of the 
Authorization Servers. This speeds up response time, as the Authorization 
Server does not have to connect to the  data store to verify subsequent 
requests. 

For more information on configuring the cache, see “Authorization Server 
Caching” on page 197. This section also discusses an optional parameter 
controlling network performance, parameters for SSO Token caching, and 
steps for enabling native cryptography for SSO Tokens.

Virtual Web 
Server Hosts

You can install the RSA Access Manager Web Server Agent once on your 
web server host and configure it differently for each web site or domain 
served from that web server. 

For more information about setting up the Agent to protect virtual hosts, 
see your RSA Access Manager Agent documentation.

Production 
Scenario

Description
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You can configure the RSA Access Manager Agent and the API clients on the 
opposite side of the firewall from the Access Manager Servers.

Each component is configured separately and may be placed inside or outside the 
firewall regardless of how the other components are configured. The following figure 
shows the default port numbers and the flow of connections. The optional Log Server 
and the Instrumentation Server are not shown.
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Default Port Mapping Reference

The following table is a list of default ports used by the Access Manager processes. 
You can change the default ports if necessary, but you must also update the relevant 
port numbers in the Access Manager Server configuration files (aserver.conf, 
eserver.conf, dispatcher.conf, and keyserver.conf), Web Server Agent configuration 
file (webagent.conf), Application Server Agent configuration file (appagent.conf), 
and the RSA Administrative Console configuration file (admingui.cfg). 

Port 
Number

Description
Related Configuration File 
Parameter

5601 Administrative API port that the 
Administrative Console web 
application uses to connect to the 
Entitlements Server.

• cleartrust.eserver.api_port 
(eserver.conf)

• port (admingui.cfg)

5606 The port that the Web Server Agents 
and the Authorization Servers use to 
connect to the Key Server.

• cleartrust.keyserver.key_port 
(keyserver.conf)

• cleartrust.aserver.key_server_list 
(aserver.conf)

• cleartrust.agent.key_server 
(webagent.conf)

5607 The port that the Authorization Servers 
use to register with the Dispatcher.

• cleartrust.dispatcher.reg_port 
(dispatcher.conf)

• cleartrust.aserver.dispatcher.list 
(aserver.conf)

5608 The listener port that the Dispatcher 
uses to listen for connections from the 
Web Server Agents and the 
Entitlements Server/Administrative 
API.

• cleartrust.dispatcher.list_port 
(dispatcher.conf)

• cleartrust.agent.dispatcher_host 
(webagent.conf)

• cleartrust.eserver.dispatcher_list 
(eserver.conf)

5609 The port used for connections between 
Redundant Key Servers.

• cleartrust.keyserver.v2_key_port 
(keyserver.conf)

• cleartrust.keyserver.local_id 
(keyserver.conf)

• cleartrust.keyserver.
all_key_servers (keyserver.conf)

5615

5617

5619

5621

5623

Authorization Server Listener ports for 
Runtime API client requests and Web 
Server Agent requests. 5615 is the 
default Authorization Server port. The 
subsequent default port numbers are 
used if you are running more than one 
Authorization Server on the same 
machine.
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Network Address Translation

If your firewall uses Network Address Translation (NAT), perform the following 
configurations in your Access Manager installation. These configurations allow 
components on either side of the firewall to resolve to the appropriate internal or 
external IP address, as shown in the following figure.

389 or 
636

This is the port that the Authorization 
and the Entitlements Servers use to 
connect to the LDAP directory. The 
default listener port for LDAP directory 
hosts is 389. The default LDAPS port 
(for SSL connections to LDAP) is 636.

• cleartrust.data.ldap.directory.
<iplanet/Active 
Directory/eDirectory>.port (in 
ldap.conf)

80 or 443 Default HTTP port for web servers is 
80. Default HTTPS port (for SSL 
connections) is 443.

8100 Default port for JRun application 
server.

Port 
Number

Description
Related Configuration File 
Parameter

Server

RSA Access Manager
Data Store

RSA Access 
Manager Agent

NAT 
External IP Address

Internal IP Address

flush cache

authserver.company.com
=198.123.44.55

authserver.company.com
=111.222.333.44

Authorization
Server

Dispatcher/Key
Server

Entitlements
Server
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To configure RSA Access Manager for NAT:

1. Create an entry in the host file (or the internal DNS) of your Entitlements Server 
machine to make the Authorization Server hostname resolve to the internal IP 
address of the Authorization Server. On Windows, you can find the host file in 
C:\WINNT\system32\drivers\etc\hosts. On UNIX you can find this file in 
etc/hosts. 

2. Create an entry in the host file (or the external DNS) of your web server machine 
to make the Authorization Server hostname resolve to the external IP address of 
the Authorization Server.

3. Open the aserver.conf file for the Authorization Server, and enter the hostname to 
publish to the Web Agents and the other Access Manager Servers:

cleartrust.aserver.export_address=authserver.domain.com

If this parameter is left blank, the Authorization Server is known by its internal IP 
address only. 

4. Open the dispatcher.conf file, and enter the hostname of the Authorization 
Server:

cleartrust.dispatcher.plugin_auth_format=hostname

This step allows the Agents and Runtime API clients to contact this Authorization 
Server by its hostname instead of by its IP address.

5. Restart your Dispatcher and Authorization Servers for the new settings to take 
effect.

Deploying Components on Multi-Homed Machines

For all Access Manager components deployed on machines with multiple Network 
Interface Cards (NICs), the components bind to their respective ports on all of the 
available IP addresses by default.

If you do not want the Access Manager Server processes to bind to all interfaces, you 
must designate a single IP address. This can be configured using the following 
parameters in the Access Manager Server configuration files in the 
AXM_HOME/conf directory.

Authorization Server (aserver.conf)

• Set the multi_home_address for the Authorization Server. For example:
cleartrust.aserver.multi_home_address=111.222.33.44 

• Specify the export_ address that the Authorization Server uses to communicate 
with the Dispatcher. For example:
cleartrust.aserver.export_address=111.222.33.44
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Dispatcher (dispatcher.conf)

• Set the multi_home_address for the Dispatcher. For example: 
cleartrust.dispatcher.multi_home_address=111.222.33.44

• Edit all the parameters in the dispatcher.conf and webagent.conf files that have 
localhost, DNS name, and IP address to reflect a second IP address for the host.

Entitlements Server (eserver.conf)

Set the multi_home_address for the Entitlements Server. For example: 
cleartrust.eserver.multi_home_address=111.222.33.44

Redundancy and Failover

You can install additional Access Manager Servers to increase runtime performance 
and stability, and to eliminate single points of failure in your Access Manager system. 

A standard installation of the Access Manager Servers installs all the Server 
components on one host. For a production installation, however, RSA recommends 
that you use a distributed deployment with each Access Manager runtime component 
on its own host. 

Access Manager supports high-availability and scalability for its runtime 
authentication and authorization operations. For failover, each runtime component 
(Authorization Server, Dispatcher/Key Server, and data store) must also have at least 
one redundant component.
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The following figure shows a distributed deployment that provides redundancy for 
runtime Access Manager Servers.

Failover

The Access Manager system architecture provides for failover using redundant 
Authorization Servers and Dispatcher/Key Servers, ensuring that an Agent can always 
find at least one available Server. 

Redundant Authorization Servers can be installed on one host or on multiple hosts. 
Failover is configured in either standard mode or in distributed mode: 

Standard mode. All Agent requests are sent to a single Authorization Server until a 
failure occurs. Then, requests are routed to the next server in the list.
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Distributed mode. Each Agent request is sent to the Authorization Server that has the 
lowest number of outstanding requests. This routes more requests to those 
Authorization Servers that are capable of higher throughput and quickly adapts to the 
current load on each Server.

For more information about configuring failover, see your Agent Configuration 
Guide.

Deploying Redundant Servers on a Single Host

Though RSA recommends that you deploy each redundant Server on a separate host in 
a production environment, you can deploy multiple Servers on a single host for testing 
purposes. To do this, you must perform special installation and setup tasks (in addition 
to the steps described separately in this chapter) for each of the Access Manager 
Servers. 

These additional steps are the same for all Servers. Follow these steps for redundant 
Entitlements Servers, Dispatcher/Key Servers, and Authorization Servers when they 
are installed on the same host, and then proceed to the Server-specific configuration 
tasks. 

To deploy redundant Servers on a single Windows host:

1. Copy the contents of the Access Manager installation directory (by default, 
C:\Program Files\RSA\Access Manager Servers 6.1) to another, separate 
directory on the host. For example, create a destination directory \RSA-copy, and 
copy the contents of \RSA to \RSA-copy.

2. In your newly created \RSA-copy directory, open the \bin directory.

3. Edit each server_type.bat file (for example, aserver.bat). Change the 
AXM_HOME variable to point to the new directory. For example:
set AXM_HOME=C:\PROGRA~1\RSA\ACCESSM~6.1
to
AXM_HOME=C:\PROGRA~1\RSA-copy\ACCESSM~6.1

Note: In aserver.bat only, there is an additional variable to modify in the .bat file. 
Change the LISTEN_PORT variable to a valid port, separate from the other 
Servers. The listener port must be specified here as well as in step 4.

4. In your newly created \RSA-copy directory, open the \conf directory.

5. Edit the configuration files for the redundant Servers to reflect different port 
settings than the first Servers. Check the dependencies noted in the comments for 
each parameter.

Note: You will not be able to run the redundant Servers as Windows services.
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To deploy redundant Servers on a single UNIX host:

1. Copy the contents of the Access Manager installation directory (/usr/axm or 
/opt/axm, depending on your operating system) to another, separate directory on 
the host. In this example, we call the destination directory /axm-copy/. For 
example, on Solaris you would copy the contents as follows:
# cp -r /opt/axm/server-61 /opt/axm-copy

2. In your newly created /axm-copy directory, change to the /bin directory.

3. Edit the servertype.sh file (for example, aserver.sh). Modify the line that sets the 
AXM_HOME variable. For example, on Solaris you would change the setting 
from:
AXM_HOME=${AXM_HOME:-/opt/axm
to
AXM_HOME=${AXM_HOME:-/opt/axm-copy
Change the path /usr or /opt as appropriate for your operating system.

Note: For the Authorization Server only, there is an additional variable to modify 
in the .sh file. Change the LISTEN_PORT variable to a valid port, separate from 
the other Servers. The listener port must be specified here as well as in step 4.

4. Edit the configuration file for the second server to reflect different port settings 
than the first server. Check the dependencies noted in the comments for each 
parameter.

5. In your /axm-copy directory, change to the /var directory. If there are .pid files 
there, delete them.

Deploying Distributed Authorization Servers

By deploying distributed Authorization Servers, it is possible to run the Servers on 
Windows and UNIX hosts simultaneously. You can also distribute your Authorization 
Servers across multiple physical locations. For more information, see “Setting Up 
Geographically Distributed Authorization Servers” on page 192.

Setting Up a Distributed Authorization Server

Setting up a distributed Authorization Server involves making a second Access 
Manager installation on a different host. This creates a standalone Authorization 
Server that uses its own aserver.conf file and requires its own copy of the license.xml 
file.

To set up a distributed Authorization Server:

Note: This procedure assumes that you have already installed and configured Access 
Manager on a single host.
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1. Using standard installation, install the Access Manager Servers on a different host 
from your primary Access Manager Servers. For more information, see Chapter 2, 
“Installing the RSA Access Manager Servers.”

2. Edit the aserver.conf file located in the /conf directory of your second Access 
Manager Servers installation. See the comments for each parameter to set the 
correct values.

3. Copy the Data Adapter configuration file (sql.conf or ldap.conf) from your 
original Access Manager Servers installation, and place it in the /conf directory of 
your second installation. See the comments for each parameter to set the correct 
values.

4. Using the keygen utility on your primary Access Manager installation, generate a 
secret key for the host that is running the second installation. Export and manually 
copy this key into the KeyClient.sec file on the second Access Manager host.

Note: Keys for all redundant Authorization Servers must be generated on the 
primary installation, that is, the first machine on which the Dispatcher/Key Server 
is installed, and for which a KeyServer.sec file is automatically created.

A KeyClient.sec file is automatically generated in each redundant Authorization 
Server installation. Replace the key string in this file with the key string you 
generate and export from the primary installation.

5. Copy license.xml from the license CD included in your Access Manager product 
package to the /conf directory of your second Access Manager installation. 

6. Open the webagent.conf files for your Web Server Agents, and set the value of 
the cleartrust.agent.auth_server_mode parameter to “DISTRIBUTED”.

7. Make sure that your primary data store is running, and manually start the 
Authorization Server on your second Access Manager installation.

• For Windows, see “Starting the RSA Access Manager Servers as Windows 
Applications” on page 124 for directions about running aserver.bat.

• For UNIX, see “Starting the Servers Manually on UNIX” on page 126 for 
directions about running aserver.sh.

Note: Disable windows services and entries in the axm book script on UNIX.
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Setting Up Geographically Distributed Authorization Servers

each web server protected by To set up geographically distributed Authorization 
Servers:

1. Install and configure your distributed Authorization Servers. For more 
information, see “Setting Up a Distributed Authorization Server” on page 190.

2. Configure all of the Authorization Servers that are in the same geographic 
location with the same location class. A location class can be any name, such as 
LA, NY, UK, east_coast, and so on. Use the name consistently in all 
webagent.conf files for the Agents and all aserver.conf files for the 
Authorization Servers in that location. To set the location class for the 
Authorization Server, set the cleartrust.aserver.location_class parameter in the 
aserver.conf file. For example:

cleartrust.aserver.location_class=NY

3. In the webagent.conf file, specify the location class of Authorization Servers that 
a particular Web Server Agent uses. If you are using more than one location class, 
set the priority using the cleartrust.agent.location_class_priority parameter. The 
Agent uses the Authorization Servers in the first location specified. If no 
Authorization Servers are available in that location, the Agent tries the remaining 
locations in the order specified. For example:

cleartrust.agent.location_class_priority=NY,LA,UK
When the cleartrust.agent.auth_server_mode parameter is set to DISTRIBUTED, 
the round-robin use of hosts is restricted to the primary location class (for 
example, it will round-robin across NY hosts only) as long as a Server is still 
available in the primary location class. If all hosts in the primary location class are 
down, the system tries the second location class in the list. If no Authorization 
Servers are available in the second location class, the system tries the third 
location class, and so on.

4. Restart your web servers and Authorization Servers for the settings to take effect.

Deploying Redundant Dispatcher/Key Servers

To ensure correct cache data invalidation, the Authorization Servers must all have the 
same list of Dispatcher/Key Servers.

During deployment, you must install redundant Dispatcher/Key Servers and configure 
them to communicate with each other, with the Authorization Servers, and with the 
Web Server Agents. For single sign-on (SSO) functionality between Web Server 
Agents, all Agents must be configured to use the same set of Dispatcher/Key Servers. 
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To set up redundant Dispatcher/Key Servers:

1. Install the Access Manager Server on a different host from your primary Access 
Manager Servers. For instructions, see Chapter 2, “Installing the RSA Access 
Manager Servers.”

2. Set or modify the following parameters in the primary Access Manager Server 
configuration files so that all Dispatcher/Key Server hostname and port 
information is listed. For more information on each parameter setting, see 
Appendix A, “Configuration Files.”
Key Server (keyserver.conf):

cleartrust.keyserver.key_port=5606
cleartrust.keyserver.keyserver_list=lucy.rsa.com:5609,charlie.rsa.com:5609
cleartrust.keyserver.v2_key_port=5609

The Key Server list must be exactly the same for all redundant Key Servers.
Dispatcher (dispatcher.conf):

cleartrust.dispatcher.reg_port=5607
cleartrust.dispatcher.list_port=5608

Authorization Server (aserver.conf):
cleartrust.aserver.keyserver_list=lucy.rsa.com:5606,charlie.rsa.com:5606
cleartrust.aserver.dispatcher_list=lucy.rsa.com:5607,charlie.rsa.com:5607

Entitlements Server (eserver.conf):
cleartrust.eserver.dispatcher_list=lucy.rsa.com:5608,charlie.rsa.com:5608

3. Copy the primary Access Manager Server configuration files to the /conf 
directory of your redundant Dispatcher/Key Server installation. Make sure that the 
following parameter in the keyserver.conf file is specific to that redundant Key 
Server machine:

cleartrust.keyserver.local_id=lucy.rsa.com:5609

Note: The parameter cleartrust.aserver.keyserver.local_id must be specific to each 
Key Server and its own keyserver.conf file. All list parameters, conversely, must 
be identical. 

4. Copy the KeyServer.sec file from the original Dispatcher/Key Server to the /var 
directory location on the redundant Key Server. You must recopy this file to the 
backup machine each time a new key is added to the primary Dispatcher/Key 
Server.

5. Make certain that a copy of your license file (license.xml) is located in the /conf 
directory of each Dispatcher/Key Server installation.

6. Set or modify the following parameters in the webagent.conf file for all Web 
Server Agents that interact with the redundant Dispatcher/Key Servers.
Web Server Agents (webagent.conf):

cleartrust.agent.dispatcher_list=lucy.rsa.com:5608,charlie.rsa.com:5608
cleartrust.agent.keyserver_list=lucy.rsa.com:5606,charlie.rsa.com:5606

7. Restart your web server(s), primary Access Manager Servers, and the redundant 
Dispatcher/Key Server process.
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Deploying a Standby Entitlements Server

The Entitlements Server can be deployed in a fashion that supports hot failover. The 
basic design premise is to use a high-availability/dispatching solution to front end a set 
of Entitlements Servers. One of these Entitlements Servers is the system. As long as 
this system is up and running, all requests from the Administrative Console, 
Administrative API, or both are routed to the default system. If the default system 
fails, future requests are routed to one of the other Entitlements Servers—the Server 
that is the new default. Clients of the Entitlements Server (Administrative Consoles 
and Administrative API clients) see a connection failure when the Entitlements Server 
fails and must reconnect.

Implementing Entitlements Server Failover

You can implement hot failover for Entitlements Servers. This allows a different 
machine running an Entitlements Server to take over the IP address of the default 
server machine when it goes down.

You can use a hardware or software solution to implement Entitlements Server 
failover. A hardware solution is the simplest method. Use load balancer hardware such 
as the Cisco LocalDirector and F5 BigIP. 

To set up a hardware solution:

1. Install and configure at least two hosts as individual standalone Entitlements 
Servers. These machines must have different hostnames and IP addresses.

2. Configure the load balancer hardware so it fails over the default Entitlements 
Server host to the backup Entitlements Server on the second host.
Load balancer hardware is designed to have a virtual IP address on one side and 
standalone hosts on the other.
The Administrative Console is now set up to point to the virtual IP instead of a 
particular Entitlements Server host IP address.

To set up a software solution:

This solution requires the installation of high-availability (HA) tools on the hosts. 
Consult the high-availability software documentation (for your chosen HA product) 
for information on how to implement HA for an Access Manager product.

Generating a Shared Secret Using Keygen

The Access Manager installer automatically creates a secret key when you install the 
Entitlements Server and Dispatcher/Key Server. This key is sufficient only for running 
the Access Manager Servers installed on the same host where the Dispatcher/Key 
Server is installed. When you add the Access Manager Authorization Servers and 
Agents on other machines, you must generate a new secret key for each machine 
where an Agent or the Authorization Server is installed.
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If you locate an Authorization Server on a different host from the Dispatcher (for 
example, if you deploy redundant Authorization Servers), you must use the Access 
Manager keygen utility (running on the Dispatcher/Key Server host) to generate a new 
key for that Authorization Server on that host. This key is saved in the shared secret 
file of the Dispatcher/Key Server (AXM_HOME\var\KeyServer.sec), and you must 
copy it into the shared secret file of the Authorization Server 
(AXM_AUTH_SERVER_HOME\var\KeyClient.sec).

Note: When you are using multiple Authorization Servers, the KeyClient.sec entries 
for all the Authorization Servers must be available in the KeyServer.sec file on all 
Key Server hosts.

Access Manager keygen is a simple command line application that takes the hostname 
of the Authorization Server machine as input and generates a text string, saving that 
string to the KeyServer.sec file of the Dispatcher/Key Server. This text string is the 
shared secret.

After generating a key, you must copy the shared secret information into the 
KeyClient.sec file that resides in the /var directory of your Access Manager 
Authorization Server installation. 

The command line flags you use with keygen are:

-a client client.domain.com, to add another server to the Key Server list and 
display the key
-e client, to export the secret key data about a given server from the list
-v client, to view a list of all secret keys already added to the Key Server list
-s client, to set a password for a secret key
-d client client.domain.com, to delete a key from the Key Server list

The procedure for adding an Agent secret is similar. For more information, see your 
RSA Access Manager Agent documentation.

Creating a Shared Secret on Windows

When you install an Authorization Server on a host other than your Dispatcher/Key 
Server host, you must create a shared secret to enable that Authorization Server to 
work with your Key Server. 

To add a shared secret using the RSA Access Manager keygen utility:

1. Manually enable the write permissions on these files:

• AXM_HOME\var\KeyServer.sec
AXM_HOME is where your Key Server/Dispatcher is installed

• AXM_AUTH_SERVER_HOME\var\KeyClient.sec
AXM_AUTH_SERVER_HOME is where your Authorization Server is 
installed. 
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These files must be writeable so you can overwrite them in the steps that 
follow. To change the permissions:

– On Windows, right-click the file, click Properties > Security, and check 
Write: Allow.

– On UNIX, use the chmod command.

2. Open a command prompt window, and navigate to AXM_HOME\bin, where the 
keygen utility resides.

3. Run keygen.bat with the -a option to add the Server to the Key Server list, which 
is written to the KeyServer.sec file. Type:

keygen.bat -a servername host.domain.com

where: 

• servername is the hostname (without domain).

• host.domain.com is the fully qualified hostname of your web server.
The secret key is generated and displayed. For example:

intranet 5cYKs4pVRXVL8XcU9PNBuUblOA6rhW56sC4l07Ysm7hk

4. Copy the shared secret information into the KeyClient.sec file that resides in the 
\var directory of your Access Manager Authorization Server installation.

5. If you must refer to the key again later, run keygen.bat with the -e option to 
extract the secret key on the machine running the Key Server. Type:

keygen.bat -e servername

where servername is the hostname (without domain) of the machine running the 
Key Server.

6. Remove the write permissions on the KeyServer.sec and KeyClient.sec files.

Creating a Shared Secret on UNIX

1. Navigate to AXM_HOME/bin, where the keygen utility is located.

2. Run keygen.sh with the -a option to add the Server to the Key Server list (written 
to the KeyServer.sec file). Type:

$ ./keygen.sh -a servername host.domain.com

where:

• servername is the hostname (without domain).

• host.domain.com is the fully qualified hostname of your web server.
The secret key is generated and displayed. For example:

intranet 5cYKs4pVRXVL8XcU9PNBuUblOA6rhW56sC4l07Ysm7hk

3. Copy the shared secret information into the KeyClient.sec file that resides in the 
/var directory of your Access Manager Authorization Server installation.
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4. If you need to refer to the key again later, use the keygen utility to extract the 
secret key on the machine running the Key Server. From AXM_HOME/bin, type:

$ ./keygen.sh -e servername

You cannot generate a shared secret using keygen.

Note: For tips on key generation, see Appendix M, “Troubleshooting.”

Authorization Server Caching

Through the caching functionality of the Authorization Server, changes made in the 
Administrative Console administrative tool take effect immediately and only flush the 
relevant records in the cache. For detailed information on the Entitlements Server 
cache flush settings, see the comments for the cleartrust.eserver.runtime.retry_count 
parameter in the AXM_HOME/conf/eserver.conf file. 

You can configure the level of information kept in the cache, depending on the level of 
performance you want to achieve. Keep in mind however, that the larger the cache 
size, the more RAM you need on the host that is running your Authorization Server. 
Plan for 12 K of memory for every record cached. For detailed information on the 
Authorization Server cache loading settings, see the comments for the 
cleartrust.aserver.cache.time_to_live parameter in the 
AXM_HOME/conf/aserver.conf file.

If cache is poisoned, an e-mail notification is sent to the e-mail address that you 
specify in the AXM_HOME/conf/aserver.conf file.

To receive an e-mail notification, add the e-mail address to the following parameter of 
the AXM_HOME/conf/aserver.conf file.

cleartrust.aserver.smtp.account.defaultrecipients=

Note: If this parameter is configured, then the SMTP server hostname/port number 
configurations are mandatory.

You must re-sync your cache after you receive such an e-mail notification.

Authorization Server Cache and Java Heap Size

Whenever the Authorization Server executes a request, it can store the results of that 
request in its memory (or cache). This ensures that the Authorization Server does not 
have to refer to the data store to check access privileges for any subsequent requests 
for that user or resource. This significantly improves runtime performance. The 
cleartrust.aserver.cache.entity parameter gives you precise control over the amount 
and type of data stored in the cache. 

Every entry cached (for example, a user record) requires about 12 KB of memory. If 
you plan to significantly increase the amount of records cached, you must make 
adjustments to the maximum heap size settings of your Java Virtual Machine.
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For smaller Access Manager installations, you can preload all of the records into the 
cache at start up. For details on preloading the cache, see the comments for the 
cleartrust.aserver.cache.bootstrap.preload parameter in the 
AXM_HOME/conf/aserver.conf file. Preloading the cache increases the startup time 
of your Authorization Servers. With the default cache configuration, startup time is 
approximately 20 to 30 minutes with cache preload enabled.

For maximum performance, make the cache size as large as the available memory on 
your machine allows. The default Java heap size setting of 128 MB for the 
Authorization Server is sufficient for the default cache parameter settings. For more 
information, see the comments for the cleartrust.aserver.cache.time_to_live parameter 
in your AXM_HOME/conf/aserver.conf file.

For larger Access Manager installations, add approximately 12 K to the Java heap size 
for each user and group record you want to store in the cache. The following table 
shows the recommended Java heap settings per number of users.

To increase the Java heap size for an Authorization Server:

1. From the /bin directory of your Access Manager installation, open the aserver.bat 
file (on Windows) or aserver.sh file (on UNIX). 

2. Within the startup file, find “-Xmx128m”, the value that controls the Java heap 
size, and change it accordingly. Make sure that your machine also has enough 
memory to support the increase in Java heap size. 

3. Save and close the file.
The Authorization Server allocates the new Java heap size setting the next time it 
is started.

To increase the Java heap size for the Windows RSAaserver service:

1. Open the Windows Registry Editor. 

CAUTION: Be very careful when using the Windows Registry Editor. Using the 
Registry Editor incorrectly can cause serious problems that may require you to 
reinstall your operating system. Microsoft recommends backing up your registry 
before making any changes. For more information about how to edit the registry, 
view the Microsoft Help in the Registry Editor.

2. In the left pane, go to the 
My Computer\HKEY_LOCAL_MACHINE\SYSTEM\
CurrentControlSet\Services\RSAaserver\Parameters directory.

3. Double-click options. 

Number of User and Group Records Java Heap Size (-Xmx value)

5000 64 MB

10,000 (default setting) 128 MB (default setting)

15,000 192 MB
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4. In the Edit String dialog box, change the maximum Java heap size by editing the 
number following -mx.

5. Click OK. The Authorization Server now allocates the new Java heap size setting 
the next time it is started.

SSO Token Caching

To increase performance, the Authorization Server provides a token cache that helps 
reduce the number of cryptographic operations performed when SSO (single sign-on) 
is enabled. Token caching reduces how often the Authorization Server needs to 
decrypt tokens.

To configure the token cache, set the following parameters in the aserver.conf file:

• cleartrust.aserver.token.cache.size

• cleartrust.aserver.token.cache.ttl

• cleartrust.aserver.token.cache.notouch_window

• cleartrust.keyserver.session_key_life

• cleartrust.keyserver.token_lifetime

Set the cleartrust.aserver.token.cache.size parameter to specify the maximum number 
of entries in the token cache. This value must be equal to the number of concurrent 
end-user sessions. Allowed values include any positive integer that corresponds to the 
maximum number of cached tokens.

Set the cleartrust.aserver.token.cache.ttl parameter to specify the maximum lifetime of 
entries in the token cache. Allowed values include any positive integer that 
corresponds to the lifetime, in minutes, of cached tokens. For this parameter to have 
any impact, the cleartrust.aserver.token.cache.size must be greater than 0. For 
efficiency, you must set this parameter less than or equal to the SSO idle timeout 
(cleartrust.keyserver.token_lifetime in the keyserver.conf file).

Set the cleartrust.aserver.token.cache.notouch_window parameter to specify the 
minimum amount of time between SSO token refreshes. Multiple attempts to update 
the touch time of a token while within this interval simply return the same token. 
Tokens are always updated, however, if there is any other change to the state of the 
token. Allowed values include any positive integer that corresponds to the number of 
seconds between touch time updates. RSA recommends that this value is kept between 
5-60 seconds. The cleartrust.keyserver.token_lifetime in keyserver.conf must be less 
than the SSO idle timeout for this parameter to have impact.
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To avoid unexpected token timeouts:

1. Open your AXM_HOME/conf/keyserver.conf file.

2. Edit the cleartrust.keyserver.token_lifetime and 
cleartrust.keyserver.session_key_life parameters, setting the session_key_life to 
half the token_lifetime.
Set these parameters in the same ratio as the default values:
cleartrust.keyserver.token_lifetime=1 hour
cleartrust.keyserver.session_key_life=30 mins

Next Steps

See Chapter 12, “Implementing Security Features” for optional steps to increase the 
security of your Access Manager installation. These options include configuring the 
Access Manager components to use Secure Sockets Layer (anonymous SSL or 
authenticated SSL) when sending information over the network.
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12Implementing Security Features

• Securing Your Operating Environment

• Encrypting Parameters in the Configuration Files

• Securing the Configuration Files

• Running the EncryptUtil Tool

• Implementing Password Lockout

• Overview of Intercomponent Security

• Configuring No Encryption

• Configuring Shared Secret Encryption

• Configuring Anonymous SSL

• Configuring Server Authenticated SSL

• Configuring Mutually Authenticated SSL

• Enabling FIPS Mode

• Session Replay Protection

• Generating lockbox

This chapter describes measures you can take to increase the security of your 
RSA Access Manager installation. The following table lists these security features.

Security Feature Description

Protecting the Access 
Manager Directory 

Secures your operating environment.

For more information, see “Protecting the RSA Access Manager 
Directory” on page 202.

Setting File 
Permissions

Secures your operating environment.

For more information, see “Setting File Permissions” on page 203.

Access Manager 
cryptedit utility

Encrypts sensitive information in your configuration files (such as 
passwords). 

For more information, see “Encrypting Parameters in the 
Configuration Files” on page 204.

Access Manager 
manage-config utility

Secures the Access Manager configuration files.

For more information, see “Securing the Configuration Files” on 
page 208.
12: Implementing Security Features 201



RSA Access Manager 6.1 SP4 Servers Installation and Configuration Guide
Securing Your Operating Environment

Windows and UNIX operating systems provide mechanisms that can help protect your 
Access Manager installation from unauthorized access. RSA recommends using these 
mechanisms to protect the Access Manager directory tree and to control file-level 
access when applicable. 

Protecting the RSA Access Manager Directory

On Windows and UNIX platforms, complete these steps immediately after you install 
Access Manager. 

Password Lockout Locks users out of the system after they reach a specified threshold of 
failed logon attempts.

For more information, see “Implementing Password Lockout” on 
page 213.

Intercomponent 
Security

Protects communications between the Access Manager components.

For more information, see “Overview of Intercomponent Security” 
on page 214.

Shared Secret 
Encryption

Generates a shared secret on the Key Server machine for every Web 
Server Agent and Authorization Server in your Access Manager 
system.

For more information, see “Generating a Shared Secret Using 
Keygen” on page 194 and the single sign-on material in your 
RSA Access Manager Agent documentation.

Anonymous SSL Encrypts communications between components. In Access Manager, 
anonymous SSL means that neither clients nor Servers present a 
certificate when connecting to a Server.

For information on how to enable anonymous SSL, see “Configuring 
Anonymous SSL” on page 217.

Server Authenticated 
SSL for LDAP

Provides server authenticated SSL communications between LDAP 
directory hosts and Access Manager Servers.

For more information, see “Configuring Server Authenticated SSL” 
on page 218.

Mutually 
Authenticated SSL

Provides mutually authenticated SSL communications between the 
Access Manager components.

For more information, see “Configuring Mutually Authenticated 
SSL” on page 221.

Security Feature Description
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To protect the RSA Access Manager directory on Windows:

Make the following permission settings on the root directory of the Access Manager 
installation. The default name for this directory is RSA. 

• For Domain Admins and SYSTEM, set all permissions to Allow. 

• For Everyone, set all permissions to Deny. 

Make sure that all the files and directories within the Access Manager root directory 
are set to inherit these permissions. For more information, see your Windows 
documentation.

To protect the Access Manager directory on UNIX:

Change the ownership of the Access Manager installation directory to the Access 
Manager user and group that you specified in the installation process. Revoke all 
group and other access, as well as user write access, by typing the following 
commands:

# chown -R CTUSER:CTGROUP AXM_HOME
# chmod -R u-w,go-rwx AXM_HOME

Note: This example assumes your system has a single administrative Access Manager 
user. If you are allowing a group of users administrator-level access to Access 
Manager, do not revoke all group access. 

Setting File Permissions

The Access Manager secret key files, configuration files, and server log files require 
special consideration in setting read/write access. Because it is very important to 
protect the secret key files, permissions for the following files are set automatically 
during installation to allow only administrators access:

• KeyClient.sec

• KeyServer.sec

Note: These files are automatically protected on NTFS and UNIX file systems. On 
FAT file systems, it is not possible to set these permissions.

Only administrators have access to these Access Manager configuration files, which 
are found in the AXM_HOME/conf directory of your Access Manager installation:

• ldap.conf

• sql.conf

• aserver.conf

• eserver.conf

• dispatcher.conf

• keyserver.conf 

• lserver.conf

• iserver.conf
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• uus.conf

Administrators must have write access to these files in order to set configuration 
parameters. After setting parameters involving passwords and other sensitive 
information, administrators can protect the information with an encryption tool. For 
more information, see “Encrypting Parameters in the Configuration Files” on page 
204.

Setting File Permissions on UNIX

To set read/write access as required, type the following commands:

chmod u+w AXM_HOME/conf
chmod u+w AXM_HOME/conf/*.conf
chmod -R u+w AXM_HOME/logs
chmod u+w AXM_HOME/var *.sec

Additionally, you may consider changing umask to 077 in .bashrc or .login.

Setting File Permissions on Windows

To set file permissions on Windows, right-click the file, and click 
Properties > Security. 

Encrypting Parameters in the Configuration Files

Some parameters in the Access Manager configuration files contain sensitive 
information. RSA provides an encryption utility called cryptedit that lets you protect 
such parameters. You may use the cryptedit utility to encrypt settings in the following 
configuration files:

• aserver.conf

• eserver.conf

• dispatcher.conf

• keyserver.conf

• ldap.conf

• sql.conf

• adaptive_auth-onpremise-6021.conf

Note: If you chose the “Encrypt configuration files” option when you ran the Access 
Manager installer, you do not need to read the following sections. With “Encrypt 
configuration files” selected, the installer handles all the work of encrypting the 
parameters.

CAUTION: Windows installations only: If you encrypt the contents of the Access 
Manager Server configuration files, you cannot run the Access Manager Servers as 
Windows services.
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Overview of Configuration File Encryption

In order to encrypt the parameters in your Access Manager configuration files, 
perform these steps, as described in the following sections:

• Prepare your configuration files. For more information, see the following section, 
“Setting the Encryption Store Parameters.”

• Remove the clear text values from the configuration parameters you want to 
protect, and mark those parameters for encryption using the .cleartext=false flag. 
For more information, see “Marking the Parameter Values to Encrypt” on 
page205. 

• Run the utility, and set the values for the parameters. These values are stored in an 
encrypted file in your /conf directory. For more information, see “Using the 
Encryption Utilities” on page 206.

Setting the Encryption Store Parameters

The Server encryption utility, cryptedit, requires you to set a pointer parameter in each 
of the Access Manager configuration files. This parameter specifies a filename where 
the encrypted parameter values are stored in the /conf directory of your Access 
Manager installation. The Access Manager Servers access these encrypted files at 
runtime to obtain the required parameter values. 

To set the encryption store parameters:

Edit your Server configuration files to set the encrypted store parameter with the 
appropriate value in each file:

• aserver.conf:
cleartrust.configuration.encrypted_store=aserver.enc

• eserver.conf:
cleartrust.configuration.encrypted_store=eserver.enc

• dispatcher.conf:
cleartrust.configuration.encrypted_store=dispatcher.enc

• keyserver.conf:
cleartrust.configuration.encrypted_store=keyserver.enc

Note: It is not necessary to set this value in the ldap.conf or sql.conf files. These files 
are automatically read in for each top-level configuration file that requires it and 
added to that configuration file’s encrypted store.

Marking the Parameter Values to Encrypt

Because you do not want passwords to be stored in clear text in your configuration 
files, RSA recommends that you encrypt the following parameter values that contain a 
password.
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In each of the Access Manager Server configuration files (eserver.conf, aserver.conf, 
dispatcher.conf, and keyserver.conf):

• cleartrust.net.ssl.ca.keystore_passphrase

• cleartrust.net.ssl.private.keystore_passphrase

• cleartrust.net.ssl.private.key_passphrase

In the ldap.conf file:

• cleartrust.data.ldap.directory.ldap_server.password

• cleartrust.data.ldap.directory.ldap_server.keystore_passphrase

In the sql.conf file:

cleartrust.data.sql.server.sql_server.password

In the adaptive_auth-onpremise-6021.conf file:

• cleartrust.adaptive_auth.caller_credential

• cleartrust.adaptive_auth.net.ssl.ca.keystore_passphrase

• cleartrust.adaptive_auth.net.ssl.private.keystore_passphrase

To mark the parameters you want to encrypt:

1. Open the configuration file in the /conf directory that contains the parameter you 
want to protect.

2. Remove the equals sign and the value from the parameter, and add .cleartext=false 
to the end of the parameter name. For example:

cleartrust.net.ssl.private.key_passphrase.cleartext=false

3. Save and close each file when you are done marking all of the parameters you 
want to encrypt.

Using the Encryption Utilities

The cryptedit and agent_cryptedit utilities have the following commands:

set. Sets or changes the value of the parameters you marked for encryption.

save. Saves all of the values you set in a particular configuration file during that 
session. You must set all values before you can save them. Values that are set, but 
not saved, are not saved if you exit the program. 

password. Changes the master startup password for a particular Access Manager 
Server configuration file.

exit. Ends a cryptedit session. 

To set and encrypt parameter values:

1. Stop your Access Manager Servers, web server, or application server before 
running the utility.

2. From a command prompt, navigate to the /conf directory in your Access Manager 
installation.
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Important: Set parameters marked in the ldap.conf file by running cryptedit first 
against the aserver.conf and then against the eserver.conf. You must encrypt both 
files.

3. Run cryptedit. Supply the filename of the configuration file in which you marked 
parameters for encryption.
You can only run the encryption utility against one configuration file at a time. In 
this example, the utility runs against the Authorization Server configuration file:

• On Windows, type:

..\bin\cryptedit.bat -c aserver.conf

• On UNIX, type:

#../bin/cryptedit.sh -c aserver.conf

4. The encryption utility finds and lists the parameters to set, based on the 
.cleartext=false tags. Type set to set the value of a parameter.

5. When prompted, type the name of the parameter you want to set. For example:

cleartrust.net.ssl.private.key_passphrase

6. Repeat step 4to 5 until all of the values for that configuration file are set. 

7. Type save once all of the values are set. This saves the changes you make during 
the session. 

8. When you finish encrypting the parameters, type exit.

9. If this is the first time you are running the encryption utility against a particular 
configuration file, create a master startup password. With encrypted configuration 
files in place, the administrator must enter this password in order to start the 
Access Manager Servers. This password is also required in order to edit the 
encrypted configuration parameters in the future. RSA recommends that this 
password be at least eight characters long and contain no recognizable dictionary 
words.

10. Restart your Access Manager Servers.

Modifying Server Startup Scripts on UNIX

Using encrypted configuration files on UNIX may require modifications to your 
Server startup scripts. These modifications allow the user to properly enter the master 
password at startup. If you encrypted your configuration files during the installation 
by choosing the “Encrypt configuration files” option from the Access Manager 
installer utility, you do not need to modify the startup scripts. If you are adding 
encrypted configuration files to an installation that previously used unencrypted 
configuration files, you must perform the following procedure.

To modify the Server startup scripts to support encrypted configuration files:

1. Open the desired Server startup file, either aserver.sh, eserver.sh, or 
dispatcher.sh.

2. Find the following line:
>> ${OUTFILE:-/dev/null} 2>&1 &
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3. Remove the ampersand. The line now reads:
>> ${OUTFILE:-/dev/null} 2>&1 

4. Repeat this procedure for the other startup scripts.

This causes the Servers to run in the foreground, which is required so that the 
administrator can enter the master password when starting the Servers.

To stop the Servers once you have modified the startup scripts, use CTRL+C or the 
kill command. The stop command does not stop the Servers.

Securing the Configuration Files

Access Manager configuration files contain sensitive information. RSA provides an 
encryption utility called manage-config that lets you protect the Access Manager 
configuration files. You may use the manage-config utility to encrypt or decrypt all the 
configuration files in the AXM_HOME/conf directory. When you encrypt a 
configuration file using the manage-config utility, the file extension of the 
configuration file changes from .conf to .enc.

CAUTION: For Windows installations: If you encrypt the contents of the Access 
Manager Server configuration files, you cannot run the Access Manager Servers as 
Windows services.

Note: For Solaris installations, a change needs to be made to the .sh files. You must 
redirect the output to the terminal (stdout), and not to the /dev/null (which is the case 
by default). In all the .sh files #OUTFILE=tty must be uncommented as 
OUTFILE=tty.

Before you encrypt or decrypt the configuration files, make sure that:

• You have created an administrator in Access Manager with Audit Admin or 
Config Admin privileges. For information on Audit admin and Config Admin 
roles, see the Administrator’s Guide.

• You have copied the boot.conf file located in the AXM_HOME\conf\default 
directory to the AXM_HOME\conf directory.

• RSA Access Manager Entitlements Server is up and running.

Using the manage-config Utility

To use manage-config utility:

1. From a command prompt, navigate to the /conf directory in your Access Manager 
installation.

2. Type:
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..\bin\manage-config.bat options

For relevant options, see the following section, see “Options for the 
manage-config Utility.”
To encrypt or decrypt the configuration files, you can use the following options:

manage-config [-d|-e] FILE_NAME [-u -p -m]*

where FILE_NAME is the file name of the configuration file.

Important: Although it is possible to enter the master password on the command 
line along with the other options, this creates a potential security vulnerability. 
RSA recommends that you enter the master password only when the utility 
presents a prompt.

Options for the manage-config Utility

The following table describes the options for the manage-config utility.

Encrypting the Configuration Files

To encrypt the configuration files:

1. From a command prompt, navigate to the /conf directory in your Access Manager 
installation.

2. Run manage-config. Supply the filename of the configuration file for encryption. 
You can only run the manage-config utility against one configuration file at a 
time. In this example, the utility runs against the Authorization Server 
configuration file:

..\bin\manage-config.bat -e aserver.conf

3. Enter the administrator username. 

Note: The administrator must have Config Admin privilege.

Flag Description

-d Decrypt the configuration files

-e Encrypt the configuration files. 

Note: This option is only available to administrators with 
Config Admin privilege.

-u User name of the administrator with Config Admin or Audit 
Admin privileges.

-p Config Admin or Audit Admin password

-m Master password for encrypting/decrypting the configuration 
files.
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4. Enter the administrator password.

5. Enter the master password. By default, the master password is validated against 
the Access Manager Default Password Policy. 

Note: You can enable validation of the master password against a custom password 
policy by adding the custom password policy name to the 
cleartrust.secure.passwordpolicy.name parameter in the boot.conf file. For 
instructions on how to create password policies, see the Administrative Console Help 
topic “Adding Password Policies.”

Important: : If this is the first time you are running the manage-config utility against a 
particular configuration file, create a master startup password. The administrator must 
enter this password in order to start the Access Manager Servers. This password is 
also required in order to decrypt the encrypted configuration file in the future.

While encrypting a configuration file, if you choose to back up the configuration file, 
a folder named backup is created in the /conf directory and all the .conf files are 
stored in the folder.

Decrypting the Configuration Files

To decrypt the configuration files:

1. From a command prompt, navigate to the /conf directory in your Access Manager 
installation.

2. Run manage-config. Supply the filename of the encrypted configuration file. You 
can only run the manage-config utility against one encrypted configuration file at 
a time. In this example, the utility runs against the encrypted Authorization Server 
configuration file:

..\bin\manage-config.bat -d aserver.enc

3. Enter the administrator username. 

Note: The administrator must have Config Admin or Audit Admin privileges.

4. Enter the administrator password.

5. Enter the master password that you created while encrypting the configuration 
file.

Modifying the Encrypted Configuration Files

An administrator with Audit Admin or Config Admin privileges can modify the 
encrypted configuration files using the manage-config utility.

Note: An administrator with Audit Admin privilege can modify only the log 
parameters in the encrypted configuration file.
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To modify the encrypted configuration files using Config Admin privilege:

Note: An administrator with Config Admin privilege can modify all the parameters 
including log parameters in the encrypted configuration file.

1. From a command prompt, navigate to the /conf directory in your Access Manager 
installation.

2. Decrypt the configuration file. For more information, see “Decrypting the 
Configuration Files” on page 210.

3. Modify the desired parameter in the decrypted configuration file located in the 
AXM_HOME/conf directory and save the configuration file.

4. Encrypt the configuration file. For more information, see “Encrypting the 
Configuration Files” on page 209.

To modify the log parameters in the encrypted configuration files using Audit 
Admin privilege:

1. From a command prompt, navigate to the /conf directory in your Access Manager 
installation.

2. Decrypt the configuration file. For more information, see “Decrypting the 
Configuration Files” on page 210.

Note: When you decrypt a configuration file using Audit Admin privilege, only 
the log parameters associated with that particular configuration file is decrypted. 

The log parameters associated with the encrypted configuration file is displayed 
with options to edit, save, and exit the secure configuration editor.

3. Enter 1 to edit the log parameter.

a. Enter the property name to edit from the list of log parameters.

b. Enter the new value for the property name.

4. Enter 2 to save the changes made to the configuration file.

5. Enter 3 to exit the secure configuration editor.

6. Encrypt the configuration file using Configuration Admin privilege. see 
“Encrypting the Configuration Files” on page 209.
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Running the EncryptUtil Tool

The encryptutil tool is used to encrypt individual parameters instead of the entire 
configuration file.

To run the encryptutil tool:

1. Navigate to AXM_HOME/bin directory.

2. Edit the encryptutil.bat or encryptutil.sh file to set the AXM_HOME path.

3. For 64-bit machines edit the encryptutil.bat or encryptutil.sh file to set the 
JAVA_HOME path to %AXM_HOME%\jre64.

4. Open a command shell, and change directories to AXM_HOME/bin.

5. Run the encryptutil tool. Type:
encryptutil mode lockbox_file_path param1=value1 
param2=value2

where,

• mode specifies whether to encrypt the value using the FIPS algorithm.

• lockbox_file_path specifies the location where the lockbox file is stored. If 
the lockbox file is not yet created, see the section “Generating lockbox” on 
page 231 to generate a lockbox.

• param1 and param2 are the two parameters that you want to encrypt.

• value1 and value2 are the values assigned to the two parameters.
The encryptutil tool encrypts the parameters as mentioned below:
Encrypted Values:
param1: Encrypted value1
param2: Encrypted value2

For example:
encryptutil.bat nonfips C:\AxM\conf\lockbox.clb admin=admin

Output:
admin: <<encrypted_value>>

Note: : In above option, set the mode to fips if the FIPS mode is enabled for the 
component for which we are generating the encrypted values. If not, set the mode 
to nonfips to encrypt the value using non-fips algorithm.

6. Copy the encrypted value of the corresponding parameter from the command 
prompt to the corresponding file.
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Implementing Password Lockout

You can configure the system to deny access to a user who fails to log on after several 
consecutive attempts. When the number of failed logon attempts goes past the limit set 
by the system administrator, the user is locked out of the system, either for a specified 
amount of time, or until reset by an administrator with the appropriate privileges. 

By default, the Authorization Server communicates the lockout status directly to the 
data store. For read-only configurations, the Authorization Server can direct the 
Entitlements Server to write the necessary changes to the data store. This latter 
configuration is described in the following section, “Password Lockout for Read-Only 
Configurations.”

Note: For LDAP Data Adapter users: Some of the data for password lockout is stored 
in the object class ctscUserAuxClass. Password policy lockout features are only 
available if this schema extension is enabled. For more information on 
ctscUserAuxClass, see “Dynamic Updates to the User Object Class” on page 91.

Password lockout is enabled by default for each password policy created by an 
administrator. Using the RSA Administrative Console, an administrator can enter 
values for the number of unsuccessful logon attempts users can make before they are 
locked out, the method for unlocking a user, and the e-mail address used for lockout 
notification. An administrator can also use the Administrative Console to disable 
password lockout. 

For more information on password policies and password lockout, see the chapter 
“Managing Delegated Administration” in the Administrator’s Guide, or see the Help 
topic “Understanding Password Policies.”

In addition to the Administrative Console, there are parameters in the Authorization 
Server configuration file that also control password policies and password lockout. 
For more information, see the Password Policy Parameters section in 
AXM_HOME/conf/aserver.conf.

Password Lockout for Read-Only Configurations

If a read-only data store is used by the Authorization Server, by default, Access 
Manager cannot lock out unauthorized users. To configure Access Manager to lock 
out unauthorized users when using a read-only data store, uncomment this parameter 
in AXM_HOME/conf/aserver.conf:

cleartrust.aserver.password_lockout_readonly=true

Uncomment and enter the appropriate values for these related parameter variables:

cleartrust.aserver.admin_api.hostname=eserver host
cleartrust.aserver.admin_api.port=eserver port
cleartrust.aserver.admin_api.username=administrator
cleartrust.aserver.admin_api.password=admin password
cleartrust.aserver.admin_api.role=admin role name
cleartrust.aserver.admin_api.use_ssl=mode
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These settings direct the Authorization Server to send password lockout information 
through the administrative API port, or Entitlements Server. This process logs on to 
the Entitlements Server under the guise of an administrator and then the Server writes 
lockout information to the user record in the data store. Note the following constraints:

• You must set the api.username parameter to Super Admin privileges. 

• You must set the api.use_ssl to the same level of SSL security as Administrative 
Console connections to the Entitlements Server. This level is defined in the 
ssl.mode parameter in the Administrative Console admingui.cfg file.

Overview of Intercomponent Security

Intercomponent security protects information as it passes between components. 
Access Manager supports five types of intercomponent security:

No Encryption. Communications between components are not encrypted when 
passed over the network. Such unencrypted information is often called clear text 
or plain text.

Shared Secret Encryption. Shared secret (or symmetric) encryption is used to 
protect the sensitive information in the Access Manager single sign-on (SSO) 
cookie. Shared secret encryption is required if you are using single sign-on or 
form-based authentication. It is always enabled, regardless of whether or not you 
pass the SSO cookie over an SSL connection.

Every Authorization Server and any Web Server Agent that participates in 
intersite single sign-on (ISSO)—a method that allows a user to go from one 
protected site to another without having to reauthenticate—must have a valid key 
generated by the Access Manager Key Server (the Access Manager internal 
cryptography server) to ensure that the SSO cookie is only encodable and 
decodable by trusted Access Manager components. The client must present the 
key to the Key Server before the client can obtain the current cookie 
encryption/decryption key, thus authenticating the client to the Key Server.

Important: The session cookie is encrypted with the shared secret key. Protect the 
key files (KeyClient.sec and KeyServer.sec), as described in “Setting File 
Permissions” on page 203. The secret must never be transported over unsecured 
networks. Anyone possessing this key may communicate with the Access 
Manager Key Server.

Shared secret encryption is used between the following Access Manager 
components:

• Authorization Servers and Key Server
• Server Agents and Key Server

For more details on configuring Access Manager shared secret encryption, see 
“Configuring Shared Secret Encryption” on page 217.
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Anonymous SSL. This is the default mode for Access Manager components. In 
this mode, all data exchanged between Access Manager components is encrypted 
using Secure Sockets Layer (SSL) encryption technology. Before transmission 
over the network, the data is encrypted using anonymous SSL. Although the data 
is encrypted in this mode, neither the client nor the Server is required to present a 
certificate to authenticate itself.

The particular SSL modes vary from one component to another, but in all cases, 
Access Manager uses 128-bit encryption for all messages sent across the network. 

Anonymous SSL can be used by all interfaces between Access Manager 
components to secure connections.

Server Authenticated SSL. Communications between the LDAP directory host 
and the Entitlements and Authorization Servers can be secured using server 
authenticated SSL. In this mode, the LDAP directory host presents its digital 
certificate when responding to client requests from the Authorization and 
Entitlements Servers. 

To activate server authenticated SSL, you must configure the LDAP directory host 
for SSL communications and then ensure that the keystore of each Access 
Manager Server includes the CA certificate of the authority that signed the LDAP 
directory host certificate. 

Server authenticated SSL is used between the following components:

• Entitlements Server and LDAP directory host
• Authorization Server and LDAP directory host

Mutually Authenticated SSL. you must configure the Access Manager Servers 
and Web Server Agents to use mutually authenticated SSLWhen setting up 
mutually authenticated SSL, you can use a single keystore format, either PKCS 
#12 or JKS (Java Keystore). Your choice may be guided by the limitation of the 
Web Server Agents, which are not compatible with JKS format. For information 
on how to select the correct format for your environment, see “Configuring 
Mutually Authenticated SSL” on page 221.
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The following figure shows the intercomponent security options for the various 
connections among components.

Authorization Server

Entitlements Server
RSA 

Access Manager
Data Store

ldap_port 389

389 or 636

RSA Access 
Manager Agent 

(Runtime API 
Clients)

Dispatcher

Key Server

reg_port 5607

key_port 5606

auth_port  
5615

key_port 
5606

port 5601

list_port 
5608

auth_port  
5615

shared secrets

anon ssl, auth ssl or clear

anon ssl or clear

key

ldap_port636

list_port  5608

Clear or Server 
Authenticated

election_port 
5609

Administrative 
API Clients

Administrative
Console 

port 5601
216 12: Implementing Security Features



RSA Access Manager 6.1 SP4 Servers Installation and Configuration Guide
Configuring No Encryption

In no encryption mode, communications between components are unencrypted. RSA 
does not recommend using this mode in a production environment.

Note: Configuring no encryption mode for Access Manager also requires making 
changes to your RSA Agent configuration file. For more information, see your Agent 
documentation.

To configure no encryption:

1. Set the cleartrust.net.ssl.use parameter to clear in your aserver.conf, 
keyserver.conf, eserver.conf, and dispatcher.conf files. For example:

cleartrust.net.ssl.use=clear

2. Open the RSA Administrative Console configuration file 
(SERVER_HOME/../admingui.cfg), and set the ssl.mode parameter to Clear. 
For example:

ssl.mode=Clear

3. Restart your Access Manager Servers.

Configuring Shared Secret Encryption

Shared secret encryption is required if you are using single sign-on or form-based 
authentication. Configuring shared secret encryption involves generating a shared 
secret on the Key Server machine for every Web Server Agent and Authorization 
Server in your Access Manager system. 

For more information, see “Generating a Shared Secret Using Keygen” on page 194 
and the single sign-on information in your RSA Access Manager Agent 
documentation.

Configuring Anonymous SSL

In anonymous SSL mode, communications between components are encrypted, but 
neither clients nor Servers need to present a certificate.

Note: Configuring anonymous SSL mode for Access Manager also requires making 
changes to your RSA Agent configuration file. For more information, see your Agent 
documentation.
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To configure anonymous SSL:

1. Set the cleartrust.net.ssl.use parameter to anon in your aserver.conf, 
keyserver.conf, eserver.conf, and dispatcher.conf files. For example:

cleartrust.net.ssl.use=anon

2. Open the Administrative Console configuration file 
(SERVER_HOME/../admingui.cfg), and set the ssl.mode parameter to Anon. 
For example:

ssl.mode=Anon

3. Optional. If you are using the Access Manager APIs, you have the option of 
configuring different SSL settings for the API connections.
For Administrative API connections to the Entitlements Server, see the comments 
for the cleartrust.eserver.api_port.use_ssl parameter in the 
AXM_HOME/conf/eserver.conf file. 
For Runtime API connections to the Authorization Server, see the comments for 
the cleartrust.runtime_api.security parameter in the 
AXM_HOME/conf/aserver.conf file.

4. Optional. You can also enable anonymous SSL between your web servers and 
browsers independent of the SSL connections between the RSA Access Manager 
Web Server Agents and the Access Manager Servers. For more information, see 
your web server vendor documentation.

5. Restart your Access Manager Servers.

Configuring Server Authenticated SSL

Access Manager uses server authenticated SSL to encrypt communications between 
the Entitlements and Authorization Servers and your LDAP directory host. For Active 
Directory, server authenticated SSL is the default mode that is set up after the Access 
Manager Servers are installed. For more information, see “Setting Up SSL for Active 
Directory” on page 45.

This general process for setting up server authenticated SSL access for LDAP 
directories is the same regardless of which directory you use. RSA recommends that 
you consult your LDAP directory vendor documentation for specific instructions 
about setting up an SSL connection.

Setting up server authenticated SSL connections requires the following 
post-installation setup tasks:

• Set up your LDAP directory host for SSL connections according to the product 
documentation from your LDAP host vendor. This process involves requesting a 
server certificate, installing the server certificate, and importing the CA certificate 
of the certificate authority that signed this server certificate.

• Configure the SSL and keystore parameters in the Access Manager LDAP 
configuration file (ldap.conf). For more information, see “Setting Keystore 
Parameters in ldap.conf” on page 219.
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• Import the signing CA certificate into the keystore of all Access Manager Servers 
that communicate with the LDAP directory host. For instructions, see “Retrieving 
the Signing CA Certificate from RSA Certificate Manager” on page 219.

Important: This process assumes that each Access Manager Server has an existing 
keystore file. For information about creating a keystore file, see “Generating 
Certificates” on page 222.

You can use any certificate authority and PKI tools to request, install, and sign a CA 
certificate. To automate this process, RSA recommends that you use the 
limited-license version of RSA Certificate Manager 6.8 and the Access Manager 
Certificate Tool that is included in your product package. This Access Manager 
Certificate Tool supports RSA Certificate Manager 6.8 as well as RSA Keon 
Certificate Authority 6.5.1.

For more information on RSA Certificate Manager, see “Installing the RSA 
Certificate Manager” on page 222. 

Configuring the LDAP Directory Host for SSL

Follow the documentation provided by your LDAP directory host vendor for setting 
up SSL connections. In this SSL setup process, note the following requirements:

• Do not select the option to require client authentication. This SSL connection 
requires only server authentication.

• Make sure that the signing CA supports the “Basic Constraints Extension.” The 
server authenticated SSL connection does not function without this extension.

Setting Keystore Parameters in ldap.conf

The Access Manager Servers that communicate with the LDAP directory host require 
information about the LDAP directory host keystore. Set the following parameters in 
the ldap.conf file to enable SSL connections between Access Manager and the LDAP 
directory host:

cleartrust.data.ldap.directory.directory_name.ssl.use: auth

cleartrust.data.ldap.directory.directory_name.port: 636

cleartrust.data.ldap.directory.directory_name.ssl.ca_keystore_file: filename

cleartrust.data.ldap.directory.directory_name.ssl.ca_keystore_type:JKS

cleartrust.data.ldap.directory.directory_name.ssl.ca_keystore_passphrase: password:

In a typical configuration, you must specify the LDAP directory host keystore name, 
type, and passphrase. For more details, see the parameter reference information in the 
AXM_HOME/conf/ldap.conf file.

Retrieving the Signing CA Certificate from RSA Certificate Manager

The Access Manager Servers require the CA certificate of the CA that signs your 
directory host certificate. You must add the signing CA certificate to the keystore (in 
the /conf directory) of each Access Manager Server.
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Important: If you configure your system for mutually authenticated SSL as described 
in “Configuring Mutually Authenticated SSL” on page 221, each Access Manager 
Server keystore already contains a valid RSA Certificate Manager certificate. If you 
use RSA Certificate Manager to sign the LDAP directory host certificates as well, skip 
this procedure, since the valid CA certificate is already present.

Retrieving the signing CA certificate from RSA Certificate Manager is a two-step 
process:

1. Retrieve the signing CA certificate by accessing RSA Certificate Manager 
Enrollment Server through a browser. Follow the instructions in your RSA 
Certificate Manager documentation on how to retrieve this certificate. Select 
“PEM of DER-encoded” as the file format. Your RSA Certificate Manager 
administrator can assist you.

2. Add the CA certificate to an existing keystore using the Access Manager 
Certificate Tool or the Sun Java Keytool.

Note: For more information about the Access Manager Certificate Tool, see 
“Generating Certificates” on page 222. The Sun Java Keytool is provided in the 
AXM_HOME/jre/bin directory of your Access Manager installation. For more 
information, see the Sun Java Keytool Help.

For other certificate authorities, consult the product documentation for information on 
saving or exporting the CA certificate, and then use the Access Manager Certificate 
Tool or Sun Java Keytool to add it to the Server keystore.

Using the Certificate Tool to add the CA Certificate to an Existing Keystore

The Certificate Tool (certool.exe) utility simplifies the process of adding the retrieved 
CA certificate to an existing keystore. The input CA certificate must be in 
PEM-encoded format. For this option, only the following parameters from the 
certool.cfg file are used:

• caalias

• cacertinfile

• pkcs12file

To add a CA certificate to an existing keystore using the Certificate Tool:

1. Open a command prompt, navigate to the directory that contains the Certificate 
Tool, and type the -add function name and the full path to the Certificate Tool 
configuration file:

certool -add c:/conf/certool.conf

2. Enter the password for the PKCS #12 keystore specified when the keystore was 
originally created. 

3. When you exit, the Certificate Tool inserts the CA certificate in the keystore 
specified by the pkcs12file parameter in certool.conf.
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Configuring Mutually Authenticated SSL

The act of one component contacting another in mutually authenticated SSL is called 
the handshake. During the handshake, which occurs at the beginning of a mutually 
authenticated SSL session, the certificates are exchanged and validated. If the 
certificates are valid and trusted, the connection proceeds. Otherwise, the peer is 
disconnected. By limiting the set of trusted Certificate Authorities (CAs), you can 
ensure that only authorized clients are using the Access Manager Servers.

Additionally, by using multiple CAs, you can establish separate trust domains. For 
example, you may establish a CA for development, another for QA, and another for 
your production site. Components within each department can be configured to trust 
only certificates from their corresponding CA, ensuring that developers and QA do 
not connect to and tamper with the production servers.

In setting up mutually authenticated SSL, you may prefer to choose a single keystore 
format for all keystores, either PKCS #12 or JKS (Java Keystore). RSA provides the 
certool utility on the RSA Access Manager 6.1 DVD to simplify the process of 
creating PKCS #12 keystores. 

However, you may prefer to use the Sun Java Keytool to create JKS format keystores. 
This simpler format allows the use of various certificate authority tools, including 
Microsoft certificate operations. The use of the Microsoft certificate authority with 
Sun Java Keytool for LDAP directory host connections is detailed in “Setting Up SSL 
for Active Directory” on page 45.

Note: RSA strongly recommends the use of JKS keystores with Active Directory, as 
described in “Setting Up SSL for Active Directory” on page 45.

Note: Because there are some dependencies between  and Access Manager 
configurations for mutually authenticated SSL, RSA recommends that a single 
technician or administrator manage all setup tasks. Alternatively,  and Access 
Manager administrators must collaborate closely on these tasks. 

Configuring Mutually Authenticated SSL Using PKCS #12 Keystores

To configure mutually authenticated SSL using PKCS #12 keystores:

1. Install and initialize the , if needed. For more information, see the following 
section, “Installing the RSA Certificate Manager.”

2. Run the Certificate Tool for each Access Manager component participating in 
mutually authenticated SSL. For more information, see “Generating Certificates” 
on page 222.

3. Set the SSL parameters in the Access Manager Server configuration files.

Note: Configuring mutually authenticated SSL mode for Access Manager also 
requires making changes to the Agent configuration file. For more information, see 
your Agent documentation.
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Installing the RSA Certificate Manager

If you do not currently have a CA from which you can issue certificates, you can use 
the RSA Certificate Manager included with Access Manager.

After the required certificates have been generated, the RSA CA services stop. 
However, these RSA CA services may need to be started when the current server 
certificates, CA, or both that signed these certificates are about to expire and must be 
reissued.

Instructions in this section refer to the RSA Certificate Manager Installation Guide, 
provided in PDF on the RSA Certificate Manager 6.8 CD. 

To install and initialize RSA Certificate Manager:

1. Install the RSA Certificate Manager program files on your Windows or Solaris 
platform as described in the RSA Certificate Manager Installation Guide.

2. When prompted, provide Key Encryption Passphrases for  SSL information and 
for CAs (System CA and Administrative CA) that are generated for the  
installation. These SSL passphrases are required for generating certificates as 
described in the following section, “Generating Certificates.”

Important: Do not use spaces, slashes, or other non-alphanumeric characters in 
these passphrases.

3. Depending on the needs of your organization, you may need to install an  license 
file as described in the  Installation Guide. The limited-license copy provided with 
Access Manager is adequate for configuring mutually authenticated SSL between 
components.

4. Create a new CA in the  installation to sign the various Access Manager 
intercomponent SSL server certificates. You must provide the distinguished name 
(DN) of this CA for later use in creating certificate requests as described in the 
following section, “Generating Certificates.”

Generating Certificates

Once your RSA Certificate Manager is set up and initialized, you may generate 
certificates for the various Access Manager components. Access Manager provides a 
utility called the Certificate Tool to automate the process of requesting and retrieving a 
password-protected PKCS #12 keystore file from your RSA Certificate Manager.

The Certificate Tool (certool.exe) and its configuration file (certool.conf) are located 
in the your_operating_system/cert_tool directory on your RSA Access Manager 6.1 
DVD. To use Certificate Tool, copy the cert_tool directory and its contents to 
AXM_HOME on your hard drive.

The Certificate Tool is supported by RSA Certificate Manager 6.8 and runs on the 
Windows and Solaris platforms.

For cases in which you must retrieve only the CA certificate, access  with a browser, 
and save certificates as described in this section.
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Using information from the Access Manager Server environment and information for 
the , the Certificate Tool automatically requests a certificate from the  and generates a 
PKCS #12 keystore file that includes the signing CA certificate, server certificate, and 
the private key. You must prepare and enter the required configuration information, 
and run the Certificate Tool in a two-step process:

1. Configure the Certificate Tool, entering values in certool.conf as described in the 
following section, “Configuring the Certificate Tool.”

2. Run the Certificate Tool on the target Access Manager Server host as described in 
“Running the Certificate Tool” on page 224.

This procedure must be completed on all Access Manager Server hosts that require a 
PKCS #12 keystore for mutually authenticated SSL. 

Note: For information about generating certificates for Agents, see your Agent 
documentation.

For the complete list of components requiring certificates for mutually authenticated 
SSL, see “Overview of Intercomponent Security” on page 214.

Configuring the Certificate Tool

To configure the Certificate Tool, gather information for the Access Manager Server 
environment and the RSA Certificate Manager, and manually enter it in the 
AXM_HOME/cert_tool/certool.conf file. 

Additionally, you must copy the administrative certificate and key files from your 
RSA Certificate Manager installation directory to the directory from which the 
Certificate Tool is run. These files are indicated by the parameters certfile and keyfile 
in certool.conf.

For more information, see the parameter comments in your 
AXM_HOME/cert_tool/certool.conf file.

In a typical configuration, specify the parameters included in the following example or 
accept the default values where they are provided. Before you begin, note these 
parameter requirements:

• You can obtain the CA distinguished name (for cacertsearchfilter), jurisdiction ID 
(jurid), and MD5 hash (camd5) from the CA Operations Workbench of the 
RSA Certificate Manager. For more information on using the CA Operations 
Workbench, see your RSA Certificate Manager documentation and Help. 

• You must generate new certificates before the end of the valid lifetime specified 
by validdays, or Access Manager Servers configured for authenticated SSL cease 
to function. A short validity period requires you to frequently generate new 
certificates. 

• Meaningful naming of aliases and filenames is important if you are issuing 
certificates for multiple server hosts or if you are using multiple CAs. In such 
cases, prepare a naming convention prior to configuration.
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Running the Certificate Tool

Before running the Certificate Tool, gather this information:

• The SSL passphrase that you specified during the installation of your 
RSA Certificate Manager. 

• A new password to protect the PKCS #12 keystore file that is generated by the 
utility. You must provide this password when you run the Certificate Tool. 

• A new password to protect the private key. This is required because the private 
key is also stored in a separate file.

Once configured, run the Certificate Tool (certool.exe) from a command prompt on 
either the Windows or UNIX platforms. The program is executed with two arguments, 
a function name and the path to the certool.conf file:

certool -function_name path_to_certool.conf

The available function names are:

-create. Generates a new key pair, requests a new server certificate, retrieves the 
signing CA certificate, and puts them all in a PKCS #12 file. This function option 
provides all the key pair and certificate information needed to configure mutually 
authenticated SSL on a typical Access Manager Server host.

For use in the Web Server Agent setup or for other special PKI needs, the 
information included in the PKCS #12 file is also retrieved separately, as defined 
by these parameters: certoutfile, keyoutfile, and cacertoutfile. For more 
information, see the parameter comments in 
AXM_HOME/cert_tool/certool.conf.

-add. Adds an external CA certificate to an existing keystore, useful for setting up 
anonymous SSL connections for Active Directory or the Web Server Agents. For 
more information, see “Retrieving the Signing CA Certificate from 
RSA Certificate Manager” on page 219.

Note: Run the Certificate Tool for each Access Manager component that needs a 
certificate, as listed in the “Overview of Intercomponent Security” on page 214. 
Though it is possible to use just one PKCS #12 keystore file for all components, this is 
not recommended.

To run the Certificate Tool:

1. Open a command prompt, navigate to the directory where the Certificate Tool is 
located, and type the appropriate Certificate Tool function name and the full path 
to the configuration file. For example:

certool -create c:AXM_HOME\cert_tool\certool.conf

2. Enter the SSL passphrase at the prompt. This passphrase is specified in the 
process of installing RSA Certificate Manager. The RSA Certificate Manager 
administrator can provide it. 

3. Enter a password to protect the PKCS #12 keystore. 

4. Enter a password to protect the separate private key file.
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When you exit, the Certificate Tool saves the keystore to the location specified in 
certool.conf.

Access Manager components using mutually authenticated SSL require information 
regarding the locations and passphrases of the CA and private keystores. This 
information is specified by keystore parameters in the configuration files of the 
Access Manager Servers, Data Adapters, and Web Server Agents.

Configuring the RSA Access Manager Servers for Mutually Authenticated SSL

The following directions apply to these files:

• Entitlements Server (eserver.conf)

• Dispatcher (dispatcher.conf 

• Key Server (keyserver.conf)

• Authorization Server (aserver.conf)

• Instrumentation Server (iserver.conf)

To set parameters for mutually authenticated SSL:

1. Set the cleartrust.net.ssl.use parameter for each Server to auth. For example:
cleartrust.net.ssl.use=auth

2. Set these keystore parameters related to the CA keystore for each Server:

• cleartrust.net.ssl.ca.keystore_file=filename 
This parameter specifies the filename of the keystore where the issuing CA 
certificate or certificates are stored. Place this file in the /conf directory, or 
provide a path relative to the /conf directory. 
For example:
cleartrust.net.ssl.ca.keystore_file=ca_keystore.p12

• cleartrust.net.ssl.ca.keystore_passphrase=password
The password used to unlock the keystore.
For example:
cleartrust.net.ssl.ca.keystore_passphrase=jeepster%#49

3. Set these keystore parameters related to the keystore and private key for each 
Server: 

• cleartrust.net.ssl.private.keystore_file=filename
This parameter specifies the filename of the keystore where the private key 
for this Access Manager Server is stored. Place this file in the /conf directory, 
or provide a path relative to the /conf directory.
For example:
cleartrust.net.ssl.private.keystore_file=keystore.p12

• cleartrust.net.ssl.private.keystore_passphrase=password 
The password used to unlock the keystore. 
For example:
cleartrust.net.ssl.private.keystore_passphrase=KerNew2z
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• cleartrust.net.ssl.private.key_alias=alias
The alias (Common Name) of your private key in the keystore.
For example:
cleartrust.net.ssl.private.key_alias=private_key77a

• cleartrust.net.ssl.private.key_passphrase=password
The password used to unlock the private key specified by 
cleartrust.net.ssl.private.key_alias.
For example:
cleartrust.net.ssl.private.key_passphrase=os4igo7o%

Note: Configuring Access Manager for mutually authenticated SSL mode also 
requires making these same changes to your RSA Agent configuration file. For more 
information, see your Agent Installation and Configuration Guide.

SSL Settings for RSA Access Manager API Clients

If you are using the Access Manager APIs, you have the option of configuring 
different SSL settings for the API connections. 

Administrative API

For Administrative API connections to the Entitlements Server, see the comments for 
the cleartrust.eserver.api_port.use_ssl parameter in the 
AXM_HOME/conf/eserver.conf file. 

Runtime API

For Runtime API connections to the Authorization Server, see the comments for the 
cleartrust.runtime_api.security parameter in the AXM_HOME/conf/aserver.conf file.

Peer Verification

Enable Peer Verification

An Authorization server can be configured to verify the clients that are connecting to 
it. It can be enabled by using the cleartrust.net.ssl.verify_peer_cn=true parameter.

Verification Mode

Typical clients of Authorization server include RSA Access Manager Agents and 
Runtime API clients. While connecting the clients will present a certificate containing 
a common name (CN). Clients will be verified based on the configured verification 
mode. It can be configured using the parameter 

cleartrust.net.ssl.peer_verification_mode=HOST_NAME | 
TRUST_LIST | BOTH | EITHER.

where, HOST_NAME: The common name (CN) in the certificate of the clients is 
compared against the fully qualified domain name (FQDN) or IP address of the 
client.The FQDN of the connecting client is resolved using DNS or the name 
resolution mechanism configured on this machine.
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TRUST_LIST: The common name (CN) or fingerprint of the certificate of the client is 
compared with the list of entries specified in the file mentioned in the parameter 
cleartrust.net.ssl.trusted_peer_list_file.

BOTH: Both the HOST_NAME and TRUST_LIST condition has to be satisfied 
before the client can be trusted.

EITHER: Either the HOST_NAME or TRUST_LIST condition has to be satisfied 
before the client can be trusted.

Trusted Peers

The trusted peer list file contains the list of accepted common names (CN) or 
certificate fingerprint that can be trusted. The file has to be placed under the conf 
directory and the file name is configured with the parameter 

cleartrust.net.ssl.trusted_peer_list_file={trusted_peer_l
ist.txt} 

trusted_peer_list.txt should be defined in the format described below: 
CN=host1.trusted.com

CN=host2.trusted.com

MD5=AC:64:87:57:51:E9:AA:41:DA:29:73:60:53:F9:2C:B3:E5:2B:05:74

SHA1=AC:64:87:57:51:E9:AA:41:DA:29:73:60:53:F9:2C:B3:E5:2B:05:74

Note: Only MD5 and SHA1 fingerprints are supported.

Revoked Peers

The revoked peer list file can be used to deny connection to clients with a revoked 
certificate. The revoked peer list file contains a list of CN or certificate fingerprints 
that cannot be trusted. The revoked peer list file has to be placed under the conf 
directory and the file name is configured with the parameter 

cleartrust.net.ssl.revoked_peer_list_file={revoked_peer_l
ist.txt}

The revoked_peer_list.txt should be defined in the format (same as 
trusted_peer_list.txt) described below. 

CN=host1.untrusted.com

MD5=EE:64:87:57:51:E9:AA:41:DA:29:73:60:53:F9:2C:B3:E5:2B:05:74

SHA1=GG:64:87:57:51:E9:AA:41:DA:29:73:60:53:F9:2C:B3:E5:2B:05:74

Note: Only MD5 and SHA1 fingerprints are supported.

Dynamic update:

The file monitor thread is provided to dynamically load the changes made to peer list 
file ({revoked_peer_list.txt } or {trusted_peer_list.txt }). The frequency at which the 
monitor thread has to check for the file update is controlled by the parameter

cleartrust.net.ssl.file_monitor_interval={positive 
12: Implementing Security Features 227



RSA Access Manager 6.1 SP4 Servers Installation and Configuration Guide
integer}

This value is read in as seconds. If it is set to zero (0) then this feature is disabled.

Note: By default this feature is disabled with the default value set to zero.

Enabling FIPS Mode

RSA Access Manager provides an option to run the AxM components in FIPS 140 
(hereafter FIPS) mode. By enabling FIPS mode, AxM uses only FIPS approved 
algorithms for encryption process. 

For more information on FIPS 140, see 
http://csrc.nist.gov/publications/fips/fips140-2/fips1402.pdf

The FIPS mode is disabled by default. To enable FIPS mode, configure the 
components as mentioned in the following sections.

Note: FIPS mode is not supported for SecurID authentication. If SecurId 
authenticaiton is configured, do not enable the FIPS mode for AXM core component.

RSA Access Manager Servers

Replace CryptoJ-5.0.jar with CryptoJFIPS-5.0.jar in AXM_HOME/lib directory. The 
jar files are available in /jars directory of service pack kit.

Set the parameter cleartrust.fips_mode_enabled =true for the following 
servers in their corresponding configuration file:

• Dispatcher: dispatcher.conf file

• Key Server: keyserver.conf file

• Authorization Server: aserver.conf file

• Entitlements Server: eserver.conf file

• Log Server: lserver.conf file

• Instrumentation Server: iserver.conf file

RSA Access Manager Administrative Console

Set the parameter cleartrust.fips_mode_enabled =true in admingui.cfg file.

RSA Access Manager User Self-Service Console

com.rsa.axm.selfservice.fips_mode_enabled=true

Set above parameter to true when all the following parameters are encrypted using 
FIPS algorithm:

• com.rsa.axm.selfservice.adapi.user_id

• com.rsa.axm.selfservice.adapi.user_password
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• com.rsa.axm.selfservice.ssl.ca.keystore_passphrase (If AUTH_SSL mode is 
enabled)

• com.rsa.axm.selfservice.ssl.private.keystore_passphrase (If AUTH_SSL mode is 
enabled)

• com.rsa.axm.selfservice.ssl.private.key_passphrase (If AUTH_SSL mode is 
enabled)

RSA Access Manager Runtime Web Service

Set the parameter cleartrust.ws.rtapi.fips_mode_enabled to "true" in 
web.xml file.

RSA Access Manager Administrative Web Service

Set the parameter cleartrust.ws.admin.api.fips_mode_enabled to "true" in 
web.xml file.

Note: When the AxM server is configured for AUTH_SSL connection mode, ensure 
that the private keystore file (PKCS12) is FIPS compliance. If not, the AxM server 
will not start up when FIPS mode is enabled. If FIPS mode is disabled, thenAxM 
servers will not complain about the non-FIPS compliance PCKS12 file.

To upgrade the private keystore file to use FIPS compliance algorithm, see the 
documentation of a key generation tool like OpenSSL. 

For example, to convert a non-FIPS compliance key store to a FIPS compliance key 
store file, see: 

http://help.globalscape.com/help/secureserver3/Converting_an_incompatible_P
KCS_12_format_file_to_a_compatible_PKCS_12_.htm
12: Implementing Security Features 229

http://help.globalscape.com/help/secureserver3/Converting_an_incompatible_PKCS_12_format_file_to_a_compatible_PKCS_12_.htm
http://help.globalscape.com/help/secureserver3/Converting_an_incompatible_PKCS_12_format_file_to_a_compatible_PKCS_12_.htm


RSA Access Manager 6.1 SP4 Servers Installation and Configuration Guide
Session Replay Protection

RSA Access Manager Session (or cookie) can be replayed after user logs out. To 
avoid replaying the logged out cookie, configure the aserver.conf as follows:

1. Set the parameter 
cleartrust.aserver.logoff.session_replay_protection to 
true.

2. The following are optional paramters that can be further configured:

Parameter Description

cleartrust.aserver.logo
ff.session_manager

this parameter takes the class name that that 
implements the interface ISessionManager. This 
class is used to manage the logged off sessions. For 
more information about the ISessionManager 
interface please see the the Runtime API java 
document

Out-of-box RSA Access manager provides two 
implementations of ISessionManager.

The 
sirrus.authserver.session.memory.I
nMemorySessionManager implementation is 
based on RSA Access Manager caching 
mechanism.

The 
sirrus.authserver.session.ehcache.
EhcacheSessionManager implementation is 
based on EHcache caching mechanism. 

For more information. see the 
AXM_HOME/conf/rsa-axm-ehcache.xml file.

The default value is 

sirrus.authserver.session.memory.I
nMemorySessionManager.

cleartrust.aserver.logo
ff.session_expiration_t
ime

This parameter contains the value after which the 
sessions that are managed by the Session Manager 
can be safely removed from the data store.

The default value is one hour.

The dependency for this parameter is that the 
values set for this parameter should be greater than 
or equal to 
cleartrust.keyserver.token_lifetim
e in the keyserver.conf.
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Note: Only rolling restart of Authorization servers is supported. At any given point, 
there should be atleast one Authorization server running. If you shutdown all the 
Authorization servers, you must restart the Dispatcher / key server as well.

Generating lockbox

This section describes the steps that need to be followed to create the lock box file 
which is used by following components:

• EncryptUtil tool, 

• Self-Service Console and 

• Instrumentation server 

The lockbox file stores the encryption key used by above components. The encryption 
key is derived from the passphrase while creating the lockbox.

To generate a lockbox you must:

1. Install the Lockbox Dependencies (DLLs/.SO files)

2. Create Lockbox File using the lockbox-tool.bat / lockbox-tool.sh

cleartrust.aserver.logo
ff.session_cleanup_inte
rval

This parameter determines time interval in which 
the ISessionManager .removeSession method will 
be invoked by Authorization server.

The default value is 120

The allowed values are any positive integer 
representing the time in seconds.

Parameter Description
12: Implementing Security Features 231



RSA Access Manager 6.1 SP4 Servers Installation and Configuration Guide
Install the Lockbox Dependencies

Lockbox relies on library files to function properly. These library files needs to be 
installed in those machines where lockbox needs to be used.

The following components use the lockbox tool.

• Self-Service console

• Instrumentation server (for SNMP v3)

• Lockbox Migration Tool

• EncryptUtil Tool.

The Lockbox dependency has to be installed in the machines where above 
components are deployed or used.

To install lockbox on a Windows platform:

1. Copy the /cst folder from 6.1 SP4 kit to a temporary location.

2. Navigate to the /cst folder in the temporary location.

3. Run vcredist_x86.exe (installs Visual C++ redistributable package).

4. Update the PATH environment to point to the .dll and .sig file in /cst folder.

To install lockbox on a Linux/Unix platform:

1. Copy the /cst folder from 6.1 SP4 kit to a temporary location.

2. Navigate to the /cst folder in the temporary location.

3. Set LD_LIBRARY_PATH environment variable to point to the .so and .sig files in 
/cst folder

To install lockbox on an AIX platform:

1. Copy the /cst folder from 6.1 SP4 kit to a temporary location.

2. Navigate to the /cst folder in the temporary location.

3. Set LIBPATH environment variable to point to the .so and .sig files in /cst folder.

Create Lockbox File

To generate the lockbox file, perform the following steps:

1. Navigate to AXM_HOME/bin directory.

2. Edit the lockbox-tool.bat or lockbox-tool.sh file to set the AXM_HOME path.

3. For 64 bit machine, Edit the lockbox-tool.bat or lockbox-tool.sh file and set the 
JAVA_HOME as below.
set JAVA_HOME=%AXM_HOME%\jre64

or
JAVA_HOME=$AXM_HOME/jre64

4. Open a command shell, and change directories to AXM_HOME/bin.

5. Run the lockbox-tool. Type:
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lockbox-tool -passphrase <phrase> [-lockbox <filepath>] 
[-hostname <hostnames>]

where,
-passphrase <phrase>  : Lockbox Passphrase used to generate the encryption 
key. The passphrase must meet the following requirements.

– 8 or more characters in length

– Contain at least one numeric character

– Contain at least one uppercase and lowercase character

– Contain at least one non-alphanumeric character such as # or !

-lockbox <filepath>   : Optional. Path of the lockbox file. If the path is not 
found, a new file will be created with the name "lockbox.clb". If found, the file 
will get updated with list of hostname passed.
-hostname <hostnames> : Optional. List of host names separated by comma 
in which the lockbox file will be used.
For example:
lockbox-tool.bat -passphrase A3!qqqqq -hostname 
self-service1.host.com, self-service2.host.com, 
iserver1.host.com
The generated lockbox file can be further used by EncryptUtil tool, Self-Service 
console, Instrumentation server or Lockbox Migration tool.
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13Managing RSA Access Manager Log Files

• Understanding the RSA Access Manager Log Files

• Understanding Log File Content

• Understanding the Logging Levels

• Configuring the Logging Parameters for Local Logging

• Archiving the Log Files

• Centralized Logging

• Disabling the Log Server

• Enhanced Logging

RSA Access Manager records system events in log files. This information is normally 
used to troubleshoot errors as well as to audit authentication, authorization, and 
administration activities. Log files are saved in two ways:

Local logging. By default, log output from the Access Manager Servers is saved in 
separate log files (aserver.log, eserver.log, and dispatcher.log) on the host.

Centralized logging. When enabled, log output from the Access Manager Servers is 
sent to the Access Manager Log Server, an optional component that installs by default 
when you install the other Servers on Windows or UNIX. The Log Server consolidates 
the logged events from the Access Manager Servers. 

This chapter provides information about: 

• The information saved in each log file

• The process of configuring each Server for local logging

• The process of configuring the Log Server and the Access Manager Servers 
for centralized logging

• The process of enabling enhanced logging

CAUTION: Log files contain sensitive information. For example, Authorization Server 
logs identify which users have access to which resources. Because of this, RSA 
recommends that you grant access to log files only to the most trusted administrators.

Understanding the RSA Access Manager Log Files

The information that is logged is the same whether the logging is local or centralized.

The following sections describe the information contained in Access Manager log 
files. 
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Authorization Server Log

The Authorization Server log monitors the activity occurring on the Authorization 
Server, which is the runtime server in the Access Manager system. This log tracks 
request activity from the RSA Access Manager Agents and other Runtime API clients. 
The Authorization Server log records the following information:

• Startup messages

• Error messages

• User authentication requests

• Resource authorization requests

Entitlements Server Log

The Entitlements Server log monitors the activity occurring on the Entitlements 
Server, which is the administrative server in the Access Manager system. This log 
tracks activity occurring in the RSA Administrative Console and the Administrative 
API clients. The Entitlements Server log records the following information:

• Startup messages

• Error messages

• Administrative API transactions

Entitlements Server Log File Format Options

These specific options provide a higher level of detail in Entitlements Server logs:

Two-phase logging. Two events are generated for each API command, the first 
prior to execution, the second upon completion. If two-phase logging is disabled 
(the default setting), a single event is generated upon command completion.

API parameters. If enabled (the default setting), API parameters are included in 
log events. These parameters may provide contextual information, such as API 
search parameters or modifications to entries, that gives details about what 
particular objects have been retrieved, modified, or both.

Verbose detail format. Logs additional information about objects in a verbose, 
readable form. Though many commands include opaque object UIDs, this option 
renders those commands in readable object names and identifiers in log events.

Enhanced logging. Generates a detailed audit of who performed an operation, 
what operation was performed, and when it was performed. For more information, 
see “Enhanced Logging” on page 251.

Dispatcher/Key Server Log

The Dispatcher/Key Server log records the activity occurring on the Dispatcher/Key 
Server, which keeps track of the available Authorization Servers and distributes SSO 
keys to the Agents. The Dispatcher/Key Server log records the following information:

• Startup messages

• Error messages

• Authorization Server registration information
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• Agent request information

Log Server Log

When centralized logging is enabled, the Log Server log is where the Log Server 
writes messages from all Access Manager Servers that have been configured for 
centralized logging. You can configure the Log Server to centralize logging for one or 
more Access Manager Servers.

RSA recommends that you run a separate instance of the Log Server on one host for 
each type of Access Manager Server. For more information, see “Setting Up Multiple 
Log Servers on One Host” on page 248.

Web Server Logs

The RSA Access Manager Agent does not interfere with the normal logging activity 
of your web server. The name and location of your web server log files vary according 
to vendor. Most web servers, such as Sun Java System Directory Server, Apache, and 
Internet Information Services (IIS) use separate log files for reporting errors and for 
reporting normal access events.

For example, when Access Manager allows a user to access a resource on a web 
server, the web server records the access as normal. Similarly, when Access Manager 
denies access, the web server records it as an error.

Access Manager records its own errors in the error log of a web server. For example, 
whenever the Agent has lost its connection to an Authorization Server and must 
contact the Dispatcher/Key Server to get a new list of active Authorization Servers, 
the Agent records the error in the error log of the web server. The Agent generally 
only records the error when the web server starts up, but it can happen again if the 
Authorization Server becomes unavailable.

Understanding Log File Content

In order to read and process log files with a third-party log parser or analyzer, the log 
entries must have a consistent format. If necessary, you can change the character used 
to delimit each log entry. For more information, see the log.delimiter parameter in the 
aserver.conf file, eserver.conf file, and dispatcher.conf file.

The default format for log messages uses commas to delimit each entry, as shown in 
the following aserver.log example:

sequence_number=127,2005-11-15 16:17:53:586PST,
messageID=1011,user=group22user4,webserver=atlas,URI=/sunset.jpg,
Resource=/sunset.jpg,client_ip_address=10.104.88.199,client_port=4231,
result_code=1000,result_action=Authorization Failure,result_reason=No 
Entitlement,ext_result=user_group<10

This example contains the following information:

sequence_number=127. Each event is tagged with a sequence number. When 
centralized logging is enabled, this identifies any gaps in the log file which are 
introduced when the Access Manager Servers assume logging because the Log 
Server is unavailable.
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2005-11-15 16:17:53:586 PST. Each event is tagged with a date and time stamp.

messageID=1011. The message ID indicates the code for the action being 
recorded in an event. The meaning of the message ID code for each Access 
Manager Server is provided in the appendixes in this book.

user=group22user4. This identifies the user being authenticated.

webserver=atlas. This identifies the web server being accessed.

URI=/sunset.jpg. This identifies the resource being sought.

Resource=/sunset.jpg. This identifies the name of the resource.

client_ip_address=10.104.88.199. This identifies the user’s computer.

client_port=4231. This identifies the port being used by the user’s computer.

result_code=1000. The result code indicates the log message for the result of the 
event. Result code IDs are provided in the relevant appendix

result_action=Authorization Failure. The result action identifies the result of 
the event.

result_reason=No Entitlement. The result reason identifies the reason for the 
result action.

ext_result=user_group<10. The extended result identifies additional information 
for the result. For example, if a user has been denied access because of a 
SmartRule, the rule that denies access is displayed here.

Note: The order of the keyword/value pairs might be displayed in a different order 
than the one in this example.

You can also use the enhanced logging parameter in your configuration files to log 
entries. For more information, see the log.enhance parameter in the configuration 
files. 

To enable the new log format, set the log.enhance parameter to true in the respective 
server configuration files.

You can configure the delimiter for each log entry in the new format for log messages. 
The first line in the log file is called header, which defines the type of log entry and the 
subsequent lines define the log entries. 

Note: The header and the log entries varies across the Access Manager server log 
files.

The following are the examples of the new log message format: 

dispatcher.log:

Sequence ID ,Date ,Message ID ,Event Type ,Additional Message ,Event Level.
1,2009-04-09 17:09:58:812 GMT+05:30,3000,Server Bootstrap,{Server 
Version=RSA Access Manager Dispatcher/Key Server Version 6.1SP4},10.
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aserver.log:

Sequence ID ,Date ,Message ID ,Event Type ,Additional Message ,Event Level.
1,2009-04-14 17:00:35:562 GMT+05:30,3000,Server Bootstrap,{Server 
Version=RSA Access Manager Authorization Server Version 6.1SP4},10.

eserver.log:

Sequence ID ,Date ,Message ID  ,Event Type ,User Name ,User Role ,Connection ID 
,Operation ID ,Event ID  ,Client IP Address ,Result ,Duration ,Exception ,Message 
,Additional Message ,Event Level.
1,2009-04-14 17:00:41:937 GMT+05:30,3000,Server Bootstrap, , , , , , , , , , ,{Server 
Version=RSA Access Manager Entitlements Server Version 6.1 SP4},10.

iserver.log:

Sequence ID ,Date ,Message ID ,Event type ,Event Details ,Additional Message 
,Event Level.
1,2009-04-15 10:59:31:687 IST,1101,Traps disabled, ,{event_details=Warning: target 
host has not been defined. Traps will not be sent.subcomponent=SNMP Agent},20.

For more information on the log message IDs, see the relevant appendix:

• Appendix C, “Log Message IDs for Authorization Server”

• Appendix D, “Log Message IDs for Entitlements Server”

• Appendix G, “Log Message IDs for Dispatcher/Key Server”
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Understanding the Logging Levels

The events that are logged depend on the logging level you set. The logging levels are 
cumulative, higher logging levels include all the information recorded in lower levels. 
For example, level 30 includes levels 10 and 20. The following table lists the various 
Access Manager logs and the events that are logged. 

Access Manager Log 10 (Error) 20 (Deny) 30 (Allow) 40 (Debug)

Authorization Server

(User Activity)

• Server Startup

• Invalid 
Argument

•  Data Store 
Error

• Authentication 
Errors 

• Internal Error

• Server Test 
Failure

• Unknown Error

• Access Denied

• Bad Password

• Locked Out

• Expired 
Account

• Inactive 
Account

• Failed 
Authentication

• Password 
Expired

• Entitlement 
Denied

• Smart Rule 
Denied

• Unknown User

• Access 
Allowed

• Protected 
Resource

• Entitlement 
Allowed

• Smart Rule 
Allowed

• Valid User

• Server Test 
Succeeded

• Unknown 
Resource

• Unprotected 
Resource

• Cache Preload 
Overflow

Entitlements Server

(Administrator Activity)

• Internal Error • Logon failed

• Create Failure

• Delete Failure

• Modify Failure

• Administrator 
Permissions 
Denied

• Read Access 
Denied

• Administrator 
Logon

• Create

• Delete 

• Modify

• Administrator 
Permissions

• Read Access 

• Startup events 
and all events 
are recorded

Dispatcher/Key Server

(System Activity)

• Server Startup

• Internal Error

• Unknown Error

• Dispatcher 
Down

• Dispatcher List 
Request

• Register with 
Dispatcher

• Send Session 
Key

• New Session 
Key

• Receive 
Session Key

• Lead Key 
Server 
Selection
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Log output is saved according to the parameter settings in each Server’s configuration 
file. In the configuration file, you can set the level of log information that is recorded 
by each Access Manager Server. The logging level that you set for each Server also 
specifies the level of information sent to the Log Server when centralized logging is 
enabled.

The following table lists the five logging levels.

Note: Logging levels 30 and 40 write entries to the logs very frequently and can use 
up significant disk space. RSA recommends using these logging levels for testing and 
debugging only. If you do plan to use levels 30 or 40 in production, make sure that you 
have sufficient disk space for the logs.

Logging Level Description

0 No events are written to the log file. RSA recommends that you do not 
use this logging level.

10 Logs only internal errors occurring within the Access Manager system. 
For example, this level records any errors that occur when an Access 
Manager component cannot connect to another component to complete 
an operation.

20 For the Authorization Server and Entitlements Server: Logs any 
denial event that occurs during Access Manager operations. For 
example, this level records when a user is denied access to a resource or 
has failed an authentication attempt. This is the recommended logging 
level. 

For the Dispatcher/Key Server: Logs only instances of complete 
server failure.

30 For the Authorization Server and Entitlements Server: Logs any 
allowed event that occurs during Access Manager operations. For 
example, this level records when a user is allowed access to a resource 
or has successfully authenticated. 

For the Dispatcher/Key Server: Logs warning events. The Dispatcher 
writes messages to the log if it is unstable or about to fail. This is the 
recommended logging level. 

40 Logs all events occurring within the Access Manager system. This level 
may be helpful during development and installation to help troubleshoot 
problems.
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Configuring the Logging Parameters for Local Logging

The procedures in this section describe how to set the logging parameters for local 
logging in the configuration file for each Server.

Setting the Logging Parameters for the Authorization Server

To set the logging parameters for the Authorization Server: 

1. Navigate to the AXM_HOME/conf directory on the host where your 
Authorization Server is installed, and open the aserver.conf file.

2. Accept the default name for the Authorization Server log file, or change the name 
by editing the following parameter:

cleartrust.aserver.log=aserver.log

3. Set the default logging level, or specify a different level in the following 
parameter:

cleartrust.aserver.log.level=

4. Accept the default maximum log size (in kilobytes), or change the size by editing 
the following parameter:

cleartrust.aserver.log.size=1000

5. Accept the default number of log file backups to save, or change the number by 
editing the following parameter:

cleartrust.aserver.log.backups=10000

6. Accept the default delimiter that separates entries in the log files, or change the 
delimiter by editing the following parameter:

cleartrust.aserver.log.delimiter=,

7. Set the delimiter value (any string value or special character) that separates 
key-value entries in the log file in the following parameter:

cleartrust.aserver.log.key_delimiter=

8. Save and close the file.

Setting the Logging Parameters for the Entitlements Server

To set the logging parameters for the Entitlements Server:

1. Navigate to the AXM_HOME/conf directory on the host where your Entitlements 
Server is installed, and open the eserver.conf file.

2. Accept the default name for the Entitlements Server log file, or change the name 
by editing the following parameter:

cleartrust.eserver.log=eserver.log

3. Set the default logging level, or specify a different level in the following 
parameter:

cleartrust.eserver.log.level=20
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4. Accept the default maximum log size (in kilobytes), or change the size by editing 
the following parameter:

cleartrust.eserver.log.size=1000

5. Accept the default number of log file backups to save, or change the number by 
editing the following parameter:

cleartrust.eserver.log.backups=10000

6. Accept the delimiter that separates entries in the log files, or change the delimiter 
by editing the following parameter:

cleartrust.eserver.log.delimiter=,

7. Set the delimiter value (any string value or special character) that separates 
key-value entries in the log file in the following parameter:

cleartrust.eserver.log.key_delimiter=

8. Accept the default value for the following parameter, or change the value to true 
to enable two-phase logging: 

cleartrust.eserver.log.enable_two_phase_logging=false

9. Accept the default value for the following parameter, or change the value to false 
to turn the API parameters off:

cleartrust.eserver.log.include_api_parameters=true

10. Accept the default value for the following parameter, or change the value to true 
to set the entries to verbose:

cleartrust.eserver.log.verbose=false

11. Save and close the file.

Setting the Parameters for the Dispatcher/Key Server

To set the logging parameters for the Dispatcher/Key Server:

1. Navigate to the AXM_HOME/conf directory on the host where your 
Dispatcher/Key Server is installed, and open the dispatcher.conf file.

2. Accept the default name for the Dispatcher Server log file, or change it by editing 
the following parameter:

cleartrust.dispatcher.log=dispatcher.log

3. Set the default logging level, or specify a different level in the following 
parameter:

cleartrust.dispatcher.log.level=

4. Accept the default maximum log size (in kilobytes), or change the size by editing 
the following parameter:

cleartrust.dispatcher.log.size=1000

5. Accept the default number of log file backups to save, or change the number by 
editing the following parameter:

cleartrust.dispatcher.log.backups=10000
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6. Accept the default delimiter that separates entries in the log files, or change the 
delimiter by editing the following parameter:

cleartrust.dispatcher.log.delimiter=,

7. Set the delimiter value (any string value or special character) that separates 
key-value entries in the log file in the following parameter:

cleartrust.dispatcher.log.key_delimiter=

8. Save and close the file.

Archiving the Log Files 

Over time, the log files in the AXM_HOME/logs directory on a Server host grow in 
size. When a log reaches the maximum size specified in the Server configuration file, 
Access Manager closes the log file and starts a new file in the /logs directory. After the 
log file is closed, Access Manager dates, timestamps, and adds a sequence number to 
the filename. For example, the names of the backup log files for an existing 
aserver.log file would be aserver.log.1 and aserver.log.2. When the number of log 
file backups reaches the maximum number specified in the Server configuration file, 
the oldest is erased.

While the Server configuration files contain parameters that control the size, name, 
and format of the log files, Access Manager does not have a mechanism for cleaning 
out the /logs directory. If you want to maintain an archive of all log files, RSA 
recommends that you develop a process for removing and archiving backup log files.

Centralized Logging

To direct log output from the Access Manager Servers to the Log Server for 
centralized logging, you must configure the Access Manager Servers to broadcast to 
the port on which the Log Server listens. You must also set the remote logging 
parameters for each Access Manager Server. These parameters include specifying the 
hostname of the Log Server, and specifying a client ID number that identifies the 
source of the log messages that the Log Server receives and writes to a log file 
(lserver.log).

Before sending log messages to the Log Server, the Access Manager Servers tag their 
individual log entries with the client ID number, indicating which Entitlements Server, 
Authorization Server, or Dispatcher/Key Server created the log entry. For example, 
you can direct the log output of both Entitlements Server 1 and Entitlements Server 2 
to lserver.log and still be able to determine which Server sent a message.

Important: To ensure that the Access Manager Servers take over logging if your Log 
Server becomes unavailable, RSA recommends that you also configure the Access 
Manager Servers for local logging by completing the procedures in “Configuring the 
Logging Parameters for Local Logging” on page 242.
244 13: Managing RSA Access Manager Log Files



RSA Access Manager 6.1 SP4 Servers Installation and Configuration Guide
The Log Server is installed by default with the other Access Manager Servers during 
standard installation on Windows. It is enabled by selecting it as an additional feature 
during the installation process. For more information, see “Installing the RSA Access 
Manager Servers on Windows” on page 30.

The Log Server is automatically installed with the other Access Manager Servers 
during standard installation on UNIX. For more information, see “Installing the 
RSA Access Manager Servers on UNIX” on page 33.

Using the Log Server is optional.

Configuring the Log Server for Centralized Logging

To configure the Access Manager Log Server for centralized logging:

1. Navigate to the AXM_HOME/conf directory on the host where your Log Server 
is installed, and open the lserver.conf file. 

2. Accept the default port where the Log Server listens for incoming messages from 
the Servers, or change the port by editing the following parameter:

cleartrust.lserver.log.listen_port=5610 
This port number must match the port number in the log.server_port parameter in 
each Access Manager Server configuration file. The default value is 5610. 

3. Accept the default name of the log file where the Log Server writes log messages, 
or change the name by editing the following parameter:

cleartrust.lserver.log=lserver.log 

4. Accept the default maximum log size (in kilobytes), or change the size by editing 
the following parameter:

cleartrust.lserver.log.size=1000

5. Accept the default number of log file backups to save, or change the number by 
editing the following parameter:

cleartrust.lserver.log.backups=10

6. Accept the default size of the backlog of incoming log messages, or change the 
size by editing the following parameter: 

cleartrust.lserver.log.backlog_size=1000

7. Accept the default restart size for the Log Server to restart receiving requests, or 
change the size by editing the following parameter:

cleartrust.lserver.log.backlog_restart_size=500

8. Save and close the file. 
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Configuring the Authorization Server for Centralized Logging

To configure the Authorization Server for centralized logging:

1. Navigate to the AXM_HOME/conf directory on the host where your 
Authorization Server is installed, and open the aserver.conf file.

2. If you have not already done so, set the default logging level, or specify a different 
level in the following parameter:

cleartrust.aserver.log.level=

3. Set the default hostname of the Log Server’s host. If necessary, change it by 
editing the following parameter: 

log.server_host=localhost

4. Set the default port of the Log Server. If necessary, change it by editing the 
following parameter: 

log.server_port=5610
This parameter must match the log.listen_port parameter of the Log Server.

5. Set the default number of milliseconds that the Authorization Server waits before 
attempting to reestablish the connection to the Log Server, after the connection is 
lost. If necessary, change it by editing the following parameter:

log.server_reconnect_delay=3000

6. Set the default backlog size, upon which the Authorization Server stops sending 
messages to the Log Server and records the log messages locally. If necessary, 
change it by editing the following parameter:

log.backlog_size=1000

7. Set the default restart size, upon which the Authorization Server restarts sending 
requests to the Log Server. If necessary, change it by editing the following 
parameter:

log.restart_size=1000

8. Set this parameter to identify messages that the Authorization Server sends to the 
Log Server:

log.client_id=
If no value is specified, the client ID is, by default, the IP address of the 
Authorization Server host.
When several different Access Manager Servers send log messages to the Log 
Server, this parameter provides the client ID at the beginning of the log message 
to identify the origin of each message.

9. Save and close the file. 
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Configuring the Entitlements Server for Centralized Logging

To configure the Entitlements Server for centralized logging:

1. Navigate to the AXM_HOME/conf directory on the host where your Entitlements 
Server is installed, and open the eserver.conf file.

2. If you have not already done so, set the default logging level, or specify a different 
level in the following parameter:

cleartrust.eserver.log.level=

3. Set the default hostname of the Log Server’s host. If necessary, change it by 
editing the following parameter: 

log.server_host=localhost

4. Set the default port of the Log Server. If necessary, change it by editing the 
following parameter: 

log.server_port=5610
This parameter must match the log.listen_port parameter of the Log Server.

5. Set the default number of milliseconds that the Entitlements Server waits before 
attempting to reestablish the connection to the Log Server, after the connection is 
lost. If necessary, change it by editing the following parameter:

log.server_reconnect_delay=3000

6. Set the default backlog size, upon which the Entitlements Server stops sending 
messages to the Log Server and records the log messages locally. If necessary, 
change it by editing the following parameter:

log.backlog_size=1000

7. Set the default restart size, upon which the Entitlements Server restarts sending 
requests to the Log Server. If necessary, change it by editing the following 
parameter:

log.restart_size=1000

8. Set this parameter to identify messages that the Entitlements Server sends to the 
Log Server:

log.client_id=
If no value is specified, the client ID is, by default, the IP address of the 
Entitlements Server host.
When several different Access Manager Servers send log messages to the Log 
Server, this parameter provides the client ID at the beginning of the log message 
to identify the origin of each message.

9. Save and close the file. 
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Configuring the Dispatcher/Key Server for Centralized Logging

To configure the Dispatcher/Key Server for centralized logging:

1. Navigate to the AXM_HOME/conf directory on the host where your Entitlements 
Server is installed, and open the dispatcher.conf file. 

2. If you have not already done so, set the default logging level, or specify a different 
level in the following parameter:

cleartrust.dispatcher.log.level=

3. Set the default hostname of the Log Server’s host. If necessary, change it by 
editing the following parameter: 

log.server_host=localhost

4. Set the default port of the Log Server. If necessary, change it by editing the 
following parameter: 

log.server_port=5610
This parameter must match the log.listen_port parameter of the Log Server.

5. Set the default number of milliseconds that the Dispatcher Server waits before 
attempting to reestablish the connection to the Log Server, after the connection is 
lost. If necessary, change it by editing the following parameter:

log.server_reconnect_delay=3000

6. Set the default backlog size, upon which the Dispatcher Server stops sending 
messages to the Log Server and records the log messages locally. If necessary, 
change it by editing the following parameter:

log.backlog_size=1000

7. Set the default restart size, upon which the Dispatcher Server restarts sending 
requests to the Log Server. If necessary, change it by editing the following 
parameter:

log.restart_size=1000

8. Set this parameter to identify messages that the Dispatcher Server sends to the 
Log Server:

log.client_id=
If no value is specified, the client ID is, by default, the IP address of the 
Dispatcher Server host.
When several different Access Manager Servers send log messages to the Log 
Server, this parameter provides the client ID at the beginning of the log message 
to identify the origin of each message.

9. Save and close the file.

Setting Up Multiple Log Servers on One Host

Though it is possible to send all the log messages from all the different Access 
Manager Servers to a single lserver.log file in the Log Server, RSA does not 
recommend this configuration. 
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RSA recommends that you run a separate instance of the Log Server on one host for 
each type of Access Manager Server. For example, on the same host you would run 
one instance of the Log Server for multiple Entitlements Servers, one instance of the 
Log Server for multiple Authorization Servers, and one instance of the Log Server for 
multiple Dispatcher/Key Servers.

To set up multiple Log Servers on one host:

1. Navigate to AXM_HOME/conf on the host machine where you plan to run 
multiple Log Servers.

2. Complete these tasks in the following order to make a Log Server instance for the 
Entitlements Servers:

• Make a copy of the lserver.conf file.

• Rename the copied file as lserver-eserver.conf

• Open the lserver-eserver.conf file, and change the parameter 
cleartrust.lserver.log=lserver.log to cleartrust.lserver.log=eserver.log.

• Edit the cleartrust.lserver.log.listen_port= parameter to specify a unique listen 
port.
Once configured as for centralized logging, multiple Entitlements Servers will 
direct their log output to the eserver.log file that is located in this instance of 
the Log Server.

3. Complete these tasks in the following order to make a Log Server instance for the 
Authorization Servers:

• Make a copy of the lserver.conf file.

• Rename the copied file as lserver-aserver.conf

• Open the lserver-aserver.conf file, and change the parameter 
cleartrust.lserver.log=lserver.log to cleartrust.lserver.log=aserver.log.

• Edit the cleartrust.lserver.log.listen_port= parameter to specify a unique listen 
port.
Once configured for centralized logging, multiple Authorization Servers will 
direct their log output to the aserver.log file that is located in this instance of 
the Log Server.

4. Complete these tasks in the following order to make a Log Server instance for the 
Dispatcher/Key Servers:

• Make a copy of the lserver.conf file.

• Rename the copied file as lserver-dispatcher.conf

• Open the lserver-dispatcher.conf file, and change the parameter 
cleartrust.lserver.log=lserver.log to cleartrust.lserver.log=dispatcher.log.

• Edit the cleartrust.lserver.log.listen_port= parameter to specify a unique listen 
port.
Once configured for centralized logging, multiple Dispatcher/Key Servers 
will direct their log output to the dispatcher.log file that is located in this 
instance of the Log Server.
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Starting Multiple Log Servers on One Host

To start multiple Log Servers on one Windows host:

1. Open a command prompt, and navigate to the AXM_HOME/bin directory.

2. At the prompt, type each of these commands:

lserver.bat start lserver-eserver.conf

lserver.bat start lserver-aserver.conf

lserver.bat start lserver-dispatcher.conf

To start multiple Log Servers on one UNIX host:

1. Navigate to the AXM_HOME/bin directory.

2. Open the lserver.sh file and change the PID name as follows:

PIDFILE=$AXM_HOME/var/lserver-$3.pid

3. At the prompt, type each of these commands:

lserver.sh start lserver-eserver.conf

lserver.sh start lserver-aserver.conf

lserver.sh start lserver-dispatcher.conf

Mirror Sites

If an organization has several load-balanced web servers acting as mirror sites—that 
is, they all serve the same content and have the same directory structure and files—
those servers can share the same name in the Administrative Console. In addition to 
having the same name in the Administrative Console, the servers must all have the 
same name specified in their RSA Access Manager Agent configuration file. You only 
need to assign URLs once for mirrored resources.

If servers are configured as mirror sites, it is not possible to track activity on each 
individual server if centralized logging is used.

Disabling the Log Server

To disable the Log Server on Windows:

Use the Microsoft Management Console to disable the Log Server as a service.

To disable the Log Server on UNIX:

Open the initialization script axm61, and set LSERVER_ENABLED to 0.
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Enhanced Logging

You can configure Access Manager to provide enhanced logs that record operations on 
the following objects:

• Administrative groups

• Administrative roles 

• Administrative password policies 

• Administrative users

• Administrative user properties

• Applications

• Resources (URL, J2EE)

• Web servers

• Smart Rules

When enhanced logging is enabled, the operations that each administrator performs on 
these objects are recorded. This makes it possible to have a detailed audit of who 
performed an operation, what operation was performed, and when it was performed.

The information that is included in enhanced logging depends on the type of 
operation—create, modify, or delete—that is performed. 

Operation Information Recorded

create • Object name

• Unique object identifier (UID)

The UID is used to track the object through its life-cycle.
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Enabling Enhanced Logging

Enhanced logging is enabled when the configuration file for the Entitlements Server 
(eserver.conf) is configured with the following settings: 

• cleartrust.eserver.log.enhance=true

• cleartrust.eserver.log.verbose=true

• cleartrust.eserver.log.include_api_parameters=true

• cleartrust.eserver.log.level=20 (or greater)

modify • Original object values and modified object values:

– For administrative users: role, Super Admin/Help Desk 
Admin privileges, user properties, password expiration 
date

– For administrative groups: admin group name, password 
policy

– For administrator roles: role name, privileges

– For administrative group membership: administrative 
group, administrative group UID

– For Access Manager Servers: administrative group, server 
name, Server host

– For web or application servers: name, policy conflict 
resolution

– For resources: server, resource type (URL/J2EE:J2EE 
type), web resource, policy conflict resolution

– For user property definitions: name, data type, external, 
external property provider, read only, export/publish, 
multi-value, administrative group, visibility, help desk 
access

– For administrative group password policy: policy name, 
lifetime, history, minimum lifetime, default policy, 
minimum length, maximum length, excluded characters, 
excluded words file, non-alpha required, lock out, lock out 
incorrect tries, lock out time, unlock, administrative group

delete • Object name

• Unique object identifier (UID)

• Associated objects:

– For administrative group: any associated administrative 
role

– For administrative user/user group: any associated 
entitlement

– For administrative user properties: any associated Smart 
Rule

– For resources: any associated policy

– For web server: any associated URL

Operation Information Recorded
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CAUTION: When enhanced logging is enabled, the demand for storage space 
increases considerably because log messages are longer and more events are logged. 
Ensure that adequate storage space is available to meet increased storage 
requirements. 

For more information about enhanced logging, see Appendix I, “Enhanced Logging.” 

You can further enhance the logs to:

• Display timestamps along with error messages on the Administrative Console.

• Contain details of messageID, result_code, result_action, result_reason, 
requested_resource, and served_state.

Note: The details for served_state have information to indicate if the data was 
fetched form database or cache.

• Contain the detail for result_code in log messages, which are aligned to the log 
level.

• Contain the header in the first line of the log file for new log format.

• Contain messages about every supported and unsupported API call.

• Contain timestamps for the events.

• Contain globally unique identifier (GUID) for every record of log message. Each 
operation will have a unique identifier (GUID).

Enhanced logging is enabled when the configuration file for the Authorization Server, 
Entitlements Server, Dispatcher, Log Server, and Instrumentation Server is configured 
with the following setting:

• cleartrust.aserver.log.enhance=true in the aserver.conf file

• cleartrust.eserver.log.enhance=true in the eserver.conf file

• cleartrust.dispatcher.log.enhance=true in the dispatcher.conf file

• cleartrust.lserver.log.enhance=true in the lserver.conf file

• cleartrust.iserver.log.enhance=true in the iserver.conf file
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14Simple Network Management Protocol 
Support

• Network Management System

• Installing and Configuring the Instrumentation Server

• Starting the RSA Access Manager Instrumentation Server Manually

• Disabling RSA Access Manager SNMP Support

• Disabling the Instrumentation Server

• Dynamic Debugging

• Monitoring Java Virtual Machine

As part of the RSA Access Manager 6.1 installation process, an Instrumentation 
Server is installed on each machine hosting Access Manager Servers. The 
Instrumentation Server enables network management using a third-party Network 
Management System (NMS) that communicates with the Access Manager Servers 
using Simple Network Management Protocol (SNMP). An NMS reveals how Access 
Manager Servers are functioning in a production environment.

This chapter provides background information about SNMP as well as the information 
required to set up Access Manager to use a third-party NMS. 
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Network Management System

The following diagram shows an Access Manager installation monitored by a 
Network Management System. In this diagram, all of the Access Manager Servers are 
installed on multiple hosts.

The NMS receives information from each Access Manager Server through the 
Instrumentation Server, which is installed on each machine hosting an Access 
Manager Server. The Instrumentation Server collects information from each Access 
Manager Server by means of Java Management Extensions (JMX) and relays that 
information to the NMS using SNMP. The information collected is defined by the 
Management Information Base (MIB), which is installed on the host when the Servers 
are installed. 

Using an NMS, a systems administrator can query the Instrumentation Server for 
information about each Access Manager Server and receive notifications that have 
been triggered by a particular Server event, such as when a Server has logged a critical 
message.

For a list of the information in the MIB that Access Manager makes available to a 
third-party NMS, see Appendix H, “Management Information Base.”
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Installing and Configuring the Instrumentation Server

During the Access Manager installation process, you can select to install the 
Instrumentation Server. If you choose to implement instrumentation, the 
Instrumentation Server is installed and set to start automatically when the host 
machine is started. If you choose not to install instrumentation, the Instrumentation 
Server is installed but is set to start manually, in case you decide to use this feature in 
the future. 

The SNMP parameters are set during the installation process. For information about 
SNMP connection parameters, see the comments in the 
AXM_HOME/conf/iserver.conf file.

SNMPv3 Support 

SNMPv1/v2 can neither authenticate the source of a management message nor 
provide encryption. Without authentication, it is possible for unauthorized users to 
exercise SNMP network management functions. It is also possible for unauthorized 
users to eavesdrop on management information as it passes from managed systems to 
the management system. To correct the security deficiencies of SNMPv1/v2, SNMPv3 
was issued as a set of proposed standards.

Starting with AXM 6.1 SP4, SNMPv3 is supported. SNMPv3 includes three important 
services: 

• Authentication

• Privacy

• Access control 

The above services are defined by two core modules namely-

• User-based Security Model (USM) 

• View-based Security Model(VACM)

The USM is in charge of authenticating/encrypting/decrypting SNMP packets. The 
USM introduces the concept of a principal, that operates from a management station 
and issues SNMP commands to the SNMP agent systems. The use of principals allows 
security policies to be tailored to the specific principal, agent, and information 
exchange, and gives network or system administrators considerable flexibility in 
assigning network authorization to users. Each user provides secret keys for 
authentication and privacy.

The VACM is in charge of administering access to MIB data. The access control 
facility makes it possible to configure agents to provide different levels of access to 
the MIB of the agent to different managers. An agent entity can restrict access to its 
MIB for a particular manager entity in two ways. First, it can restrict access to a 
certain portion of its MIB. For example, an agent may restrict most principals to 
viewing performance-related statistics and allow only a single designated principal to 
view and update runtime configuration parameters. Second, the agent can limit the 
operations that a principal can use on that portion of the MIB. For example, a 
particular principal could be limited to read-only access to a portion of the MIB of an 
agent. 
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The access control policy to be used by an agent for each manager must be pre 
configured. The access control policy essentially consists of a table that details the 
access privileges of the various authorized managers. Access control is done at group 
level where a group may be a set of multiple users unlike authentication which is done 
by the user.

Note: Lockbox is required for SNMPv3. Please install lockbox dependency and 
configure lockbox_file_path parameter.

SNMP Agent Access Policy File 

SNMP Agent Access Policy configuration file is used to create and configure 
SNMPv3 User Security Model (USM) and view-based Access Control Model 
definitions. The access policy file has three different sections namely:

• USM-User table definitions 

• VACM-Security to Group and Access Table definitions

• VACM- View tree family table definitions

User Table

Every agent maintains a user table which is used to store all the users that have access 
to the system via SNMP. 

Each user entry in the table contains the following information, all of which can be 
modified via SNMP operations on the USM MIB:

User Entry Information

User Name or securityName A human readable string representing the name of 
the user or principal.

Authentication Protocol or 
authProtocol

An indication of whether or not messages sent or 
received on behalf of this user can be authenticated 
and if so, which authentication protocol to use. The 
current values for this field are MD5 or SHA.

Authentication Key or 
securityPassphrase

The localized secret key used by the authentication 
protocol for authenticating messages. For more 
information, see “Running the EncryptUtil Tool” 
on page 212.

Privacy Protocol or 
privacyProtocol

An indication of whether or not messages sent or 
received on behalf of this user can be encrypted 
and if so, which privacy protocol to use. The 
current values for this field are DES and AES.
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Security to Group Table

A group name is used to define an access control policy for a group of principals. Note 
that a principal is more specific than an SNMP entity. It is more like an individual user 
operating from an SNMP entity. A group is a set of zero of more securityModel and 
securityName tuples on whose behalf managed objects can be accessed. The 
combination of a securityModel and a securityName maps to at most one group. That 
is, a given principal whose communications are protected by a given securityModel 
can only be included in one group. The vacmSecurityToGroupTable is used to store 
group information and is indexed by a securityModel and securityName. 

Each row in this table contains the following information:

Context Table

A context is defined as a collection of managed objects accessible by an SNMP entity. 
In other words, a name is given to a subset of managed objects. The 
vacmContextTable is used to store the locally available context, as defined by the 
parameter in the iserver.conf-“cleartrust.iserver.snmp.agentserver.context”. 

Privacy Key or 
privacyPassphrase

The localized secret key used by the privacy 
protocol for encrypting and decrypting messages. 
This value needs to be encrypted using 
EncryptUtil tool. For more information, see 
“Running the EncryptUtil Tool” on page 212.

User Entry Information

User Entry Information

vacmSecurityModel An SNMPv1, SNMPv2c or SNMPv3 security 
model(USM).

vacmSecurityName or userIDs A name representing a principal in a security model. In 
the case of the USM, this securityName is identical to 
the userName. In the case of SNMPv1 and SNMPv2c, 
the securityName is in accordance with the following 
parameter in the iserver.conf file 
cleartrust.iserver.snmp.agentserver.s
ecurityname.

Multiple userID's can be defined only for SNMPv3 
group definitions and not for SNMPv1 and SNMPv2c 
configurations.

vacmGroupName A human readable string which identifies the group that 
this table entry belongs. 
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The table is indexed by a contextName and each row in this table contains:

vacmContextName or 
cleartrust.iserver.snmp.agentserver.context: A unique human 
readable string which names a context. Default value is public.

Note: For SNMPv1/SNMPv2, this value need not be modified. If the snmp message's 
specified contextName is not found in the table, access is denied and noSuchContext 
is returned. Else access checking continues if the contextName exists. 

Access Table

The vacmAccessTable is used to store the access rights defined for groups. In 
determining if access is allowed, one entry must be selected and the proper viewName 
from that entry must be used for further access checking. 

Note: The vacmAccessReadViewName, vacmAccessWriteViewName and 
vacmAccessNotifyViewName should match the views defined in the View Tree 
Family Table.

Entry Information

vacmGroupName The name of the group that this access right applies.

vacmAccessSecurityModel The securityModel that must be used in order to 
gain access to this access right.

vacmAccessSecurityLevel The minimum securityLevel that must be used in 
order to gain access to this access right. 

A security level of noAuthNoPriv is less than 
authNoPriv and authNoPriv is less than authPriv.

vacmAccessReadViewName The authorized MIB viewName used for read 
access. If the value is an empty string, then there is 
no active view configured for read access.

vacmAccessWriteViewName The authorized MIB viewName used for write 
access. If the value is the empty string then there is 
no active view configured for write access.

vacmAccessNotifyViewName The authorized MIB viewName used for notify 
access. If the value is the empty string then there is 
no active view configured for notify access. 
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Once an access right has been chosen, the appropriate viewName specified by the 
access right must be chosen. The view name to use is determined by the SNMP 
operation defined in the PDU. For GET and NEXT operations the 
vacmAccessReadViewName is used. For SET operations the 
vacmAccessWriteViewName is used. For TRAP operations the 
vacmAccessNotifyViewName is used. If the appropriate viewName is not configured 
within the access right, access is denied and noSuchView is returned.

If the access right has been chosen and the appropriate viewName has been configured 
within the access right, access checking continues. 

View Tree Family Table

The vacmViewTreeFamilyTable is used to store MIB views. A MIB view is defined as 
a family of view subtrees. All the MIB views are stored in the 
vacmViewTreeFamilyTable which is indexed by a viewName and an OID of a MIB 
subtree.

SNMPv1, SNMPv2c, and SNMPv3 Configuration

The following SNMP4J jars need to be added to <AxM_HOME>/lib directory:

• snmp-core-2.0.2.jar

• snmp-agent-2.0.4.jar

The following policy file needs to added to the <AxM_HOME>/conf directory:

snmp-access-policy.xml

Using SNMPv1 or SNMPv2c, you can access AXM SNMP data using the configured 
community strings and securityname defined by the following parameters and their 
default values:

• cleartrust.iserver.snmp.agentserver.securityname=axmuser

• cleartrust.iserver.snmp.community=public

• cleartrust.iserver.snmp.write_community=private

For SNMPv3, the following parameter needs to be configured:

cleartrust.iserver.snmp.agentserver.context=public

The following are some common parameters across the SNMP versions:

• cleartrust.iserver.snmp.accesspolicy.filename = 
snmp-access-policy.xml

Entry Information

vacmViewTreeFamilyViewN
ame or viewName

A human readable name for the MIB view.

vacmViewTreeFamilySubtre
e or nodeID

The OID subtree which when combined with the 
mask defines a one or more MIB view subtrees.

vacmViewTreeFamilyType or 
viewIncluded

Indicates whether or not the corresponding MIB 
view subtrees defined by the OID subtree and mask 
are included or excluded from the MIB view. 
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• cleartrust.iserver.trap.target.host=localhost

• cleartrust.iserver.trap.target.port=162

• cleartrust.iserver.snmp.port=161

• cleartrust.iserver.snmp.version=1

As stated in the SNMPv3 RFC, for a given set of SNMP managed objects, in this case 
AXM SNMP tables, the securityModel and securityName determines ‘who’. The 
contextName defined by cleartrust.iserver.snmp.agentserver.context 
in iserver.conf file determines ‘where’. The securityModel and securityLevel 
determines ‘how’. The viewType, that is read, write, or notify determines ‘why’. The 
OID of the managed object determines ‘what’ and the instances of the managed object 
determines ‘which’.

For SNMPv1 and SNMPv2c, the 'who' is governed by the read-write community 
strings and the configured securityName of the agent defined by the following 
parameters in the iserver.conf file:

• cleartrust.iserver.snmp.community

• cleartrust.iserver.snmp.write_community

• cleartrust.iserver.snmp.agentserver.securityname

SNMPv1/SNMPv2c Configuration

Although SNMPv1 and SNMPv2c security is based on community strings, for 
coexistence across SNMP versions, the community strings are mapped to the security 
name ensuring view based access control for both SNMPv1 and SNMPv2c.

A group can be mapped only to a given combination of securityModel and 
securityName. Since there is only one default security name, multiple group 
definitions are not possible for SNMPv1 and SNMPv2. By default, two groups by 
name "v1group" and "v2group" are present in the access policy file.These groups are 
mapped to the default securityname, "axmuser". 

For configuring a different securityName, update the parameter 
cleartrust.iserver.snmp.agentserver.securityname in the iserver.conf 
file and configure the same in the policy file.

For example:-

<axm:group groupID="v2group">
      <axm:groupName>v2group</axm:groupName>
      <axm:securityModel>2</axm:securityModel> 
      <axm:securityLevel>1</axm:securityLevel>
      <axm:userids>
        <axm:userID>axmuser</axm:userID>
      </axm:userids>      
      <axm:readViewName>axmReadView</axm:readViewName>
      <axm:writeViewName>axmWriteView</axm:writeViewName>
      <axm:notifyViewName>axmNotifyView</axm:notifyViewName>
 </axm:group>

Note: Only one userID can be defined for SNMPv1 and SNMPv2c definitions. The 
userID should be in accordance with the configured parameter 
cleartrust.iserver.snmp.agentserver.securityname in iserver.conf file. 
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Access control can be modified for SNMPv1 and SNMPv2 groups by defining 
specific views to the above mentioned groups.

 <axm:view>

      <axm:nodeID>.1.3.6.1.4.1.2197.10.1</axm:nodeID>

      <axm:viewName>axmReadView</axm:viewName>      

      <axm:viewIncluded>1</axm:viewIncluded>

 </axm:view>

Note: For the default configuration, that is, public read community, private write 
community and 'axmuser' securityName, the read/write/notify access permission is 
available on all the AXM MIB data. Use the access policy file to define access 
restrictions on the AXM MIB data, while using SNMPv1 or SNMPv2c. For more 
information, refer the snmp-access-policy.xml file.

SNMPv3 Configuration

Configure below parameter in iserver.conf to a lockbox file which was used to encrypt 
privacyPassphrase and securityPassphrase:

cleartrust.lockbox_file_path=c://lockbox.clb

To define a new v3 user, perform the following configurations:

    <axm:user userID="newuser">
      <axm:securityName>newuser</axm:securityName> 
      <axm:securityPassphrase>password</axm:securityPassphrase>
      <axm:authProtocol>SHA</axm:authProtocol>
      <axm:privacyProtocol>DES</axm:privacyProtocol>
      <axm:privacyPassphrase>password</axm:privacyPassphrase>
    </axm:user> 

Create a new group definition, map the created user or users, and add an appropriate 
access restriction defined by a view definition as follows:

<axm:group groupID="newgroup">
      <axm:groupName> newgroup </axm:groupName>
      <axm:securityModel>3</axm:securityModel>
      <axm:securityLevel>1</axm:securityLevel>
      <axm:userids>
        <axm:userID>newuser</axm:userID>
        <axm:userID>newuser1</axm:userID>

      </axm:userids>      
      <axm:readViewName>axmReadView</axm:readViewName>
      <axm:writeViewName>axmWriteView</axm:writeViewName>
      <axm:notifyViewName>axmNotifyView</axm:notifyViewName>
    </axm:group>

Create a view definition as follows:

    <axm:view>
      <axm:nodeID>.1.3.6.1.4.1.2197.10.1</axm:nodeID>
      <axm:viewName>axmReadView</axm:viewName>      
      <axm:viewIncluded>1</axm:viewIncluded>
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    </axm:view>
    <axm:view>
      <axm:nodeID>.1.3.6.1.4.1.2197.10.1</axm:nodeID>
      <axm:viewName>axmNotifyView</axm:viewName>
      <axm:viewIncluded>1</axm:viewIncluded>
    </axm:view>
<axm:view>
      <axm:nodeID>.1.3.6.1.4.1.2197.10.1.1.50.1.3</axm:nodeID>
      <axm:viewName>axmWriteView</axm:viewName>
      <axm:viewIncluded>1</axm:viewIncluded>
    </axm:view>

By default, the snmp-access-policy.xml file defines three SNMPv3 users 'snmpuser', 
'snmpadmin' and 'v3admin'. All these users are mapped to either of the two defined 
SNMPv3 groups, 'v3group' and 'v3adminGroup'. 

You can access to all the MIB data by default, without configuring any of the above 
parameters or creating any definitions. Use the access policy file for defining new 
SNMPv3 users and providing SNMPv1, SNMPv2c and SNMPv3 access restrictions 
on the MIB data.

For more information refer to the snmp-access-policy.xml file.

Upgrading from JoeSNMP Agent to SNMP4J Agent

Follow the steps below to upgrade to the SNMP4J agent:

• Update the SNMP jars

• Update the SNMP access policy file

• Update the MIB file definitions

• Update the configuration parameters

• Update the MIB browser

To update the SNMP JARS:

1. Add the following SNMP4J jars to the <AxM_HOME>/lib directory:

• snmp-core-2.0.2.jar

• snmp-agent-2.0.4.jar

Note: Remove the opennms_joesnmp.jar and agentapi_0.9.jar jars from 
<AxM_HOME>/lib.
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To update the SNMP Access Policy File:

1. Add the snmp-access-policy.xml file to the <AxM_HOME>/conf directory.

Note: By default SNMPv2 is enabled in iserver.conf. This implies that traps of are 
sent from AxM usingSNMPv2. The default read community is 'public' and write 
community is 'private'. You can perform SNMPv2c GET|GETNEXT|GETBULK|SET 
operations without any configurations to the snmp-access-policy.xml file. If you 
choose to perform SNMPv3 GET|GETNEXT|GETBULK|SET, then it is mandatory to 
set the authPassphrase and privacyPassphrase for default 'axmuser' in the 
snmp-access-policy.xml file before proceeding.

To update the MIB Definition File:

1. Add the SNMP Authorization Server MuxRequestsPool Table Definition to the 
RSA-ACCESS-MANAGER-MIB mib file present in <AxM_HOME>/mibs 
directory.

Note: It is mandatory to add this definition, if you are upgrading to SP4, and if you 
want to view AuthServer MuxRequestsPool Statistics. If this definition is not added, 
then details of this particular table cannot be viewed in the mib browser.

Starting the RSA Access Manager Instrumentation Server Manually 

If you choose not to install instrumentation during the Access Manager installation, 
you can enable instrumentation at a later time by starting the Instrumentation Server 
manually. For more information, see Chapter 6, “Running Your RSA Access Manager 
Servers.”

Disabling RSA Access Manager SNMP Support

To disable Access Manager SNMP support, you must disable instrumentation on each 
of the Access Manager Servers by setting the 
cleartrust.servername.instrumentation.enabled parameter to false in the eserver.conf, 
aserver.conf, dispatcher.conf, and keyserver.conf files located in the 
AXM_HOME/conf directory. For example:

cleartrust.servername.instrumentation.enabled=false

Disabling the Instrumentation Server

To disable the Instrumentation Server on Window, use the Microsoft Management 
Console to disable the Instrumentation Server as a service.

To disable the Instrumentation Server on UNIX, open the initialization script axm61, 
and set ISERVER_ENABLED to 0.
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Dynamic Debugging

Dynamic debugging is a feature in Access Manager that allows you to enable or 
disable debugging without restarting the Access Manager servers.

Note: To enable dynamic debugging at runtime you need an NMS browser.

To enable dynamic debugging:

1. Enable instrumentation on each of the Access Manager Servers by setting the 
cleartrust.servername.instrumentation.enabled parameter to true in the 
eserver.conf, aserver.conf, dispatcher.conf, and keyserver.conf files located in 
the AXM_HOME/conf directory. For example: 
cleartrust.servername.instrumentation.enabled=true
Where servername is the name of the Access Manager server for which you want 
to enable dynamic debugging.

2. On each of the Access Manager Servers, provide the IP address or DNS hostname 
of the Instrumentation Server for the 
cleartrust.servername.instrumentation.registration.hostname parameter in the 
eserver.conf, aserver.conf, dispatcher.conf, and keyserver.conf files. For 
example: 
cleartrust.servername.instrumentation.registration.hostname=127.0.0.1

3. For SNMPv1/SNMPv2c, in the iserver.conf file located in the 
AXM_HOME/conf directory, set the read community parameter 
cleartrust.iserver.snmp.community to public and the write community parameter 
cleartrust.iserver.snmp.write_community to private.
For SNMPv3, in the iserver.conf file located in the AXM_HOME/conf directory, 
set the context name parameter cleartrust.iserver.snmp.agentserver.context to 
public. Also configure appropriate SNMPv3 user and provide user to group and 
group to view mappings in the snmp-access-policy.xml file present in the 
AXM_HOME/conf directory. Refer to the previous section on configuring the 
access policy file.

4. For SNMPv1/SNMPv2c, provide the read and write community parameters in 
your NMS browser. The values that you set in your NMS browser must match 
with the values set in your iserver.conf file in step 3.
For SNMP v3, provide the context name and user credentials in you NMS 
browser. The value that you set in your NMS browser must match with the values 
set in your iserver.conf in step 3.

Monitoring Java Virtual Machine

Java Virtual Machine (JVM) supports SNMP and must be configured to provide 
details of the functioning of JVM in Access Manager.

You can monitor the statistics of the functioning of JVM for the Authorization Server, 
Entitlements Server, Dispatcher, Instrumentation, and Log Server. For more 
information on setting up monitoring for JVM statistics, go to 
http://java.sun.com/javase/6/docs/technotes/guides/management/snmp.html
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Note: The configuration information available in the URL above, allows you to 
monitor JVM statistics for the first Access Manager Server that starts up.

To set up JVM monitoring for a particular Access Manager Server or for all 
Access Manager Servers:

Note: Make sure that you have completed the configurations provided in the URL 
above.

1. Open the server.bat file.
Where server is the Access Manager Server, for which you want to monitor JVM 
statistics.

2. Search for “%_EXECJAVA% %JVM_OSARGS%” and add the following:

-Dcom.sun.management.jmxremote-Dcom.sun.management.jmxrem
ote.port=<Portnumber>-Dcom.sun.management.jmxremote.authe
nticate=<true/false>-Dcom.sun.management.snmp.acl.file=<A
CLFilePath (if .authenticate is true)>

3. Restart the Access Manager Server.
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15Integrating RSA Access Manager with RSA 
Adaptive Authentication

• Prerequisites

• Terminology

• Integration Overview

• Integration Process Overview

• Configuring Adaptive Authentication on the Access Manager Server

• Configuring Adaptive Authentication in SignIn Monitoring Mode

• Configuration Parameters

• HTTPS Support for Adaptive Authentication

• HTTPS Support for Adaptive Authentication

• Proxy Support for Adaptive Authentication

• Log Message IDs and Result Codes

Prerequisites

Before integrating the RSA Access Manager Agent and the RSA Access Manager 
Server with the RSA Adaptive Authentication Server, ensure that the following 
prerequiLEVEsites are met:

• The RSA Access Manager Server is running and all the necessary components are 
properly installed and configured.

• The RSA Access Manager Agent is installed and configured to work with the 
Access Manager Server.

• The RSA Adaptive Authentication infrastructure is properly configured. 

Supported RSA Access Manager Agents:

• RSA Access Manager Agent 4.9 SP1 or later

Supported RSA Access Manager Server:

• RSA Access Manager 6.1 SP4 or later

Supported RSA Adaptive Authentication Servers: 

• RSA Adaptive Authentication (On-Premise) 6.0.2.1 SP2
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Terminology

The following table lists the terms used in this chapter.

Integration Overview

RSA Adaptive Authentication is a flexible, layered authentication solution designed to 
tighten security and lower transaction risk. It makes extensive use of device 
fingerprints to make determinations about the risk of end-user logons. Device 
fingerprint information is provided to the Adaptive Authentication Server for 
assessing risk and building user profiles. 

The Access Manager Server and Agent work with the Adaptive Authentication Server 
to give customers a first level of authentication before a second level of authentication 
with Access Manager.

Supported RSA Adaptive Authentication Credential Types

Credentials help a user to authenticate to an application. In any of the RSA types of 
authentication, the RSA Adaptive Authentication System could request additional 
credentials if a user is deemed potentially risky (the risk score and recommended 
policies dictate that additional authentication is required from the user).

Access Manager supports the following Adaptive Authentication credential types:

• Challenge questions. A credential where the user is presented with a set of 
questions. The user must enter the correct response to the challenge questions 
to access the requested page. The user enters answers to these questions using 
the Access Manager Agent console while enrolling for Adaptive 
Authentication.

• Out-of-band phone. A credential where the system makes a call on a listed 
phone number. The user provides phone numbers to the system using the 
Access Manager Agent console while enrolling for Adaptive Authentication. 
When the phone call is made, a passcode is generated and displayed on the 
screen. The user must enter the passcode on the phone. After the passcode is 
verified, the Submit button is displayed on the screen. The user must click 
Submit to access the requested page.

• Out-of-band email. A credential where the system sends a mail to a listed 
email address. The user provides an email address to the system using the 
Access Manager Agent console while enrolling for Adaptive Authentication. 
After the passcode is verified, the user is navigated to the AxM authentication 
page.

SOAP Simple Object Access Protocol

Device Fingerprint Data Data collected from a browser using Java Script

On-Premise Solution that is physically implemented at the customer, 
premises's independent of the centrally hosted solution
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Integration Process Overview

Access Manager Agent retrieves user information through the browser. The 
information is passed to the Access Manager Server through Runtime API calls. 
Access Manager makes SOAP calls to the Adaptive Authentication Server to find the 
status or risk of a user. 

Depending on the status or risk from the Adaptive Authentication server, Access 
Manager performs the following actions:

Enroll. Registers user data in the Adaptive Authentication datastore using 
challenge questions and answers, along with images and phrases for the Adaptive 
Authentication server (On Premise). Enrollment is done only if the user has a 
valid cookie and if the user completes Access Manager authentication. 

Signing/Risk analysis. Analyzes the risk involved when a user tries to access a 
protected resource.

Maintenance. Allows users to modify their profiles stored in the Adaptive 
Authentication datastore. The user information includes challenge questions and 
answers, along with images and phrases for the Adaptive Authentication server 
(On Premise). Maintenance can be done only if the user has a valid cookie and if 
the user completes Access Manager authentication.

Configuring Adaptive Authentication on the Access Manager Server

You must perform the following procedure to configure Adaptive Authentication on 
the Access Manager Server.

To configure Adaptive Authentication on the Access Manager Server:

1. Stop the Access Manager Authorization Server.

2. Remove all the aa*.jar files from the AXM_HOME/lib folder.

3. Copy the appropriate adaptive authentication .jar file from the jar folder that is 
available in your Access Manager installation folder, and paste the .jar file in the 
AXM_HOME/lib folder.

4. Open the aserver.conf located in the AXM_HOME/conf directory.

5. Add the name of the Adaptive Authentication Server configuration file to the 
following parameter in the aserver.conf file.

cleartrust.adaptive_auth.source.configuration= 

The Adaptive Authentication configuration file is 
adaptive_auth-onpremise-6021.conf file, if the Adaptive Authentication Server 
is RSA Adaptive Authentication (On-Premise) 6.0.2.1 SP2.

6. Configure the parameters in the Adaptive Authentication Server configuration file 
with appropriate values.

7. Restart the Access Manager Authorization Server.
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Configuring Adaptive Authentication in SignIn Monitoring Mode

Adaptive Authentication in signin monitoring mode suppresses enrollments, 
challenges, and adds the user to Adaptive Authentication database during analyze 
requests. In this mode, the engine gathers data without affecting the end user 
experience, while the risk engine learns the user population. All users are allowed to 
access the resource, provided they enter the correct Access Manager credentials. Users 
that receive a high risk score, may receive REVIEW response, and a case is created, 
based on the risk calculation rules of the organization.

The signin monitoring mode is used when you are learning about your users, 
deployment, and risks. For more information, see the RSA Adaptive Authentication 
(On-Premise) 6.0.2.1 SP2 Workflow and Processes Guide.

Note: Only RSA Adaptive Authentication (On-Premise) 6.0.2.1 SP2 is supported for 
integration with Access Manager in the SignIn Monitoring mode.

Note: Ensure that the Adaptive Authentication installation that you are using is 
deployed in the SignIn Monitoring mode (Deployment Mode 3).

To configure Adaptive Authentication on the Access Manager Server in signin 
monitoring mode:

1. Add the location of the adaptive_auth-onpremise-6021.conf file in the following 
parameter in the aserver.conf file.
cleartrust.adaptive_auth.source.configuration

2. Add values in the Adaptive Authentication configuration parameters for the signin 
monitoring mode in the adaptive_auth-onpremise-6021.conf file.
For more information on configuration parameters, see “Configuration 
Parameters” on page 273.

Note: You must configure cleartrust.adaptive_auth.webservice, 
cleartrust.adaptive_auth.caller_id, and cleartrust.adaptive_auth.caller_credential to 
configure Adaptive Authentication in signin monitoring mode.

3. Set the following parameters to True in the Access Manager Agent's 
webagent.conf file.
cleartrust.agent.aa.enabled
cleartrust.agent.aa_silent_mode
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Configuration Parameters

The following table lists the common configuration parameters for Adaptive 
Authentication..

Parameter Description

cleartrust.adaptive_auth.proxy_ip Specifies the IP Address of the proxy between the 
Authorization Server and the Adaptive 
Authentication Server

cleartrust.adaptive_auth.proxy_port Specifies the port number of the proxy between 
the Authorization Server and the Adaptive 
Authentication Server.

cleartrust.adaptive_auth.timeout Specifies the timeout value while making web 
service call to the Adaptive Authentication Server 
from the Authorization Server.

cleartrust.adaptive_auth.org_name Determines the organization name to which the 
supplied user belongs. This parameter is required 
to handle multiple organizations. 

cleartrust.adaptive_auth.net.ssl.use Specifies the level of security used for web service 
calls between the Authorization Server and the 
Adaptive Authentication Server.

cleartrust.adaptive_auth.net.ssl.ca.keysto
re_file

Specifies the filename of the keystore where the 
issuing CA certificate is stored.

cleartrust.adaptive_auth.net.ssl.ca.keysto
re_type

Specifies the type of keystore in which the CA 
certificate is stored.

cleartrust.adaptive_auth.net.ssl.ca.keysto
re_passphrase

Specifies the passphrase required to unlock the 
CA keystore.

cleartrust.adaptive_auth.net.ssl.private.k
eystore_file

Specifies the filename of the keystore where the 
private key for this Authorization Server is stored. 
This file is used for client authentication between 
the Authorization Server and the Adaptive 
Authentication Server

cleartrust.adaptive_auth.net.ssl.private.k
eystore_type

Specifies the type of keystore in which the private 
key is stored.

cleartrust.adaptive_auth.net.ssl.private.k
eystore_passphrase

Specifies the passphrase needed to unlock the 
keystore that holds the private key.
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Parameter Description

cleartrust.adaptive_auth.webservice Specifies the SOAP destination URL of the 
Adaptive Authentication web service through 
which the Authorization Server contacts the 
Adaptive Authentication Server for Adaptive 
Authentication.

cleartrust.adaptive_auth.caller_id Specifies the identifier to be used to authenticate 
the caller sending the request.

cleartrust.adaptive_auth.caller_credential Specifies the password of the Adaptive 
Authentication caller.

cleartrust.adaptive_auth.enrollment.risk.t
hreshold

Specifies the threshold risk score. For a risk score 
above this level, the user is considered risky to 
allow enrollment into the system. 

cleartrust.adaptive_auth.supported.crede
ntial.types

Specifies the RSA Adaptive Authentication 
credential types supported by the adapter. The 
information required for the configured 
credential types are collected during user 
enrollment.

The allowed values are:

• QUESTION

• OOBPHONE

• OOBEMAIL

cleartrust.adaptive_auth.enrollment.quest
ions.count

Specifies the number of challenge questions and 
answers a user must supply during enrollment. 
The value must not be greater than the value 
configured in the Adaptive Authentication 
Server.

cleartrust.adaptive_auth.signin.questions.
count

Specifies the number of challenge questions 
displayed at the time of login. The value of this 
parameter must not be greater than the value 
configured in the Adaptive Authentication 
Server.

Dependencies:

The value specified for this parameter must be a 
positive factor of the value specified for the 
cleartrust.adaptive_auth.enrollment.questions.co
unt parameter. For example:

If 
cleartrust.adaptive_auth.enrollment.questions.co
unt=6, then the value of 
cleartrust.adaptive_auth.signin.questions.count 
can be set to 1, 2, 3, or 6 that are factors of 6.
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Note: For more information on the configuration parameters, see the 
adaptive_auth-onpremise-6021.conf file supplied with this package.

cleartrust.adaptive_auth.enrollment.max.
phones.count

Specifies the maximum number of phone 
numbers a user can enter during enrollment.

cleartrust.adaptive_auth.enrollment.max.
emails.count

(Optional) Specifies the maximum number of 
email addresses that the user can supply during 
enrollment. The default value is 1.

cleartrust.adaptive_auth.enable_axis_log (Optional) Specifies whether to log AA SOAP 
calls. For example, the log file is created under 
the logs directory with the file name axis.log. The 
allowed values are FALSE and TRUE. The 
default value is FALSE.

cleartrust.adaptive_auth.imageservice Specifies the SOAP destination URL of the 
Adaptive Authentication Image Service through 
which the Authorization Server contacts 
RSA Adaptive Authentication (On-Premise) 
Server for images.

cleartrust.adaptive_auth.group_name Determines the group name of the supplied user. 
This parameter is required to handle multiple 
groups in an organization.

cleartrust.adaptive_auth.image_phrase If this parameter is set to true, Adaptive 
Authentication will be done using the challenge 
questions and answers along with the image and 
phrase information supplied by the user. If this 
parameter is set to false, Adaptive Authentication 
will be done only using the challenge questions 
and answers provided by the user.

cleartrust.adaptive_auth.date_format Specifies the date format to be used in all SOAP 
requests to Adaptive Authenication Server. The 
default value is yyyy-MM-dd HH:mm:ss.SSS.

Parameter Description
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Error Handlers for RSA Adaptive Authentication 6.0.2.1 SP2

This section specifies the list of error handlers defined for handling error responses 
from RSA Adaptive Authentication Web Services. The error handlers are responsible 
for extracting the error information from the response and sending that information 
back to the RSA Access Manager Agents.

Parameter Description

cleartrust.adaptive_auth.error.handl
ers.list

Specifies the list of error handlers defined to handle 
error responses from RSA Adaptive Authentication 
Web Services. The error handlers are responsible for 
extracting the error information from the response and 
sending the response back to the RSA Access 
Manager Agents.

Allowed Values:

• A comma separated list of strings that contain no 
spaces or special characters. Each name must be 
unique.

Dependencies:

The names that you select in this list must be reflected 
in the parameters listed in 
cleartrust.adaptive_auth.error.handler.default.class and 
cleartrust.adaptive_auth.error.handler.default.handled.
error.codes pararmeters. Each error handler must have 
its set of required parameters. If you specify a handler 
name as 'DataValidationHandler', then its 
corresponding parameters is 
cleartrust.adaptive_auth.error.handler.DataValidation
Handler.class.

cleartrust.adaptive_auth.error.handl
er.default.class

Specifies the fully qualified class name of the error 
handler that extends the 
sirrus.authserver.aa.handlers.error.ErrorHandler.

Allowed Values:

• A fully qualified class name.

Default Value:

None

Example:

cleartrust.adaptive_auth.error.handler.default.class=sa
mple.aa.ErrorHandler
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HTTPS Support for Adaptive Authentication

Authorization servers are capable of communicating with Adaptive Authentication 
servers in secure HTTP (HTTPS) mode. The following parameters must be configured 
in the adaptive_auth.conf file to enable the HTTPS mode. For a detailed description 
of these parameters, see the adaptive_auth.conf file available in the /conf/ directory.

cleartrust.adaptive_auth.net.ssl.use=
cleartrust.adaptive_auth.net.ssl.ca.keystore_file= 
cleartrust.adaptive_auth.net.ssl.ca.keystore_type=
cleartrust.adaptive_auth.net.ssl.ca.keystore_passphrase=
cleartrust.adaptive_auth.net.ssl.private.keystore_file=
cleartrust.adaptive_auth.net.ssl.private.keystore_type=
cleartrust.adaptive_auth.net.ssl.private.keystore_passphrase=

Proxy Support for Adaptive Authentication

RSA Access Manager servers are capable of communicating with Adaptive 
Authentication Servers through a firewall proxy server. The following parameters 
must be configured in the adaptive_auth.conf file to enable Access Manager to 
access Adaptive Authentication Servers running behind a firewall. For a detailed 
description of these parameters, see the adaptive_auth.conf file available in the 
/conf/ directory.

cleartrust.adaptive_auth.proxy_ip=
cleartrust.adaptive_auth.proxy_port=

cleartrust.adaptive_auth.error.handl
er.default.handled.error.codes

Specifies the list of RSA Adaptive Authentication 
Web Services reason codes that are recognized by the 
handler.

Allowed Values:

• All reason code specified in the RSA Adaptive 
Authentication Web Services API Reference Guide.

Default Value:

None

Parameter Description
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Log Message IDs and Result Codes

When the Access Manager Authorization Server communicates with the Adaptive 
Authentication Servers, it logs messages with new message IDs and result codes based 
on the success or failure of the request made. The following table lists the new 
message IDs and result codes added as part of this integration.

Action/Reason Code Code Description

LOG_LEVEL_INFORMATIONAL

Action 3010 Request to AdaptiveAuth store

Reason 3010 Succeeded

The result code is 120 for AA operation success.

LOG_LEVEL_ERROR

Action 11 Request to AdaptiveAuth store

Reason 11 Failed

The result code is 121 for AA operation failure.
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16Uninstalling the RSA Access Manager 
Servers

• Uninstalling the RSA Access Manager Servers on Windows

• Uninstalling the RSA Access Manager Servers on UNIX

• Uninstalling the RSA Administrative Console

• Reinstalling or Upgrading the RSA Administrative Console

This chapter describes how to remove RSA Access Manager from your computer. The 
process removes the program files and directories, but leaves the configuration files 
unchanged. On Windows, you can also modify your Access Manager installation.

Note: Before uninstalling RSA Access Manager, make sure that you stop all the RSA 
Access Manager Servers.

Uninstalling the RSA Access Manager Servers on Windows

The Windows uninstallation program launches automatically when you run Setup.exe 
against an existing installation. 

To uninstall RSA Access Manager on Windows:

1. Insert the RSA Access Manager 6.1 DVD on the machine with the existing 
Access Manager installation, and navigate to \win2k3-x86\axm_servers. 

2. Double-click Setup.exe.

3. Click Remove to delete all Access Manager files except configuration files and 
registry settings. 

4. Restart your server machine.

Note: The Access Manager installation directory and configuration files are not 
removed. You must remove the installation directory and configuration files manually. 

Uninstalling the RSA Access Manager Servers on UNIX

You can uninstall the Access Manager Servers packages on UNIX using one of these 
methods:

• Run the uninstall-server.sh script, which is provided on your RSA Access 
Manager 6.1 DVD or at AXM_HOME/bin/uninstall.
16: Uninstalling the RSA Access Manager Servers 279



RSA Access Manager 6.1 SP4 Servers Installation and Configuration Guide
• Run the package removal commands for the RSAaxms61 and RSAaxmj61 
packages, making sure to uninstall the server package before you uninstall the 
JRE package.

To uninstall RSA Access Manager on UNIX with the uninstall-server.sh script:

1. From AXM_HOME/bin/uninstall, run uninstall-server.sh to remove the Server 
binaries. 

2. Manually remove the following directories:

• AXM_HOME/conf (contains your configuration files and license file)

• AXM_HOME/logs (contains your log files)

• AXM_HOME/var (contains your KeyServer.sec file, which is the Key 
Server list of all client keys. It also contains the KeyClient.sec file, which is 
the Authorization Server client key.)

During the server package installation, if you have created a new Access Manager 
user account on UNIX, then the user account is removed in the package post-remove 
process. This process performs the following:

• Deletes the Access Manager user’s home directory.

• Deletes all the files in the Access Manager user’s home directory

• Removes the Access Manager user from the passwd files.

The post-remove script prompts you to run the groupdel command to remove the 
UNIX group that was created during installation.

Note: The Access Manager installation directory and configuration files are not 
removed. You must remove the installation directory and configuration files manually. 

To uninstall the RSA Access Manager SDK on UNIX:

From the SDK_HOME directory, type:

# rm -rf ./sdk

Note: If you are unsure where the SDK_HOME directory is located, see “Installing 
the RSA Access Manager SDK on UNIX” on page 37.

Uninstalling the RSA Administrative Console

Remove the RSA Administrative Console by deleting the web application and 
removing the related files from the deployment directory. 

To uninstall the RSA Administrative Console on Tomcat, WebLogic, or 
WebSphere:

1. Stop the server, and manually remove the application deployment directory.

2. Restart the server.
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Reinstalling or Upgrading the RSA Administrative Console

If you are reinstalling or upgrading the RSA Administrative Console, back up the 
admingui.cfg file in order to preserve your settings for redeployment.
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A Configuration Files

• Tips for Setting Parameters

• Additional Data Adapter Information

• Date Format Reference Table

• Additional Certificate Tool Information

This appendix provides an overview of the RSA Access Manager configuration files, 
listing their names and installed locations in the following table.

Each component of Access Manager has its own configuration file. You can find these 
files in the AXM_HOME/conf directory of your Access Manager installation.

Note: The abbreviation AXM_HOME refers to the root directory where you installed 
the Access Manager software.

Components Conf Filename File Location Description

LDAP Data Adapter ldap.conf AXM_HOME/conf Allows you to:

• Configure connections between 
Access Manager and your LDAP 
directory host(s). 

• Map your existing user and group 
data for use by Access Manager.

In addition to the ldap.conf file on 
your machine, you may see 
ldap-iplanet.conf, 
ldap-activedirectory.conf, or 
ldap-activedirectory-adam.conf 
files. These are unused copies that 
contain the default settings for each  
data store type. You can ignore them.

SQL Data Adapter sql.conf AXM_HOME/conf Allows you to configure the 
connection between Access Manager 
and your SQL database host(s).

In addition to the sql.conf file on your 
machine, you may see 
sql-oracle.conf, sql-sybase.conf, and 
sql-mssql.conf files. These are unused 
copies that contain the default settings 
for each data store type. You can 
ignore them.
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Entitlements Server eserver.conf AXM_HOME/conf Contains security and other 
parameters that govern how the 
RSA Administrative Console and 
Administrative API clients connect to 
the Entitlements Server. 

Authorization 
Server

aserver.conf AXM_HOME/conf Contains security and other 
parameters that govern how the 
Agents and Runtime API clients 
connect to the Authorization Server.

Dispatcher dispatcher.conf AXM_HOME/conf Contains parameters that govern how 
the Agents and Authorization Servers 
connect to the Dispatcher.

Key Server keyserver.conf AXM_HOME/conf Contains parameters that govern how 
the Agents and Authorization Servers 
communicate with the Key Server.

Log Server lserver.conf AXM_HOME/conf Contains parameters that govern what 
information is logged and where.

Adaptive 
Authentication (On 
Premise 6.0.2.1)

adaptive_auth-onpre
mise-6021.conf

AXM_HOME/conf Contains the configuration parameters 
and descriptions for Adaptive 
Authentication On Premise 6.0.2.1.

Unique User 
Session

uus.conf AXM_HOME/conf Allows you to configure the RSA 
Access Manager Authorization 
Servers to use SQL database for 
session management.

RSA Administrative 
Console

admingui.cfg This file is located in 
the directory you 
specified as the 
webgui.config.
directory when you 
deployed the 
Administrative 
Console. 

The location varies 
depending on the 
application server you 
are using.

Contains parameters that govern how 
the Administrative Console connects 
to the Entitlements Server, as well as 
some options that set what 
information administrators can view 
and edit in the Administrative 
Console.

Access Manager 
Certificate Tool

certool.conf On the RSA Access 
Manager 6.1 DVD in 
your_operating_
system/cert_tool

Contains sample configurations and 
default values for standard key 
generation and installation.

Components Conf Filename File Location Description
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Tips for Setting Parameters

Use the following guidelines when setting the parameter values in the Access 
Manager configuration files.

Line Breaks

If you decide to use line breaks within a parameter setting to make it easier to read, 
end each line with a backward slash (\) before inserting the line break. For 
example,cleartrust.agent.auth_resource_list=/apps/*=BASIC+NT,\

                              /financial/*=BASIC:SECURID\

                              /hr/*=CERTIFICATE+BASIC

Case Sensitivity

Make sure that the parameter values use uppercase and lowercase letters 
appropriately. For example, www.Example.com is not the same as 
www.example.com. If you are unsure about the case, it is best to use all lowercase 
letters (for example, use true instead of TRUE). 

Web Server Agent webagent.conf CT_AGENT_ 
HOME/conf

Contains parameters that govern what 
authentication method is used to 
protect which resources, user session 
limits, user token settings, form 
locations, and other Agent settings. 
For more information, see your 
RSA Access Manager Agent 
documentation.

Application Server 
Agent

appagent.conf CT_AGENT_ 
HOME/conf

Contains parameters that govern what 
authentication method is used to 
protect which resources, user session 
limits, user token settings, form 
locations, and other Agent settings. 
For more information, see your 
RSA Access Manager Agent 
documentation.

SNMP Access 
Policy

snmp-access-policy.x
ml 

AXM_HOME/conf Allows you to create SNMPv3 users 
and provide appropriate user to group, 
group to access , access to node 
SNMPv3 User Security Model (USM) 
and View Access Control Model 
(VACM)

Components Conf Filename File Location Description
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Dependencies between Parameters

In many cases, changing a parameter setting requires other parameter settings to be 
changed as well. Before you change a parameter setting, check for dependent 
parameters or other requirements. Any parameters with dependencies are noted in the 
configuration file of each Access Manager component.

Paths for Windows Configurations

Use double-backslashes when specifying path information in a parameter value. For 
example, use C:\\Program Files\\RSA\\Access Manager Servers 6.1 for configuration 
files that reside on Windows machines. 

Additional Data Adapter Information

This section contains information in addition to the comments in the individual Data 
Adapter configuration files.

LDAP Data Adapter (ldap.conf)

The LDAP Data Adapter parameters are set in the ldap.conf file in the /conf directory 
of your Access Manager installation.

The ldap.conf configuration file contains information that the Access Manager 
Servers need to connect to the LDAP directories used as your Access Manager data 
store. A copy of this file must reside on each machine that is running either an 
Entitlements Server or an Authorization Server. Your Entitlements Server 
(eserver.conf) and Authorization Server (aserver.conf) configuration files have a 
parameter that points to the location of this file, relative to the /conf directory of your 
Access Manager installation:

cleartrust.data.source.configuration :ldap.conf

Set this parameter to point to the correct filename and relative path location of the 
LDAP configuration file to be used by that particular Access Manager Server. 

It is possible for your Authorization Servers to use a different data source 
configuration file than your Entitlements Server. For example, you must configure 
your Entitlements Server to connect to the writable master copy of your LDAP 
directory. You must configure your Authorization Servers to connect to read-only 
replicas.

This file allows you to configure connections for more than one LDAP directory host. 
However, all of the  data store hosts used by your Access Manager deployment must 
be of the same type. For example, you must use all Sun Java System Directory Server 
or all Active Directory servers, not a combination of the two.

This configuration file also allows you to map Access Manager attributes to existing 
LDAP attributes. This allows you to leverage your existing user and group data in 
your LDAP directory hierarchy.

All of the parameters in this file begin with the prefix, cleartrust.data.ldap. Most 
parameters apply to all of the LDAP v3 data store servers currently supported by 
Access Manager. Vendor-specific parameters are noted where applicable. 
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Note: Access Manager does not support multiple master copies of an LDAP directory. 
Therefore, if your primary writable LDAP directory host goes down, you cannot 
create or modify records in your directory with the Administrative Console. You must 
only specify your primary (or master) LDAP directory in the ldap.conf file that is 
accessed by the Entitlements Server.

Access Manager supports LDAP directory host failover for lookup or search 
operations only. The ldap.conf file used by the Authorization Servers must specify a 
list of LDAP directory hosts that are read-only replicas of your data store. 

SQL Data Adapter (sql.conf)

The SQL Data Adapter parameters are set in the sql.conf file in the /conf directory of 
your Access Manager installation.

The sql.conf configuration file contains information that the Access Manager Servers 
need to connect to the SQL database used as your Access Manager data store. A copy 
of this file must reside on each host that is running either an Entitlements Server or an 
Authorization Server. Your Entitlements Server (eserver.conf) and Authorization 
Server (aserver.conf) configuration files have a parameter that points to the relative 
location of this file:

cleartrust.data.source.configuration :sql.conf

Note: In the comments of the configuration file, use Oracle as the  data store product 
name. Users of other SQL data store products must substitute with the appropriate 
product name. Wherever parameters and their examples are specific to a data store 
product, this is noted.

Date Format Reference Table

Refer to the symbols in the following table for determining your preferred date format 
for date-related parameters.

Symbol Meaning Data Type Example

G era designator text AD

y year digit 1996

M month 

Use MM for the number of the month, 
use any other number of Ms for text.

text or digit July and 07

d day digit 10

h hour in am/pm (1-12) digit 12

H hour in 24-hour day (0-23) digit 0
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Time Zone Reference Table

The following table is a reference of time zone codes that you can optionally use with 
the date format parameters.

m minute in hour digit 30

s second in minute digit 55

S millisecond digit 978

E day in week text Tuesday

D day in year digit 189

F day of week in month digit 2 (2nd Wed in July)

w week in year digit 27

W week in month digit 2

a am/pm market text PM

k hour in day (1-24) digit 24

K hour in am/pm (0-11) digit 0

z time zone text Pacific Standard Time

‘ escape for text delimiter

‘’ single quote literal

Symbol Meaning Data Type Example

Time Zone Code Definition

GMT Greenwich Mean Time 

AST Atlantic Standard Time

ADT Atlantic Daylight Saving Time

EST Eastern Standard Time

EDT Eastern Daylight Saving Time

CST Central Standard Time

CDT Central Daylight Saving Time

MST Mountain Standard Time

MDT Mountain Daylight Saving Time
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Additional Certificate Tool Information

Comments in the certool.conf file include sample configurations and default values 
for standard key generation and installation.

Some of the values required in the certool.conf file, such as the RSA Certificate 
Manager distinguished name (DN) and MD5 hash, must be obtained from the 
Certificate Manager Operations workbench of Certificate Manager. For more 
information on using the Certificate Manager Operations Workbench, see the 
Certificate Manager documentation and Help.

PST Pacific Standard Time

PDT Pacific Daylight Saving Time

AKST Alaska Standard Time

AKDT Alaska Daylight Saving Time

HST Hawaiian Standard Time

BST British Summer Time

IST Irish Summer Time

CET Central Europe Time

CEST Central Europe Summer Time

EET Eastern Europe Time

EEST Eastern Europe Summer Time

AEST Australian Eastern Standard Time

Time Zone Code Definition
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B Installing the RSA Access Manager Servers 

Using Silent Mode

• Automated Silent Installation on Windows

• Automated Silent Installation and Configuration on UNIX

• Automated Silent Uninstallation on UNIX

• Next Steps

You can install the RSA Access Manager Servers using two different methods:

Standard installation. You are prompted for parameter decisions during the 
installation process.

Automated silent installation. The product installs according to your recorded 
prompt input from a previous standard installation.

Automated silent installation allows you to install the Servers efficiently on multiple 
machines. It can be used in both Windows and UNIX environments. For more 
information about setting up multiple Access Manager Servers, see Chapter 11, 
“Deploying RSA Access Manager in Production Environments.”

For more information on standard installation, see “Installing the RSA Access 
Manager Servers on Windows” on page 30 or “Installing the RSA Access Manager 
Servers on UNIX” on page 33.

Automated Silent Installation on Windows

Automated silent installation of the Access Manager Servers on Windows uses an 
InstallShield silent (.iss) setup file. This file stores your responses to the required setup 
parameter prompts during a standard installation. An .iss file allows you to perform 
automated Access Manager installations at a later time without having to repeat any 
manual input. 

To create an .iss file for Access Manager silent installation on Windows:

1. Insert your RSA Access Manager 6.1 DVD.

2. Open a command prompt, and type the setup command adding the -r parameter 
along with the other elements shown in the following example:

setup.exe -r -f1c:\directory_name\CTinstall.iss

In this example, directory_name is the name of the directory created to store the 
.iss file. Also, note that in the parameter -f1c, “1” is the number one and not the 
letter L. CTinstall.iss is the name of the setup file.
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Note: Make sure that you create the response file in a valid, existing directory. If your 
path to the .iss file specifies a directory that does not exist, you may receive errors 
warning of insufficient drive space.

3. Complete the standard installation process, providing input as described in 
“Installing the RSA Access Manager Servers on Windows” on page 30. This input 
is written to C:\directory_name with the filename CTinstall.iss.

To install the Access Manager Servers on Windows using silent installation:

1. Insert your RSA Access Manager 6.1 DVD.

2. Open a command prompt, and type the setup command adding the -s parameter 
along with the elements shown in the following example:

setup.exe -s -f1c:\directory_name\CTinstall.iss 
-f2c:\CTinstall.log

In this example, directory_name is the name of the directory where you have 
stored the CTinstall.iss file that was created when you performed step 3 in the 
previous procedure. You can add the -f2 parameter to specify where to write the 
installation log file, CTinstall.log.
When this command is executed, the standard setup dialogs display rapidly, the 
installer exits, and a log file of events and errors is written to the specified 
location.

3. Generate the required secret keys using the keygen utility. For more information, 
see “Generating a Shared Secret Using Keygen” on page 194.

4. Copy the license file located on the CD included with your RSA Access Manager 
6.1 package to the Access Manager Servers configuration directory 
(AXM_HOME\conf) on each machine where the Servers are installed.

5. Go to “Next Steps” on page 294. 

Automated Silent Installation and Configuration on UNIX

Automated silent installation of the Access Manager Servers on UNIX uses a response 
file. This file stores your responses to the required setup parameter prompts during a 
standard installation. A response file allows you to perform automated Access 
Manager installations at a later time without having to repeat any manual input.

To create a response file for Access Manager silent installation on UNIX:

Create a response file for silent installation by following all the steps in the procedure 
“To install the RSA Access Manager Servers on UNIX using standard installation:” 
on page 34, but change the command syntax when you type the command in step 3 so 
that it includes the -m parameter and a name you choose for the installation response 
file:

# ./install-server.sh -m response-file-name
292 B: Installing the RSA Access Manager Servers Using Silent Mode



RSA Access Manager 6.1 SP4 Servers Installation and Configuration Guide
Important: To avoid being prompted (for example, involving the su command), RSA 
recommends running both the installer and configuration script as root.

To install the Access Manager Servers on UNIX using silent installation:

Follow all the steps in the procedure “To install the RSA Access Manager Servers on 
UNIX using standard installation:” on page 34, but change the command syntax when 
you type the command in step 3 so that it contains the -s parameter and the name of 
the installation response file you created during the standard installation:

# ./install-server.sh -s response-file-name

Note: Solaris installations only: If you are unnecessarily prompted for 
information during the silent installation, you may need to configure an Admin 
file to run with the installation. For more information, see the Sun Solaris 
documentation for information on Admin files.

To create a response file for Access Manager silent configuration on UNIX:

Create a response file for silent configuration by following all the steps in in the 
procedure “To configure the RSA Access Manager Servers on UNIX:” on page 36, 
but change the command syntax when you type the command in the Note so that it 
contains the -m parameter and a name you choose for your configuration response file:

# ./axm-configure.sh -m config-resp-file-name

To configure the Access Manager Servers on UNIX using silent installation:

1. Follow all the steps in the prodecure “To configure the RSA Access Manager 
Servers on UNIX:” on page 36, but this time change the command syntax when 
you type the command in the Note so that it contains the -s parameter and the 
name of the configuration response file you created in of the previous procedure.
# ./install-server.sh -s config-resp-file-name

For AIX and Solaris, you need to provide the absolute path of the configuration 
response file you created in the previous procedure.
# ./axm-configure.sh -s AXM_HOME/bin/config-resp-file-name

2. Generate the required secret keys using the keygen utility. For more information, 
see “Generating a Shared Secret Using Keygen” on page 194.

3. Copy the license file located on the CD included with your RSA Access Manager 
6.1 package to the Access Manager Servers configuration directory 
(AXM_HOME/conf) on each machine on which the Servers are installed.
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Automated Silent Uninstallation on UNIX

To uninstall the Access Manager Servers on UNIX using silent uninstallation:

1. Type the following script to remove the Server binaries:

# ./uninstall-server.sh -s

2. Manually remove the following directories:

• AXM_HOME/conf (contains your configuration files and license file)

• AXM_HOME/logs (contains your log files)

• AXM_HOME/var (contains your KeyServer.sec file, which is the Key 
Server list of all client keys. It also contains the KeyClient.sec file, which is 
the Authorization Server client key.)

During the server package installation, if you have created a new Access Manager 
user account on UNIX, then the user account is removed in the package post-remove 
process. This process performs the following:

• Deletes the Access Manager user’s home directory.

• Deletes all the files in the Access Manager user’s home directory

• Removes the Access Manager user from the passwd files.

The post-remove script prompts you to run a groupdel command to remove the UNIX 
group that was created during installation.

Note: The Access Manager installation directory and configuration files are not 
removed. You must remove the installation directory and configuration files manually. 

Next Steps

After you have completed the Access Manager Servers installation, you need to:

• Encrypt passwords in your configuration files using the Access Manager cryptedit 
tool. If you selected the option to encrypt passwords during installation, see 
“Encrypting Parameters in the Configuration Files” on page 204.

• Install and configure your Data Adapters. For more information, see Chapter 3, 
“Installing the LDAP Data Adapter” or Chapter 5, “Installing and Configuring the 
SQL Data Adapter.”
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C Log Message IDs for Authorization Server

The following table lists the action or reason, code, and code description for all user 
activity events logged in the RSA Access Manager Authorization Server.

Action/Reason Code Code Description

action -2 Internal error event

reason -2 Placeholder

action -1 Unknown event

reason -1 Unknown event

action 0 Request not serviced

reason 0 Auth server busy

action 1 Startup event

reason 1 Placeholder

action 2 Internal Error

reason 2 Invalid Argument

action 3 Internal Error

reason 3 LDAP Authentication Error

action 4 Authentication Failure

reason 4 NT PDC Error

action 5 Server Test

reason 5 Server Test Failed

action 7 Internal Error

reason 7 Unknown Authentication Type

action 8 Internal Error

reason 8 Unknown Error

action 9  Data Store Error

reason 9 Placeholder

action 10 Authentication Failure

reason 10 Custom Authentication Type

action 11 Request to AdaptiveAuth Store
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reason 11 Failed

action 12 Protected URI cache not loaded

reason 12 Exceeded maximum uri per server count

action 13 Cache Event

reason 13  Data Store Error

action 14 Connection to Adaptive Authentication

reason 14 Failed

action 15 MUX Event

reason 15 MUX Pool Exhausted

LOG_LEVEL_DENY 
messages (message id 
between 1000 and 1999)

action 1000 Authorization Failure

reason 1000 Access Denied

action 1001 Authentication Failure

reason 1001 Administrative Lockout

action 1002 Authentication Failure

reason 1002 Bad Password

action 1003 Authorization Failure

reason 1003 Cached Deny

action 1004 Authentication Failure

reason 1004 Account Expired

action 1005 Authorization Failure

reason 1005 Group Entitlement

action 1006 Authentication Failure

reason 1006 Inactive Account

action 1007 Need more information

reason 1007 New PIN Accepted

action 1008 Authentication Failure

reason 1008 New PIN Rejected

Action/Reason Code Code Description
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action 1009 Need more information

reason 1009 New PIN Required

action 1010 Need more information

reason 1010 Next Code Required

action 1011 Authorization Failure

reason 1011 No Entitlement

action 1012 Authorization Failure

reason 1012 Passive Deny

action 1013 Authentication Failure

reason 1013 Password Expired

action 1014 Authentication Failure

reason 1014 Password Expiration Forced

action 1015 Authentication Failure

reason 1015 Password Expired

action 1016 Authentication Failure

reason 1016 New User Password Expired

action 1017 Property/Properties not returned

reason 1017 Property Not Found (does not exist or is 
not exportable) or Property Read Failure

action 1018 Authorization Failure

action 1019 Authentication Failure

reason 1019 SecurID Authentication Failed

action 1020 Authorization Failure

reason 1020 Smart Rule

action 1021 Authentication Failure

reason 1021 Unknown User

action 1022 Authorization Failure

reason 1022 User Entitlement

action 1023 Impersonation Policy Search

reason 1023 No Policy Found

Action/Reason Code Code Description
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action 1024 Unique User Session Failure

reason 1024 Unique User Session Constraint Violated

action 1025 Authorization Failure

reason 1025 Impersonation-Cached Deny

action 1026 Authorization Failure

reason 1026 Impersonation-Group Entitlement Deny

action 1027 Authorization Failure

reason 1027 Impersonation-Passive Deny

action 1028 Authorization Failure

reason 1028 Impersonation-Smart Rule Deny

action 1029 Authorization Failure

reason 1029 Impersonation-User Entitlement Deny

action 1030 Authorization Failure

reason 1030 Impersonation-No Entitlement Deny

action 1031 User Token Failed

reason 1031 Token error

LOG_LEVEL_ALLOW 
messages (message id 
between 2000 and 2999)

action 2000 Authorization Success

reason 2000 Access Allowed

action 2001 Authorization Success

reason 2001 Entitlement

action 2002 Authorization Success

reason 2002 Cached Allow

action 2003 Authorization Success

reason 2003 Group Entitlement

action 2004 Authorization Succcess

reason 2004 Passive Allow

action 2005 Read Properties

Action/Reason Code Code Description
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reason 2005 -

action 2006 Check Resource

reason 2006 Protected Resource

action 2008 Authorization Success

reason 2008 Smart Rule

action 2009 User Token Created

reason 2009 Valid User

action 2010 Authentication Success

reason 2010 Valid User

action 2011 Impersonation Policy Search

reason 2011 Successful 

action 2012 Authorization Success

reason 2012 Impersonation-User Entitlement Allow

action 2013 Authorization Success

reason 2013 Impersonation-Cached Allow

action 2014 Authorization Success

reason 2014 Impersonation-Group Entitlement Allow

action 2015 Authorization Success

reason 2015 Impersonation-Smart Rule Allow

action 2016 Authorization Success

reason 2016 Impersonation-Passive Allow

action 2017 Administrative Unlock

result 2017 LockOut Period Expired

LOG_LEVEL_
INFORMATIONAL 
messages (message id 
greater than or equal to 
3000)

action 3000 Server Startup

reason 3000 -

action 3001 Server Test

Action/Reason Code Code Description
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reason 3001 Server Test Succeeded

action 3002 Resource Check

reason 3002 Unknown Resource

action 3003 Check Resource

reason 3003 Unprotected Resource

action 3004 User In Group

reason 3004 -

action 3005 User Not In Group

reason 3005 -

action 3006 Returned Groups For User

reason 3006 Valid Group

action 3007 Entries Not Fully Cached

reason 3007 Cache Preload Overflow

action 3008 Returned User Mapping

reason 3008 Returned User Mapping

action 3009 Returned Federated User Mapping

reason 3009 Returned Federated User Mapping

action 3010 Request To AdaptiveAuth Store

reason 3010 Succeeded

action 4001 Data Store Error

reason 4001 Invalid Windows UPN

Action/Reason Code Code Description
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D Log Message IDs for Entitlements Server

The following table lists the codes and messages for all administration events logged 
in the Entitlements Server. 

Code Message

-3 Referential integrity error

-2 Internal error event

-1 Unknown event

100 Connect

101 Login

102 Disconnect

200 Create password policy

201 Modify password policy

202 Delete password policy

203 Get default password policy

204 Set default password policy

205 Get password policy by UID

206 Transfer password policy

207 Get number of password policies

208 Get password policy by index

209 Get password policies by range

210 Get password policy by name

211 Get password policies by name

212 Check create password policy

213 Check delete password policy

214 Check modify password policy

215 Check set default password policy

216 Check get password policies

300 Get default account lifetime

301 Get default password lifetime
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400 Get active user

401 Create admin user

402 Modify admin user

403 Delete admin user

404 Get administrative user by UID

405 Get number of administrative users

406 Get administrative user by index

407 Get administrative users by range

408 Get administrative user by name

409 Get administrative users by name

410 Get administrative user search result size

411 Get administrative user search result by index

412 Get administrative user search results by range

413 Get administrative user search result by name

414 Get administrative user search results by name

415 Get number of admin users for admin group

416 Get admin user for admin group by index

417 Get admin users for admin group by range

418 Get admin user for admin group by name

419 Get admin users for admin group by name

420 Get number of users for role

421 Get user for role by index

422 Get users for role by range

423 Get user for role by name

424 Get users for role by name

425 Check create administrative user

426 Check delete administrative user

427 Check modify administrative user

500 Get active role

Code Message
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501 Modify admin role

502 Delete admin role

503 Create admin role

504 Get administrative role by UID

505 Get role ids for user

506 Get number of roles for admin group

507 Get role for admin group by index

508 Get roles for admin group by range

509 Get role for admin group by name

510 Get roles for admin group by name

511 Check create administrative role

512 Check delete administrative role

513 Check modify administrative role

517 User locked out

600 Get active group

601 Create admin group

602 Modify admin group

603 Delete admin group

604 Get administrative group by UID

605 Transfer ownership

606 Get number of administrative groups

607 Get administrative group by index

608 Get administrative groups by range

609 Get administrative group by name

610 Get administrative groups by name

611 Get administrative group search result size

612 Get administrative group search result by index

613 Get administrative group search results by range

614 Get administrative group search result by name

Code Message
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615 Get administrative group search results by name

616 Get administrative group for application

617 Get administrative group for group

618 Get administrative group for property definition

619 Get administrative group for user

620 Get administrative group for administrative user

621 Get administrative group for web server

622 Get administrative group for server tree

623 Get administrative group for Smart Rule

624 Get administrative group for object

625 Check create administrative group

626 Check delete administrative group

627 Check modify administrative group

628 Get administrative group children

629 Get all administrative groups by name

630 Transfer ownership of object

631 Transfer ownership of object due to administrative group 
delete

700 Create user

701 Modify user

702 Delete user

703 Validate user

704 Get user by dn

705 Get user by UID

706 Get number of users

707 Get user by index

708 Get users by range

709 Get user by name

710 Get users by name

711 Get user search result size

Code Message
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712 Get user search result by index

713 Get user search results by range

714 Get user search result by name

715 Get user search results by name

716 Get number of users for admin group

717 Get user for admin group by index

718 Get users for admin group by range

719 Get user for admin group by name

720 Get users for admin group by name

721 Get number of users for group

722 Get user for group by index

723 Get users for group by range

724 Get user for group by name

725 Get users for group by name

726 Get number of properties for user

727 Get property for user by index

728 Get properties for user by range

729 Get property for user by name

730 Get properties for user by name

731 Check create user

732 Check delete user

733 Check modify user

734 Check modify user property

735 Create federated user mapping

736 Delete federated user mapping

737 Delete federated user mappings for user

738 Delete federated user mappings for domain

739 Create user mapping

740 Delete user mapping
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741 Delete user mappings for user

742 Delete user mappings for domain

800 Force password expiration

801 Check password expiration override

802 Get password expiration date for user

803 Set password expiry

804 Reset password expiry

805 Check password

806 Reset password

807 Set password

808 Check change password

900 Create group

901 Modify group

902 Delete group

903 Get group by UID

904 Add member to group

905 Remove member from group

906 Get number of groups

907 Get group by index

908 Get groups by range

909 Get group by name

910 Get groups by name

911 Get group search result size

912 Get group search result by index

913 Get group search results by range

914 Get group search result by name

915 Get group search results by name

916 Get number of groups for admin group

917 Get group for admin group by index

Code Message
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918 Get groups for admin group by range

919 Get group for admin group by name

920 Get groups for admin group by name

921 Get number of groups for group

922 Get group for group by index

923 Get groups for group by range

924 Get group for group by name

925 Get groups for group by name

926 Get number of parents for group

927 Get parent for group by index

928 Get parents for group by range

929 Get parent for group by name

930 Get parents for group by name

931 Get number of groups for user

932 Get group for user by index

933 Get groups for user by range

934 Get group for user by name

935 Get groups for user by name

936 Check add member to group

937 Check remove member from group

938 Check create group

939 Check delete group

940 Check modify group

1000 Delete entity

1001 Get entity for entitlement

1002 Check delete entity

1003 Check modify entity

1100 Create application

1101 Modify application

Code Message
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1102 Delete application

1103 Get application by UID

1104 Get applications for user

1105 Get application for application

1106 Get application for function

1107 Get application for URL

1108 Get application for resource

1109 Get number of applications

1110 Get application by index

1111 Get applications by range

1112 Get application by name

1113 Get applications by name

1114 Get application search result size

1115 Get application search result by index

1116 Get application search results by range

1117 Get application search result by name

1118 Get application search results by name

1119 Get number of applications for admin group

1120 Get application for admin group by index

1121 Get applications for admin group by range

1122 Get application for admin group by name

1123 Get applications for admin group by name

1124 Check create application

1125 Check delete application

1126 Check modify application

1200 Get application function by UID

1201 Create application function

1202 Modify application function

1203 Delete application function

Code Message
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1204 Get number of functions for application

1205 Get function for application by index

1206 Get functions for application by range

1207 Get function for application by name

1208 Get functions for application by name

1209 Check create application function

1210 Check delete application function

1211 Check modify application function

1300 Create application URL

1301 Modify application URL

1302 Delete application URL

1303 Get URL by UID

1304 Get number of URLs for application

1305 Get URL for application by index

1306 Get URLs for application by range

1307 Get URL for application by name

1308 Get URLs for application by name

1309 Get number of URLs for server

1310 Get URL for server by index

1311 Get URLs for server by range

1312 Get URL for server by name

1313 Get URLs for server by name

1314 Check create application URL

1315 Check delete application URL

1316 Check modify application URL

1400 Delete resource

1401 Get resource for Smart Rule

1402 Get resource for policy

1403 Check delete resource
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1404 Check modify resource

1500 Create server

1501 Modify server

1502 Delete server

1503 Get web server by UID

1504 Get server for URL

1505 Get number of web servers

1506 Get web server by index

1507 Get web servers by range

1508 Get web server by name

1509 Get web servers by name

1510 Get server search result size

1511 Get server search result by index

1512 Get server search results by range

1513 Get server search result by name

1514 Get server search results by name

1515 Get number of servers for admin group

1516 Get server for admin group by index

1517 Get servers for admin group by range

1518 Get server for admin group by name

1519 Get servers for admin group by name

1520 Check create server

1521 Check delete server

1522 Check modify server

1600 Create server tree

1601 Modify server tree

1602 Delete server tree

1603 Get server tree by UID

1604 Get number of server trees for server

Code Message
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1605 Get server tree for server by index

1606 Get server trees for server by range

1607 Get server tree for server by name

1608 Get server trees for server by name

1609 Check create server tree

1610 Check delete server tree

1611 Check modify server tree

1700 Create entitlement

1701 Modify entitlement

1702 Delete entitlement

1703 Get entitlement by UID

1704 Get entitlement for user

1705 Get number of entitlements for application

1706 Get entitlement for application by index

1707 Get entitlements for application by range

1708 Get entitlement for application by name

1709 Get entitlements for application by name

1710 Get number of entitlements for group

1711 Get entitlement for group by index

1712 Get entitlements for group by range

1713 Get entitlement for group by name

1714 Get entitlements for group by name

1715 Get number of entitlements for user

1716 Get entitlement for user by index

1717 Get entitlements for user by range

1718 Get entitlement for user by name

1719 Get entitlements for user by name

1720 Get number of entitlements for function

1721 Get entitlement for function by index
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1722 Get entitlements for function by range

1723 Get entitlement for function by name

1724 Get entitlements for function by name

1725 Get number of entitlements for URL

1726 Get entitlement for URL by index

1727 Get entitlements for URL by range

1728 Get entitlement for URL by name

1729 Get entitlements for URL by name

1730 Check create entitlement

1731 Check delete entitlement

1732 Check modify entitlement

1800 Create Smart Rule

1801 Modify Smart Rule

1802 Delete Smart Rule

1803 Get Smart Rule by UID

1804 Get number of Smart Rules for application

1805 Get Smart Rule for application by index

1806 Get Smart Rules for application by range

1807 Get Smart Rule for application by name

1808 Get Smart Rules for application by name

1809 Get number of Smart Rules for function

1810 Get Smart Rule for function by index

1811 Get Smart Rules for function by range

1812 Get Smart Rule for function by name

1813 Get Smart Rules for function by name

1814 Get number of Smart Rules for URL

1815 Get Smart Rule for URL by index

1816 Get Smart Rules for URL by range

1817 Get Smart Rule for URL by name

Code Message
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1818 Get Smart Rules for URL by name

1819 Check create Smart Rule

1820 Check delete Smart Rule

1821 Check modify Smart Rule

1900 Delete policy

1901 Check delete policy

1902 Check modify policy

2000 Create property definition

2001 Modify property definition

2002 Delete property definition

2003 Get property definition by UID

2004 Get property definition for Smart Rule

2005 Get number of property definitions

2006 Get property definition by index

2007 Get property definitions by range

2008 Get property definition by name

2009 Get property definitions by name

2010 Get property definitions search result size

2011 Get property definitions search result by index

2012 Get property definitions search results by range

2013 Get property definitions search result by name

2014 Get property definitions search results by name

2015 Get number of property definitions for admin group

2016 Get property definition for admin group by index

2017 Get property definitions for admin group by range

2018 Get property definition for admin group by name

2019 Get property definitions for admin group by name

2020 Check create property definition

2021 Check delete property definition

Code Message
D: Log Message IDs for Entitlements Server 313



RSA Access Manager 6.1 SP4 Servers Installation and Configuration Guide
2022 Check modify property definition

2023 Get exportable property definitions search result size

2024 Get exportable property definitions search result by index

2025 Get exportable property definitions search results by range

2026 Get exportable property definition by name

2027 Get exportable property definitions by name

2100 Delete object

2101 Get object by UID

2102 Get object search result size

2103 Get object search result by index

2104 Get object search results by range

2105 Get object search result by name

2106 Get object search results by name

2107 Get number of related objects

2108 Get related object by index

2109 Get related objects by range

2110 Get related object by name

2111 Get related objects by name

2112 Get number of objects

2113 Get object by name

2114 Get objects by name

2115 Get object by index

2116 Get objects by range

2200 Bulk remove members from group start

2201 Bulk remove members from group end

2202 Bulk add members to group start

2203 Bulk add members to group end

2204 Bulk modify users start

2205 Bulk modify users end
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2206 Bulk delete objects start

2207 Bulk delete objects end

2208 Bulk create groups start

2209 Bulk create groups end

2210 Bulk create users start

2211 Bulk create users end

2212 Bulk modify groups start

2213 Bulk modify groups end

2300 Check URL access

2301 Check function access

2302 Flush cache

2303 All attempts to send the cache flush notification failed for 
atleast one authServer on the current list

2304 Get configuration from eServer

2305 Validate password against given password policy

3000 Server Startup

Code Message
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E Log Message IDs for Instrumentation Server

The following table lists the codes and messages for all administration events logged 
in the Instrumentation Server.

Code Message

-2 Internal error event

-1 Unknown event

100 Initialization error

101 Startup error

102 Trap configuration error

103 Resource registration error

104 Resource ping error

105 Resource connection reset error

106 Resource update error

107 Table update error

108 Connection error

109 Trap send error

800 Runtime error

999 Error

1100 Shutdown

1101 Traps disabled

1102 Invalid configuration

2000 Initialization

2001 Sub-component startup

2002 Running

2010 Resource registration

2012 Resource connection rest

2013 Trap event

2014 Table registration

2015 Trap registration
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2016 SNMP GET Request

2017 SNMP SET Request

2018 SNMP Table Update Info

2019 SNMP Table Row Update Info

2999 Info

3000 Server Startup

3011 Resource ping event

3012 Get attribute fail

3013 Got attribute

Code Message
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F Log File Result Codes

Every entry in a log file provides an integer result code that indicates the outcome of 
the corresponding operation.

The following example shows a representative log file entry for an RSA Access 
Manager Server component: 

sequence_number=30,2003-05-08 09:32:12:527 PDT, conn=67, op=105, msgid=709, 
ip=127.0.0.1, uname=admin, msg="Get user by name", result=2, etime=70ms, 
name=RTAPItestUserID 

Here, result=2 indicates that the object of the requested operation was not found. 

See the following table for a description of the result codes that each integer in the log 
file entries represent.

Log File Result Code Description for the Requested Operation

0 RC_OK 

Indicates that the requested operation was successfully 
completed.

2 RC_OBJ_NOT_FOUND 

Indicates that the object of the requested operation was not 
found.

3 RC_INVALID_TYPE 

Indicates that the requested operation used an invalid id.

4 RC_NOT_AUTHORIZED

Indicates that the requested operation was unauthorized.

5 RC_TRANSPORT_ERROR 

Indicates that a transport error occurred during the requested 
operation.

6

7 RC_DUPLICATE_OBJ 

Indicates that a duplicate OBJ exists for the requested operation.

8 RC_RANGE_OUT_OF_BOUNDS

Indicates that the range for the requested operation was 
out-of-bounds.

9 RC_ADMINISTRATOR_NOT_FOUND

Indicates that the administrator was not found for the requested 
operation.
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10 RC_NO_AUTH_SERVERS

Indicates that no Access Manager Authorization Servers were 
available for the requested operation.

11 RC_RANGE_EXCEEDS_LIMIT

Indicates that the range for the requested operation exceeded the 
limit.

12 RC_INVALID_REFERENCE

Indicates that an invalid reference occurred during the requested 
operation.

13 RC_BAD_ARGS

Indicates a result of bad arguments for the requested operation.

14 RC_INVALID_CONTEXT

Indicates an invalid context for the requested operation.

15 RC_ALREADY_CONNECTED

Indicates a connection already in place for the requested 
operation.

16 RC_NOT_CONNECTED

Indicates that a connection is not in place for the requested 
operation.

17 RC_ALREADY_INITIALIZED

Indicates that the requested operation is already initialized.

18 RC_ILLEGAL_PASSWORD

Indicates use of an illegal password during the requested 
operation.

19 RC_EXPIRED_PASSWORD

Indicates use of an expired password during the requested 
operation.

20 RC_INCOMPLETE_DATA

Indicates incomplete data for the requested operation.

21 RC_OPERATION_NOT_SUPPORTED

Indicates that the requested operation was not supported.

22 RC_LOGIN_RETRY_EXCEEDED

Indicates that the requested operation exceeded the limit for the 
logon retry. 

Log File Result Code Description for the Requested Operation
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G Log Message IDs for Dispatcher/Key Server

• LOG_LEVEL_ERROR Messages

• LOG_LEVEL_DOWN Messages

• LOG_LEVEL_WARNING Messages

• LOG_LEVEL_INFORMATIONAL Messages

The following tables list and describe all event types logged in the RSA Access 
Manager Dispatcher.

LOG_LEVEL_ERROR Messages

These messages have an ID number less than 1000.

LOG_LEVEL_DOWN Messages

These messages have an ID number between 1000 and 1999.

LOG_LEVEL_WARNING Messages

These messages have an ID number between 2000 and 2999.

Event type Description

-2 Internal Error

0 Error

2 Internal Error

3 Invalid Election Message

Event type Description

1000 Server Down

Event Type Description

2000 E-mailed Administrator

2001 Ping Failure
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LOG_LEVEL_INFORMATIONAL Messages 

These messages have an ID number greater than or equal to 3000.

2002 Discard the Valid Session 
Key

2003 Invalid Expiration Time for 
the Session Key

2004 Node Failure

Event Type Description

Event Type Description

3000 Startup Event

3001 Server Registration

3002 Election Start

3003 Receive the Session Keys 
(Before Election)

3004 Become the Master Server

3005 Become the Master Server

3006 Send the Session Key

3007 Auth Server List Request
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H Management Information Base

• Authorization Server

• Entitlements Server

• Dispatcher

• Key Server

The following tables list the nodes in the Access Manager v610 Management 
Information Base (MIB). The object identification (OID) number for each node is 
included. For all nodes, the first six numbers, .1.3.6.1.4.1, correspond to 
ios.org.dod.internet.private.enterprise. The number 2197 is the OID designated for 
RSA. The number 10 is the OID designated for Access Manager.

Authorization Server

System Information Node Name\OID Number Description

Configuration 
information

.aserverConfigurationTable

.1.3.6.1.4.1.2197.10.1.1.1

This table provides 
configuration information 
for the Authorization Server. 
Sensitive information, such 
as the administrator 
password, is excluded.

.aserverConfigHost

.1.3.6.1.4.1.2197.10.1.1.1.1.1

Name and port number of the 
host machine providing 
configuration information.

.aserverConfigParamValue

.1.3.6.1.4.1.2197.10.1.1.1.1.2

Parameter names from 
aserver.conf.

.aserverConfigParamValue

.1.3.6.1.4.1.2197.10.1.1.1.1.3

Current value of each 
parameter in aserver.conf at 
time of request.

System uptime .aserverSysUpTimeTable

.1.3.6.1.4.1.2197.10.1.1.2

This table provides 
Authorization Server uptime 
information.

.aserverSysUpTimeHost

.1.3.6.1.4.1.2197.10.1.1.2.1.1

Name and port number of the 
host machine providing the 
Server uptime information.
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.aserverSysUpTimeValue

.1.3.6.1.4.1.2197.10.1.1.2.1.2

Time elapsed since Server 
startup.

Requests .aserverRequestsTable

.1.3.6.1.4.1.2197.10.1.1.3

This table provides 
Authorization Server 
requests information.

.aserverRequestsHost

.1.3.6.1.4.1.2197.10.1.1.3.1.1

Name and port number of the 
host machine providing the 
Server requests information.

.aserverRequestsTotal

.1.3.6.1.4.1.2197.10.1.1.3.1.2

Number of requests received 
by the Server since startup at 
the time of request.

.aserverRequestsPerSec

.1.3.6.1.4.1.2197.10.1.1.3.1.3

Average number of requests 
received per second during 
the last 30 seconds at the 
time of request.

Number of connected 
clients

.aserverNumOfConnClientsTable

.1.3.6.1.4.1.2197.10.1.1.5

This table provides the 
number of clients connected 
to the Authorization Server.

.aserverNumOfConnClientsHost

.1.3.6.1.4.1.2197.10.1.0.5.1.1

Name and port number of the 
host machine providing the 
number of clients connected 
to the Server information.

.aserverNumOfConnClientsValue

.1.3.6.1.4.1.2197.10.1.0.5.1.2

Number of clients connected 
to the Server at the time of 
request.

List of connected clients 
and number of 
connections by each 
client

.aserverNumOfConnByClientsTable

.1.3.6.1.4.1.2197.10.1.1.7

This table provides the 
number of client connections 
to the Authorization Server 
grouped by hostname and 
port number.

.aserverNumOfConnByClientsHost

.1.3.6.1.4.1.2197.10.1.1.7.1.1

Name and port number of the 
host machine providing the 
number of client connections 
to the Server information.

.aserverConnClientName

.1.3.6.1.4.1.2197.10.1.1.7.1.2

Hostname and port number 
of connected client.

.aserverNumOfConnections

.1.3.6.1.4.1.2197.10.1.1.7.1.3

Number of client 
connections at the time of 
request.

System Information Node Name\OID Number Description
324 H: Management Information Base



RSA Access Manager 6.1 SP4 Servers Installation and Configuration Guide
Authorization requests .aserverAuthZRequestsTable

.1.3.6.1.4.1.2197.10.1.1.8

This table provides 
authorization requests 
information. 

.aserverAuthZRequestsHost

.1.3.6.1.4.1.2197.10.1.1.8.1.1

Name and port number of the 
host machine providing the 
authorization requests 
information.

.aserverAuthZRequestsTotal

.1.3.6.1.4.1.2197.10.1.1.8.1.2

Number of authorization 
requests since startup at the 
time of request.

.aserverAuthZRequestsPerSec

.1.3.6.1.4.1.2197.10.1.1.8.1.3

Average number of 
authorization requests 
received per second during 
the last 30 seconds at the 
time of request.

.aserverAuthZRequestsFailedTotal

.1.3.6.1.4.1.2197.10.1.1.8.1.4

Number of authorization 
requests that failed since 
startup at the time of request.

.aserverAuthZRequestsFailedPerSec

.1.3.6.1.4.1.2197.10.1.1.8.1.5

Average number of 
authorization requests that 
failed per second during the 
last 30 seconds at the time of 
request.

.aserverAuthZRequestsSuccessfulTotal

.1.3.6.1.4.1.2197.10.1.1.8.1.6

Number of authorization 
requests that were successful 
since startup at the time of 
request.

.aserverAuthZRequestsSuccessfulPerSec

.1.3.6.1.4.1.2197.10.1.1.8.1.7

Average number of 
authorization requests that 
were successful per second 
during the last 30 seconds at 
the time of request.

Authentication requests .aserverAuthNRequestsTable

.1.3.6.1.4.1.2197.10.1.1.14

This table provides 
authentication requests 
information.

.aserverAuthNRequestsHost

.1.3.6.1.4.1.2197.10.1.1.14.1.1

Name and port number of the 
host machine providing the 
authentication requests 
information.

System Information Node Name\OID Number Description
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.aserverAuthNRequestsTotal

.1.3.6.1.4.1.2197.10.1.1.14.1.2

Number of authentication 
requests since startup at the 
time of request.

.aserverAuthNRequestsPerSec

.1.3.6.1.4.1.2197.10.1.1.14.1.3

Average number of 
authentication requests 
received per second during 
the last 30 seconds at the 
time of request.

.aserverAuthNRequestsFailedTotal

.1.3.6.1.4.1.2197.10.1.1.14.1.4

Number of authentication 
requests that failed since 
startup at the time of request.

.aserverAuthNRequestsFailedPerSec

.1.3.6.1.4.1.2197.10.1.1.14.1.5

Average number of 
authentication requests that 
failed per second during the 
last 30 seconds at the time of 
request.

.aserverAuthNRequestsSuccessfulTotal

.1.3.6.1.4.1.2197.10.1.1.14.1.6

Number of authentication 
requests that were successful 
since startup at the time of 
request.

.aserverAuthNRequestsSuccessfulPerSec

.1.3.6.1.4.1.2197.10.1.1.14.1.7

Average number of 
authentication requests that 
were successful per second 
during the last 30 seconds at 
the time of request.

Cache content 
information

.aserverCacheTable

.1.3.6.1.4.1.2197.10.1.1.20

This table provides 
Authorization Server cache 
information. Only caches 
configurable by 
administrator are included.

.aserverCacheHost

.1.3.6.1.4.1.2197.10.1.1.20.1.1

Name and port number of the 
host machine providing the 
cache information.

.aserverCacheName

.1.3.6.1.4.1.2197.10.1.1.20.1.2

Name of cache.

.aserverCacheSize

.1.3.6.1.4.1.2197.10.1.1.20.1.3

Number of objects in cache 
at the time of request.

System Information Node Name\OID Number Description
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.aserverCacheTotalEvents

.1.3.6.1.4.1.2197.10.1.1.20.1.4

Number of cache data 
requests since startup at the 
time of request.

.aserverCacheTotalHits

.1.3.6.1.4.1.2197.10.1.1.20.1.5

Number of cache hits since 
startup at the time of request.

.aserverCacheTotalMisses

.1.3.6.1.4.1.2197.10.1.1.20.1.6

Number of cache misses 
since startup at the time of 
request.

.aserverCacheHitRatio

.1.3.6.1.4.1.2197.10.1.1.20.1.7

Average number of cache 
hits per second (expressed as 
a percent value) at the time 
of request.

Cache flush information .aserverCacheFlushesTable

.1.3.6.1.4.1.2197.10.1.1.21

This table provides 
Authorization Server cache 
flush information.

.aserverCacheFlushesHost

.1.3.6.1.4.1.2197.10.1.1.21.1.1

Name and port number of the 
host machine providing the 
cache flush information.

.aserverCacheFlushesValue

.1.3.6.1.4.1.2197.10.1.1.21.1.2

Number of complete cache 
flushes since startup at the 
time of request.

 Data store requests .aserverDALRequestsTable

.1.3.6.1.4.1.2197.10.1.1.41

This table provides 
Authorization Server data 
store requests information.

.aserverDALRequestsHost

.1.3.6.1.4.1.2197.10.1.1.41.1.1

Name and port number of the 
host machine providing the 
data store requests 
information.

.aserverDALRequestsTotal

.1.3.6.1.4.1.2197.10.1.1.41.1.2

Number of  data store 
requests since startup at the 
time of request.

.aserverDALRequestsPerSec

.1.3.6.1.4.1.2197.10.1.1.41.1.3

Average number of requests 
processed by the data store 
per second during the last 30 
seconds at the time of 
request.

.aserverDALRequestsPending

.1.3.6.1.4.1.2197.10.1.1.41.1.4

Number of requests pending 
for the data store at the time 
of request.

System Information Node Name\OID Number Description
H: Management Information Base 327



RSA Access Manager 6.1 SP4 Servers Installation and Configuration Guide
 Data store response time .aserverDALResponseTable

.1.3.6.1.4.1.2197.10.1.1.43

This table provides 
Authorization Server data 
store response time 
information.

.aserverDALResponseHost

.1.3.6.1.4.1.2197.10.1.1.43.1.1

Name and port number of the 
host machine providing the 
data store response time 
information.

.aserverDALResponseAvgTime

.1.3.6.1.4.1.2197.10.1.1.43.1.2

Average  data store response 
time during the last 30 
seconds at the time of 
request.

.aserverDALResponseMinTime

.1.3.6.1.4.1.2197.10.1.1.43.1.3

Minimum data store 
response time during the last 
30 seconds at the time of 
request.

.aserverDALResponseMaxTime

.1.3.6.1.4.1.2197.10.1.1.43.1.4

Maximum data store 
response time during the last 
30 seconds at the time of 
request.

Active connections to 
data store listed by type

.aserverDALActiveConnTable

.1.3.6.1.4.1.2197.10.1.1.46

This table provides 
information about active 
connections made to the data 
store by the Authorization 
Server. All data is grouped 
by data store type.

.aserverDALActiveConnHost

.1.3.6.1.4.1.2197.10.1.1.46.1.1

Name and port number of the 
host machine providing the 
data store active connection 
information.

.aserverDALActiveConnType

.1.3.6.1.4.1.2197.10.1.1.46.1.2

Type of data store (for 
example, “Oracle”) that is 
actively connected at the 
time of request.

.aserverDALActiveConnCount

.1.3.6.1.4.1.2197.10.1.1.46.1.3

Number of active 
connections to the data store 
at the time of request.

.aserverDALActiveConnMaxCount

.1.3.6.1.4.1.2197.10.1.1.46.1.4

Number of active 
connections made to the data 
store since startup at time of 
request.
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Active connections to 
data store listed by pool 
type

.aserverDALNumConnByPoolTable

.1.3.6.1.4.1.2197.10.1.1.49

This table provides 
information about active 
connections made to the data 
store by the Authorization 
Server. All data is grouped 
by data store pool type.

.aserverDALNumConnByPoolHost

.1.3.6.1.4.1.2197.10.1.1.49.1.1

Name and port number of the 
host machine providing the 
data store active connection 
information.

.aserverDALNumConnByPoolName

.1.3.6.1.4.1.2197.10.1.1.49.1.2

Pool type name (SQL or 
LDAP) of a data store that is 
actively connected at the 
time of request.

.aserverDALNumConnByPoolCount

.1.3.6.1.4.1.2197.10.1.1.49.1.3

Number of active 
connections made to a data 
store pool type at the time of 
request.

Runtime configuration .aserverRuntimeConfigTable

.1.3.6.1.4.1.2197.10.1.1.50

This table provides runtime 
configuration for the 
Authorization Server. These 
configurations can be 
modified at runtime.

.aserverRuntimeConfigHost

.1.3.6.1.4.1.2197.10.1.1.50.1.1

Name and port number of the 
host machine providing 
configuration information.

.aserverRuntimeConfigParamName

.1.3.6.1.4.1.2197.10.1.1.50.1.2

Runtime configuration 
parameter name.

.aserverRuntimeConfigParamValue

.1.3.6.1.4.1.2197.10.1.1.50.1.3

Runtime configuration 
parameter value.

Authorization Server 
Token Errors 

.aserverTokenErrorsEntry

.1.3.6.1.4.1.2197.10.1.1.51

This table provides 
information on the 
Authorization Server token 
errors.

.aserverTokenErrorsHost

.1.3.6.1.4.1.2197.10.1.1.51.1.1

Name and port number of the 
host machine providing the 
Server requests. 

.aserverTotalTokenErrors

.1.3.6.1.4.1.2197.10.1.1.51.1.2

Total number of token errors 
in the Server since start up.
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Entitlements Server

.aserverTokenErrorsPerHour

.1.3.6.1.4.1.2197.10.1.1.51.1.3

Average number of requests 
received per hour during the 
last hour in the server.

Authorization Server 
Mux Requests Pool

.aserverMuxRequestPoolEntry

.1.3.6.1.4.1.2197.10.1.1.52.1

This table provides 
information on the 
Authorization Server 
MuxRequestPool statistics

.aserverMuxRequestPoolHost

.1.3.6.1.4.1.2197.10.1.1.52.1.1

Name and port number of the 
host machine providing the 
Server requests.

.aserverMuxRequestsServed

.1.3.6.1.4.1.2197.10.1.1.52.1.2

Total number of 
MuxRequests being 
serviced.

.aserverMuxAvgQueueSize

.1.3.6.1.4.1.2197.10.1.1.52.1.3

Average Size of 
MuxRequests queue

.aserverMuxAvgTimeInQueue

.1.3.6.1.4.1.2197.10.1.1.52.1.4

Average time for requests in 
the queue.

.aserverMuxAvgExecutionTime

.1.3.6.1.4.1.2197.10.1.1.52.1.5

Average time of execution of 
requests in the queue

.aserverMuxAvgIdleTime

.1.3.6.1.4.1.2197.10.1.1.52.1.6

Average idle time for 
requests in the queue.

Notifications .aserverNotifications

.1.3.6.1.4.1.2197.10.1.1.100

Notifications sent when 
trapped events take place on 
the Server.

.aserverLogEvent

.1.3.6.1.4.1.2197.10.1.1.100.1.1

Notification that the Server 
has logged a critical message 
(Level 10 and higher).

.aserverFailoverEvent

.1.3.6.1.4.1.2197.10.1.1.100.1.2

Notification that the Server 
has failed over to another 
data store. (Only available 
for LDAP.)
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System Information Node Name\OID Number Description

Configuration 
information

.eserverConfigurationTable

.1.3.6.1.4.1.2197.10.1.2.1

This table provides 
configuration information 
for the Entitlements Server. 
Sensitive information, such 
as the administrator 
password, is excluded.

.eserverConfigHost

.1.3.6.1.4.1.2197.10.1.2.1.1.1

Name and port number of the 
host machine providing 
configuration information.

.eserverConfigParamName

.1.3.6.1.4.1.2197.10.1.2.1.1.2

Parameter names from 
eserver.conf.

.eserverConfigParamValue

.1.3.6.1.4.1.2197.10.1.2.1.1.3

Current value for each 
parameter at the time of 
request.

System uptime .eserverSysUpTimeTable

.1.3.6.1.4.1.2197.10.1.2.2

This table provides 
Entitlements Server uptime 
information.

.eserverSysUpTimeHost

.1.3.6.1.4.1.2197.10.1.2.2.1.1

Name and port number of the 
host machine providing 
Server uptime information.

.eserverSysUpTimeValue

.1.3.6.1.4.1.2197.10.1.2.2.1.2

Time elapsed since Server 
startup.

Data store requests .eserverRequestsTable

.1.3.6.1.4.1.2197.10.1.2.3

This table provides 
Entitlements data store 
requests information.

.eserverRequestsHost

.1.3.6.1.4.1.2197.10.1.2.3.1.1

Name and port number of the 
host machine providing the 
data store Server requests 
information.

.eserverRequestsTotal

.1.3.6.1.4.1.2197.10.1.2.3.1.2

Number of data store 
requests received by Server 
since startup at the time of 
request.

.eserverRequestsPerSec

.1.3.6.1.4.1.2197.10.1.2.3.1.3

Average number of requests 
processed by the data store 
per second during the last 30 
seconds at the time of 
request.
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Number of connected 
clients

.eserverNumOfConnClientsTable

.1.3.6.1.4.1.2197.10.1.2.5

This table provides the 
number of clients connected 
to the Entitlements Server.

.eserverNumOfConnClientsHost

.1.3.6.1.4.1.2197.10.1.2.5.1.1

Name and port number of the 
host machine providing the 
number of connected clients 
information.

.eserverNumOfConnClientsValue

.1.3.6.1.4.1.2197.10.1.2.5.1.2

Number of clients connected 
to Server at the time of 
request.

List of connected clients 
with number of 
connections by each 
client

.eserverNumOfConnByClientsTable

.1.3.6.1.4.1.2197.10.1.2.7

This table provides the 
number of client connections 
to the Entitlements Server 
grouped by hostname and 
port number.

.eserverNumOfConnByClientsHost

.1.3.6.1.4.1.2197.10.1.2.7.1.1

Name and port number of the 
host machine providing the 
number of client connections 
to the Server information.

.eserverConnClientName

.1.3.6.1.4.1.2197.10.1.2.7.1.2

Hostname and port number 
of connected client.

.eserverNumOfConnections

.1.3.6.1.4.1.2197.10.1.2.7.1.3

Number of client 
connections at the time of 
request.

Administrators with 
active connections

.eserverAdminConnListTable

.1.3.6.1.4.1.2197.10.1.2.101

This table provides a list of 
administrators with active 
connections to the 
Entitlements Server.

.eserverAdminConnListHost

.1.3.6.1.4.1.2197.10.1.2.101.1.1

Name and port number of the 
host machine providing the 
list of active administrator 
connections to Server.

.eserverAdminConnListName

.1.3.6.1.4.1.2197.10.1.2.101.1.2

Name of the administrator 
with active connection to the 
Server at the time of request.

.eserverAdminConnListClient

.1.3.6.1.4.1.2197.10.1.2.101.1.3

Hostname used by the 
administrator at the time of 
request.
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List of administrators 
(and roles) with active 
connections

.eserverAdminListTable

.1.3.6.1.4.1.2197.10.1.2.102

This table provides a list of 
administrators (and their 
roles) with active 
connections to the Server.

.eserverAdminListHost

.1.3.6.1.4.1.2197.10.1.2.102.1.1

Name and port number of the 
host machine providing the 
list of administrators (and 
their roles) with active 
connections to the Server.

.eserverAdminListName

.1.3.6.1.4.1.2197.10.1.2.102.1.2

Name of the administrator 
with active connection to 
Server at the time of request.

.eserverAdminListRole

.1.3.6.1.4.1.2197.10.1.2.102.1.3

Name of administrative 
role(s) of user with active 
connection to Server at the 
time of request.

Cache content 
information

.eserverCacheTable

.1.3.6.1.4.1.2197.10.1.2.103

This table provides 
Entitlements Server cache 
information. Only caches 
configurable by 
administrator are included.

.eserverCacheHost

.1.3.6.1.4.1.2197.10.1.2.103.1.1

Name and port number of the 
host machine providing the 
cache information.

.eserverCacheName

.1.3.6.1.4.1.2197.10.1.2.103.1.2

Name of the cache.

.eserverCacheSize

.1.3.6.1.4.1.2197.10.1.2.103.1.3

Number of objects in the 
cache at the time of request.

.eserverCacheTotalEvents

.1.3.6.1.4.1.2197.10.1.2.103.1.4

Number of cache data 
requests since startup at the 
time of request.

.eserverCacheTotalHits

.1.3.6.1.4.1.2197.10.1.2.103.1.5

Number of cache hits since 
startup at the time of request.

.eserverCacheTotalMisses

.1.3.6.1.4.1.2197.10.1.2.103.1.6

Number of cache misses 
since startup at the time of 
request.
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.eserverCacheHitRatio

.1.3.6.1.4.1.2197.10.1.2.103.1.7

Average number of cache 
hits per second (expressed as 
a percent value) at the time 
of request.

 requests .eserverDALRequestsTable

.1.3.6.1.4.1.2197.10.1.2.41

This table provides 
Entitlements Server  requests 
information.

.eserverDALRequestsHost

.1.3.6.1.4.1.2197.10.1.2.41.1.1

Name and port number of the 
host machine providing the  
requests information.

.eserverDALRequestsTotal

.1.3.6.1.4.1.2197.10.1.2.41.1.2

Number of  requests since 
startup at the time of request.

.eserverDALRequestsPerSec

.1.3.6.1.4.1.2197.10.1.2.41.1.3

Average number of requests 
processed by the  per second 
during the last 30 seconds at 
the time of request.

.eserverDALRequestsPending

.1.3.6.1.4.1.2197.10.1.2.41.1.4

Number of requests pending 
for the  at the time of request.

 response time .eserverDALResponseTable

.1.3.6.1.4.1.2197.10.1.2.43

This table provides 
Entitlements Server  
response time information.

.eserverDALResponseHost

.1.3.6.1.4.1.2197.10.1.2.43.1.1

Name and port number of the 
host machine providing the  
response time information.

.eserverDALResponseAvgTime

.1.3.6.1.4.1.2197.10.1.2.43.1.2

Average  response time 
during the last 30 seconds at 
the time of request.

.eserverDALResponseMinTime

.1.3.6.1.4.1.2197.10.1.2.43.1.3

Minimum  response time 
during the last 30 seconds at 
the time of request.

.eserverDALResponseMaxTime

.1.3.6.1.4.1.2197.10.1.2.43.1.4

Maximum  response time 
during the last 30 seconds at 
the time of request.

Active connections to 
the  listed by type

.eserverDALActiveConnTable

.1.3.6.1.4.1.2197.10.1.2.46

This table provides 
information about active 
connections made to the  by 
the Entitlements Server. All 
data is grouped by  type.
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.eserverDALActiveConnHost

.1.3.6.1.4.1.2197.10.1.2.46.1.1

Name and port number of the 
host machine providing the  
active connection 
information.

.eserverDALActiveConnType

.1.3.6.1.4.1.2197.10.1.2.46.1.2

Type of  (for example, 
“Oracle”) that is actively 
connected at the time of 
request.

.eserverDALActiveConnCount

.1.3.6.1.4.1.2197.10.1.2.46.1.3

Number of active 
connections to the  at the 
time of request.

.eserverDALActiveConnMaxCount

.1.3.6.1.4.1.2197.10.1.2.46.1.4

Number of connections 
made to the  since startup at 
time of request.

Active connections to 
the  listed by pool type

.eserverDALNumConnByPoolTable

.1.3.6.1.4.1.2197.10.1.2.49

This table provides 
information about active 
connections made to the  by 
the Entitlements Server. All 
data is grouped by  pool 
type.

.eserverDALNumConnByPoolHost

.1.3.6.1.4.1.2197.10.1.2.49.1.1

Name and port number of the 
host machine providing the  
active connection type 
information.

.eserverDALNumConnByPoolName

.1.3.6.1.4.1.2197.10.1.2.49.1.2

Pool type name (SQL or 
LDAP) of a  that is actively 
connected at the time of 
request.

.eserverDALNumConnByPoolCount

.1.3.6.1.4.1.2197.10.1.2.49.1.3

Number of active 
connections made to a  pool 
type at the time of request.

Runtime configuration .eserverRuntimeConfigTable

.1.3.6.1.4.1.2197.10.1.2.53

This table provides runtime 
configuration for the 
Entitlements Server. These 
configurations can be 
modified at runtime.

.eserverRuntimeConfigHost

.1.3.6.1.4.1.2197.10.1.2.53.1.1

Name and port number of the 
host machine providing 
configuration information.
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Dispatcher

.eserverRuntimeConfigParamName

.1.3.6.1.4.1.2197.10.1.2.53.1.2

Runtime configuration 
parameter name.

.eserverRuntimeConfigParamValue

.1.3.6.1.4.1.2197.10.1.2.53.1.3

Runtime configuration 
parameter value.

Notifications in case of 
trapped events

.eserverNotifications

.1.3.6.1.4.1.2197.10.1.2.100

Notifications sent when 
trapped events take place on 
the Server.

.eserverLogEvent

.1.3.6.1.4.1.2197.10.1.2.100.1.1

Notification that the Server 
has logged a critical message 
(Level 10 and higher).

.eserverFailoverEvent

.1.3.6.1.4.1.2197.10.1.2.100.1.2

Notification that the Server 
has failed over to another . 
(Only available for LDAP.)

System Information Node Name\OID Number Description
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Configuration 
information

.dispatcherConfigurationTable

.1.3.6.1.4.1.2197.10.1.3.1

This table provides 
Dispatcher configuration 
information. Sensitive 
information, such as the 
administrator password, is 
excluded.

.dispatcherConfigHost

.1.3.6.1.4.1.2197.10.1.3.1.1.1

Name and port number of the 
host machine providing 
configuration information.

.dispatcherConfigParamName

.1.3.6.1.4.1.2197.10.1.3.1.1.2

Parameter names from 
dispatcher.conf.

.dispatcherConfigParamValue

.1.3.6.1.4.1.2197.10.1.3.1.1.3

Current value for each 
parameter at the time of 
request.

System uptime .dispatcherSysUpTimeTable

.1.3.6.1.4.1.2197.10.1.3.2

This table provides 
Dispatcher uptime 
information.
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.dispatcherSysUpTimeHost

.1.3.6.1.4.1.2197.10.1.3.2.1.1

Name and port number of the 
host machine providing 
Dispatcher uptime 
information.

.dispatcherSysUpTimeValue

.1.3.6.1.4.1.2197.10.1.3.2.1.2

Time elapsed since 
Dispatcher startup.

Requests .dispatcherRequestsTable

.1.3.6.1.4.1.2197.10.1.3.3

This table provides 
Dispatcher requests 
information.

.dispatcherRequestsHost

.1.3.6.1.4.1.2197.10.1.3.3.1.1

Name and port number of the 
host machine providing 
Dispatcher requests 
information.

.dispatcherRequestsTotal

.1.3.6.1.4.1.2197.10.1.3.3.1.2

Number of requests since 
startup at the time of request.

.dispatcherRequestsPerSec

.1.3.6.1.4.1.2197.10.1.3.3.1.3

Average number of requests 
received per second during 
the last 30 seconds at the 
time of request.

Number of connected 
clients

.dispatcherNumOfConnClientsTable

.1.3.6.1.4.1.2197.10.1.3.5

This table provides 
information about the 
number of clients connected 
to the Dispatcher.

.dispatcherNumOfConnClientsHost

.1.3.6.1.4.1.2197.10.1.3.5.1.1

Name and port number of the 
host machine providing the 
number of connected clients 
information.

.dispatcherNumOfConnClientsValue

.1.3.6.1.4.1.2197.10.1.3.5.1.2

Number of connected clients 
at the time of request.

Client connections .dispatcherNumOfConnByClientsTable

.1.3.6.1.4.1.2197.10.1.3.7

This table provides the 
number of client connections 
to the Dispatcher grouped by 
hostname and port number.

.dispatcherNumOfConnByClientsHost

.1.3.6.1.4.1.2197.10.1.3.7.1.1

Name and port number of the 
host machine providing the 
client connection 
information.
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.dispatcherConnClientName

.1.3.6.1.4.1.2197.10.1.3.7.1.2

Hostname and port number 
of the connected client.

.dispatcherNumOfConnections

.1.3.6.1.4.1.2197.10.1.3.7.1.3

Number of client 
connections at the time of 
request.

Authorization Server 
connections

.dispatcherActiveAuthServersTable

.1.3.6.1.4.1.2197.10.1.3.10

This table provides a list of 
all active Authorization 
Servers registered with the 
Dispatcher.

.dispatcherActiveAuthServersHost

.1.3.6.1.4.1.2197.10.1.3.10.1.1

Name and port number of the 
host machine providing the 
active Authorization Servers 
registered with the 
Dispatcher information.

.dispatcherActiveAuthServersName

.1.3.6.1.4.1.2197.10.1.3.10.1.2

Name of the active 
Authorization Server 
registered with the 
Dispatcher at the time of 
request.

Key Server connections .dispatcherActiveKeyServersTable

.1.3.6.1.4.1.2197.10.1.3.11

This table provides a list of 
all active Key Servers 
registered with the 
Dispatcher.

.dispatcherActiveKeyServersHost

.1.3.6.1.4.1.2197.10.1.3.11.1.1

Name and port number of the 
host machine providing the 
active Key Servers registered 
with the Dispatcher 
information.

.dispatcherActiveKeyServersName

.1.3.6.1.4.1.2197.10.1.3.11.1.2

Name of active Key Server 
registered with the 
Dispatcher at the time of 
request.

Runtime configuration .dispatcherRuntimeConfigTable

.1.3.6.1.4.1.2197.10.1.3.12

This table provides runtime 
configuration for the 
Dispatcher Server. These 
configurations can be 
modified at runtime.

.dispatcherRuntimeConfigHost

.1.3.6.1.4.1.2197.10.1.3.12.1.1

Name and port number of the 
host machine providing 
configuration information
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Key Server

.dispatcherRuntimeConfigParamName

.1.3.6.1.4.1.2197.10.1.3.12.1.2

Runtime configuration 
parameter name.

.dispatcherRuntimeConfigParamValue

.1.3.6.1.4.1.2197.10.1.3.12.1.3

Runtime configuration 
parameter value.

Notifications .dispatcherNotifications

.1.3.6.1.4.1.2197.10.1.3.100

Notifications sent when 
trapped events take place on 
the Dispatcher.

.dispatcherLogEvent

.1.3.6.1.4.1.2197.10.1.3.100.1.1

Notification that the 
Dispatcher has logged a 
critical message (Level 10 
and higher).

.dispatcherRegistrationFailureEvent

.1.3.6.1.4.1.2197.10.1.3.100.1.2

Notification that an 
Authorization Server has 
failed to register with the 
Dispatcher.
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Configuration 
information

.keyserverConfigurationTable

.1.3.6.1.4.1.2197.10.1.4.1

This table provides Key 
Server configuration 
information. Sensitive 
information, such as the 
administrator password, is 
excluded.

.keyserverConfigHost

.1.3.6.1.4.1.2197.10.1.4.1.1.1

Name and port number of the 
host machine providing 
configuration information.

.keyserverConfigParamName

.1.3.6.1.4.1.2197.10.1.4.1.1.2

Parameter names from 
keyserver.conf.

.keyserverConfigParamValue

.1.3.6.1.4.1.2197.10.1.4.1.1.3

Value for each parameter at 
the time of request.

System uptime .keyserverSysUpTimeTable

.1.3.6.1.4.1.2197.10.1.4.2

This table provides Key 
Server uptime information.
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.keyserverSysUpTimeHost

.1.3.6.1.4.1.2197.10.1.4.2.1.1

Name and port number of the 
host machine providing 
Server uptime information.

.keyserverSysUpTimeValue

.1.3.6.1.4.1.2197.10.1.4.2.1.2

Time elapsed since Server 
startup.

Requests .keyserverRequestsTable

.1.3.6.1.4.1.2197.10.1.4.3

This table provides Key 
Server requests information.

.keyserverRequestsHost

.1.3.6.1.4.1.2197.10.1.4.3.1.1

Name and port number of the 
host machine providing 
Server requests information.

.keyserverRequestsTotal

.1.3.6.1.4.1.2197.10.1.4.3.1.2

Number of requests since 
startup at the time of request.

.keyserverRequestsPerSec

.1.3.6.1.4.1.2197.10.1.4.3.1.3

Average number of requests 
received per second during 
the last 30 seconds at the 
time of request.

Number of connected 
clients

.keyserverNumOfConnClientsTable

.1.3.6.1.4.1.2197.10.1.4.5

This table provides the 
number of clients connected 
to the Key Server.

.keyserverNumOfConnClientsHost

.1.3.6.1.4.1.2197.10.1.4.5.1.1

Name and port number of the 
host machine providing the 
number of clients connected 
to Server information.

.keyserverNumOfConnClientsValue

.1.3.6.1.4.1.2197.10.1.4.5.1.2

Number of clients connected 
to Server at the time of 
request.

Client connections .keyserverNumOfConnByClientsTable

.1.3.6.1.4.1.2197.10.1.4.7

This table provides the 
number of client connections 
to the Key Server grouped by 
hostname and port number.

.keyserverNumOfConnByClientsHost

.1.3.6.1.4.1.2197.10.1.4.7.1.1

Name and port number of the 
host machine providing the 
number of client connections 
information.

.keyserverConnClientName

.1.3.6.1.4.1.2197.10.1.4.7.1.2

Hostname and port number 
of connected client.

System Information Node Name\OID Number Description
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.keyserverNumOfConnections

.1.3.6.1.4.1.2197.10.1.4.7.1.3

Number of client 
connections at the time of 
request.

Running mode .keyserverRunningModeTable

.1.3.6.1.4.1.2197.10.1.4.10

This table indicates whether 
the Key Server is running in 
master or slave mode.

.keyserverRunningModeHost

.1.3.6.1.4.1.2197.10.1.4.10.1.1

Indicates whether the Key 
Server is running in master 
or slave mode at the time of 
request.

Key information .keyserverKeyInfoTable

.1.3.6.1.4.1.2197.10.1.4.11

This table provides a list of 
keys and their time to live.

.keyserverKeyInfoHost

.1.3.6.1.4.1.2197.10.1.4.11.1.1

Name and port number of the 
host machine providing the 
list of keys and their time to 
live information.

.keyserverKeyInfoNumber

.1.3.6.1.4.1.2197.10.1.4.11.1.2

Key in Server at the time of 
request.

.keyserverKeyInfoTTL

.1.3.6.1.4.1.2197.10.1.4.11.1.3

Key time to live value.

Runtime configuration .keyserverRuntimeConfigTable

.1.3.6.1.4.1.2197.10.1.4.12

This table provides runtime 
configuration for the Key 
Server. These configurations 
can be modified at runtime.

.keyserverRuntimeConfigHost

.1.3.6.1.4.1.2197.10.1.4.12.1.1

Name and port number of the 
host machine providing 
configuration information.

.keyserverRuntimeConfigParamName

.1.3.6.1.4.1.2197.10.1.4.12.1.2

Runtime configuration 
parameter name.

.keyserverRuntimeConfigparamValue

.1.3.6.1.4.1.2197.10.1.4.12.1.3

Runtime configuration 
parameter value.

Notifications .keyserverNotifications

.1.3.6.1.4.1.2197.10.1.4.100

Notifications sent when 
trapped events take place on 
the Server.

System Information Node Name\OID Number Description
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.keyserverLogEvent

.1.3.6.1.4.1.2197.10.1.4.100.1.1

Notification that the Key 
Server has logged a critical 
message (Level 10 and 
higher).

System Information Node Name\OID Number Description
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I Enhanced Logging

• Enhanced Logging of Create Operations

• Enhanced Logging of Modify Operations

• Enhanced Logging of Delete Operations

• Handling LDAP Exceptions

Enhanced Logging provides a more complete record of RSA Access Manager 
operations, making it possible to track the life cycle of an object in the system. 
Enhanced Logging also records: 

• The administrator who performed an operation

• The role selected by the administrator for the session

• The time when the operation was performed

• The type of operation that was performed

This makes it possible to audit who made changes to the system as well as when those 
changes were made. This appendix provides an in-depth reference of the information 
that is recorded when create, modify, and delete operations are logged in Enhanced 
Logging mode. For information about enabling Enhanced Logging, see “Enabling 
Enhanced Logging” on page 252.

CAUTION: When enhanced logging is enabled, the demand for storage space 
increases because log messages are longer and more events are logged. Care must be 
taken to ensure that adequate storage space is available to meet increased storage 
requirements.

Enhanced Logging of Create Operations

Information about create operations in Enhanced Logging mode includes a variety of 
common items as well as items particular to the object being created.

Common Items in Create Operation Logs

All create operations that are recorded in Enhanced Logging mode provide the 
following information:

Sequence number. (sequence_number=) Each logged event is tagged with a 
sequence number. This identifies any gaps in the log file that are introduced when 
the Access Manager Servers have to assume logging because the Log Server is 
unavailable.
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Event time stamp. (YYYY-MM-DD HH:MM:SS:MS TIME ZONE) The date 
and the time at which the operation was performed on the machine, where the 
Authorization, Entitlement, and Dispatcher/Key or Instrumentation servers are 
running. 

Note: You can configure the timestamp format using the 
CT_LOG_DATE_FORMAT system variable.

Connection ID. (conn=) This is used to distinguish among multiple threads of 
execution.

Client operation ID. (op=) Each operation a client makes increments this by 1.

MessageID. (messageID=) The message ID indicates the code for the action 
being recorded in an event. For more information, see Appendix D, “Log Message 
IDs for Entitlements Server.”

Entitlements Server ip address. (ip=) The ip address of the Entitlements Server.

Administrator user name. (uname=) The user name of the administrator who 
performed the operation.

Administrator user role. (urole=) The name of the administrative role that the 
administrator has selected for the session.

Operation name. (msg=) The name of the operation being performed.

Operation type. (msgtype=) The type of operation—create, modify, delete, or 
read, that was performed.

Result code. (result=) The code for the result of the event. For more information, 
see Appendix F, “Log File Result Codes.”

Entitlements Server time. (etime=) Identifies the amount of time used by the 
Server in processing the operation.

Object name. (name=) The name of the object created in this operation.

Object unique identifier. (object_nameUID=) Each time a new object is created, 
a Unique Object Identifier (UID) is assigned that is used to track the object after 
its creation. For more information, see the following section, “Unique Object 
Identifier.”

Related object name(s). (related_object_name=) The name(s) of additional 
objects that are a functional part of the new object.

Related object UID(s). (related_object_nameUID=) The UID(s) of additional 
objects that are a functional part of the new object.
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Unique Object Identifier

Each Unique Object Identifier (UID) consists of the following three elements as well 
as either an LDAP Distinguished Name (DN) or SQL integer identifying the object 
being stored.

Following is a plain text example of a UID as it would appear in a log file:

applicationUID=UniqueIdentifier ( Type: LDAP Store ID: Testv1 Class Identifier: 6) 
DN:  "cn=5104 ou=ctscApplicationDataRepository dc=NA c=RSA dc=NET"

Disabling Base 64 Encoding of Unique Identifiers

Normally, Unique Identifiers (UIDs) representing Access Manager objects are base 
64-encoded when written to a log file. This is done to ensure that the string is safe 
from various forms of character conversion or log manipulation. However, for 
debugging or manual auditing purposes, it is helpful to have the UID written in plain 
text as seen in the previous example.

Base 64 encoding is disabled when the cleartrust.eserver.log.encoding parameter in 
eserver.conf is set to false. For example: 

cleartrust.eserver.log.encoding=false

After base 64 encoding has been disabled, all UIDs display in plain text, allowing the 
user to track data and to distinguish among different objects during an operation.

 Type  ID Object Class Identifier

• LDAP

• SQL

• VIRTUAL

Name of the  host • ADMINISTRATIVE_GROUP = 1

• ADMINISTRATIVE_ROLE = 2

• ADMINISTRATIVE_USER = 3

• APPLICATION = 4

• APPLICATION_FUNCTION = 5

• APPLICATION_URL = 6

• ENTITLEMENT = 7

• ENTITY = 8

• GROUP = 9

• OWNED_URL = 10

• PASSWORD_POLICY = 11

• PROPERTY_DEFINITION = 12

• RESOURCE = 13

• SMART_RULE = 15

• USER = 16

• WEBSERVER = 17

• IMPERSONATION_POLICY=18
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Create Operation Log Example

Event: An administrator creates (adds) a new administrative group using the 
RSA Administrative Console.

Log output:

sequence_number=110,2005-10-04 18:16:07:974 PDT,
conn=1,op=53,messageID=601,ip=127.0.0.1,uname=admin,
urole=InternationalSpaceStationManagerRole,
msg=Create admin group,msgtype=CREATE,result=0,etime=90ms,
password_policyUID=UniqueIdentifier ( Type: LDAP Store ID: Testv1 Class 
Identifier: 11) DN:  "cn=1208 ou=ctscPolicyRepository dc=tgrenier 
dc=net",admin_groupUID=UniqueIdentifier ( Type: LDAP Store ID: Testv1 Class 
Identifier: 1) DN:  "cn=4803 ou=ctscAdminRepository 
dc=tgrenierdc=net",name=InternationalSpaceStationAdminGroup23,password_policy
=ApolloManagersPasswordPolicy

Note: The order of the keyword/value pairs might be displayed in a different order 
than the one in this example 

Specific Create Operation Log Information

The following table lists the specific information that is recorded in Enhanced 
Logging mode when each of the following objects are created. This specific 
information is logged in addition to the information previously described in “Common 
Items in Create Operation Logs” on page 343.

Created Object Logged Information Specific to the Object

Administrative Group • Administrative group name

• Administrative group UID

• Administrative group password policy name

• Administrative group password policy UID

Administrative Role • Administrative role name

• Administrative role UID

• Administrative group name

• Administrative group UID

Administrator • Administrator name

• Administrator user name

• Administrator Super Admin rights

• Administrative group name

• Administrative group UID

• List of administrator added role names and role UIDs
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Application • Application name

• Administrative group name

• Administrative group UID

• Policy conflict resolution

Application Function • Application name

• Application UID

• Function name

• Function UID

Password Policy • Password policy name

• Password policy UID

Smart Rule • Resource name

• Resource UID

• Resource type

• Property name

• Property UID

• Smart Rule (policy) UID

User Property Definition • Property name

• Property UID

Web Server • Server name

• Administrative group name

• Administrative group UID

• Resource name (server name)

• Resource UID (server UID)

• Hostname

Web URL, Application 
URL, J2EE resource 
belonging to an application

• Uniform Resource Identifier (URI)

• Server name

• Server UID

• Application name

• Application UID

• Resource name

• Resource type

• Resource UID

• Policy conflict resolution

Created Object Logged Information Specific to the Object
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Enhanced Logging of Modify Operations

Information about modify operations recorded in Enhanced Logging mode includes a 
variety of common items as well as items particular to the object being modified.

Common Items in Modify Operation Logs

All modify operations that are recorded in Enhanced Logging mode provide the 
following information:

Sequence number. (sequence_number=) Each logged event is tagged with a 
sequence number. This identifies any gaps in the log file that are introduced when 
the Access Manager Servers have to assume logging because the Log Server is 
unavailable.

Event time stamp. (YYYY-MM-DD HH:MM:SS:MS TIME ZONE) The date 
and time when the operation was performed.

Connection ID. (conn=) This is used to distinguish among multiple threads of 
execution.

Client operation ID. (op=) Each operation a client makes increments this by 1.

MessageID. (messageID=) The message ID indicates the code for the action 
being recorded in an event. For more information, see Appendix D, “Log Message 
IDs for Entitlements Server.”

Entitlements Server ip address. (ip=) The ip address of the Entitlements Server.

Administrator user name. (uname=) The user name of the administrator who 
performed the operation.

Administrator user role. (urole=) The name of the administrative role that the 
administrator has selected for the session.

Operation name. (msg=) The name of the operation being performed.

Operation type. (msgtype=) The type of operation—create, modify, delete, or 
read, that was performed.

Result code. (result=) The code for the result of the event. For more information, 
see Appendix F, “Log File Result Codes.”

Entitlements Server time. (etime=) Identifies the amount of time used by the 
Server in processing the operation.

Object name. (object_name=) The name of the object modified in this operation.

Object unique identifier. (object_nameUID=) When an object is modified, the 
UID that was assigned when the object was created is displayed. For more 
information, see “Unique Object Identifier” on page 345.

New object name. (new_object_name=) The name of the object after 
modification.

Original object name. (original_object_name=) The name of the object before 
modification.
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New related object name(s). The name(s) of additional objects that are a 
functional part of the new object after modification.

Original related object name(s). The name(s) of additional objects that are a 
functional part of the new object before modification.

Modify Operation Log Example

Event: An administrator modifies (edits) a server using the Administrative Console.

Log output:

sequence_number=104,2005-11-03 22:13:51:178 PST,
conn=0,op=102,eventID=1104,messageID=1101,ip=127.0.0.1,uname=admin,urole=
Default Administrative Role,msg=Modify application,msgtype=MODIFY,
result=0,etime=109ms,original_application=[admin_group:[null] application:[App40] 
properties:[] isPolicyAllowBeforeDeny:[true] visibility:[false]],
resourceUID=UniqueIdentifier ( Type: LDAP Store ID: Testv1 Class Identifier: 4) 
DN:  "cn=2902 ou=ctscApplicationDataRepository dc=NA dc=RSA 
dc=NET",new_application=[admin_group:[Default Administrative Group] 
application:[App40] properties:[Property Definitions:[[name:[departmentnumber] 
data type:[INT]] ] ] isPolicyAllowBeforeDeny:[true] visibility:[true]],
application=App40

Note: The order of the keyword/value pairs might be displayed in a different order 
than the one in this example 

Specific Modify Operation Log Information

The following table lists the specific information that is recorded in Enhanced 
Logging mode when each of the following objects is modified. This specific 
information is logged in addition to the information previously described in “Common 
Items in Modify Operation Logs” on page 348.

Modified Object Logged Information Specific to the Object

Administrative Group • Administrative group name

• Administrative group UID

• New administrative group name

• New administrative group password policy

• Original administrative group name

• Original administrative group password policy

Note: Administrative group password policy is logged in complete detail listing all the 
parameters, such as policy name, minimum and maximum length, excluded characters, and so 
on. 
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Administrative Role • Administrative group name

• Administrative role name

• Administrative role UID

• New administrative role name

• New administrative role privileges

• Original administrative role name

• Original administrative role privileges

Note: Administrative role privileges are logged in complete detail listing all of the possible 
operations that can be performed, which operations for the role are allowed (marked true), 
and which operations are not allowed (marked false). Each object is abbreviated and prefaced 
according to the type of operation: C = create, M = modify, D = delete. For example, CSRVR: 
true means that the role allows the administrator to create (add) a server.

Object abbreviations:

• SRVR - Server

• APPL - Application

• GRUP - User Group

• ADMR - Administrative Role

• ADMU - Administrative User

• USER - User

• PROP - User Property

Administrator • User name of the administrator being modified

• UID of the administrator being modified

• Name of the item being modified (updated)

• Confirmation that the item has been modified (updated)

• Administrative group to which the administrator belongs

• Removed roles (legacy list of deleted role names)

• Added roles (legacy list of added role names)

• New administrative role(s)

• New administrator help desk rights

• New administrator Super Admin rights

• New administrator properties

• New administrator account expiration date

• Original administrative role(s)

• Original administrator help desk rights

• Original administrator Super Admin rights

• Original administrator properties

• Original administrator account expiration date

Modified Object Logged Information Specific to the Object
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Administrator Property • Property name

• Property UID

• New property administrative group name

• New property name

• New property data type

• New property location (internal/external)

• New property external provider

• New property URL exported (true/false)

• New property help desk access (true/false)

• New property public (true/false)

• New property read only (true/false)

• Original property administrative group name

• Original property name

• Original property data type

• Original property location (internal/external)

• Original property external provider

• Original property URL exported (true/false)

• Original property help desk access (true/false)

• Original property public (true/false)

• Original property read only (true/false)

Application • Application name

• Resource UID

• New application administrative group

• New application name

• New application properties

• New property name and data type (if any)

• New application policy conflict resolution

• New application policy visibility

• Original application administrative group

• Original application name

• Original application properties

• Original property name and data type (if any)

• Original application policy conflict resolution

• Original application policy visibility

Modified Object Logged Information Specific to the Object
I: Enhanced Logging 351



RSA Access Manager 6.1 SP4 Servers Installation and Configuration Guide
Smart Rule • Operation type = UPDATE

• Policy UID

• Property name

• Resource type

• Resource name

• Administrator name

• New Smart Rule definition

• Original Smart Rule definition

• Application UID

Web Server • Web server name

• Web server UID

• New web server administrative group

• New web server name

• New web server hostname

• Original web server administrative group

• Original web server name

• Original web server hostname

Web URL, Application 
URL, J2EE resource 
belonging to an application

• Application name

• Application UID

• Resource

• Resource UID

• Administrative group name

• New name

• New resource type

• New resource name (URL)

• New web server name (web/application URLs only)

• New web server hostname

• New resource policy conflict resolution

• Original name

• Original resource type

• Original resource name (URL)

• Original web server name (web/application URLs only)

• Original web server hostname

• Original resource policy conflict resolution

Modified Object Logged Information Specific to the Object
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Enhanced Logging of Delete Operations

Information about delete operations in Enhanced Logging mode includes a variety of 
common items as well as items particular to the object that is deleted.

Common Items in Delete Operation Logs

All delete operations that are recorded in Enhanced Logging mode provide the 
following information:

Sequence number. (sequence_number=) Each event is tagged with a sequence 
number. This identifies any gaps in the log file which are introduced when the 
Access Manager Servers have to assume logging because the Log Server is 
unavailable.

Event time stamp. (YYYY-MM-DD HH:MM:SS:MS TIME ZONE) The date 
and time when the operation was performed.

Connection ID. (conn=) This is used to distinguish among multiple threads of 
execution.

Client operation ID. (op=) Each operation a client makes increments this by 1.

Event ID. (eventID=) Each event is tagged with an event ID. When an object is 
deleted, all objects that have a child relationship to that object are deleted as well. 
The event ID is used to identify these parent-child relationships.

Parent event ID. (parent_eventID=) Each child object that is being deleted is 
identified by the event ID of the parent object.

Autodelete index. (autodelete_index=) Each child object that is being deleted is 
tagged with an autodelete number that indicates the order in which the child 
objects are deleted.

MessageID. (messageID=) The message ID indicates the code for the action 
being recorded in an event. For more information, see Appendix D, “Log Message 
IDs for Entitlements Server.”

Entitlements Server ip address. (ip=) The ip address of the Entitlements Server.

Administrator user name. (uname=) The user name of the administrator who 
performed the operation.

Administrator user role. (urole=) The name of the administrative role that the 
administrator has selected for the session.

Operation name. (msg=) The name of the operation being performed.

Operation type. (msgtype=) The type of operation—create, modify, delete, or 
read, that was performed.

Result code. (result=) The code for the result of the event. For more information, 
see Appendix F, “Log File Result Codes.”

Entitlements Server time. (etime=) Identifies the amount of time used by the 
Server in processing the operation.

Deleted object name. (object_name=) The name of the object deleted in this 
operation.
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Deleted object unique identifier. (object_nameUID=) When an object is deleted, 
the UID that was assigned when the object was created is displayed. For more 
information, see “Unique Object Identifier” on page 345.

Deleted related object(s). (name=) The name(s) of additional objects that are a 
functional part of the deleted object and are deleted along with it.

Deleted related object UID(s). (objectUID=) The UID(s) of additional objects 
that have a child relationship to the deleted object and are deleted along with it.

Delete Operation Log Example

Event: An administrator deletes an administrative group using the Administrative 
Console.

Log output:

sequence_number=220,2005-11-01 16:01:36:956 PST,
conn=-1,op=-1,eventID=1222,messageID=502,ip=<internal>,uname=<system>,urole
=<system>,msg=Delete admin role,msgtype=DELETE,parent_eventID=1221,
autodelete_index=0,objectUID=UniqueIdentifier (DataStore Type: LDAP Store ID: 
Testv1 Class Identifier: 2) DN:  "cn=697 ou=ctscAdminRepository dc=NA dc=RSA 
dc=NET",name=ppRuntimeRole

sequence_number=221,2005-11-01 16:01:36:956 PST,
conn=1,op=214,eventID=1221,messageID=603,ip=127.0.0.1,uname=admin,
urole=Default Administrative Role,msg=Delete admin group,msgtype=DELETE,
result=0,etime=78ms,admin_group=ppRuntimeGroup,admin_groupUID=UniqueIden
tifier ( Type: LDAP Store ID: Testv1 Class Identifier: 1) DN:  "cn=696 
ou=ctscAdminRepository dc=NA dc=RSA dc=NET"

Specific Delete Operation Log Information

The following table lists the specific information that is recorded in Enhanced 
Logging mode when each of the following objects is deleted. This specific 
information is logged in addition to the information previously described in “Common 
Items in Delete Operation Logs” on page 353.

Deleted Object Logged Information Specific to the Object

Administrative Group • Administrative group name

• Administrative group UID

• Administrative role name

• Administrative role UID

• Events for any associated administrative group(s) for this 
administrative group

Note: When an administrative group is deleted, any users or groups are automatically 
transferred to the default administrative group. The transfer of users or groups to the default 
administrative group is not logged.
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Administrative Group 
Password Policy

• Password policy name

• Password policy UID

Administrative Role • Administrative group name

• Administrative role name

• Administrative role UID

Application or Web Server • Server name

• Server UID

• Associated web URL name(s)

• Associated web URL UID(s)

• Associated application name(s)

• Associated application name UID(s)

Entitlement • Policy UID

• Resource name

• Resource type

• Entitlement name

• Entitlement type

• Entitlement UID

Entity (User, Administrator, 
or User Group)

• Entity name

• Entity UID

• Associated entitlement name(s)

• Associated entitlement UID(s)

Smart Rule • Policy UID

• Resource type

• Resource name

• Associated Smart Rule user property name

User Property • User property name

• User property UID

• Associated Smart Rule definition

• Associated Smart Rule UID

Web URL, Application 
URL, J2EE resource 
belonging to an application

• Resource name

• Resource UID

• Associated Smart Rule definition

• Associated Smart Rule UID

Deleted Object Logged Information Specific to the Object
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Handling LDAP Exceptions

LDAP exceptions are applicable only to active directory and “authentication failure” 
events. When you deploy LDAP with validate_with_connect parameter enabled in the 
ldap.conf file, Access Manager users intermittently encounter authentication failures 
for the following reasons:

• Disabled account/password

• Expired account/password

• The user failed to change the password on first logon. 

In all such authentication failures, an INVALID_USER message is logged and the 
actual reason for the authentication failure is not logged in the log files. Also, the same 
log message (INVALID_USER) is returned as an authentication result to the agent in 
case of an authentication failure.

You can configure the ldap.conf file to handle all such authentication errors and log 
the appropriate messages in the log files for the administrators to view.

To configure LDAP exceptions handling:

1. Navigate to AXM_HOME/conf, and open the ldap.conf file.

2. If your LDAP throws error messages during authentication, set the values for the 
following parameter in the ldap.conf file:

cleartrust.data.ldap.errorMessages parameter 

This optional parameter specifies what is logged and returned as an authentication 
result to agent in case of an authentication failure in Active Directory. 
The value of the parameter must be in key-value pairs separated by ‘=’. A key 
value pair must be delimited from the other pairs by ‘;’. 
The key specifies the character sequence contained in the LDAP error message 
thrown by LDAP during authentication and the value defines the reason for the 
error messages, which can be any of the authentication results supported by 
Access Manager.
The key can be any subset of the actual message returned by AD containing the 
numeral after the word 'data'. The reason should be one of the authentication 
results supported by RSA Access Manager.
Allowed values are:

LdapErr: DSID-0C09030B, comment: AcceptSecurityContext 
error, data 532 = EXPIRED_PASSWORD

LdapErr: DSID-0C09030B, comment: AcceptSecurityContext 
error, data 533 = INACTIVE_ACCOUNT

LdapErr: DSID-0C09030B, comment: AcceptSecurityContext 
error, data 701 = EXPIRED_ACCOUNT

LdapErr: DSID-0C09030B, comment: AcceptSecurityContext 
error, data 773 = EXPIRED_PASSWORD_NEW_USER

LdapErr: DSID-0C09030B, comment: AcceptSecurityContext 
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error, data 775 = ADMIN_LOCKOUT

For example,

cleartrust.data.ldap.errorMessages : LdapErr: 
DSID-0C09030B, comment: AcceptSecurityContext error, data 
775=ADMIN_LOCKOUT;data 
532=EXPIRED_PASSWORD;533=INACTIVE_ACCOUNT

Note: This parameter should not be set if ctscUserAuxClass is enabled.
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J Enhanced Functionality

• Virtual User Support

• Support for Access Denial Feedback

• Creating an External Property

• Publishing Properties to HTTP Header

• Clearing Cache

• Functions

• Authorization Server Modes

• Sequential Evaluation of Smart Rules

• Configuring Unique User Session

• Configuring Password Restrictions

• Enabling Delegated Impersonation

This appendix describes RSA Access Manager features that require changes to 
configuration file parameters or the development of custom software in order to be 
enabled. Many of these features are mentioned in the Administrator’s Guide and are 
described here in more detail.

Virtual User Support

In order to enable integration for special purposes, Access Manager provides support 
for “virtual” users who have no record in the Access Manager . This makes it possible 
for users to be authenticated through a custom authentication method and to be 
authorized to access resources by using Smart Rules that are matched with user 
properties supplied by an external property provider.

This functionality is achieved by configuring the Authorization Server to run in virtual 
user mode. For more information, see the comments about the 
cleartrust.data.virtual.user_mode parameter in the aserver.conf file.

Support for Access Denial Feedback

Access Manager provides a Java Runtime API and a C Runtime API to develop the 
means for generating a customized message to a user that explains why access to a 
resource has been denied. Currently, when a user is denied access, a 404 screen 
displays. For more information, see the Developer’s Guide.
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Creating an External Property

External properties have values stored in an external  and are used for creating and 
evaluating Smart Rules.

To create an external property:

1. Use the Property Provider API to create an external property provider, the process 
or procedure that retrieves the property value from the external .
For more information about creating a property provider, see the Developer's 
Guide.

2. Use the RSA Administrative Console to create a property. Select the External 
checkbox, and enter the name of the external property provider in the External 
Property Provider field.

3. Enter the name and the full classname of the external property provider in the 
cleartrust.property.providers parameter in the aserver.conf file.

Publishing Properties to HTTP Header

To select a property to be automatically published to the HTTP header upon 
authentication:

1. Select the Export/Publish checkbox when you add or edit the property in the 
RSA Administrative Console.

2. In the Web Server Agent configuration file, add the property to the list parameter, 
cleartrust.agent.userprops. This is a comma-separated list of the property names as 
defined in the Administrative Console. For example:
cleartrust.agent.userprops=departmentNumber,homephone,postalCode

To publish all your properties, enter the wildcard character, *, in the parameter. You 
must restart the web server after you add or delete properties from the parameter list.

For more information, see your RSA Access Manager Agent documentation.

Clearing Cache

Before you attempt to clear the cache, make sure that all the running Authorization 
Servers are accessible from the Entitlements Server. If you click Clear Cache when 
an Authorization Server is not accessible, the system returns the following error 
message: 

Error: clearServerCaches ( "null" ) failed 6 consecutive 
times
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When making large-scale changes to the system—for example, modifying thousands 
of administrative groups—turn off the automatic cache updates first, make the 
changes, and then use the Clear Cache command to manually clear the cache. To turn 
off automatic cache updates, set the cleartrust.eserver.runtime.granular_updates 
parameter in the eserver.conf file to false.

Functions

A function is an Access Manager representation of any type of function or method in 
any type of custom application that you build. Modeling a method as a function allows 
Access Manager to control access to that method. This allows you to implement 
Access Manager Agent-like controls (similar to building an Access Manager WAX) 
governing access to methods in your custom applications.

If you create a non-web Java application that has a sensitive method, which you do not 
want to make available to all users, you can govern access to this method by creating a 
function for it.

For example, for a method called updateBalance(), you can create a function entry in 
the Administrative Console with this specific name, description, and policy conflict 
resolution setting:

• Name: updateBalance

• Description: Lets users with the appropriate access update account balances.

• Policy Conflict Resolution: Deny access when policy conflicts occur.

This setting determines access priority for conflicting entitlements and Smart Rules. 

Assuming that the updateBalance function has been integrated with Access Manager 
through the API, you can apply Smart Rules or entitlements to this application-level 
resource using the defined name.

When you set policies in the Access Manager system, you treat a function the same as 
you would treat a URL. That is, you collect related functions (along with any related 
URLs) into applications, and you grant users or user groups permission to use these 
applications, functions, and URLs.

If you are not building stand-alone applications, you generally do not need to use 
functions. For most dynamic web content such as CGIs on web pages, you control 
access by creating a URL that matches the URL request string or the name of the CGI 
script being called. Once you create entitlements based on these URLs, the 
RSA Access Manager Web Server Agents can control access to the functions in the 
CGI script. In contrast, functions are useful for access checking in situations that do 
not involve URL requests, that is, in situations where the RSA Access Manager 
Agents cannot be used.

You manage functions from the Define Resources menu of the Administrative 
Console.

Software developers must use the exact value for the function name when making the 
appropriate function call to the Authorization Server from the function. For more 
information, see the Developer's Guide.
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Authorization Server Modes

The cleartrust.aserver.authorization_mode parameter, in aserver.conf, determines 
whether the system behaves in active or passive mode. Allowed values are active or 
passive. By default, the value of the cleartrust.aserver.authorization_mode parameter 
is set to passive. For example, a system set to passive mode appears this way in the 
aserver.conf file: cleartrust.aserver.authorization_mode=passive

Sequential Evaluation of Smart Rules

Access Manager can be configured to ignore policy conflict resolution settings and 
evaluate the Smart Rules in the order they appear in the Administrative Console.

For more information, see the cleartrust.aserver.ordered_smartrule_eval parameter in 
aserver.conf.

Configuring Unique User Session

RSA Access Manager by default does not have any restrictions on number of sessions 
for the users and allows them to logon to new sessions without logging off from the 
previous sessions. Unique user session is an optional feature that helps you to disable 
concurrent user sessions in Access Manager. You can configure unique user session 
during configuration of Access Manager or at runtime.

Important: Unique User Session must be configured with either Oracle or Microsoft 
SQL as the database. Unique user session cannot be configured with LDAP.

To configure unique user session at startup:

1. Open AXM_HOME/conf/uus.conf.

2. Provide the values for the following database connection parameters in the 
uus.conf file:

cleartrust.uus.database.type=

cleartrust.uus.database.jdbc.driver=

cleartrust.uus.database.jdbc.url=

cleartrust.uus.database.user=

cleartrust.uus.database.password=

Note: The user connecting to the SQL database must have privileges to create 
tables on the database.

3. Open the eserver.conf file and set the value for the following parameter to true.

cleartrust.eserver.unique_user_session.enable=
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4. Open the aserver.conf file and add the following parameters with appropriate 
values:

cleartrust.aserver.admin_api.hostname=<eserver host>

cleartrust.aserver.admin_api.port=<eserver port>

cleartrust.aserver.admin_api.username=<administrator>

cleartrust.aserver.admin_api.password=<admin password>

cleartrust.aserver.admin_api.role=<admin role name>

cleartrust.aserver.admin_api.admingroup=<group name>

cleartrust.aserver.admin_api.use_ssl=<mode>

To configure unique user session at runtime:

Note: An NMS browser is required to configure unique user session at runtime.

1. Open AXM_HOME/conf/uus.conf.

2. Provide the values for the following database connection parameters in the 
uus.conf file:

cleartrust.uus.database.type=

cleartrust.uus.database.jdbc.driver=

cleartrust.uus.database.jdbc.url=

cleartrust.uus.database.user=

cleartrust.uus.database.password=

Note: The user connecting to the SQL database must have privileges to create 
tables on the database.

3. Enable instrumentation on the Entitlements Server. To enable instrumentation, set 
the following parameter to true in the eserver.conf file located in the 
AXM_HOME/conf directory:

cleartrust.eserver.instrumentation.enabled 

4. Provide a valid IP address or DNS hostname of the Instrumentation Server for the 
cleartrust.eserver.instrumentation.registration.hostname parameter in the 
eserver.conf file.

5. In the iserver.conf file located in the AXM_HOME/conf directory, perform the 
following:

a. Set the following read community parameter to public:

cleartrust.iserver.snmp.community = public

b. Set the following write community parameter to private:

cleartrust.iserver.snmp.write_community = private

6. Load the MIB file RSA-ACCESS-MANAGER-MIB located in the 
AXM_HOME/mibs directory to your NMS browser.
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7. Provide the read and write community parameters in your NMS browser. The 
values that you set in your NMS browser must match the values set in your 
iserver.conf file in step 5.

8. For all the servers for which you want to enable unique user session, set the 
following parameter to true in your NMS browser:

cleartrust.eserver.unique_user_session.enable

Configuring Password Restrictions

In addition to the password policy in Access Manager, passwords can also be 
validated by the password restrictions feature. When a user is created or modified, this 
feature checks for the validity of the password before the changes are saved. 

You can write your own listener classes to enforce any extra validation for the 
passwords of the created or modified users. An example of such a listener class is 
PasswordHookEventExample, located in the AXM_HOME/sdk/java/admin 
directory.

To configure Entitlements Server to enforce password restrictions:

1. Set the classpath for the listener class that validates the passwords.

2. Provide the listener class name using the following parameter in the eserver.conf 
file:

cleartrust.hooks.listeners

Note: You can provide multiple listener class names separated by commas.

For more information on creating listener classes, see the Developer’s Guide.

Enabling Delegated Impersonation

Delegated impersonation lets you control the activities performed by an impersonator. 
For example, if a user has access to five applications, you can let the impersonator 
access two applications. You can delegate administrators to act as impersonators and 
access the applications used by other users and troubleshoot the issues that the users 
face. 

To enable delegated administration, set the following parameter to true in the 
aserver.conf file in the AXM_HOME/conf directory:

cleartrust.aserver.impersonation.enable=true

Delegated impersonation policies can be set only at the application level using Access 
Manager Administrative APIs. For more information, see the Developer’s Guide.
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K Integration with RSA enVision

• Supported RSA enVision Versions

• Generating Access Manager Log Reports in RSA enVision

You can integrate Access Manager with RSA enVision to manage your logs. To do 
this, you must install the enVision agent on all instances where you have the Log 
Server running.

Supported RSA enVision Versions

You can integrate Access Manager with the following RSA enVision versions:

• RSA enVision 3.7

• RSA enVision 4.0

Note: You need to download and install the event source update #9 patch for enVision 
available at https://knowledge.rsasecurity.com.

Generating Access Manager Log Reports in RSA enVision

For informaion on how to generate log reports in enVision, see the RSA enVision 
documentation set.

To get appropraite information in the log reports, make sure that you have selected the 
following tables and fields for respective Access Manager Servers in enVision:

Access Manager 
Servers

Table Fields

Authorization Server Access Control System DATEFORMAT(EventTime, 
‘yyyy-mm-dd hh’)

DeviceAddress

MessageID

Action

Reason

Username

Threshold
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Dispatcher / Key 
Server

Access Control Security DATEFORMAT(EventTime, 
‘yyyy-mm-dd hh’)

MessageID

Message

DeviceAddress

Action

Entitlement Server Access Control Security DATEFORMAT(EventTime, 
‘yyyy-mm-dd hh’)

DeviceAddress

MessageID

Message

Username

Action

Access Manager 
Servers

Table Fields
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L Third-Party Reference

• Application Servers

• LDAP Directory Servers

• SQL Database Servers

• Certificate Authorities

• Network Management Systems

• Embedded and Bundled Products

RSA Access Manager integrates with several third-party products in order to provide 
authorization capabilities for your existing web environment. This appendix provides 
useful links to third-party applications that are supported by Access Manager.

Product links are organized in the following categories:

• Application Servers

• LDAP Directory Servers

• SQL Database Servers

• Certificate Authorities

• Network Management Systems

There are third-party libraries or products embedded into or bundled with Access 
Manager. Access Manager supports these components as part of the Access Manager 
environment. They are provided for use through the license of Access Manager. For 
more information, see “Embedded and Bundled Products” on page 370.

Application Servers

For web server and application server information, see the following:

• For Apache Tomcat 5.5 Comprehensive Documentation, go to 
http://tomcat.apache.org/tomcat-5.5-doc/index.html

• For Apache Tomcat 6.0 Comprehensive Documentation, go to
http://tomcat.apache.org/tomcat-6.0-doc/index.html

• For Apache Tomcat 7.0 Comprehensive Documentation, go to
http://tomcat.apache.org/tomcat-7.0-doc/index.html

• For WebLogic 10 Documentation, go to 
http://download.oracle.com/docs/cd/E13222_01/wls/docs100/index.html

• For WebLogic 11 Documentation, go to
http://www.oracle.com/us/products/middleware/application-server/index.ht
ml
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• For WebSphere Documentation, go to
http://www-306.ibm.com/software/webservers/appserv/was/library/index.ht
ml

LDAP Directory Servers

Access Manager provides Data Adapters for the leading LDAP directory servers, 
allowing you to leverage your existing user accounts and data structure. 

The following web sites provide installation and configuration information for the 
supported LDAP directory servers:

• For Sun ONE directory server 5.2 Comprehensive Documentation, go to 
http://download.oracle.com/docs/cd/E19850-01/816-6696-10/docoview.html

• For Sun Java System Directory Server 6.3.1 Comprehensive Documentation, go 
to
http://download.oracle.com/docs/cd/E19261-01/820-5817/index.html

• For Sun Java System Directory Server 7.0 Comprehensive Documentation, go to 
http://download.oracle.com/docs/cd/E19424-01/820-4807/index.html

• For Novell eDirectory, go to
http://www.novell.com/products/edirectory/

• For Microsoft Server 2003 Active Directory and Active Directory Application 
Mode, go to
http://www.microsoft.com/windowsserver2003/

• For Microsoft Server 2008 Active Directory and Active Directory Application 
Mode, go to 
http://www.microsoft.com/windowsserver2008/

• For Microsoft Server 2008 Active Directory Lightweight Directory Services 
Comprehensive Documentation, go to
http://technet.microsoft.com/en-us/library/cc754361(WS.10).aspx

• For OpenDJ 2.4.3 Comprehensive Documentation, go to
https://wikis.forgerock.org/confluence/display/OPENDJ/OpenDJ+2.4.3+Rele
ase+Notes

SQL Database Servers

Access Manager provides Data Adapters for the leading SQL database management 
servers (RDBMS), allowing you to leverage your existing user accounts and data 
structure:

• For Oracle 10g, go to
http://www.oracle.com/technology/products/database/oracle10g/index.html

• For Oracle 11g, go to
http://www.oracle.com/technology/products/database/oracle11g/index.html
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• For Sybase, go to
http://www.sybase.com/products/databaseservers/ase

• For Microsoft SQL Server 2005, go to
http://www.microsoft.com/technet/prodtechnol/sql/2005/downloads/

• For Microsoft SQL Server 2008, go to
http://www.microsoft.com/sqlserver/en/us/default.aspx

Certificate Authorities

Access Manager supports X.509 certificates from the leading certificate authorities 
(CAs) for both client certificate authentication and server certificate authentication. 
The following list provides information about the CAs supported by Access Manager:

• RSA Certificate Manager: Access Manager is distributed with a limited-license 
copy of RSA Certificate Manager. If you do not currently have a certificate 
authority (CA) from which you can issue server certificates, you can use the 
Certificate Manager to generate certificates for Access Manager intercomponent 
security. The Certificate Manager software and documentation is located on the 
RSA Certificate Manager 6.8 DVD.

• Entrust. Go to http://www.entrust.com/

• Verisign. Go to http://www.verisign.com/enterprise/

Note: For Certificate authentication to work properly with SQL s, the Certificate 
distinguished name (DN) string must not have spaces around the DN string delimiter 
(“,” or sometimes “/”), and the entire string must be set in lowercase letters. For 
example, cn=user,o=rsa,c=us. The Administrative Console automatically follows 
these formatting conventions. If you are using an existing record of Certificate DN 
strings or are entering a Certificate DN string using a third-party utility, you must 
follow these conventions.

Network Management Systems

Access Manager provides Simple Network Management Protocol (SNMP) support for 
the following leading third-party Network Management Systems. This enables you to 
monitor the Access Manager Servers in real-time:

• IBM Tivoli Software. Go to http://www-306.ibm.com/software/tivoli/

• HP OpenView. Go to http://www.managementsoftware.hp.com/
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Embedded and Bundled Products

Access Manager supports products as part of the Access Manager environment. They 
are provided for use through the license of Access Manager as part of the Access 
Manager deployment. The web sites mentioned in the following sections are useful for 
developers seeking detailed information.

Sun Java Runtime Environment

The Access Manager Servers for Solaris and Linux run on the Sun Java Runtime 
Environment (JRE) 1.5, the Java runtime virtual machine. To access product 
downloads, release notes, and online support, go to http://java.sun.com/j2se/1.5/.

IBM SDK Java Runtime Environment

The Access Manager Servers for AIX run on the IBM Java Runtime Environment 
(JRE) 1.5 and 1.6, the Java runtime virtual machine. To access product downloads, 
release notes, and online support, go to 
http://www-128.ibm.com/developerworks/java/jdk/.

RSA BSAFE

Access Manager is developed using encryption tools from RSA BSAFE. RSA BSAFE 
is a full-featured toolkit implementing SSL and Transport Layer Security (TLS v1) 
protocols as well as a full-strength general-purpose cryptography library. Access 
Manager uses the BSAFE Crypto-J, Crypto-C, SSL-J and SSL-C libraries. For more 
information about RSA BSAFE, go to http://www.rsasecurity.com/products/bsafe/.

RSA Certificate Manager

RSA Certificate ManagerCertificate Managerthe Certificate Manager
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M Troubleshooting

Diagnosing RSA Access Manager Installation Problems  

Access Manager has a debugging utility that is helpful in diagnosing problems with 
your Access Manager Server installation. The DEBUG utility outputs additional 
information to the command screen and log files, which can help you determine the 
cause of potential problems with your Access Manager setup. You must not enable 
this utility in a production environment, but it is very useful in a test or development 
environment.

To start the Servers in DEBUG mode on Windows:

There are two ways to run the Servers in DEBUG mode on Windows. Do one of the 
following:

• Run the Server from the command line, appending the argument “debug”. For 
example, to run the Authorization Server in DEBUG mode, type:

aserver debug

• Edit the startup script of any Server so that the script launches the Server in 
DEBUG mode. To do this:

– Open the Server startup script (aserver.bat, dispatcher.bat, and so on) 
located in the \bin directory of your Access Manager installation. 

– Type the -DDEBUG flag after the -xmx flag. For example, to set up the 
Authorization Server, you would open the aserver.bat file and add 
-DDEBUG after the -xmx128m flag. Do not remove the %DEBUG% 
argument that already exists in the file. After your edits, the line will look 
similar to the following:

-DAuth -xmx128m -DDEBUG %DEBUG% -Djava.ext.dirs=...

– Save and close the startup script. Make sure that you use the script each time 
you want to run the Server in DEBUG mode.

To start the Servers in DEBUG mode on UNIX:

1. Open the Access Manager Server startup scripts (aserver.sh, dispatcher.sh, and 
eserver.sh). They are located in the /bin directory of your Access Manager 
installation.

2. Uncomment the following lines in each of the startup scripts:
DEBUG="-DDEBUG"
LOGFILE=$AXM_HOME/logs/aserver-$DATE.dbg

This step writes debugging information into a log file in the /logs directory of your 
Access Manager installation.
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3. Save and close each file. 

4. Start each Server. For more information, see “Starting the Servers Manually on 
UNIX” on page 126. This step sends extra debugging information to the Access 
Manager debugging log files.

5. Disable the DEBUG utility before moving your Servers into production.

Authorization Server Leaks Connections

The cleartrust.aserver.socket_timeout parameter in AXM_HOME/conf/aserver.conf 
sets an idle timeout on all connections that the Authorization Server accepts. This 
optional parameter is usually not necessary, but in some configurations it ensures that 
the server closes connections that a firewall terminates.

If this parameter is not set, the Authorization Server sees such connections as still 
valid even though they are not. When connections leak in this way, they count against 
the maximum number of connections to the Authorization Server, as the value for the 
cleartrust.aserver.max_connections parameter defines in 
AXM_HOME/conf/aserver.conf.

For more information, see the comments for the cleartrust.aserver.socket_timeout 
parameter in the AXM_HOME/conf/aserver.conf file.

RSA Administrative Console does not Successfully Start

A number of dependencies can affect the successful startup of your Administrative 
Console:

• The Administrative Console cannot start until you start the application server, , 
Dispatcher/Key Server, and the Entitlements Server. 

• If you set the Administrative Console for SSL connections to the Entitlements 
Server, make sure that the use_ssl setting in the admingui.cfg file matches the 
cleartrust.eserver.api_port.use_ssl setting in eserver.conf (the value must be 
anon).

• Make sure that you specify the Entitlements Server host in admingui.cfg, and that 
the variable webgui.config.directory indicates the correct path. 

• You must synchronize the system clocks of the Entitlements Server and 
Administrative Console hosts.

• You must configure your browser to accept cookies.
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• JSP files fail to compile on WebLogic if WebLogic is started as an NT service. 
The failure to compile happens because WebLogic cannot find javac.exe. To 
resolve this problem, add the following to the Administrative Console 
weblogic.xml file:

 <jsp-descriptor>
    <jsp-param>
      <param-name>compileCommand</param-name>
      <param-value>/bea/jdk131/bin/javac.exe</param-value>
    </jsp-param>
  </jsp-descriptor>

The value /bea/jdk131/bin/javac.exe is relevant to the JDK on your particular 
host.

Unable to Generate a Shared Secret Using Keygen

Make sure that:

• You are not trying to create a shared secret for a server that already exists in your 
Key Server list (KeyServer.sec).

• The fully qualified hostname is valid. This must be a real DNS name in the 
context of your network.

• You are entering the complete and correct path to the keygen utility file.

Problematic Characters in LDAP Directories

Access Manager interacts uniquely with each supported LDAP directory. For this 
reason, using characters, such as " / \ , ; : [ ] | < > + = ? * # can cause problems when 
creating the names of users and groups. RSA recommends avoiding the use of these 
characters when creating the names of users and groups using Access Manager tools. 

Unable to start the aserver/dispatcher in debug mode

Access Manager throws the following error message while attempting to start the 
aserver/dispatcher in the debug mode:

Resolved hostname to following IP(s) : 172.26.9 9.32 0:0:0:0:0:0:0:1
java.lang.NumberFormatException: For input string: "0:0:0:0:0:0:1"

This error is because AxM does not currently support IPV6, and it should be disabled 
in Windows. If the error persists after disabling IPV6, the following workaround can 
be used.
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To start the aserver/dispatcher in debug mode:

1. In aserver/dispatcher/eserver.bats init section, add the IPV4 preference as 
JVM_OSARGS option, for example:
init
set JAVA_HOME=%AXM_HOME%\jre
set JVM_OSARGS=-server -Djava.net.preferIPv4Stack=true
set JVM_64=0

2. In the hosts file, in addition to removing the IPV6 loopback, add the IPV4 IP 
address and FQDN of the host (by default, this is blank). This ensures that it 
matches the hostname.
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